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Overview 

Our unique space-time platform allows you to conduct advanced spatial and space-time 
analysis within a fast, user-friendly environment.  Visualization capabilities allow you to 
view the data in your project, display these data in maps and graphs, and perform statistics to 
evaluate spatial pattern.  The space-time platform also incorporates a temporal component 
which lets time be a dimension of the data, rather than an attribute linked to each object in 
the dataset.  Thus, almost all views of the data can be animated, from maps to histograms to 
tables. But, SpaceStat does more than just animate your data, it allows you to make statistical 
inferences about patterns in the data as well. SpaceStat allows you to view, interact with and 
statistically analyze your space-time data so that you can make informed decisions.   

The space-time platform interface consists of a few components: the data view, spatial 
weights view, and log view; the task manager; the toolbars; and a workspace containing the 
maps and graphs you choose to generate. 

Right-clicking in the toolbar area will bring up a list of the toolbars and views, which allows 
you to "uncheck" those you don't want to see. You can retrieve toolbars and views by 
selecting them from the Window menu.  In the view below, the views, and tools bars are 
shown in their default locations, but these can all be docked or free-floating.  The data, 
spatial weights, and log view can also be layered with access tabs.  You can also move the 
graphs, plots, and maps within the workspace.  You can click on the image below for more 
information about the elements shown. 
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Overview 

Data View 
The data view is a visual display of all of the data in your project. Unlike other GIS 
programs, which tend to organize the data by tables, this view organizes the data by the 
associated geography, and all variables associated with that geography are listed. 

The data view occupies the left side of the application window as a default. 

Weight sets and Variogram model View 
This window houses both the spatial weights view and the variogram model view.  This view 
can be hidden and brought back by going to the "Window" menu and selecting "Spatial 
weights and variogram model view".   

The spatial weights view is a visual display of the spatial weights sets you have in your 
project. It lists the weights sets available, and it is where you create new weights sets to use 
in statistical methods or to view in the map. The variogram model view is a visual display of 
the variogram models you have in your project. You can use this view to organize and edit 
your variograms. 

Log View 
SpaceStat records text-based information from your analyses in the log view: the screen 
below the Data view and Map. You can move the log or resize it as you like. You can also 
close it and re-open it by going to "Window" and selecting "Log view." 

Task Manager 
The task manager guides you through implementation of SpaceStat's collection of data 
transformation and statistical methods. 

Toolbars 
SpaceStat has four tool sets for you to use: Project, Visualization, Animation, and Map tools. 
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Welcome to SpaceStat 4.0 

Welcome to the latest SpaceStat, version 4.0! 

SpaceStat 4.0 presents a major reworking of the underlying architecture of SpaceStat. 
 Multithreading has been introduced improving the performance of numerous methods. 
 Updates have been made to the appearance, functionality, and performance of maps and 
graphs. 

A LePace-Sage estimator for spatial-error and spatial-lag analyses has been added to the 
spatial regression method. 

The help documentation has been revised and updated and features an improved look. 

Visit the Changelog to see changes made in previous versions of SpaceStat. 
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SpaceStat Changelog 

version 4.0 
Version 4.0 adds a major reworking of the underlying architecture of SpaceStat. 
 Multithreading has been introduced improving the performance of numerous methods. 
 Updates have been made to the appearance, functionality, and performance of maps and 
graphs.  A LePace-Sage estimator for spatial-error and spatial-lag analyses has been added to 
the spatial regression method.  The help documentation has been revised and updated and 
features an improved look. 

version 3.8 
Fixed several bugs and added support for automatic checking for updates. 

version 3.6 
Added new Q-statistic, Jacquez's Q, for evaluating space-time clustering in case-control data. 
 Integrated Flexera licensing for network and individual licenses. 

version 3.5 
Included discretization and deconvolution as additional options that allow you to perform 
kriging from one geography to another.  Added the 2D histogram view for exploring how 
objects are distributed with respect to two variables. 

version 3 
Extended importing and exporting to include the geodatabase (gdb) format so that you can 
easily integrate SpaceStat into a workflow that uses Esri's ArcGIS. (Esri, and esri.com are 
trademarks, registered trademarks, or service marks of Esri in the United States, the 
European Community, or certain other jurisdictions.)   "Spatial interpolation" was renamed to 
"scale conversion/interpolation" to better describe the applications of this procedure. 
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Begin an Analysis 

When you start SpaceStat, you can choose to create a new project or open a previously saved 
project. 

Open a previously saved project 
Click on the folder icon in project toolbar. Browse to locate the project you want to open. 
 SpaceStat 2.1 and later projects have the extension *.spt.  SpaceStat 2.0 projects have 
extension *.sps.  The current version can open both file types, as well as projects created with 
our Space-Time Intelligence System (STIS), version 1.7 or earlier, *.sts. 

Want to see a sample project? Try a tutorial! 

Create a new project by importing data 
An overview of importing and modifying data within SpaceStat can be found here.  To 
import data, go to the File menu, select "Import", and then select "Polygon or Point file." 
 You can also click on the green import folder on the toolbar.  Once you import a shapefile 
(polygons or points) or Excel file or text file with point locations, you can import additional 
geographies, and/or import datasets (attributes) that will link to the geographies already 
present. 

 Create a new project by importing a problem file 
SpaceStat 1.8 and earlier created problem files.  These files contained records of analyses 
which were conducted in the software.  If you have a problem file and would like to continue 
your work in the current SpaceStat, you can import the problem file into the newer version.   

  

7 





Data Preparation 

  

Overview of Importing Data 
The first step toward visualizing and analyzing your own data is preparing your data so it can 
be imported into SpaceStat.  Since SpaceStat is built upon our unique space-time platform, 
all of your data must be associated with a spatial location and a time.   Currently the software 
supports analyses based on two representations of space: point and polygon geographies. 
 You may also import line geographies for visualization purposes, but they cannot currently 
used with the statistical methods. 

In many cases, your first step in creating a SpaceStat project will be to import a shapefile that 
represents the spatial support for your data or to import a feature class from a gdb file.  This 
is often an areal (polygon) representation of counties, states, zip codes, or some similar 
political boundary, but can be any collection of polygons or points.  Within shapefiles or gdb 
files, each spatial unit has a unique identifier (ID), which allows information or attributes of 
that spatial unit to be linked and tracked over time.  If the shapefile already contains attribute 
information (datasets) as part of the associated DBF, you can begin to visualize and analyze 
your data right away.  If not, you can import datasets as Excel, text, or DBF files, and link 
them to the geography with a common ID column.  Point geographies can be imported as 
shapefiles or gdb files, or as Excel, text, or DBF files of coordinates and IDs. 

Importing shapefiles, gdb files or point data coverages is a routine task when working with 
GIS software, and is likely to be familiar to many SpaceStat users.  However, in SpaceStat 
you also need to be able assign each attribute to a time, because SpaceStat allows you to 
work with data for which the attributes, and even the shape of a given polygon can change 
over time.  Similarly, the location and attributes of objects represented in point geographies 
can change over time, but the ID of each point remains constant.  The dynamic nature of how 
data are represented in SpaceStat makes it possible to visualize and analyze data in exciting 
new ways, but does mean that the process of getting data into the program involves a few 
additional steps to ensure that objects and their attributes are represented correctly.  Here we 
provide a brief overview of what is required to bring data in to SpaceStat, and how data can 
be modified once it has been successfully imported. 

Handling time - time series or time slice? 

Once you have chosen a polygon or point file to bring into SpaceStat, the first question you 
will need to address is "What is the most appropriate way to assign time stamps to the data?" 
 In SpaceStat you have two options - to treat data as a time series, or as time slices.  We 
provide this choice because sometimes you will be working with data that is collected in 
specific time intervals (time slices), while in other cases, values can change for different 
objects at different times (best represented as a time series).  Time slices are cases where data 
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values or locations change synchronously across objects in the geography (or at least are all 
recorded at the same time) so time stamps can be applied to all objects at once, and data for 
different time intervals within the total interval can be grouped into one dataset during the 
import process (see the Illinois tutorial for an example).  However, if attributes or locations 
of objects change at different times (asynchronously), the start and end time for each 
combination of attribute and location needs to be recorded as an individual line within a 
column of data.  As a result, each object ID is likely to be repeated in a file to be imported; 
we call these temporal data of this type "time series".  SpaceStat treats the first date or time in 
a series as an inclusive start value, and treats the end value as exclusive for both temporal 
representations.  There is an "advanced" option on the import dialog box to change this 
default if desired.   

In the end, a time series data file requires more "up-front" work to get it ready for import 
(i.e., each line must have a start and end date or time), but there are fewer steps in the import 
process.  Many sources of publicly available space-time data (e.g., cancer rate data for a 
county or state geography) represent time slices, which are easy to prepare for import (often 
just a matter of copying values and object IDs into a spreadsheet), but these datasets require 
additional steps during the import process to assign time stamps.  Click here to see how these 
two different ways of handling time data are formatted for SpaceStat, and here to link to the 
two import tutorials (mentioned above) that demonstrate import of time slice and time series 
data. 

Once you have decided whether to import as a time slice or time series, check on how dates, 
times, and locations need to be formatted, and then look here for help on the File import 
dialog box. 

Coordinating time stamps across geographies and datasets 

When working with temporal data, a meaningful time stamp must be provided for 
geographies during import, even if the spatial characteristics of the geography do not change 
over time (i.e., county or state boundary shapefiles or gdb files). This is because time stamps 
for geographies and datasets in your project will determine the start and end dates on your 
animation (time) slider.   For objects to be "visualizable" (i.e., seen in maps) at the same 
time, they must have at least some overlap in their time stamps.  Visualization of certain 
objects within the geographies and datasets in a given project will not be possible if they 
have very different time stamps that do not overlap.    

For example, a geography is imported and defined with a very wide time slice (e.g., 1950 - 
2000). If you then attempt to view datasets linked to objects in the geography that have a 
much narrower time slice (e.g., 1960 - 1965), a map of the geography would only appear as 
the animation runs through 1960-65; these polygons would appear blank through the rest of 
the animation.   

If none of your data have a time component, the default import time format can be used for 
all files you bring in. In order to work with these files together, they must all receive the 
same stamp.   
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Modifying geographies by importing and merging a new file 

Once you have an existing geography, you can import changes in shapes or positions by 
bringing in another shapefile, gdb file, text file, or Excel file with a different time stamp and 
merging it with an existing geography.  In most cases, this can be accomplished with time 
slice data where the end of the first time slice (exclusive) is set to match the beginning 
(inclusive) of the time slice for the geography you are merging.  For SpaceStat to allow 
objects to move or change shape, the objects must have the same ID in both geographies. 
 The "Merge with existing geography" option will appear in the "Import method" menu 
within the "Import file" dialog box when you are working on projects for which you have 
already imported at least one geography.    

Modifying geographies after import 

There are also many ways to create geographies and datasets from those that have already 
been imported, as described in the "Create New Data" page.  Briefly, tools for modifying 
geographies include the ability to create a subset of an existing geography, to create a 
centroid geography from a polygon geography, and to alter the spatial structure of a 
geography through a set of tools we group under "Scale Conversion/Interpolation" in the 
methods menu.   

Modifying and creating datasets after import 

There are many ways to modify or create new datasets within SpaceStat.   The following two 
categories describe these methods. 

1. products of techniques you can use as part of a visualization process or to prepare data for 
further analysis, and 

2. products of a statistical analysis.    

As part of a data preparation or visualization step, you may want to standardize datasets 
using the Z-score transformation, or smooth them using the Empirical Bayesian Smoother. 
  Prior to conducting an analysis, you may need to modify an existing datasets using tone of 
the dataset calculator's functions (i.e., take an absolute value, or multiply by a constant).   

The creation of new datasets is primarily achieved through the use of statistical methods.  In 
some cases, the new datasets are the focal product of the analysis, and in others they help you 
to evaluate spatial patterns in your results (i.e., by mapping the residuals from a regression 
analysis). 

  

How to Represent Time 
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Temporal Data Formats 

When preparing time series data for importing into SpaceStat, you will need to create the 
date and time stamps that can be read by the software. 

Dates 

SpaceStat accepts dates as integers formatted as: YYYYMMDD, YYYYMM, or YYYY. 
This is consistent with the Federal Geographic Data Committee (FGDC) metadata standards 
for representing dates. If you are preparing your data file in a spreadsheet, you can use either 
a numeric format or a date format column for this. 

You can also import dates as MM/DD/YYYY in string or text format in a DBF. 

Times 

SpaceStat accepts times as integers formatted as HHMMSS or strings (alphanumeric) 
formatted as HH:MM:SS (so 10:01 AM is 100100 or 10:01:00 and 10:01 PM is 220100). 
This is equivalent to the "local time" specification in the FGDC standard, but without 
milliseconds. The hours must be expressed military style, with a 24 hour clock. See time 
format in DBF for more information. 

Arbitrary (unitless) 

You may use your own format for tracking time. SpaceStat accepts arbitrary times as integers 
and orders them in numerical order. 

  

  

Time Series vs. Time Slice 

As described here, when importing geographies (shapefiles, gdb files, Excel files, or text 
files) and files of attribute data (Excel files, text files, or DBFs), you will need to determine 
the most appropriate way to structure your data with respect to time.  SpaceStat provides two 
options, time series and time slice, described below. 

Time Series 

• Time series data is for data that varies asynchronously (objects move or change 
attributes at different times). 

• Time is specified by the time stamp in the rows in the data file. Time stamps in series 
data are considered to be inclusive of the start stamp and exclusive of the end stamp. 
To include all of the end date or time, specify "Through end of time period". For 
details on how to write dates for SpaceStat, see temporal data formats. 
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• As an example: the table records that a rate of 56.7 for object 3 is valid from [1980, 
1990) and then 89.1 is valid from [1990, 2000).  This means that at the beginning of 
1990, the value changes from 56.7 to 89.1. 

ID Start Year End Year Rate 

3 1980 1990 56.7 

4 1980 2000 70.6 

3 1990 2000 89.1 

• If your file includes records with missing values for start or end times, these rows will 
be skipped upon import into SpaceStat. 

Time Slice 

• Time slice data is for data that varies in a synchronous matter (objects or attributes 
change at specified times for all objects in the dataset). 

• Time slice data are efficiently represented as files with synchronous observations on 
all of the objects. The time stamp is set at the level of the entire file or for individual 
data columns on import, rather than individual data rows. 

File 1 
[1980-1990) 

ID Rate_80 

3 56.7 

4 70.6 
 

File 2 
[1990-2000] 

ID Rate_90 

3 89.1 

4 70.6 
 

or Combined 
  

ID Rate_80 Rate_90 

3 56.7 89.1 

4 70.6 70.6 
 

A note on exporting data 

When exporting, SpaceStat exports time slice data, though several time slices can be 
exported in a single shapefile set. 

  

Spatial Data Formats 
  

Spatial Data Formats 
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SpaceStat accepts point, line, and polygon data sets in shapefile or gdb file format. 

Point data consist of X, Y, and values of variable(s). SpaceStat automatically generates a 
spatial weight set when you import a point dataset. The default weights set is "5 nearest 
neighbors," although you can add others to suit your analysis needs. You can create a point 
geography from a polygon geography by generating a centroid geography. 

Polygon data consists of vertices and associated data. Polygon files typically come from a 
GIS, and are imported into SpaceStat as a shapefile or a gdb file. Correct representation of 
polygons in SpaceStat requires the file to contain valid polygons.  Valid polygons are non-
overlapping, do not include self-intersections, and border each other.     

When you import a polygon file, there is an option for SpaceStat to verify the polygons are 
valid. SpaceStat will verify that the vertices are listed in the correct order within the file, so 
the polygons will import correctly.   

SpaceStat automatically generates a spatial weight set when you import a polygon dataset. 
The default spatial weight set is "first-order queen neighbors," although you can add others to 
suit your analysis needs. 

Line data consists of vertices and associated data. Lines cannot be used for spatial statistics, 
but they can be used to help you visualize your data. 

  

  

Coordinate Systems 

Point, line, and polygon data are expressed as vertices in GIS files (shapefiles, gdb files or 
point DBF files), but there are many types of units for these coordinates. Example coordinate 
systems include: 

        geographic (latitude and longitude, spherical coordinates on the globe) 
        planar (projection of spherical coordinates to a plane) 

o       UTM 
o       Albers equal area 
o       Lambert conformal conic 

  

SpaceStat cannot project imported data from geographic coordinates or convert (reproject) 
data from different planar projections. You must import all of your datasets in the same 
coordinate system to have them overlay properly in the map and for spatial analyses.  If 
your imported data includes a *.prj file, SpaceStat will show the coordinate system of the 
data in the data source properties. 
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Import Geographies and Datasets 
  

File Import dialog 

As described in the overview, you can import new spatial data (geographies) and attribute 
data (datasets) into SpaceStat in several formats: shapefiles, gdb files, Excel files, text files, 
and DBFs.  If you have imported a problem file, you can also bring along attribute data via a 
Gauss file.  Shapefiles and gdb files can hold point, polygon or line geographies. Currently 
line geographies, like roads, can be used for visualization, but not as input for statistical 
analyses.   

Text, Excel, and DBF files can only hold point geographies (i.e., columns with x and y 
coordinates) or datasets.   Note that if you import a shapefile that already has associated 
attribute data in a DBF, you can import and timestamp both the geography and datasets at the 
same time, as described here. 

Click here for a step-by-step introduction to importing shapefiles and gdb files (for use as 
new geographies, or for merging with existing geographies). 

Click here for a step-by-step introduction to importing Excel files, text files, and DBFs for 
use as point geographies, or here to use a file of one of these types for importing a dataset. 

For information on adding new spatial weight sets to a SpaceStat project, click here. 

  

  

Overview of Importing Data 

The first step toward visualizing and analyzing your own data is preparing your data so it can 
be imported into SpaceStat.  Since SpaceStat is built upon our unique space-time platform, 
all of your data must be associated with a spatial location and a time.   Currently the software 
supports analyses based on two representations of space: point and polygon geographies. 
 You may also import line geographies for visualization purposes, but they cannot currently 
used with the statistical methods. 

In many cases, your first step in creating a SpaceStat project will be to import a shapefile that 
represents the spatial support for your data or to import a feature class from a gdb file.  This 
is often an areal (polygon) representation of counties, states, zip codes, or some similar 
political boundary, but can be any collection of polygons or points.  Within shapefiles or gdb 
files, each spatial unit has a unique identifier (ID), which allows information or attributes of 
that spatial unit to be linked and tracked over time.  If the shapefile already contains attribute 
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information (datasets) as part of the associated DBF, you can begin to visualize and analyze 
your data right away.  If not, you can import datasets as Excel, text, or DBF files, and link 
them to the geography with a common ID column.  Point geographies can be imported as 
shapefiles or gdb files, or as Excel, text, or DBF files of coordinates and IDs. 

Importing shapefiles, gdb files or point data coverages is a routine task when working with 
GIS software, and is likely to be familiar to many SpaceStat users.  However, in SpaceStat 
you also need to be able assign each attribute to a time, because SpaceStat allows you to 
work with data for which the attributes, and even the shape of a given polygon can change 
over time.  Similarly, the location and attributes of objects represented in point geographies 
can change over time, but the ID of each point remains constant.  The dynamic nature of how 
data are represented in SpaceStat makes it possible to visualize and analyze data in exciting 
new ways, but does mean that the process of getting data into the program involves a few 
additional steps to ensure that objects and their attributes are represented correctly.  Here we 
provide a brief overview of what is required to bring data in to SpaceStat, and how data can 
be modified once it has been successfully imported. 

Handling time - time series or time slice? 

Once you have chosen a polygon or point file to bring into SpaceStat, the first question you 
will need to address is "What is the most appropriate way to assign time stamps to the data?" 
 In SpaceStat you have two options - to treat data as a time series, or as time slices.  We 
provide this choice because sometimes you will be working with data that is collected in 
specific time intervals (time slices), while in other cases, values can change for different 
objects at different times (best represented as a time series).  Time slices are cases where data 
values or locations change synchronously across objects in the geography (or at least are all 
recorded at the same time) so time stamps can be applied to all objects at once, and data for 
different time intervals within the total interval can be grouped into one dataset during the 
import process (see the Illinois tutorial for an example).  However, if attributes or locations 
of objects change at different times (asynchronously), the start and end time for each 
combination of attribute and location needs to be recorded as an individual line within a 
column of data.  As a result, each object ID is likely to be repeated in a file to be imported; 
we call these temporal data of this type "time series".  SpaceStat treats the first date or time in 
a series as an inclusive start value, and treats the end value as exclusive for both temporal 
representations.  There is an "advanced" option on the import dialog box to change this 
default if desired.   

In the end, a time series data file requires more "up-front" work to get it ready for import 
(i.e., each line must have a start and end date or time), but there are fewer steps in the import 
process.  Many sources of publicly available space-time data (e.g., cancer rate data for a 
county or state geography) represent time slices, which are easy to prepare for import (often 
just a matter of copying values and object IDs into a spreadsheet), but these datasets require 
additional steps during the import process to assign time stamps.  Click here to see how these 
two different ways of handling time data are formatted for SpaceStat, and here to link to the 
two import tutorials (mentioned above) that demonstrate import of time slice and time series 
data. 
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Once you have decided whether to import as a time slice or time series, check on how dates, 
times, and locations need to be formatted, and then look here for help on the File import 
dialog box. 

Coordinating time stamps across geographies and datasets 

When working with temporal data, a meaningful time stamp must be provided for 
geographies during import, even if the spatial characteristics of the geography do not change 
over time (i.e., county or state boundary shapefiles or gdb files). This is because time stamps 
for geographies and datasets in your project will determine the start and end dates on your 
animation (time) slider.   For objects to be "visualizable" (i.e., seen in maps) at the same 
time, they must have at least some overlap in their time stamps.  Visualization of certain 
objects within the geographies and datasets in a given project will not be possible if they 
have very different time stamps that do not overlap.    

For example, a geography is imported and defined with a very wide time slice (e.g., 1950 - 
2000). If you then attempt to view datasets linked to objects in the geography that have a 
much narrower time slice (e.g., 1960 - 1965), a map of the geography would only appear as 
the animation runs through 1960-65; these polygons would appear blank through the rest of 
the animation.   

If none of your data have a time component, the default import time format can be used for 
all files you bring in. In order to work with these files together, they must all receive the 
same stamp.   

Modifying geographies by importing and merging a new file 

Once you have an existing geography, you can import changes in shapes or positions by 
bringing in another shapefile, gdb file, text file, or Excel file with a different time stamp and 
merging it with an existing geography.  In most cases, this can be accomplished with time 
slice data where the end of the first time slice (exclusive) is set to match the beginning 
(inclusive) of the time slice for the geography you are merging.  For SpaceStat to allow 
objects to move or change shape, the objects must have the same ID in both geographies. 
 The "Merge with existing geography" option will appear in the "Import method" menu 
within the "Import file" dialog box when you are working on projects for which you have 
already imported at least one geography.    

Modifying geographies after import 

There are also many ways to create geographies and datasets from those that have already 
been imported, as described in the "Create New Data" page.  Briefly, tools for modifying 
geographies include the ability to create a subset of an existing geography, to create a 
centroid geography from a polygon geography, and to alter the spatial structure of a 
geography through a set of tools we group under "Scale Conversion/Interpolation" in the 
methods menu.   

Modifying and creating datasets after import 
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There are many ways to modify or create new datasets within SpaceStat.   The following two 
categories describe these methods. 

1. products of techniques you can use as part of a visualization process or to prepare data for 
further analysis, and 

2. products of a statistical analysis.    

As part of a data preparation or visualization step, you may want to standardize datasets 
using the Z-score transformation, or smooth them using the Empirical Bayesian Smoother. 
  Prior to conducting an analysis, you may need to modify an existing datasets using tone of 
the dataset calculator's functions (i.e., take an absolute value, or multiply by a constant).   

The creation of new datasets is primarily achieved through the use of statistical methods.  In 
some cases, the new datasets are the focal product of the analysis, and in others they help you 
to evaluate spatial patterns in your results (i.e., by mapping the residuals from a regression 
analysis). 

  

  

File Import dialog 

As described in the overview, you can import new spatial data (geographies) and attribute 
data (datasets) into SpaceStat in several formats: shapefiles, gdb files, Excel files, text files, 
and DBFs.  If you have imported a problem file, you can also bring along attribute data via a 
Gauss file.  Shapefiles and gdb files can hold point, polygon or line geographies. Currently 
line geographies, like roads, can be used for visualization, but not as input for statistical 
analyses.   

Text, Excel, and DBF files can only hold point geographies (i.e., columns with x and y 
coordinates) or datasets.   Note that if you import a shapefile that already has associated 
attribute data in a DBF, you can import and timestamp both the geography and datasets at the 
same time, as described here. 

Click here for a step-by-step introduction to importing shapefiles and gdb files (for use as 
new geographies, or for merging with existing geographies). 

Click here for a step-by-step introduction to importing Excel files, text files, and DBFs for 
use as point geographies, or here to use a file of one of these types for importing a dataset. 

For information on adding new spatial weight sets to a SpaceStat project, click here. 
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Import Shapefile or Geodatabase File 

To import new shapefiles (polygon, point, or line geographies), or to merge a new geography 
with an existing one, you will start by going to the File menu and selecting  Import, then 
Polygon or point file.  To import a feature class from a geodatabase file, you will start by 
going to the File menu and selecting   Import, then Esri geodatabase.  This will open up the 
dialog box that is shown in the excerpts below.  The shapefile example uses a shapefile 
containing polygons from the Illinois tutorial that is installed along with SpaceStat.  Recall 
that all data in your project should be in the same coordinate system or projection to overlay 
properly. 

You can click on many of the boxes in the screen images below for more information. 

The next step when importing a shapefile or geodatabase file is to browse to the file that you 
want to import.  Once you select a file, SpaceStat will identify the file type, and then 
determine what import options can be used with this file type.   

In the example below, the file type is shown as a shapefile (.shp), and there is already another 
geography in the project that is in use.  As a result, SpaceStat shows two possible import 
options in the import drop-down menu - Create or Merge.  If a shapefile had NOT already 
been imported into the project, the only option would be to "Create new geography".  The 
same process works for geodatabase files.  If there are already geographies of the same type 
in SpaceStat, you can merge your geodatabase with this pre-existing geography or import it 
as a new geography 

Create a new geography.   

In the first example (below), we will treat the file as a new geography and then will show the 
options for merging next.  To skip the merging section and go on to the section of the dialog 
box that handles time, click here.  Once you have browsed to and chosen your file, SpaceStat 
will name the geography based on the shapefile name.  If you want to change the name, do so 
in the box marked "Geography name" (partially covered below). 

 

The dialog is similar for the geodatabase.  The only additional step is that you will need to 
choose which Feature class you are interested in importing. 
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Merge a new shapefile or geodatabase with an existing polygon geography.   

If you choose to merge a shapefile or geodatabase with an existing geography, a new set of 
options will appear.  These will allow you to identify the name of the field in each geography 
that should be used as the ID field.  Merging geographies also includes "advanced" options, 
accessed by checking the "Show advanced options" box (below the "Browse" button). 

The “New data takes precedence” option is a confirmation that new data for a given object 
and time will overwrite the previous data for that same object in time. These options are used 
when you want to replace some of the data in the original file with information from the new 
file. 

Checking the “Merge data with existing datasets” option confirms that you want to merge 
datasets with the same name.  This option is used if you want to extend the duration of time 
covered by the datasets by adding new observations.  If you do not want to merge the files, 
uncheck the box. For example, if you have the same variable name representing different 
things in different files, you could uncheck the box to prevent your data from being merged 
or overwritten inappropriately). Problems with merging data? 

 

Choose how time is represented 

The next step in importing a geography is to define how times are represented in the file.  In 
the upper left corner of the "Time options" section of the dialog, use the drop-down menu to 
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choose a time format - either time slice or time series.  In this example, all of the units 
(counties) change together, so a time slice format is appropriate.   

Shapefiles only allow you to represent each object once, thus in most cases you will import a 
polygon shapefile as a time slice, especially if it is representing static political boundaries.   

Note that you may associate time series datasets with a geography that has been entered as a 
time slice at a later time, and/or you may merge a second version of a geography with the 
first version to allow you to work with a geography that changes over time. 

The next step is to decide how to format the temporal data.  This will allow SpaceStat to 
determine what information is required when the time stamp is set for the geography.  Below 
the time representation menu there is a button marked "set" (the set button is hidden behind 
the time format options in the image directly above).  Press the "set" button to open the 
geography time stamp dialog, shown in the next image. 

 

The "Specify a time stamp" dialog will appear when you click the Set button. This dialog 
will allow you to define the start and end dates, times, dates and times, or arbitrary units 
required for the data (whatever was specified under time representation, above).  Note that 
this value is for the entire geography, and datasets that you work with may have dates/times 
that encompass a subset of what is entered on this dialog.  This stamp will determine when 
the shapefile is visible in maps, and, if applied to all datasets, how values are treated in 
analyses, so make sure you double check the stamp.   

As described in the Illinois tutorial, the datasets used with the counties shapefile describe 
population projections from 1990 til the end of 2020.  Therefore, the start date will be 
changed from the default (1-1-2001) to 1-1-1990.  Leave the "inclusive" box checked.  Then 
enter 1-1-2021 for the end date, and leave the "inclusive" button unchecked.  This indicates 
that the time slice ends at the very end of the year 2020.  Click OK to close the time stamp 
dialog, then verify that the dates which appear after "Geography time stamp" reflect the 
changes you just made.   
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If your geography does not contain datasets, or if all of the datasets should be time stamped 
in the same way as the geography, click OK at the bottom of the dialog to import the 
shapefile.  If datasets in the file include a missing value code, check the box and enter the 
code that you used.  If datasets in the same file require separate time stamps, see more 
information on how to group and stamp datasets here, and see the example in the Illinois 
tutorial.  The option to include a missing value code does not apply to geodatabase files.   

Once you click OK, the geography will appear in the Data View.  To view the geography in a 
map, right click on the geography name, and select "Add to map."   

 Calculation of spatial weights for very large geographies 

If you have a very large geography, the import process may appear stall as SpaceStat 
calculates spatial weights.  You can wait for the calculations to complete, or you may skip 
these calculations during the import process.  If you select to skip this step during import, the 
spatial weights will be calculated later if they are needed for a statistical method.      

Error message:  Self-intersecting polygons 

In some polygon geographies, polygons that share one ID have boundaries that self-intersect. 
 This will trigger an error message from SpaceStat that will appear in the Log view.   

For example, the images below appear when the National Cancer Institute's State Economic 
Area geography (available from the NCI website) is imported.  This is due to the fact that one 
of the polygons in Texas self intersects (the orange SEA on map). 

Information on how to identify this and other problematic polygons is given in the error 
message (bottom-left of image), which allows you to find them in the table and highlight 
them on the map.   
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SpaceStat can map these polygons and includes them in the tabular data but self intersecting 
polygons will be excluded from Scale Conversion/Interpolation methods.  Often, you can 
make small edits in the shapefile (in a GIS software program such as ArcGIS) to correct this 
problem, and then re-import the file into SpaceStat (it is not currently possible to edit 
polygon boundaries within SpaceStat).   

  

  

Import Coordinate Data (Points) 

Text files, DBF files, or Excel files can be used to import point geographies and require 
coordinate data.  Before trying to import one of these files, review the pages detailing the 
respective formatting requirements: text file, DBF, or Microsoft Excel file.   At a minimum, 
the file must include x and y coordinates, and an ID column; it may also include datasets, and 
time boundaries needed for time series data.  All data in a project should be in the same 
coordinate system or projection to overlay properly. 

To import new geographies, or to merge a point geography with an existing one, browse to 
the File menu and select  Import -> Polygon or point file.  The dialog box below will 
appear.  In this example, the file "Excel_import.xls" is used.  This file is also featured on the 
Excel file page. 

You can click on many of the boxes in the screen images below for more information. 

The next step is to select the desired file.  SpaceStat will identify the file type, and then 
determine what import options can be used.  In the example below, the file type is shown as 
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an Excel file (.xls).  Recall that, at this time, SpaceStat can not import files from Excel in the 
2007 .xlsx file format.  Other tips for working with Excell files can be found here).   

Create a new geography. In this example, the file will be imported into a new project, so the 
only option available is to create a new point geography.  If the file was imported into a 
project that already contained a point geography, the merge options would also be present. 
 This scenario is explored with a shapefile example here.   

SpaceStat will automatically name the geography the same name as the imported file (see the 
box to the right of "Geography name").  Use the Geography name field to give the geography 
a different name if desired.   

The next section of the import dialog defines the x- and y-coordinate datasets. These 
selections identify which columns in your file contain the x coordinate (location on a 
horizontal axis) and y coordinate (location on a vertical axis).  In the Excel file we used 
(shown here), these columns are conveniently labeled as "x" and "y". 

 

Merge a new shapefile with an existing point geography.   

To merge a new shapefile with an existing point geography, select the "Merge a point 
geography with an existing geography" from the Import method drop down menu. A new set 
of options will appear, prompting you to identify the name of the field in each file that should 
be used as the  ID field.   

Merging point geographies also includes some "advanced" options that you can see by 
checking the "Show advanced options" box (below the "Browse" button).  Two of these 
options ask you to confirm that new data for a given object and time should overwrite old 
data for that same object in time.  This would be the case if you want to replace some of the 
data in the original file with information from the new file.    

Similarly, to confirm that you want to merge datasets with the same name, leave the "merge 
data" box checked.  For example, you would make these selections if you wanted to extend 
the duration of time covered by the datasets by adding new observations.  If you do not want 
to merge these datasets, uncheck the box.  For example, if the same variable name is used in 
multiple files, and actually represents different variables, you would uncheck the box to 
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prevent your data from being merged or overwritten inappropriately. Problems with merging 
data? 

Choose how time is represented.  The next step in importing a point file is to define how 
times are represented in the file.  Use the drop-down menu to choose a Time format - either 
time slice or time series.  In this example, all of the units (people) change their disease status 
and location at different times, so the appropriate format is a Time series.  Choosing this 
format will enable the additional input boxes shown below.  The default "Time 
representation" is set to Dates, which is appropriate for this example.  You may use the drop-
down menu to view the other options. Note that the "Start time field" and "End time field" 
boxes on the right side are disabled because the “Time representation” is set to Dates. 

Next, you will define which columns in the spreadsheet represent the Object id field (in this 
example, "ID"), the starting date, and the ending date.    

 

If datasets in the file include a missing value code, check that box and enter the appropriate 
code.  Select OK to import your new point geography into SpaceStat.  The name assigned to 
your geography will appear in the Data View.  To view the geography in a map, right click 
on the geography name, and select "Add to map."   

  

  

Import Datasets 

You can import a dataset that links to a geography as a text file, DBF, or Microsoft Excel 
file.  Each link will take you to the page detailing the required format for each file type.   At a 
minimum, a dataset file must include an ID column which links it to the existing geography. 
 The dataset file may also include time boundaries needed for time series data. 

To import new datasets, or to merge a dataset with an existing one, select  Import -> 
Polygon or point file.  This will open up the dialog box that is shown in the figures below. 
  This example uses an Excel file "bresea5.xls", a collection of datasets downloaded from the 
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National Cancer Institute's website.  The file is described here on the Excel file page.  These 
datasets will be merged with a State Economic Area polygon geography (USSEA.shp) that is 
also available for free download from the NCI website. 

You can click on many of the boxes in the screen images below for more information. 

The first step is to browse through the files on your computer to locate the file that you want 
to import.  Once you select a file, SpaceStat will identify the file type, and then determine 
what import options are available.  In the example below, the file type is shown as an Excel 
file (.xls).  Recall that at this time, SpaceStat cannot import files from Excel in the .xlsx file 
format.  (See this and other tips for working with Excel files here.)   

To import files as datasets that will be merged with a geography, you must already have 
imported at least one geography such as a shapefile for polygons, or as a shapefile or 
coordinate data for a point geography.  Select the Import method “Merge as Data” since you 
are importing datasets rather than a new point geography. The next step is to identify the 
dataset in your geography that represents the ID.  In the NCI's shapefile for SEAs, this ID is 
"ID_", and in the breast cancer datasets, the ID is "SEA" (see image below). 

 

Choose how time is represented 

The next step in importing datasets is to define how times are represented in the file.  Use the 
drop-down menu to select a time format - either time slice or time series.  In the bresea5.xls 
file, all of the data are organized into columns of "time slices", in that each column represents 
a different five year interval, with the dates included in the column header (i.e., CWF5054 is 
the Count of White Female breast cancer cases for the years 1950-54).  The default "Time 
representation" option is Dates, which is appropriate for this data.   

We won't be time stamping a geography in this case, so ignore the "Set" button to the right of 
the line showing the default geography time stamp. 

The next several steps required to import the breast cancer data include grouping and date 
stamping all of the columns in the Excel file, such that the final result is a single dataset for 
each variable that changes over time.  To start this step, click the "Specify dataset time 
stamps" button.   
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If you have multiple datsets that are made up of multiple time slices, it will be helpful to start 
by reviewing how to group datasets (described here), and then follow the link to see how to 
specify dataset time stamps, which includes a link to information on how to copy and paste 
time stamps. 

   

Once you have finished setting the dataset time stamps, click "OK".  The import dialog will 
appear again, refleting any new information that was added.    

Finally, if datasets in the file include a missing value code, check that box and enter the 
appropriate code. 

  

Set Time Stamps 

  

Specify a Time Stamp 

When you import a time slice file, you need to set a time stamp so that SpaceStat can link the 
start and end dates or times with other datasets.  You can time stamp the entire file with the 
same start and end dates, such as a shapefile or gdb file with datasets, or a file of coordinate 
data that also includes datasets.  Alternatively, you can use different dates for the geography 
and the datasets.  In many cases, you will want to time stamp the geography so that a long 
time period is covered, especially if it is something like state or county boundaries that rarely 
change.  Other datasets may be imported in several columns that will be grouped and time 
stamped with shorter durations.  You can also import datasets on their own, and merge them 
with a geography, which again will require that you set the time stamp for the datasets.   

To set a stamp for the entire file (geographic objects and all datasets), choose the "Set" button 
by the "Geography time stamp" field in the import dialog. You will see the following dialog: 
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Type or use the up and down arrow key buttons to specify the Start and End dates and/or 
times (if applicable). You also must specify whether your dates and times are inclusive.  For 
this example, the values entered above define the time period for this geography as starting 
on January 1, 1990, and ends on the last day of December in 2020 (note the "inclusive" box 
is not checked for our end date of January 1, 2021).   

To set a stamp for individual datasets within a file that includes both a geography and 
datasets, first set a time for the geography (to tell SpaceStat when the points or polygons are 
valid).  Then choose "Specify dataset time stamps" to set the time stamps for columns in the 
shapefile's DBF (for a polygon geography), or for datasets included in the same file as 
coordinate data (in a text, Excel, or DBF file).   

WARNING:  Once you have set the dataset time stamps, DO NOT click the "Set" button 
again, or all of the dataset timestamps will be changed to the timestamp for the geography. 

  

  

Time Boundaries 

As you import or create a space-time dataset, you will need to define how to handle the break 
points.  In other words, which data take precedence at the moment of change? 

For time slice data, you need to specify whether the time stamps are inclusive or exclusive. 
For time series data, the start dates and times are presumed to be inclusive, and the end dates 
and times are interpreted as exclusive. However, you can specify whether SpaceStat uses the 
date as exclusive of the first moment of that date/time or inclusive of the last moment. If you 
select "through end of time period", the data is inclusive to the last moment of that date/time. 
The time slice will be exclusive of the next day if it is a date, or next second if it is a time. 

Inclusive 

An inclusive time stamp begins at the first moment of the start date or time and ends at the 
first moment of the end date or time specified. So an inclusive start time stamp of 20011001 
(October 1, 2001) begins at 12AM on that day and an inclusive end time stamp of 20011031 
ends at 12AM on that day. 
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Exclusive 

An exclusive time stamp begins at the first moment after the start date or time and ends at the 
first moment before the end date or time. So, an exclusive start time stamp of 20011001 
begins immediately after 12AM on October 1, 2001. An exclusive end time stamp of 
20011031 ends just before 12AM on October 31, which means the last moment of October 
30. 

Through End of Time Period 

Often, when we write an end time of 20011031 or October 31, what we really mean is that 
we are including all time up to, but not including November 1, 2001. ONe way to achieve 
this is to check the "through end of time period" box.  When this option is enabled, it is 
interpreted as including the last moment of that date and/or time. So, 20011031 through end 
of time period means through the last moment of October 31, 2001. 

  

  

Group Datasets for Import 

If you have a time slice file, you can combine several individual data columns (datasets) in 
your file into one meta-dataset. This meta-dataset will be composed of individual columns in 
the imported file, but each column will have a separate time stamp within the range covered 
by the meta-dataset.  Confused? It is easier to see it in a picture, below. 
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This image shows that several columns in the import dataset (CBF7074 through CBF9094) 
have been combined into a new dataset (CBF).  The counts for white females (CWF5054 
through CWF9094) have been selected and are about to be grouped into a dataset called 
"CWF". These are breast cancer data prepared by the National Cancer Institute, and 
described here.   

Steps: 

1. Select the columns you wish to combine with your mouse.  If they are similarly 
named (as in the example above) they will appear together in the list, even if they 
were separated in the original file. 

2. If you want to reorder the way the datasets are listed prior to grouping them, select 
them and click on the up or down arrow buttons. 

3. Click the "Group" button to group selected columns into one new dataset. Columns 
must have the same type (numeric, integer, or text, identified by the symbol next to 
the dataset name) to be grouped. If they are not the same format, edit the original file 
in the software used to create it (i.e., Excel, GIS or text editor software) before 
importing.  If you need to undo a previous action, you may select the group name and 
click "Ungroup". 
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4. Set the time stamps for individual columns by double clicking the dataset (the Specify 
a time stamp dialog will appear). Alternatively, you can copy and paste time stamps 
from other datasets or dataset groups in the file. 

  

  

Specify Dataset Time Stamps 

When you import a time slice file of datasets, you need to set a time stamp for the entire file, 
or subsets of datasets separately. If the geographic objects (points, lines, or polygons) have 
the same time stamp as the datasets, this can be accomplished in one step. However, you may 
have datasets that only apply to one portion of the duration of the object (say cancer rates for 
5 year intervals over 25 years....). You can set stamps for individual datasets by choosing to 
specify dataset time stamps on import, using the button on the import dialog that looks like 
this: 

 

To set a stamp for individual datasets within a file, set a time stamp for the geography (when 
the points or polygons are valid) and then choose "Specify dataset time stamps" to set the 
time stamps for individual data columns within the file.    

In the example below, time stamps are being set for a series of data columns that have 
already been grouped under the heading "CBF" (count for black females).  This example uses 
the 5 year interval breast cancer data from the National Cancer Institute, described here). 
 The dialog box shown in the background is the first to open when you click "Specify dataset 
time stamps".  The dialog shown in front opens when you click on the default time stamp for 
any entry in the list of datasets.  As mentioned above, the grouping step has been done first in 
this example.  It is also possible to group after setting time stamps as well.   

 

31 



Data Preparation 

Setting the time stamp for a dataset works exactly the same way as setting the stamp for a 
geography.  Type or use the up and down arrows key buttons to specify the Start and End 
dates and/or times (if applicable). You also must specify whether your dates and times are 
inclusive.  The values entered above indicate that the time period for the CBF8084 
component of the CBF dataset starts on January 1, 1980, and ends on the last day of 
December in 1985 (note the "inclusive" box is not checked for our end date of January 1, 
1985).   

If different multi-part datasets are based on the same time intervals, you can also copy and 
paste time stamps between columns. In addition, you can also rename a dataset or group 
using the right click menu, just as you might in the data view. 

  

  

Copy and Paste Time Stamps 

If you have a large file, it may be tedious to set the time stamp for every dataset individually. 
 SpaceStat allows you to copy time stamps you have already set to other places. You can do 
this individually, or in groups. The image below shows that the time stamps for the grouped 
datasets in "CBF" have all been updated, but that the group under "LBRBF" have not.  The 
copy past option allows you to copy and paste the five time stamps from CBF to LBRBF.   

 

The copy and paste option can be found by right-clicking on the group name, as shown in the 
image below.  Alternatively, you can select the group and use Ctrl+C. In order to use either 
the right-click or Ctrl+C option, the datasets do not need to be in the grouped state, as they 
are in this example. 
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Steps 

1. Select the dataset(s) to use as a template. For grouped data, right click to see the 
"Copy group time stamp option", or use "Control-C" to copy the time stamps from 
selected dataset(s). 

2. Select the dataset(s) upon which to paste the time stamps. If you need to reorder the 
datasets within the group, use the up or down arrows. 

3. Type "Control-V" to paste the time stamps. 

4. Repeat as needed 

  

  

Overwrite Data? 

When importing a series of files, it is possible through an error in specifying the time stamps, 
or perhaps because there is conflicting information in the file set, that two sets of data could 
apply to the same point in time. When you import data into SpaceStat, you need to define 
how to handle overlapping time stamps. The choices are: 

• Do not merge data with the same name (uncheck "merge data with existing datasets 
by name"). This allos both sets of data to be viewed in maps, tables, and graphs. 

• Merge data with the same name (check the "merge data" option) but retain data 
already imported (uncheck "new data takes precedence..."). This allows the new 
dataset to only be applied where there is no data for that time and for those variable 
names already in the project. 

• Merge data with the same name but overwrite old information with new data (check 
"new data takes precedence..."). 
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For shapefiles only, you will also have the option to overwrite objects (location, size, 
shape....) when overlap occurs. Again, you must choose whether the geography already in the 
project or the new geography you are importing takes precedence. 

  

File types and formats 

  

Shapefile 

The Shapefile format is a way to store geometry and attribute data for point, line, or polygon 
data. A full description can be found on the ESRI website.  To import correctly, you must 
have several associated files: .shp, .shx, .dbf.  You can also have others, such as .prj files, that 
provide additional information (e.g., about the projection). 

• .shp - main file, each record is a shape and its vertices (geometry) 

• .shx - index file records position and length of information each record in the main 
file 

• .dbf - feature attributes and IDs, with one record per feature (must stay in same order 
as .shp and .shx) 

  

  

Microsoft Office Excel file 

SpaceStat can import files directly from Excel.  The first row of information is imported as 
column headers.  With the Excel format, you can import both point geographies (with or 
without additional datasets), and datasets to link with other geographies, using the Excel 
format.  Note that SpaceStat can import Excel files with the .xls suffix from Microsoft Office 
2003.  The more recent Excel format (.xlsx) included in Microsoft Office 2007 cannot yet be 
imported into SpaceStat. 

Example Excel file for a point geography of time series data 

An example of a file for a point geography with time series data is shown below for a group 
of 10 "objects" (e.g., participants in a research study) that each have a unique identifying 
number (under the "ID" column).  The columns labeled "x" and "y" are the x and y 
coordinates, and the "start_year" and "end_year" columns show the years in which the 
location designated by the coordinates was occupied by each object.  When an object moves, 
and/or shows a change in an attribute (such as disease stage, shown at the far right), it has a 
new row in the file, with both location and time information.  By default, start times are 
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inclusive, and end times are exclusive (this can be changed by choosing the "advanced 
options" button on the import dialog).   

For example, in the file below, the object with ID=1 has three rows of data.  The first, in row 
1, indicates a location for the years from 1990 until the end of 1992, and a disease stage of 1. 
 The next observation for this object is in row 12, indicating that the object moved in 1993, 
but not changed disease stage.  Next, in row 21, the object has changed disease status starting 
in 1995, but stayed in the same location as in the previous record.   

  

Example Excel file for datasets in time slice format 

Here is a second example of an Excel file, this time representing datasets in time slice format. 
 Specifically, this file shows information that has been downloaded in Excel format from the 
National Cancer Institute's Cancer Atlas website.  Here we show the file we downloaded for 
breast cancer in State Economic Area (SEA) spatial units for five year intervals.  The excerpt 
below only shows a small subset of the data for white females (denoted with a "WF" prior to 
the year, which is either 1950-54, or 1955-59 in this example).  The rest of the dataset name 
is defined in the box below.  Prior to import, we suggest removing the top line (with the SEA 
code 99999 for the entire US), as SpaceStat will not be able to link it to anything in the 
shapefile of SEAs (also available from the NCI website). 
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Important tips for importing from Excel: 

Only data contained in the "top" page of your Excel worksheet will be imported into 
SpaceStat.  If you have information that you want to import from other pages, save them as 
their own new Excel file. 

Currently SpaceStat can only recognize MS Excel files with the extension ".xls", so if your 
file was created in the most recent version of Excel (with the extension "xlsx"), you will need 
to open it in Excel, and re-save it in the older format (1997-2003 workbook compatible).     

Please check your MS Excel file to make sure that you are not trying to import columns with 
formulas.  If some of your data were created with formulas, you will need to copy and paste 
the created values to a new column, and then delete the column that contains the formulas 
prior to trying to import the file into SpaceStat. 

If you are converting text files used previously in SpaceStat to the Excel format, you simply 
need to import the text file into Excel, remove the first two rows of the original file (file title, 
and number indicating the total number of columns), move the column headings (just the 
name, not the description if you have one) to the top of the appropriate columns, and then 
delete any extra rows at the top that may be left after you move the headings. 

  

  

Text File 

SpaceStat can import data in the GeoEAS text file format. These files can be viewed or 
edited in a text editor and may have any file extension.  An example is shown below. 
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Text file header 

1. The first line is informational, a dataset title or metadata. This information can be 
viewed in the geography properties after import. 

2. The second line is the number of data columns in the file.  For point data, you will 
need to include the x and y coordinates (see example above).  For files that include 
datasets that will be linked to an existing point or polygon geography, you will need 
to have a column that allows you link the new information with locations in the 
geography. 

3. The next lines list the dataset names, one name to a line. If the names are more than 
one word, SpaceStat will use the first word of the phrase as the name and then place 
extra information into the dataset properties.  If you want to use a two word name, 
link the words with an underscore ("male_rate"). 

Data 

Below the header the data should be organized in rows, with individual values delimited by 
spaces, commas, or tabs. Delimiters at the beginning of a data row are ignored. The rows are 
interpreted in the order of dataset names in the header (so the first set of characters or 
numbers is the data for the first column, then a delimiter, then the data for the second 
column, etc.).  Note that your file must consistently use the same delimiter throughout the file 
(e.g., files with a mixture of spaces and tabs separating columns will not import correctly). 

Missing values 

SpaceStat will lump multiple spaces, so to specify missing values in a space-delimited text 
file, you will need to use a missing value code. 

In contrast, SpaceStat will not lump multiple tabs or commas, so two commas or tabs will 
indicate a missing value in between. 

Comments 

Use quotes around text data that includes the delimiter. This may come in handy when you 
want to import a comment field that includes spaces in a space-delimited file, or a comma in 
a comma delimited file. 
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DBF File 

The DBF (*.dbf) format was created for early spreadsheet applications in the 1960s. It is 
used in the set of files that make up a shapefile, and can be used in SpaceStat to merge 
additional attribute data to a geography. 

The DBF file has a header that defines the number of records, fields (names, type, length...) 
and several field or variable types (each field or variable would be termed a "dataset" in 
SpaceStat). Included below is a list of field types: 

• character 
• data 
• numeric 
• logical 
• memo 
• variable 
• picture 
• binary 
• general 

For SpaceStat, the most important types are character, date, and numeric datasets.  When a 
DBF is exported from SpaceStat, it will contain columns that show the start and end dates 
associated with the data, as well as "flags" (0 or 1) that indicate if these dates are inclusive (1 
= "true").  These data columns facilitate the re-import of DBFs from one SpaceStat project to 
another, since the time stamping process will not need to be repeated.   

Representing dates 

You can also use the date field type in the DBF file. This automatically stores the dates in the 
correct format for import into SpaceStat (YYYYMMDD). Alternatively, you can follow 
these temporal format guidelines. 

Representing time 

As there is no data type for time in the DBF format, you must use either the numeric format 
HHMMSS or string format HH:MM:SS to represent times. 

Missing values 

Cells cannot be empty in a DBF, you must specify a missing value code to substitute for "no 
data" or missing data cells. Otherwise, the file will not import properly. 
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Editing a DBF for use in SpaceStat 

In most cases you can use the data from a DB by importing it into a Microsoft Excel 
spreadsheet, modifying as needed in Excel, then importing into SpaceStat using the Excel 
format.  However, if you wish to work with DBF files, please note the following: 

• There are several DBF file sources that you may wish to use in SpaceStat.  Often, 
these are associated with shapefiles that have been created in other software 
applications. You can view the contents of these files outside of your GIS and 
SpaceStat software, but it is not recommended to edit these files outside of your GIS 
software (i.e., in a text editor). Note that shapefiles (which have an associated DBF) 
or DBF files can be exported  from one SpaceStat project and then import them into a 
new project. 

• If you are creating new datasets for import into SpaceStat, you will also need to 
specify the field or variable types for the DBF in the spreadsheet software you are 
using (this is done automatically if you export a DBF or shapefile from SpaceStat).  If 
you edit the file outside of SpaceStat after you've imported the data, and then re-load 
your project, the changes to the DBF will not be reflected in the SpaceStat project. 
You will need to re-import the DBF to update your project.  If you import a DBF that 
was exported from SpaceStat, several datasets reflecting the timestamp of the data 
will appear among your other datasets.  If your data represent a time series, these will 
be datasets you can select to use during import to allow SpaceStat to code the times 
for your data ("Start", "End", "Inc start" and "Inc end"). SpaceStat creates these 
columns in the DBF to designate time using the common file format.   

Common problems 

• Numbers are truncated after the decimal point. You can specify the number of places 
after the decimal point in the column format. Neglecting to specify the number of 
places is a common error, and may cause you to lose information. 

• Time format. If you are preparing your data in a spreadsheet program such as Excel 
that has a "time" format, this does not translate when the file is saved as a DBF, as 
there is no time field in the DBF specification. You will need to represent time as 
integers as HHMMSS (so 10:01 AM is 100100 and 10:01 PM is 220100) or as a 
string field HH:MM:SS. 

• Variables "disappear" if you add them to an existing DBF in spreadsheet software. 
This may be because the number of fields is stored in the header of the DBF and not 
rewritten. The best work-around for this is to copy all of the data into a blank 
spreadsheet, format the columns correctly, and then save the new file as a DBF. 

Hints 
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• Save the data in the native file format of the spreadsheet program and then save as a 
DBF. This safeguard will usually allow you to recover data "lost" by specifying an 
incorrect field type (such as decimal data truncated to integers). 

• Open the saved DBF in a spreadsheet program before bringing it into SpaceStat.  This 
will help you identify data that is unrecognized, truncated, or cells containing missing 
fields. 

• After importing the data into SpaceStat, open a table to view it. You can compare the 
imported data to the original spreadsheet to identify any problems. 

• If you see extra datasets labeled "Start", "End", "Inc start" and "Inc end", these are 
columns created by SpaceStat to represent the time stamp of data.  Exporting a DBF 
from SpaceStat, then importing into another SpaceStat project will cause this 
behavior. Once the DBF file is in your project, you can delete these datasets by right-
clicking on them and selecting "Remove dataset" from the pop-up menu. 

  

  

GeoDatabase File 

The geodatabase is the common data storage and management framework for ArcGIS. It 
creates a central data repository for spatial data storage and management. 

BioMedware is proud to announce, along with our new Esri Partnership, that SpaceStat 3.0 
can import and export these geodatabase files.  We are excited to see how this new 
development will help streamline workflow from Esri products to SpaceStat, allowing users 
to integrate our advanced space-time analysis methods and visualization techniques.   

For SpaceStat to be able to import the GDB file, it must be from ArcGIS version 10.  Also, 
the folder containing the spatial components must end with a .gdb extension. 
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Import Problem Files 
  

Importing Problem Files 

SpaceStat has undergone major changes since its 1.8 release.  If you have used these early 
versions, then you will be familiar with problem files.  They contain the necessary 
information to carry out an analysis as well as a record of analyses previously conducted. 
 Currently, the analyses that can be transferred to SpaceStat 2.0 and beyond include Spatial 
Lag and Spatial Error regression models.  Other analyses, such as ANOVA, spatial regimes, 
spatial expansion and trend surface regression can be reconstructed with minimal input. 

To import a problem file, go to File -> Import > SpaceStat 1.x file.  You may also select the 
  icon on the toolbar and choose SpaceStat 1.x. 

This dialog will appear: 

 

Click the Browse button and navigate to the location of your problem file.  Make sure that 
any associated files referenced in the problem file are in the same location.  These should 
include the following:     

• The GAUSS data files (DAT and DHT files) 
• The spatial weight files (.gal or .fmt) 

Next, click the second Browse button and choose the shapefile that matches your data and 
spatial weight set.  The shapefile does not need to be in the same location as the other files. 
 If you no longer have the shapefile that goes along with your data, please contact 
support@biomedware.com for further assistance. 
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Once your files are loaded, you may choose which Time representation best describes your 
data.  Set your time stamp and select OK.   

Your problem file will import.  The log will record this event, along with the datasets 
imported and the time stamps assigned to these datasets.   

If your problem file contained regression analyses, these analyses will be reconstructed for 
you in the Task Manager.  Each model will receive its own Spatial Regression tab.  The only 
input needed is what type of regression model you would prefer to run (OLS, Spatial Lag, or 
Spatial Error).  Once you’ve selected the type of regression, push the RUN button to see the 
results of your analysis.   

If your problem file contained other analyses, the log will report which problems can be 
reconstructed with further manipulation.  Please see the page on Reconstructing Problem File 
Analyses for a step-by-step guide for their reconstruction.   

  

  

Reconstructing Problem File Analyses 

If your problem file contained Spatial ANOVA, trend surface regression, spatial regimes, or 
spatial expansion analyses, you will receive a message in the Log View that further 
manipulation is needed to fully reconstruct these analyses.  Here we discuss how the user can 
carry out these methods in the new SpaceStat, built upon our space-time platform. 

Spatial ANOVA 

The spatial analysis of variance (ANOVA) method carries out regression of a continuous 
dependent variable against one or more categorical datasets (i.e. levels typically describing 
different possible states of a particular variable). As in conventional ANOVA, the individual 
levels of a particular variable are modeled by values of 0 or 1 according to whether an 
observation has a particular category as its value for that dataset. For example suppose that 
 "Country of origin" is a regression  independent variable with three possible categories, 
France, U.S. or German. Then there will be three regression variables in any regression 
model . For someone of French descent the France variable will take on a value of 1 while 
the German and U.S. variables will be zero. 

Because this scheme leads to redundant variables, regression calculations require one of the 
categories to be designated as the "reference" category. The estimated value for this category 
is the same as that of the intercept. Since most data imported into SpaceStat is either integer 
or decimal, categorical variables have to be created out of these (usually integer) values. In 
the old version of SpaceStat this was done automatically behind the scenes whenever the 
ANOVA option (setting "5" for flag #1 in the problem file) was invoked. 
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In SpaceStat, the creation of categorical data from integer data is done by right-clicking on a 
dataset in the dataview and selecting the "convert data type" option. A default name will 
appear for the new dataset with the possible choices of "Integer" and "String" for "New data 
type". Selecting the "String" option will create a categorical dataset with the new name.  On 
opening up any regression tab, select a geography, then click on "Create". The new 
categorical dataset will appear in the list for independent variables.  It can then be include in 
any regression model. 

Spatial regimes 

A straightforward extension of the use of categorical datasets is found in the Spatial regimes 
method which allows for the fact that different regression models may be applicable to 
different regions of the geography. To estimate the regression coefficients in this model, start 
with a list of global independent explanatory variables that are valid over the entire 
geography. Next, decide on a variable that would be the distinguishing indicator for different 
spatial regions. In the earlier version of SpaceStat this had to be an integer but in the new 
version of SpaceStat any categorical variable will do (for example "Country of origin" as in 
the previous section). 

The user then has to create by hand, using the regression model dialog, a regression model 
that contains (1) the regional indicator variable as a linear term, with the reference category 
chosen appropriately (2) for each of the global explanatory variables, create an interaction 
term between that global variable and the regional indicator variable (select the global 
explanatory term, hold down the control key then select the regional indicator variable). Do 
not include the global variable on its own as a linear term in the model. Once the regression 
model is set up it can be saved, spatial weight datasets can be specified and any one of the 
three regression types (OLS, spatial lag and spatial error) can be invoked. 

The new version of SpaceStat does not output tests for structural instability or tests for the 
stability of individual coefficients. In addition the Breusch-Pagan tests in the new version are 
against the squares of the original regression terms. 

Trend surface regression 

The regression variables in this case are the spatial coordinates of the observations 
themselves. For point geographies, the spatial coordinates usually appear in the data view. 
For polygon geographies, we can create these datasets by using the "Create centroid 
geography" option.   This option can be found by right-clicking on the geography and select 
"Create centroid geography", or by locating the option under the Tools menu.  Deselect the 
 "Include parent geographies’ datasets" option on the dialog that appears and select OK.  A 
new centroid geography will be created under the parent geography. The datasets "X" and 
"Y" denote the spatial coordinates of these centroids. They may be dragged up to the parent 
geography to appear in that geography’s dataset list. 

Trend surface regression requires using the "X" and "Y" and powers of these as regression 
variables. The higher powers have to be created manually using the dataset calculator. Under 
the "Tools" menu select "Derive new dataset". Select the geography, assign a name, then 
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from the "Insert dataset" dropdown, double click on "X" or "Y" and it will appear in the 
window as $("X"). Follow that with a multiplicative * from the "Insert function" dropdown 
and you can build up powers of the "X" or "Y" variables explicitly as well as interactions 
between them. These new variables can then be saved under the original geography and used 
in the regression model dialog. The resulting regression models can be saved as part of the 
project. 

In the new version, the Breusch-Pagan tests are against the squares of the original regression 
terms. 

Spatial expansion 

This approach models regression coefficients that vary over space by including regression 
variables that are made up of interactions of non-spatial regression variables with powers of 
"X" and "Y". For example the dependence of crime on income would require independent 
variables Income, Income*X, Income*Y as well as higher powers possibly. These models 
would require creating "X" and "Y" variables explicitly following the procedure indicated 
above under trend surface regression and then forming the interactions of these powers of 
"X" and "Y" with other regression variables in the regression dialog. 

The new version does not output tests on the expansion of the coefficients or tests on the 
expansion of individual coefficients. In addition the Breusch-Pagan tests in the new version 
are against the squares of the original regression terms. 

  

Create New Data 
  

Create New Geographies or Datasets 

Datasets and geographies imported into SpaceStat can be modified in a variety of ways: 

• A new geography can be created from a subset of an existing geography.  To do 
this, select areas in a map, then right-click and select the "New geography from 
Select" option. 

• ->   The representation of the objects can be changed from polygons to points 
using the "Create a centroid geography" option located under the Tools menu. 

• -> , or  ->   You can convert data from point datasets to polygon datasets, and 
from polygon datasets to polygon sets with a different geography.   

• You can standardize datasets using the Z-score transformation, or smooth them using 
either Poisson smoothing or the Empirical Bayesian smoother (Methods menu, Data 
transformation section of Help). 
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• New datasets can be created from existing datasets using the dataset calculator 
(Tools menu, "derive new dataset"). 

•   New datasets can be also be created from existing datasets using statistical 
methods (Methods menu, Statistical Methods section of Help). 

• New spatial weights sets can be defined for use in spatial statistics (right click on a 
geography in the spatial weights view). 

• You can define new variogram models in the variogram model dialog to use in 
kriging (right click on a geography in the variogram model view). 

New geographies or datasets created from others are nested by default, and placed 
underneath their parents in the datasets window. 

  

  

  

Create a Subset Geography 

After at least one geography has been imported, a new subset geography can be created from 
the parent geography.   

Follow these steps: 

1. In the map view, use the select tool   to click and drag a rectangular border around 
the geography that will be a subset of the parent geography. Alternatively, you can 
hold down the control key and add items to the selection individually. 

2. Right-click on the subset you have created. From the list of options, choose "New 
geography from selected." 

3. Select the parent geography and give a new name to the subset geography you want 
to create. 

4. Determine if you want to include the parent geography's datasets, then check the 
appropriate box. Click Ok. The subset geography will appear in the dataset pane of 
the map window, listed under the parent geography you chose. You can view the 
subset as a new map and proceed with your analysis. 

If you want to include only a subset of the datasets, deselect the check box to include the 
datasets from the parent geography.  After the subset geography is created, drag the datasets 
you want from the parent geography and drop them on the name of the subset geography. 
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 They will appear below the geography name.  It is also possible to drag datasets from a 
"child" geography up to the parent geography level.    

  

  

Create a Centroid Geography 

A polygon geography can be transformed to a point geography by generating a centroid 
geography from the polygon dataset. SpaceStat creates points from polygons by finding the 
polygon's center of mass. The point could be outside the polygon for certain polygon shapes. 
For instance, a polygon shaped like a donut would have its center of mass in the "hole". 

Right click the polygon geography in the Data view, and select "create centroid geography" 
from the pop-up menu, OR select this option from the tools menu. 

 

Select the parent polygon geography from the drop-down menu in the pop-up dialog, and 
enter a name for the new centroid geography.  If you want all of the datasets associated with 
the polygon geography to also be linked to the centroids, check this option in the dialog box. 

 

SpaceStat will create a new point geography underneath the polygon geography, as shown 
below. This new centroid geography will have two datasets, the X and Y coordinates (cut-off 
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in the image below), and also will include all of the other data sets in the parent geography if 
you checked this option. 

If you did not check the "Include parent geography's data sets" option, you can add data sets 
by dragging them down from the parent geography; they will copy into the point geography 
and remain in the polygon geography.  You can also drag datasets the opposite way once 
they have been created --from the centroid geography to the original polygon geography.   

 

  

  

Create New Grid 

SpaceStat can create a new grid geography from a polygon or a point geography.  This can be 
especially helpful as the destination geography in the kriging method.    You can create a new 
grid geography from a polygon or a point geography by going to the Tools menu and 
selecting "Create matching grid".  You can also right click on a geography in the Data view 
and select "Create matching grid." 
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Once you have chosen to create the grid geography, the following dialog will appear. 

 

This dialog specifies the parent geography, the name of the new grid geography, and the 
method by hich you would like to create the grid: by column or by pixel width.   

  

  

  

Create a Dataset 
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Create a Dataset 

SpaceStat allows you to create new datasets from existing datasets. This can be done through 
statistical methods, through standardization, or through using the dataset calculator to make a 
custom dataset, such as a threshold dataset (illustrated below) or a difference dataset. 

To calculate a new custom dataset, go to the "Tools" pulldown menu and select "  Derive 
new dataset." 

The dataset calculator will appear, shown below. First, you name your new dataset and select 
the appropriate geography for the dataset(s) which will be used to create the new dataset . To 
specify how you would like the existing dataset to be modified, type a mathematical 
expression in the box titled "dataset definition."  You can type standard symbols (e.g., +, -), 
or choose functions from the pull-down menu in the lower right corner labeled "insert 
function."  The new derived dataset will have values at all of the times included in the 
original dataset, so, as with other datasets, you can animate views of derived datasets and 
synchronize these animations with data in other views. 

The syntax for identifying datasets to be modified is to precede the dataset name by a $, 
surround it in parentheses, and include the name in quotation marks. This syntax 
encapsulates the dataset name so that it isn't interpreted as part of a mathematical expression, 
even if the name includes mathematical symbols. SpaceStat automatically adds this syntax if 
you select datasets from the drop-down menu at the lower left. Thus, in the example below, 
our new dataset will be categorical, with RWM (rates for white males) values greater than 
1.5 coded as "high", and other rates coded as "low."  To see two more examples of dataset 
definitions, including one that involves using values for the same dataset at different times in 
the calculation, go to the Difference Dataset page. 
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Functions for Deriving Datasets 

There are many functions available for calculating new datasets. You can type them directly 
(in ALL CAPS for those that include words or abbreviated words), or add them to your 
dataset definition using the pull-down menu. Click on the functions below for more 
information about each one. 

+   

- 

* 

/ 

^ 

= 

!= 

OR 

AND 

< 

<= 

> 

>= 

ABS(expr) 

COS(expr) 

DECIMAL(expr) 

EXP(expr) 

IF(condition, then expr, else expr) 

INTEGER(expr) 

ISMISSING() 
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LOG(expr) 

LOG10(expr) 

MAX($("Dataset")) 

MAX($("Dataset"), y, m, d, h, m, s) 

MEAN($("Dataset")) 

MEAN($("Dataset"), y, m, d, h, m, s) 

MIN($("Dataset")) 

MIN($("Dataset"), y, m, d, h, m, s) 

MISSING() 

MOD(expr) 

OBJID() 

SIN(expr) 

SQRT(expr) 

STDDEV($("Dataset")) 

STDDEV($("Dataset") , y, m, d, h, m, s) 

STRING(expr, width) 

SUM(expr, expr, ...) 

TAN(expr) 

  

  

Deriving Difference Datasets   

Generating a difference dataset is just one example of a way to use the  "Derive new 
dataset" option from the Tools drop-down menu (or from the right-click menus for 
geographies).  A difference dataset is simply the difference between values for each location 
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in two specified datasets at two specified times.  You can also create a difference dataset 
using the "Difference" method. 

Here are two ways that difference datasets are commonly used: 

• To examine how values for different variables vary at a given time. For example, you 
can use these datasets to examine differences in lung cancer rates between women 
and men.  When you use the "Derive new dataset" option (rather than the Difference 
method), you can produce datasets with multiple times and animate them. 

• To observe how one dataset changes through time. For example, you could analyze 
how lung cancer incidence rates differ across years, as in the example below.  Note in 
this example, rates in all polygons were higher in 1980 than in 1960, so the difference 
is always positive.  In many cases, you will have both negative and positive values in 
your difference map. 

 

  

How to create a difference dataset starting with two different datasets (all times): 

1. Choose  "Derive new dataset" from the Tools menu, or from the menu that pops up 
when you right-click on a geography. 

2. To subtract one dataset from a different dataset (the example in the first bullet-point, 
above), first enter a name for the new dataset, and then choose the geography (both 
datasets must be in the same geography).   

3. The syntax for identifying datasets to be modified is to precede the dataset name by a 
$, surround it in parentheses, and include the name in quotation marks. This syntax 
encapsulates the dataset name so that it isn't interpreted as part of a mathematical 
expression, even if the name includes mathematical symbols. SpaceStat automatically 
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adds this syntax if you select datasets from the drop-down menu at the lower left. 
 The final dialog box for subtracting the cancer rate for white females (RWF) from 
the rate for white males (RWM) would look like the image below, and once you hit 
"ok", a new dataset with the name "RWM-RWF" would appear under SEAs in the 
Data View. 

   

4. Once the new dataset appears in the data view, you can view it in the table (excerpted 
below), or with any of the other visualization tools.  In this example, the dataset for 
males was entered first, so that values for females were subtracted from males, which 
just happens to produce only positive results for these datasets.  Doing the analysis 
with datasets in the reverse order would give the same results, except for the sign of 
the difference would be reversed.   

 

How to create a difference dataset for two times in the same dataset: 

1. Choose  "Derive new dataset" from the Tools menu, or from the menu that pops up 
when you right-click on a geography. 
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2. To subtract values from one dataset from values for the same dataset at a different 
time (the example in the second bullet-point and map, above), first enter a name for 
the new dataset, and then choose the geography (both datasets must be in the same 
geography).   

3. The syntax for identifying datasets to be modified is to precede the dataset name by a 
$, surround it in parentheses, and include the name in quotation marks. This syntax 
encapsulates the dataset name so that it isn't interpreted as part of a mathematical 
expression, even if the name includes mathematical symbols. SpaceStat automatically 
adds this syntax if you select datasets from the drop-down menu at the lower left, but 
you will need to modify this definition by including the specific dates and/or times 
that you want to subtract.  Then, to indicate dates, you will need to insert the year, 
month, day information within the parenthesis, and separated by commas, as shown 
in the example below (you can also include leading zeros before single digit months 
or days, e.g., "1980,01,01" but these are not required).  If your dataset is hours, 
minutes, seconds, then these parameters need to be indicated within the parenthesis 
following a comma after the dataset name.  Finally, if your dataset includes BOTH 
dates and times, then you need to include both in the dataset definition, e.g., 
$("RWM", 1980,1,1,12,0,0).   

 

4. The final dialog box for subtracting the cancer rate for white males (RWM) in 1960 
from the rate for white males in 1980 would look like the image above, and once you 
click OK, a new dataset with the name "RWM1980-RWM1960" would appear under 
SEAs in the Data View. 

  

Managing Data 
  

Managing Datasets 
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In the data view, you can use folders and nesting to organize your datasets. You can open or 
close a folder or nested set by clicking on the [+] or [-] symbol next to the icon. 

 

• You can hide or group data into folders beneath each geography by right clicking a 
geography and choosing "New dataset folder". Then, drag datasets into the folder. 

• New geographies or datasets created from others are nested by default, and placed 
underneath their parents. New geographies are created by conversion, developing 
subset geographies, or by making a centroid geography. New datasets can be created 
by standardization, by various mathematical operations using the dataset calculator, 
or through statistical transformation. You can drag the datasets to the main list to un-
nest them, or drag un-nested datasets back under their parents. However, you cannot 
nest datasets under non-parent datasets. For instance, in the above image, you could 
not nest RWM under RWF. 

• You can rearrange the order of folders and datasets within a geography by dragging 
them around. 

• You can copy datasets into nested geographies by dragging them to the subgeography 
name. 

  

  

Geography Properties 

Both your datasets and your geographies have properties in SpaceStat. The geography 
properties can be accessed by right clicking a geography in the data view or by clicking on 
the "Geography properties" button in the upper right portion of the Map Properties dialog. 
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You can change the name of the geography in this dialog. Also, you can view the history of 
the actions on the geography, such as when it was created and from which file if imported, or 
from which other "parent" geography if created within SpaceStat. The history also records 
any merged DBFs, the projection or coordinate system of the data if known, and the time 
range of the geography. 

 

  

  

Dataset Properties 

To view a dataset's properties, right-click the dataset and choose "Properties." This will bring 
up a window holding information on a dataset, including its name, data type, time range, and 
information about its origin. You can change the dataset's name here. The other information 
is not editable. 

 

  

56 



SpaceStat 4.0 Documentation 

  

Convert Data Type 

The data type for each variable in your project is identified in the data view. Variables can be 
numeric ( decimal or   integer) or  text-based (string). You may need to convert the type 
of an ID variable so that datasets can be merged when you import DBFs into a project. 
Convert the type by right-clicking the dataset in the data view and then choosing "convert 
data type". 

 

SpaceStat will convert each of the three data types (decimal, integer or string) into either of 
the other two, upon request. If you are changing from decimal to string values, you will be 
asked to specify the number of significant digits. After you press "Ok", SpaceStat will create 
a new dataset and place it in the data view. 

  

  

Rename 

To rename a dataset, geography, or weights set, select it with your mouse and wait a moment. 
The name will become selected, and a blinking cursor will appear.  At this point, you can 
either replace the name or edit it using your keyboard and mouse.  When you right click on a 
name, and chose "rename" from the list of options, this will also work by selecting the name 
and showing the cursor so you can change it. 

You can also rename a dataset in dataset properties, a geography in the geography properties, 
and a weights set in the define polygon weights or point weights dialog. 
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Remove 

To delete a dataset, geography, or weights set, select it with your mouse and hit the delete 
button on your keyboard. Alternatively, you can right-click the item and choose "Remove" 
from the pop-up window. 

  

  

Saving Projects 

Once you have imported your data and performed statistical analyses, you may wish to save 
your work to reopen later or share with a colleague. You can save your work, all open 
windows, all datasets, and information in the log, in a project file (*.spt). 

To save a project 

Choose "Save As" from the File menu or the save button on the tool bar . Choose a name 
and a location to save the file, then choose "Save" to save your file. 

Alternatively, when you close a project or attempt to open a new one, you will be asked 
whether or not you want to save your current project. 

To reduce project file size 

To reduce the size of your project file (*.spt), you can clear stored spatial weights before you 
choose to save the project. This will not delete the weights set or remove it from the list, but 
SpaceStat will have to recalculate the weights set the next time you need it. 

  

Add Weight Sets 
  

Spatial Weights Files 

You can export or import spatial weights from SpaceStat as a contiguity file (*.gal or *.gwt). 
These files can be read in a text editor or imported into other spatial analysis software 
products that use these formats. 

Contiguity files in the *.gal format contain binary contiguities, such as Y or N (is it a 
neighbor or not). Files in the *.gwt format contain information on which locations are the 
neighbors and their weight values. 

Binary contiguity relationships (*.gal) 
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These files indicate whether a region or location has any neighbors, identifying them if so.     

The *.gal file has the following structure when it exports from SpaceStat.  Files imported into 
SpaceStat need not have the geography name entry. 

0 total region count geography name 

egolabel neighbor count 

  

  

neighbor label neighbor label......   

egolabel 1 

  

  

neighbor label     

egolabel 0 

  

  

egolabel neighbor count   

etc.     

The first row specifies the total region count and the geography name. 

The second row specifies a target region, called an "ego," by its label and a count of its 
neighbors. An ego without neighbors will be listed as having a neighbor count of zero. 

The third row lists the identities of those neighbors if the count is non-zero, with the row 
continuing until all neighbors have been listed.   

Generalized weights format file (*.gwt) 

These files identify the neighbors of each region or location in turn and specify a weight for 
each pairing. Unlike GAL files, neighbor weight values are included. 

The *.gwt file has the following structure 

0 total region count geography name 
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egolabel neighbor label neighbor weight 

egolabel neighbor label neighbor weight 

egolabel neighbor label neighbor weight 

etc.     

The first row specifies the total region count and the geography name. 

All subsequent rows specify a target region, called an "ego," by its label, the label of its 
neighbor, and the weight of that relationship. An ego without neighbors will be omitted from 
the list. 

  

  

Import Spatial Weights File 

You can import a spatial weights dataset in a binary contiguity file (*.gal) or generalized 
weights format (*.gwt) file.  The main difference between these two formats is binary 
contiguity files hold information on neighbor relationships only, while generalized weights 
files hold information on neighbors and weights values. 

There are two ways to import a GAL or a GWT file. You can click the File menu and select 
Import -> Spatial weight set, or you can right-click on the name of a geography within the 
weights and cluster sets view, and select the Import option shown to the below. 

 

Either method will open the Import spatial weights file dialog box (shown below): 
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Choosing the parent geography and selecting a file 

First, browse to the location of your spatial weight set and then identify the parent geography 
to which the weight set will be associated.  By default, SpaceStat gives the spatial weight set 
the same name as the file, however the file name can be edited as desired.     

Time Stamp 

The Time stamp field is used to indicate which times in your geography are appropriate for 
use with the imported weight set.  If the location of objects is constant throughout the times 
included in your geography, then it is likely that you can apply the same spatial weights sets 
to all times, as in the example above. However, if objects appear or disappear over time, or if 
objects move over time, you will need to import separate weight sets for each spatial 
configuration of objects.  If you need to import several weight sets, remember to use the 
proper format for indicating the inclusive/exclusive nature of boundary dates. 

ID dataset 

Next, you may identify an object ID dataset within the parent geography that will serve as a 
link between the weights in your file and the objects within your geography.  If you choose to 
use this option, all objects must have a unique ID that matches a unique ID in your 
GAL/GWT file.  In the States geography shown here, the ID dataset is a list of state name 
abbreviations. 

If you do not choose to use this option, the weights will be assigned to your objects in the 
order which they appear in the Table view.  

  

Export 
  

Export 
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You can export your data from SpaceStat in three formats: shapefiles for geographies (and 
associated datasets), and DBFs or text files for datasets.  You can also export animations as 
AVI files, copy single graphs and maps to the clipboard as an image file, copy data from the 
table into Excel or other spreadsheet software using the copy option, and export spatial 
weights as GAL or GWT files. 

  

  

Export Animation 

You can export animated maps and graphs as audio-video interleave files (*.avi). AVI files 
store video clips and are playable in several media players and browsers. 

To export animation 

Choose "Export animation" from the "Map" or "Graph" menu of the view you wish to export. 
   

Click on the image below for more information. 

 

Start and end times 

First, set the start and end times for the animation.   

Time increment 

Next, select the time increment (how big you want the jumps in time to be.) If your dataset 
has hours, minutes, and seconds, those boxes will be available. In the example above, the 
data has time information down to days, but not below.   

Use exact time 
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As there is some variation in the number of days in a year, and days in a month, for data in 
these units SpaceStat offers you the option of exporting data in "exact time."  If you select 
this option, the animation will jump forward by a set time increment in days (you could input 
365 days for a year, or 30 days for a month). If you leave "use exact time" cleared, the 
animation will jump forward by the pre-set step size to the anniversary of the initial date. If 
the step size is 1 year and the first time is January 1, it will jump forward to the next January 
1.  If "use exact time" is checked, and you enter 365 days as your interval, the date 
corresponding to the jump will wander a bit from January 1 as leap years occur. 

Animation width 

At export, you choose the size of the animation. The default size is the size of the window on 
your screen. Reducing the animation width will lower the file size but the animation will be 
narrower. Reducing the size of the animation can make it appear smudged. 

  

  

Export Shapefile or Geodatabase File 

There are three ways to export a geography as a shapefile or geodatabase: choose (1) 
"Export>Geography" from the "File" menu, (2) or "Export geography" from the menu that 
pops-up when you right-click the geography, or (3) click on the export   button and choose 
"Geography" from the drop-down menu on the project toolbar.  Once the Export geography 
dialog appears, select the appropriate Export format (shapefile or geodatabase).   

SpaceStat exports the data and locations of the objects in your geography at the time(s) you 
specify. It exports the data as a time-slice file with one or several time slices. For shapefiles, 
the resulting DBF will have one or several rows for each object in your geography with a 
start and end time for each change in its attributes or position. For instance, if the dataset 
"RBF" changes every 5 years between 1950 and 1995, then each object will have 9 rows in 
the DBF, one for each RBF value. The DBF will include all the data you can see in the table 
in SpaceStat, plus the start and end date and/or time when those data values apply. 
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Instructions: 

You will need to specify which geography to export at which date and time, and specify a 
missing value code if appropriate for a shapefile. 

Geography 

Choose the geography to export from the pull-down list. 

Datasets 

Choose which datasets to export by selecting them, select a range of datasets using Shift-
select or individual datasets using Control-select. 

Time slices 

To choose the time exported, select the start and end time range. 

Time increment 

You may also choose to export data at regular increments (how often SpaceStat should 
"slice" the data). This determines the number of rows per object that SpaceStat creates. If you 
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export a 12 hour range every hour, each object in the geography could have up to 13 rows in 
the DBF associated with the shapefile, one for each time slice chosen. Objects may have less 
than the maximum number of rows if they do not exist for the entire time range exported. 

Use exact time 

As there is some variation in the number of days in a year, and days in a month, for data in 
these units SpaceStat offers you the option of exporting data in "exact time."  If you select 
this option, the animation will jump forward by a set time increment in days (you could input 
365 days for a year, or 30 days for a month). If you leave "use exact time" cleared, the 
animation will jump forward by the pre-set step size to the anniversary of the initial date. If 
the step size is 1 year and the first time is January 1, it will jump forward to the next January 
1.  If "use exact time" is checked, and you enter 365 days as your interval, the date 
corresponding to the jump will wander a bit from January 1 as leap years occur. 

Troubleshooting shapefile export 

Note that when datasets are exported as a shapefile, their names are truncated at 10 
characters.  If this will lead to confusion (i.e., datasets with the same name), you should edit 
your dataset names by right clicking on them and selecting "rename dataset".  Also, some 
GIS software may have trouble importing datasets if there are spaces in the dataset names. 
 Again, you can remove these by editing the dataset name prior to import.    

  

  

Export Datasets 

There are three ways to export dataset(s) as DBF files or text files: choose (1) 
"Export>datasets" from the "File" menu, (2) or "Export datasets" from the menu that pops-up 
when you right-click the geography, or (3) click on the export   button and then chose 
"Datasets" from the drop-down menu on the project toolbar .  Recall that if you prefer to 
work with your data in a spreadsheet like Excel, you can also copy all of the datasets (as 
shown in the table) to the clipboard, and then paste into your spreadsheet program. 

Details on exporting datasets 

SpaceStat exports all the data for the time range you specify. 

The resulting DBF or text file will have one or several rows for each object in your 
geography with a start and end time for each change in its attributes. For instance, if the 
dataset "RBF" changes every 5 years between 1950 and 1995, then each object will have 9 
rows in a DBF, one for each RBF value. The DBF will include all the data you can see in the 
table in SpaceStat, plus the start and end date and/or time when those data values apply. 

Troubleshooting dataset export 

65 



Data Preparation 

Note that when datasets are exported, their names are truncated at 10 characters.  If this will 
lead to confusion (i.e., data columns in the exported file that have the same name), you 
should edit your dataset names by right clicking on them and selecting "rename dataset". 
 Also, some GIS software may have trouble importing datasets if there are spaces in the 
dataset names.  Again, you can remove these by editing the dataset name prior to import.    

Click on the image below for more information. 

 

Once the Export DBF window opens, you will need to specify your geography, which 
datasets to export at which time range. 

Geography 

Choose the geography to export from the pull-down list. 

Export Format 

Choose whether you would like to export the data as a text file or a DBF.  Note you can also 
copy all of the datasets in the table to the clipboard, and then paste into Excel if that is your 
preferred format. 

Datasets 

Choose which datasets to export by selecting them, select a range of datasets using Shift-
select or individual datasets using Control-select. 

Time slices 

To choose the time range exported, select the start and end time range. 
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Copy or Export Animation 

Copy (Graph or Map menu, or right click menu) 

The  copy function under the Grpah menu allows you to copy images of any of the time 
plots, scatter plots, maps, or other visualization tools that you have created in your 
workspace.  You can then paste these images into word processing or presentation software 
such as Microsoft Powerpoint.  This option replaces the "export graph" option.   

 

Copy from Tables 

In Tables, the copy option allows you to select rows and/or columns of data, and copy them 
to the clipboard.  These can then be pasted into a spreadsheet or database.   

Export Animation 

All of the maps and graphs that can be animated (i.e., all but the time plot and scatter plots 
that compare two time periods for the same dataset) can also be exported as animation files 
(.avi) files, which you can include in slide show files, or run directly. 

  

  

Export Weights File 

You can export a spatial weights set as a binary contiguity file (*.gal) or generalized weights 
format (*.gwt) file. Both of these files can be read with a text editor or imported into a 
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spreadsheet. The main difference between these two formats is that binary contiguity files 
contain information on neighbor relationships only, while generalized weights files hold 
information on neighbors and weight values. 

Choose to export a GAL or a GWT file by right-clicking on a weights set in the weights set 
view (marked "weights view" in the middle left of this screen shot) and choosing "Export" 
from the pop-up menu. You will then need to choose whether to export a GAL or GWT file, 
a date and/or time (a field will appear for entering the time if that is appropriate for your 
weight file) and an ID dataset to use, if you choose to use one. The IDs are used to identify 
locations in the exported file. Only unique variables without any missing values at the time 
specified will show up in the "ID dataset" drop-down. If you choose a time outside the range 
of your data, no ID datasets will be available.  If you choose not to assign an ID dataset, the 
objects will be identified by the order in which they were imported or created, as they are 
originally displayed in the Table View.   

 

  

  

Missing Values 
In complex datasets, observations may be missing at some locations and/or some times. This 
may occur when data for a few locations were lost or deemed unreliable.  This can also 
happen when some variables are not observed at all time intervals covered by other datasets 
in the same geography.  Text files and Excel files with missing values can show these as 
empty placeholders or cells. These can also be identified using a missing value code.  If you 
are working with DBF files (as part of a shapefile, or as a file for importing datasets), you 
MUST set a missing value code.   

Click here to see information on representing missing values in the Map View. 

Missing values in imported DBF files 

The DBF file does not allow empty cells to represent missing data, so it must be defined as a 
no-data or missing value code. By convention, filling the field with -9's is a common missing 
value code. To make sure that the data are not analyzed as "-9,999" rather than missing, you 
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need to identify the code so that SpaceStat will handle the missing value code appropriately. 
 Note that if empty fields in a DBF are not filled, your data may still import, but it will be 
incorrect, as values may shift to fill the empty space. 

Missing values when exporting data 

Missing values are shown in SpaceStat tables as a dash. When you export data with missing 
values, such as Local Moran statistics for geographies that include islands (polygons without 
neighbors), you need to specify a missing value code for export to a DBF. 

Choosing a missing value code 

Because the exported DBF does not allow blank entries, you must provide some value to 
represent the data that are missing. The missing value code should be a value that could not 
possibly show up as a true data value in the data set. Often, codes such as "-9999" are used so 
that the code is easy to recognize when you scan a column of data. For example, it is 
recommended to use negative values if the dataset contains only positive values. Any integer 
value can be used, including negative numbers. Currently, decimal values and text strings 
(such as "no data") cannot be used. 

Missing values over time 

When you import several time slices to become one space-time dataset in SpaceStat, you can 
import a file for each time slice. Columns with the same name in each data file are 
considered to be the same variable. Variables that do not appear in all these files are 
considered to be missing values when excluded.   
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Data View 
The Data view is the table of contents for all of the data in your project. The Data view holds 
geographies and associated datasets. 

You can undock the Data view window by clicking on the  symbol in the upper right 
corner, and hide it by clicking on the   button. Undocking allows you to move the window 
to another location on your SpaceStat screen.  To unhide the Data view, select Data view 
from the "Window" menu. 

You can manage data in the data view by nesting and creating folders. 

 

Symbols explained 

 The geographies are identified with their spatial data format. 

 Integer data, numeric data consisting of whole numbers. 

  Decimal data, numeric data that can include fractional numbers. 

 String or text data can consist of letters and/or numbers. For numbers, 
differences between the values do not have mathematical meaning (they 
can be descriptors for different categories). 

Naming The names of datasets derived from other data contain the name of the 
original dataset. In the example above, "RWM(Z)" is the z-score 
standardized version of "RWM" dataset. 

The other datasets shown (LISA index) come from the Local Moran 
statistic performed on the standardized dataset. Names get rather long 
using these conventions, but the relationships are clear. You may rename 
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your datasets if desired. 

To see the parentage of a dataset, you can also right-click on it to view its 
properties, which describe its origin if the dataset was created within 
SpaceStat. 

  

  

Data View Actions 
The Data View lists all the geographies and associated datasets in your project. In the Data 
View, geographies (   ) appear above their associated datasets. Datasets appear as string 

  (character-based) or numeric (integer   or decimal ) data. To expand the window and 
view the full dataset names, drag the bar between the dataset names and the legend layer. 
You also can dock or undock the data view window. You can resize it by dragging its edges. 

A dataset can also be moved from the dataset window into the legend layer of a map to add it 
to the map. 

Geographies 

Right-clicking on any geography brings up these menu options: 

• Add it to a new or existing map 

• Export the data to a shapefile or to a DBF file 

• Create a centroid (point) geography from a polygon set 

• Create new datasets from existing datasets using the dataset calculator. 

• Organize the view by creating folders for datasets 

• Rename or remove the geography 

• Sort the datasets for the geography (and other geographies in the project) into 
alphabetical order 

• View the geography's properties 

Datasets 

Right-clicking on any dataset brings up these menu options: 
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• Add it to a new or existing map 

• Rename or remove the dataset 

• Convert a dataset's type 

• View the dataset's properties 

  

  

Log View 
SpaceStat records information from your analyses and displays it as text in the Log view 
screen, located below the Data view and Map.   

Log contents 

• A project's start and end date/time 

• Data files that have been imported and merged 

• ID column, time stamp and time series fields for each file imported 

• statistics SpaceStat calculates along with their associated parameters and results for 
the statistics 

• spatial weights 

• any error messages 

Editing 

You may add references or notes directly to the Log view page by placing the cursor in the 
log and typing. 

Saving 

SpaceStat saves your session log along with your project. When you open a saved project, 
SpaceStat will add any new actions you perform to the end of the previously saved Log view. 

Moving and hiding the window 

You can undock the Log view window by clicking on the   symbol in the upper right 
corner, and hide it by clicking on the   button. Undocking allows you to move the window 
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to another location on your SpaceStat screen.  To unhide the Log view, select Log view from 
the "Window" menu. 

  

  

Spatial Weights View 
The spatial weights sets and cluster sets in your project are held in a special window, which 
they share the Variogram model view.  Its default location is docked below the data view on 
the left edge of the application window.   

If the view has been hidden, you can show it by going to the "Window" menu, and checking 
the entry for "Spatial weights and variogram model view".  Another option is to use the 
Ctrl+3 shortcut. 

  

Moving and Hiding the Window 

You can undock the Spatial weights and variogram model view by clicking on the  symbol 
in the upper right corner.  To hide it, click the   button.  Undocking allows the window to 
float, so it can be moved as needed. 

Right-Click Actions 

• Define a new point or polygon spatial weights set by right clicking a geography. 

• Import a weights set as a GAL or GWT file by right clicking on a geography. 

• Show a weights set in a map by right clicking the set and select "Show in map". This 
creates a new map and turns on the view object neighbors for that weights set. 

• Edit an existing point or polygon weights set by double clicking its name, or by 
choosing "Edit" from the right-click menu. 

• Duplicate (copy) a spatial weight set. 

• Export a weights set as a GAL or GWT file. 
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• Rename or Remove a weights set. 

  

  

Variogram Model View 
The variogram models in your project are held in a special window, which they share with 
the Weight sets view.  Its default location is docked below the data view on the left edge of 
the application window.   

If the view has been hidden, you can show it by going to the "Window" menu, and checking 
the entry for "Spatial weights and variogram model view".  Another option is to use the 
Ctrl+3 shortcut. 

 

Moving and Hiding the Window 

You can "undock" the Spatial weights and variogram model view by clicking on the  
symbol in the upper right corner, and hide it by clicking on the   button.  Undocking allows 
you to move the window around; if you choose to close the window, you can view it again 
via the "Window" menu or the shortcuts. 

Right-Click Actions 

• Define a new variogram model by right clicking a geography or a dataset 

• View a model by right clicking on a variogram model. 

• Rename, Duplicate or Remove a variogram model. 
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Virtual Workspace 
The SpaceStat user interface is made up of several sections, including the Data view, the 
spatial weights view, and the log. The rest of the application window, the workspace, is 
available to fill with the task manager (not shown in the image below), and visualization 
tools like maps, time plots, scatter plots, and histograms. 

Because dynamic data exploration is quite graphical, you may want to keep several windows 
open to display multiple views of the data.  However, this often means that one or more 
windows are not visible, either because they are too small to see (when many windows are 
tiled), or because some are underneath others (as when you use the cascade option). 
 SpaceStat allows you to turn on a "virtual workspace" so that you can arrange many 
windows, and then use scroll bars on the workspace (the area surrounded by the data view, 
spatial weights view, and log) to move through all of the information. 

The virtual workspace can be enabled by selecting Use virtual workspace from the Window 
menu. Note that when the windows are tiled, they will shrink to fit in the visible part of the 
screen space. 

 

  

  

Task Manager 
The task manager provides a framework for transforming and analyzing your data.  By 
default, the Task Manager view first appears when you select a method from the Method 
drop-down menu, and will appear with the first section open.  In the image below, the Task 
Manager view displays the input screen for the Disparity method.  The blue "x" displayed on 
the same tab can be clicked to remove that method from the Task Manager view.   
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For most methods, the Task Manager view will contain four sections, labeled "Input", 
"Advanced" (sometimes not present), "Output", and "Run Method" (see green circles in the 
image below).  The sections for regression methods are different, and are shown here.   

  

As the name suggests, the "Input" tab is used to identify the parameters that will determine 
how SpaceStat performs the data transformation or statistical analysis. These include 
datasets, relevant times, and other factors as shown in the image above.  The "Advanced" tab 
typically provides an opportunity to adjust additional features, such as the p-value, or the 
option to use a Simes Correction.  The "Output" tab is where you can specify the name of 
output files, and the "Run method" tab summarizes all of the other pages, and contains the 
"Run" button to implement the method.   

You can link directly to guidance on what to enter in each of these sections by clicking on the 
following methods:   Z-Score; Aggregation; Empirical Bayesian Smoothing; Local G; Local 
G*; Univariate Local Moran; Bivariate Local Moran; Turnbull; Besag and Newell, Disparity, 
Aspatial Regression, and Geographically-weighted Regression. 

Task Manager special features 

Encompassing the methods within the Task Manager framework has several advantages. 
 First, by displaying all of the methods into a similar framework, we hope to simplify the 
process of learning how to use the many powerful tools in SpaceStat.  In addition, because 
the Task Manager works as a view, it can be hidden or shown without losing the information 
that was entered for a particular analysis, even if you close a project. Another advantage is 
that several versions of a method can be run and re-run with different datasets or different 
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"Advanced" settings. This is done by selecting the method again from the drop-down menu 
(see the image to the right, where the "Disparity" method appears twice).  Another option is 
to edit the pages for a given method to re-run an analysis using different options (then only 
the last version will be saved).  Finally, you can run different methods, and the task manager 
will maintain this information until you choose to "close" a method by clicking on the "x" to 
the left of the method name.  When you have run several methods and the "Method Name" 
bar (shown in circled in green, above) is larger than the window extents, it is possible to 
scroll through the collection as needed. 

 

Resizing, docking, and hiding the task manager 

Depending on the screen space available, the Task manager may open in a compressed 
format when a method is invoked.  This compressed view will not display the entire screen 
for a particular section (e.g., "Input"). If horizontal or vertical sliders are visible in a given 
section of the Task Manager (shown circled in green for the Input page of the Task Manager 
View of Turnbull’s Method, below left), then you may need to expand the size of the Task 
Manager View.   This can be done by clicking on the window edges and expanding the 
window or you may use the scroll bars to see all the relevant information. 

Compressed version All of the "Input" window shown 
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You can "undock" the Task Manager window by clicking on the  symbol in the upper right 
corner, and hide it by clicking on the  button. Undocking allows you to move the window to 
another location on your SpaceStat screen.  To unhide the Task manager view, select Task 
manager view from the "Window" menu.   

  

  

Printing 
You can print any of the maps and graphs you generate in SpaceStat. Currently, the printing 
functionality is very simple. 

• SpaceStat prints the map from the map display only. It does not currently print the 
map legends. To create an image containing both the legend and map, a screenshot of 
the window is required. Once the image has been captured, use an image editor to 
optimize and edit the image. 

• For plots such as the box plot, scatter plot, time plot, Moran scatter plot, or histogram, 
you can print by browsing to the Graph menu and selecting Print. 
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Dynamic Data Exploration 
SpaceStat provides interactive visualization for your space-time data. 

You can view data in 

• maps, 

• plots ( box plot, histogram, time plot, parallel coordinate plot, scatter plot,   
Moran scatter plot, and variogram cloud), 

• and tables. 

These views are all dockable and can be linked and synchronized for dynamic data 
exploration. All views have time as a dimension, so you can scroll through them using the 
animation toolbar or by changing the time displayed. 

If you have shapefiles and DBFs to import, you can jump-start your own analysis now. 

  

Visualization Tools 
  

Dynamic Data Exploration 

SpaceStat provides interactive visualization for your space-time data. 

You can view data in 

• maps, 

• plots ( box plot, histogram, time plot, parallel coordinate plot, scatter plot,   
Moran scatter plot, and variogram cloud), 

• and tables. 
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These views are all dockable and can be linked and synchronized for dynamic data 
exploration. All views have time as a dimension, so you can scroll through them using the 
animation toolbar or by changing the time displayed. 

If you have shapefiles and DBFs to import, you can jump-start your own analysis now. 

  

Map 

  

About Maps 

SpaceStat displays maps in a two-pane window. The left pane holds the map legend, which 
lists the geography of the data, and the variables that are plotted, along with and their 
symbols and color schemes. The right pane contains the map itself.  The three menus across 
the top of the window allow you to hide or show the Animation and Map toolbars (click on 
"toolbars"), to control aspects of the animation, including the time-step size (click on 
"Animation"), and to use all of the tools in the Map toolbar, and to access several other 
functions (click on "Map"; see below for details). 

 

The left panel: the map legend 

The map legend panel lists all the layers in the map, and provides a way for you to manage 
these layers. You may show or hide a map layer by checking or clearing its associated box 
using the mouse; displayed layers have a check in the box next to their name.  If you add an 
additional dataset from the same geography to your map, SpaceStat will give it a sequential 
layer name -- for example, if another dataset for the county geography was added to the map 
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shown above, the name of this layer would appear as "County 2", with the specific dataset 
identified by default under the "Fill color/pattern" heading (where you see "Rate - white 
female" in the example).  You can always change which datasets are used to determine 
various properties of the map in the Map Properties dialogs.  You can delete a layer from a 
map by selecting it and then hitting the delete key, or by selecting it, and then right clicking 
to reveal the "remove" option. 

To change the order of layers in a map or datasets in a layer, drag layers up or down the list. 

You can add layers to an existing map by right-clicking a geography or dataset in the data 
view and choosing "View in map". Or, you can click on a dataset in the data view and drag it 
into the left panel. 

You can close the legend by clicking on the [x] button on the top right of the panel labeled 
"Map legend", or by unselecting "Legend" under the "Map" pulldown menu. To bring the 
legend back, return to the Map pulldown menu and click on the blank space to the left of 
"Legend" to make the check mark and the legend re-appear. 

The right panel: the map pane 

Your map appears in the right pane of the map window.  You can use the map toolbar to pan, 
zoom, select, and query the map. By default, the entire extent of your data will appear in the 
map pane, but if you zoom or pan within the data such that some areas are hidden, scrollbars 
will appear within the pane, providing an additional method for shifting the area shown in the 
window.  You can view a slideshow of any of the datasets associated with a particular map in 
this window by using tools from the animation toolbar. 

If you right click within the map pane, a menu will appear listing options for letting you 
change the cursor to a query tool, allowing you to zoom in to a selected object, to invert your 
selection, or to create a new subset geography from selected objects.  The right click menu 
will also give you the option of converting the cursor to a tool for showing spatial weight sets 
for selected objects, or for accessing the map properties dialog, or printing options. 

Map controls 

You can interact with the map using the map or animation toolbars; if you wish to hide these 
toolbars, you can do so and still access of their options from the "Map" and "Animation" 
pulldown menus.  The "Animation" menu also includes the option for setting the time-step 
for animations.  From the "Map" menu, you can also hide or show the legend (see above), 
copy an image of the map to the clipboard, export an animation, print, or view map 
properties. 

Status bar 

In the lower left of the map, the location portion of the status bar shows the most recent 
coordinates of the mouse pointer, and will tell you how many objects are selected when you 
are selecting or querying objects. The coordinates are in the projection of the geography, 
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viewable in the geography properties.  In the lower right, there is a progress bar that indicates 
when SpaceStat is drawing or re-drawing map contents.  Sometimes with very complex 
geographies, or when many layers are present in the same map, updating the map can take a 
few seconds -- action in this box shows you that the change is "in-progress." 

  

  

Map Tools 

       

 

The map tools allow you to interact with the map by changing the field of view, by finding 
more information about objects in the map, or by editing how the map is displayed. The map 
toolbar can be docked or free-floating, and all of the map tools are also available from the 
"Map" pulldown menu in the Map Window if you should choose to hide the map toolbar 
(unselect "Map" in the "Toolbar" pulldown menu).   Each tool is described below.   Note that 
the map pulldown menu also includes two options for exporting maps - you can copy an 
image of the map you see to the clipboard, or export an animation if your data change over 
time. 

 selection This is the default tool. 

• In the map layer pane, it can be used for changing the 
order of map layers, and activating and deactivating map 
layers (see Maps overview for details). 

• In the map pane, it can be used to select items on the 
map. Using this tool you can click directly on a single 
item to select it, or you can click and drag open a 
rectangle to select all items that intersect the rectangle. 
Selection is useful in linked data views. 

• When you right click on the map, this tool can also be 
used to show object neighbors. 

 zoom in Use the zoom in tool to focus on a section of the map. Move the 
tool to where you want to zoom, and click to zoom in.  You can 
also draw a box by left clicking your mouse and holding the 
button down as you drag the cursor from the starting point; 
when you release the button the map view will zoom to the area 
in the box. 

Alternatively, you can "zoom to selected"  objects using the 
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map's right click menu. 

 zoom out Use the zoom out tool to enlarge the field of view. Move the 
tool to where you want the enlargement to be centered and click 
to zoom out. The map focus will not zoom out beyond the 
spatial extent of the data. This button will not be active unless 
you are zoomed in somewhat from the full extent of the dataset. 

 zoom to 
fit 

The zoom to fit tool returns the visual display to the full spatial 
extent of the data set. This button will not be active unless you 
are zoomed in from the full extent of the dataset. 

 pan The pan tool can be used instead of the scrollbars to move the 
field of view across the map. This tool only works when the 
map is zoomed in from the full spatial extent of the data. Click 
on the button to activate the tool and then use it to pan the map 
across the viewing window. For example, to expose a section to 
the right of the viewing window, drag the map to the left. 

 query The query button is a method for querying the map; clicking a 
point with this tool brings up a table of information about the 
selected location. You can also query by right-clicking a single 
object (state, SEA, or county) in the layer. 

 properties The properties button can be used to view and edit map layer 
properties (color schemes, data in map, etc.). 

 print Use this button to send your map to a printer.  The map printed 
will be for the time shown in your time window (upper right, 
next to the animation toolbar), and currently only the map (not 
the legend) will be printed. 

  

  

Create a Map 

1. Click on "View> Map," or click on the Map  icon on the visualization toolbar, 

2. Then, select the geography that you want to see on the map. 

3. Select the dataset you want to use to determine the fill color, 
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4. <optional> Change the name of the new layer - the default name will be the same as 
the geography, but here we have changed the name to match the variable (lung cancer 
rate for white males, abbreviated as RWM). 

5. The last section of the dialog box asks if you want to create a new map, or add a new 
layer to an existing map.  If you choose to add to an existing map, you can scroll 
through other maps in your project by clicking on the down arrow for this box. 

 

Express Option 

Alternatively, you can right-click on any geography or dataset and choose "Add to Map" 
from the pop-up menu. You can then choose to display this information in new map, or to 
add it to an existing map. 

  

  

Querying Maps 

Querying calls up information about items on the map, producing a table of all the data that 
pertain to the selected location. 

Click on the query tool in the map tools toolbar, and then click on the map (or right-click 
on the map to show the "Query this location" option). This brings up a table of information 
on the selected map layer (the highlighted layer). Note that you can query more than one 
geography from the same project simultaneously, with the outlines of both selected elements 
appearing in the map, and values from each dataset shown sequentially within a column in 
the query output table.   

Saving and clearing queries 

If you wish to compare several locations in the query table, you can press the "Save" button 
on the lower right of the query window. Then, when you query a new location, the 
information from the previous query is moved to the right and given a query number, as in 
the column labeled "Query 1" below.  As more queries are done and saved, the Query 1 
column will continue moving right, and additional queries will be saved next to the "Values" 
column.  The image below shows a vertical scroll bar that you can use to see values for 
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datasets that do not fit in the query data window; a horizontal scroll bar will also appear if 
you run out of window space so that you can scroll through your saved queries.  The most 
recent query will always appear in the "Values" column, next to the listing of dataset names. 
 If you hit the "clear" button, all saved queries will be removed from the query window.  You 
can also bring up an option to clear the query output by right-clicking in the query data 
window. 

 

  

  

Interpolation in Maps 

You can animate any view in SpaceStat by moving the time slider or hitting the play button. 
This default type of animation is essentially a slide show, with abrupt changes when data 
values change. For maps only, you can see a more gradual view of changes over time by 
asking SpaceStat to interpolate the data. This is strictly a visual effect, essentially smoothing 
over the abrupt jumps in data values. It is not meant to be statistically accurate, but it does 
provide a more natural-looking display of time-slice data. 

To see the animation interpolated, check the "interpolate values" box at the bottom of 
relevant pages within the Map Properties dialog window.  In the example below, this box is 
checked on the polygon fill attributes page.  You can open the Map Properties window by 
clicking on the properties icon  on the map toolbar, by clicking on the "Map" pulldown 
window and selecting "Properties", or by right-clicking on the map and again selecting 
"Properties" from the pop-up menu.  If you are working with polygons, you have the option 
of interpolating values in all of the various polygon attributes (polygon fill, polygon border, 
and polygon border width); similarly, for point geographies, you can again interpolate 
between attributes that change over time (point color, size, and sometimes symbols). 
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How the interpolation works 

For time-slice data that is valid for a time range, the value is 
assigned to the median time for each range. Then, times in 
between those midpoints receive intermediate values, linearly 
interpolated between the two points, as shown in the simple 
example with two data values at left. The left bar, which shows 
a sharp color transition between time 1 and 2 is the original un-
interpolated data. The right bar is the interpolated display of the 

same data, with the color change suggesting a smooth transition between the midpoints. 

Interpolation will also hide missing values in the original dataset, unless the location is 
missing for the entire time range. If there is a value for any time in the range, that value, or 
an interpolated value between existing values will replace the missing ones. 

Except for locations with missing values, SpaceStat does not extrapolate outside the range for 
which it has data. This means that for an observation associated with the earliest time, the 
value is applied to the first half of the time range (up to and including the median) rather than 
linearly extrapolated from the trend after that first median time. 

  

  

Selection in maps and plots 

You can select data in a map or any linked graphical view in several ways. 

        Use the selection cursor from the map toolbar  to select individual objects, or click it to 
open a selection rectangle anywhere in the map. You can change the properties of the 
selection rectangle on the "General" pages of the Map Properties dialogs for polygons, points, 
or lines.  Note that the default color for identifying selected objects is orange (see the image 
below) but you can change this in map properties.  The number of selected objects is tallied at 
the bottom-left of the map window, shown circled in red in the image below.   
        You can also select multiple objects by holding down the "shift" key and clicking on 
locations in your map; unlike the selection box, this method allows to select sets of non-
adjacent locations.   
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        Click to select an item anywhere within any graphical view (histogram, scatter plot, box 
plot...); click and hold down the button while moving the cursor to create a selection rectangle 
that will allow you to select multiple items. 
        Select by value in the map: 

o       Select by class in a classified color scheme by right clicking on the class of interest in 
the map layers pane. 
o       Select by category in a qualitative color scheme by right-clicking on the category of 
interest in the map layers pane. 

  

  

Invert Selection 

The invert selection option allows you to select a subset of objects from a geography or 
geographies, and then "invert" the selection so that all objects EXCEPT the ones you 
originally selected are highlighted in maps or tables (and as a result of their being selected in 
the map or table, are also selected in various plots, etc).  To use this tool in a map, simply 
select an object or objects with the selection  tool. Then right-click, and choose "Invert 
selection" from the pop-up menu.  Similarly, in tables, select a subset of objects (entire rows 
within the table), and then right click to show the "Invert Selection" option. 

One common use for the invert selection tool is in creating subset geographies, as illustrated 
below with the map view: 
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In this example, Florida has been selected 

 

After right clicking on Florida and choosing "Invert selection," 
Florida is no longer selected, but all other locations are.  Then you 
can create a new geography without Florida from the selected 
geography. Right-click on a selected part of the map and choose 
"New geography from selected." SpaceStat will ask you to name 
your new map, and if you want to include the parent datasets with it. 

  

 

 This map is the result of creating a new geography from the selected 
geography. 

Note: If you have multiple geographies in the same map, invert selection will invert the 
selection in all layers and geographies. This may make things confusing if you then go on to 
create a new geography from selected. Just be careful to select the geography you want in the 
dialog. 

  

  

View Spatial Weights 

You can view spatial weights in the map and log by selecting an individual object (or set of 
objects) and directing SpaceStat to show you the neighbors.  For example, the polygons with 
blue borders in the image to the right are the first-order rook neighbors of the orange-
bordered polygon.  Using the "Show object neighbors" function will also add the neighbor 
IDs and their weights to the log.  The numbers shown before the weights values will be from 
the ID dataset, which is also visible in the table, or by querying the object in the map.  Note 
that if you need a reminder of the name of the ID dataset in your project, this information is 
displayed at top of the Log view. 
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Steps 

1. Right click on a map and choose "Show object neighbors". If there are multiple layers 
in the map and multiple weights sets, you will need to choose a weights set for each 
layer you want to see. The weight selection step enables the "Show neighbors" 
functionality. 

 

2. Each object you click with the selection pointer  will be highlighted in the selection 
color (orange is the default).  Its neighbors will be highlighted in blue, with the 
weights reported in the log. If ego is included in your weight calculation, then the 
selected area will also be highlighted in blue, and it will be listed as a neighbor and 
have a weight in the log. It is possible to select multiple objects to view several sets of 
neighbors at once using the Shift key. 

3. You have the option to zoom, pan, and query as usual, but the selection pointer  will 
select objects and show their neighbors in blue until you turn off the functionality. 
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4. To stop showing neighbors, right click on the map, select "Show object neighbors" 
and then uncheck the chosen weights set(s). When all sets have been cleared, the 
selection pointer returns to its normal state. 

  

Map Properties 

  

Map Properties - Overview 

The map properties dialogs allow you to change the way your data are displayed in the map. 
You can view the properties by selecting "Properties" from the "Map" menu, by clicking on 
the Map Properties  button on the toolbar, or by right-clicking on the map. Once you have 
accessed the set of dialog boxes, you can change the how items are selected (General tabs for 
polygons, points, and lines), can change the color scheme for polygons, points, or lines, and 
can change polygon border attributes, polygon border width, line width, point size, and point 
symbols.  At the bottom of each page, there are additional options for representing missing 
values in your dataset.  Once you have this window up, you can change properties for any of 
the layers in your project. Switch between layers by using the "Layer" pull-down box in the 
top left corner of the window. 

The top of the dialog allows you to change the map name (what shows in the title bar of the 
map window) or the layer name (displayed in the legend pane of the map). To change the 
name of a dataset, you must edit its name in the data view. You can also view the data source 
or geography properties from this dialog by pressing the "Geography properties" button. 

The options on the different tabbed pages for polygon, point, and line geographies vary 
slightly, and are described in more detail in geography-specific sections of the Map 
properties help.    

Click on the tabs in the images of the Map properties windows (below) for more 
information. 

Map properties for polygon data 

 

For point data 
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For line data 

 

  

Polygon Geographies 

  

Map Properties for Polygons - General Tab 

You can view the properties by selecting "Properties" from the "Map" menu, by clicking on 
the Map Properties   button on the map toolbar, or by right-clicking on the map. 

In the general map properties tab for polygon geographies, you can set how you want to 
select polygons in the map, how to color selected polygons, and whether to link or hide 
missing values.  When you change your selection options in the dialog, the preview map will 
update and show you how your changes will look on an example dataset. 

Choose "Preview" to view your selections on the map (but keep the properties dialog open), 
and then choose "OK" to apply your changes and close the dialog. If you press "Cancel" after 
"Preview" your changes will not be saved. 

Click on tabs and boxes in the image below for more information. 
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Selected polygon attributes 

You can change the fill color, outline color, and outline thickness for displaying the polygons 
you have selected on the map. Your choices are shown in the preview map on the right. As 
shown here, the default is to show selected polygons with an orange outline with a width of 
1. 

Rectangle select method 

You can select polygons in the map in one of three ways: by overlapping your selection 
rectangle with any part of polygons (object overlap), overlapping with their minimum 
bounding rectangles (so selections could include polygons not actually touched by the 
selection rectangle), or by the selection rectangle overlapping the polygon's centroid (center 
containment, the fastest option and the default). When you change your choice, the preview 
map in the right portion of the dialog will update to show you which polygons would be 
selected by the same rectangle using each selection method. 

Missing-value display 

On the general tab, you can choose to link missing value attributes across all datasets used in 
the map, or to hide objects with missing values.  These options, and other options related to 
how missing values are displayed in your maps are described in missing values in map view. 
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Map Properties for Polygons - Fill Attributes Tab 

In the Map Properties fill attribute dialog for polygons, you can choose which dataset to use 
to color the polygons (by selecting the dataset from the data sets column on the lower left - 
the map displays a single dataset in each layer), and then you can customize the color mode 
and color scheme (options are listed in the pull-down menu next to "Color palettes". 
 Datasets can be represented in one of several color modes: single color, qualitative, 
classified, or continuous.  To create "custom" categories, choose the classified option, choose 
custom for the classification method, and then enter the number of classes.  You can then 
type in Min and Max values for each group.  Once you have divided the data, you can further 
modify how each category is colored and filled by clicking on the colored box for each group 
(in the fill column, which is partially hidden in the image below -- to the left of the 
"Minimum" column).  You can also change the fill pattern for all data categories (Global fill 
pattern), and the fill pattern for missing values (see bottom right of dialog box).   

By checking the box in the lower left (below the list of datasets), you can choose to have 
SpaceStat interpolate values during animations or map movies to smooth the transitions 
between different fill types if an object's fill class changes over time. 

Choose "Preview" to view your selections in the map (don't close the properties dialog box 
while you preview, or your changes will be lost).  When you have finished choosing a fill 
scheme, choose "OK" to apply your changes and close the dialog. If you press "Cancel" after 
"Preview" your changes will not be saved. 

Click on tabs and boxes in the image below for more information. 

95 



Data Exploration 

 

  

  

Map Properties for Polygons - Border Attributes Tab 

In the border attributes tab, you can set how you want the polygon border to look by 
specifying line color and style attributes. If you want to specify something other than single 
color, you need to choose a dataset and then an appropriate color mode.  Datasets can be 
represented in one of several color modes: single color, qualitative, classified, or continuous. 
 To create "custom" categories, choose the classified option, choose custom for the 
classification method, and then enter the number of classes.  You can then type in Min and 
Max values for each group.  Once you have divided the data, you can further modify how 
each category is colored and the line style by clicking on the "Fill" box for each group.  Note 
that you can choose a different dataset than the one you used for selecting polygon fill if you 
want to show patterns for two variables on the same map.  In the example below, we have 
used the "Count of black females" dataset to show the polygon border, while on the polygon 
fill attributes page, we chose the cancer rate for black females for coloring the polygons. 
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In this dialog, you can change the attributes of the polygon borders shown in the map and/or 
make borders transparent. You can change color and line style, applying a single color or line 
style or various color modes and line styles (e.g. solid, transparent, dashed).  To create 
"custom" categories, choose the classified option, choose custom for the classification 
method, and then enter the number of classes.  You can then type in Min and Max values for 
each group.  Once you have divided the data, you can further modify how each category is 
colored and filled by clicking on the colored box for each group (in the fill column, which is 
partially hidden in the image below -- to the left of the "Minimum" column). 

If you check the interpolate values box in the lower left, the transitions between border 
attribute classes will be smoothed during animations of the data.  Note that a separate set of 
attributes can be chosen for polygons with missing values in your datasets. 

Choose "Preview" to view your selections in the map (don't close the properties dialog box 
while you preview, or your changes will be lost).  When you have finished choosing a fill 
scheme, choose "OK" to apply your changes and close the dialog. If you press "Cancel" after 
"Preview" your changes will not be saved. 

Click on tabs and boxes in the image below for more information. 
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Map Properties for Polygons - Border Width Tab 

You can change the border width for polygons in the map. If you want to specify something 
other than single width, you need to choose a dataset for determining the width distribution, 
and then an appropriate mode.  Datasets can be represented in one of several color modes: 
single color, qualitative, classified, or continuous.  To create "custom" categories, choose the 
classified option, choose custom for the classification method, and then enter the number of 
classes.  You can then type in Min and Max values for each group.  Once you have divided 
the data, you can further modify the width by clicking on the size box for each group. Note 
that you can choose a different dataset than you did for the polygon fill if you wish to show 
characteristics of two different datasets (in the same geography) in one map, or you could 
even use three different variables (one for fill, one for border attributes, and one for border 
width), although this is likely to produce a map that is very hard to interpret. 

If you choose border widths that vary in time, you can check the interpolate values box 
(lower left corner) to smooth the transitions between border widths in an animation or map 
movie.  Also, you can chose specific polygon border width characteristics for objects with 
missing values in the lower right corner. 

Choose "Preview" to view your selections in the map (don't close the properties dialog box 
while you preview, or your changes will be lost).  When you have finished choosing a fill 
scheme, choose "OK" to apply your changes and close the dialog. If you press "Cancel" after 
"Preview" your changes will not be saved. 

Click on tabs and boxes in the image below for more information. 
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Point Geographies 

  

Map Properties for Points - General Tab 

You can view the properties by selecting "Properties" from the "Map" menu, by clicking on 
the Map Properties   button on the toolbar, or by right-clicking on the map. 

In the general map properties tab, you can set how you want to select points in the map, and 
how to color the points to show they have been selected. When you change your selection 
options in the dialog, the preview map will update and show you on an example dataset how 
your changes will look.  In the lower left, you can choose if you want to link or hide missing 
values. 

Choose "Preview" to view your selections on the map (but keep the properties dialog open), 
and then choose "OK" to apply your changes and close the dialog. If you press "Cancel" after 
"Preview" your changes will not be saved. 

Click on tabs and boxes in the image below for more information. 
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Selected point attributes 

You can change the fill color, outline color, and point size for displaying the points you have 
selected on the map. Your choices are shown in the preview map on the right.  Note this 
preview shows both a point geography (with just two points) with a polygon geography (US 
states) in the background. 

Missing-value display 

On the general tab, you can choose to link missing value attributes across all datasets used in 
the map, or to hide objects with missing values.  These options, and other options related to 
how missing values are displayed in your maps are described in missing values in map view. 
 For point geographies, linking missing value attributes is the default (thus, if the value of 
any of the maximum of three different datasets used to characterize points as missing, the 
point is shown with a missing value symbol.  This is the default for points, but not for 
polygons, because it is harder to see indications of missing values shown by color changes or 
point sizes.   

  

  

Map Properties for Points - Point Color Tab 
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In the Map Properties point color dialog, you can choose which dataset to view (by selecting 
the dataset from the data sets column on the lower left), and then you can customize its color 
mode and color scheme (options are in the Color palette pull-down list).  Datasets can be 
represented in one of several color modes: single color, qualitative, classified, or continuous. 
 To create "custom" categories, choose the classified option, choose custom for the 
classification method, and then enter the number of classes.  You can then type in Min and 
Max values for each group.  Once you have divided the data, you can further modify how 
each category is colored and filled by clicking on the colored box for each group (in the fill 
column).  You can left click on any individual colored block to change the color or fill for 
one group, or can choose to change the global fill pattern for points by pulling down the fill 
window. 

A box in the lower right allows you to choose a different color and fill pattern for missing 
values in your dataset.  In the point color dialog box, you can also choose to have SpaceStat 
interpolate values during animations or map movies to smooth the transitions between 
different colors if a point's class changes over time. 

Choose "Preview" to view your selections in the map (don't close the properties dialog box 
while you preview, or your changes will be lost).  When you have finished choosing a fill 
scheme, choose "OK" to apply your changes and close the dialog. If you press "Cancel" after 
"Preview" your changes will not be saved. 

Click on tabs and boxes in the image below for more information. 
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Map Properties for Points - Point Size Tab 

You can make all points on your map the same size (increasing or decreasing the size from 
the default), or can use point size as a way of providing additional information about your 
dataset.  If you want to show points of different sizes, you need to choose a dataset for 
determining the size distribution (left side of dialog box), and then an appropriate size 
classification mode.  Left click in the box for point size to change the size in your grouped 
data.  Note that you can choose a different dataset than you did for the point color and/or 
point symbol if you wish to show characteristics of different datasets (in the same geography) 
in one map.  Here we have used the count of black males (dataset CBM), while for 
determining point color, we used the cancer rate for black males (RBM). 

If you choose point sizes that vary in time, you can check the interpolate values box (lower 
left corner) to smooth the transitions in an animation or map movie.  Also, you can choose a 
size for missing value points in the lower right corner. 
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Choose "Preview" to view your selections in the map view (don't close the properties dialog 
box while you preview, or your changes will be lost).  When you have finished choosing a 
fill scheme, choose "OK" to apply your changes and close the dialog. If you press "Cancel" 
after "Preview" your changes will not be saved. 

Click on tabs and boxes in the image below for more information. 

 

  

  

Map Properties for Points - Point Symbol 

In the point symbol tab, you can set how you want the points to look by specifying their 
shape. If you want to specify something other than single symbol for all of the points in your 
dataset, you need to choose a dataset to use for grouping points.  After you've chosen a 
dataset, you can either see classified or qualitative symbols, depending on your data type. 
Note that you can use a different dataset for in the point color, size, and symbol dialogs, 
allowing you to show characteristics of more than one dataset (from the same geography) in 
a single map. 

A box in the lower right allows you to choose a different symbol for missing values in your 
dataset (the default is an "X").   
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Choose "Preview" to view your selections to the map (don't close the properties dialog), then 
choose "OK" to apply your changes and close the dialog. If you press "Cancel" after 
"Preview" your changes will not be saved. 

Click on tabs and boxes in the image below for more information. 

 

For single symbol, you can change the symbol for all points from the menu (below). For 
classified or qualitative symbols, you can accept the default choices or customize the look of 
each class in your scheme by left clicking in the box for each symbol. 

 

  

Line Geographies 

Map Properties for Lines - General Tab 

You can view the properties by selecting "Properties" from the "Map" menu, by clicking on 
the Map Properties   button on the toolbar, or by right-clicking on the map. 
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In the general map properties tab for lines, you can set how you want to select lines in the 
map, and how to color the selected lines. Choose "Preview" to view your selections on the 
map (but keep the properties dialog open), and then choose "OK" to apply your changes and 
close the dialog. If you press "Cancel" after "Preview" your changes will not be saved. 

Click on tabs and boxes in the image, and see below for more information. 

 

  

Selected line attributes 

You can change the fill color, outline color, and outline thickness for displaying the polygons 
you have selected on the map. Your choices are shown in the preview map on the right. 

Missing-value display 

On the general tab, you can choose to link missing value attributes across all datasets used in 
the map, or to hide objects with missing values.  These options, and other options related to 
how missing values are displayed in your maps are described in missing values in map view. 

  

Map Properties for Lines - Line Color and Style 

In the Map Properties line attributes dialog, you can choose which dataset to view (by 
selecting the dataset from the data sets column on the lower left), and then you can customize 
its color mode and color scheme.  Datasets can be represented in one of several color modes: 
single color, qualitative, classified, or continuous.  Once you have chosen a scheme for 
dividing the data, you can further modify how each category is colored by left clicking on the 
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color box for each group.  You can also left click directly on the box showing the line color 
and style to change both of these attributes, and similarly can change the pattern for missing 
values (see bottom right of dialog box).   

You can also choose to have SpaceStat interpolate values during animations or map movies 
to smooth the transitions between different line attributes if a line's class changes over time. 

Choose "Preview" to view your selections in the map (don't close the properties dialog box 
while you preview, or your changes will be lost).  When you have finished choosing a fill 
scheme, choose "OK" to apply your changes and close the dialog. If you press "Cancel" after 
"Preview" your changes will not be saved. 

Click on tabs and boxes in the image below for more information. 

 

When you click on a box showing the line characteristics for a particular group, you will 
open a new dialog box like the one below that allows you to select the color and line style. 
 Similarly, the global line style uses the same pulldown menu to offer you choices for how 
lines are represented. 
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Map Properties for Lines - Line Width Tab 

You can easily change the width of the lines shown on the map. If you want to specify 
something other than a single width, you need to choose a dataset for determining the width 
distribution, and then an appropriate mode. Note that you can choose a different dataset than 
you did for the polygon fill if you wish to show characteristics of two different datasets (in 
the same geography) in one map.  To override the default values that appear when you 
classify your data, you can left click in the width box for any category to type in a new value. 

If you choose line widths that vary in time, you can check the interpolate values box (lower 
left corner) to smooth the transitions between widths in an animation or map movie.  Also, 
you can chose specific line widths for lines with missing values in the lower right corner. 

Choose "Preview" to view your selections in the map (don't close the properties dialog box 
while you preview, or your changes will be lost).  When you have finished choosing a fill 
scheme, choose "OK" to apply your changes and close the dialog. If you press "Cancel" after 
"Preview" your changes will not be saved. 

Click on tabs and boxes in the image below for more information. 
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Color, Width, and Size of Objects 

  

Color, Width, and Size Modes Overview 

You can view polygon fill, polygon border color, line color, and point color in one of several 
color modes: single color/transparent, qualitative (categorical), continuous, or classified 
color. You can also use single, qualitative, and classified schemes to show variations in your 
data by modifying the polygon border width, line width, point sizes, and point symbol 
attributes. 

For fill and border color, you can customize the default color scheme in each color mode to 
fit your needs.  For non-color attributes (border or line widths, point sizes), the chosen mode 
determines how the variation in widths/size is distributed.  In the table below, we use color 
variation to illustrate the different modes. 

Color, Width, or Size Mode Example Legends 

Single 
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Qualitative 

for labels, categories, or statistical output 

 

Continuous 

 for numeric data, integer or decimal. 

Legend shows colors associate with break points, not 
ranges. Map colors are stretched between break colors. 
Shows the complexity of the data. Compare to 
classified. 

 

Classified 

 for numeric data, integer or decimal. 

Legend shows colors associated with ranges. Map 
colors are limited to the set shown. Simplifies map by 
grouping observations. Compare to continuous. 

 

SpaceStat uses continuous color as a default, and all of its default color specifications and 
designs were developed by Cynthia Brewer (http://colorbrewer.org/). ColorBrewer.org 
provides a comprehensive, interactive, and visual means to examine which map color 
schemes are best for which purposes. 

  

  

Single Color, Width, or Size 

The single mode can be used for any map. You can use single color for polygon fill, point or 
line color, or polygon border attributes; single width mode for lines and polygon borders; and 
single size mode for points. 

 

Changing the color 

You can change it by clicking on the "Fill Color" button and choosing another. You can 
make the areas transparent by checking the "None" box. 
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Qualitative Color, Widths, or Sizes 

Qualitative color represents unique values as separate colors. This is most useful when the 
values do not have an inherent arithmetic order (such as "high-high, low-low"). Similarly, 
you can group data for display in other map attributes, such as widths of lines or polygon 
borders, or sizes of points.  The same logic applies to classification of these attributes, but to 
simplify the text below, we use color as the subject.  This qualitative grouping scheme can 
only be used for text data. 

The legend in the left part of the map view shows the color for each category in the dataset. 
You can use a qualitative classification for coloring polygons, points, or lines; and can also 
use this scheme for setting polygon border attributes, polygon border width, line width, point 
size, and point symbols. 

Using the Map Properties Polygon Fill tab you can group or split categories and change the 
displayed colors and fill patterns. 

   

Grouping or splitting categories 

To group categories, select two or more categories and choose "group". You will be asked to 
name the grouped category. Then, all values in the group will have that group name and the 
group count next to each value will show the group count over all values. 
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To split grouped categories, select the category and choose "split." The selected category will 
be returned to the original state of one value per group. 

Changing the colors 

Within each color mode, you can choose different colors to create an informative map. 

You can change the color for each category by double-clicking on the color in the fill 
column, and then selecting a new color. You can also choose from several color palettes to 
change all of the colors for all of the categories at once. 

 

  

  

Classified Color, Width, or Size 

Instead of a full gradient of color from minimum to maximum, the classified color groups or 
bins the values into a series of classes. While this decreases the resolution of your data, it can 
allow for quicker visual identification of important categories. 

The classified color mode is for numeric data. Its legend shows the ramp of colors between 
the maximum and minimum colors you specify (represented here by colored squares next to 
the ranges for each class.  You can use classified color for polygon fill, point or line color, or 
polygon border attributes; classified width mode for lines and polygon borders; and classified 
size mode for points.  We illustrate the concept with colors, below. 

   
Changing the fill color and patterns 

Within each color mode, you can choose different colors and fill patterns in the Map 
Properties Polygon Fill Tab to create an informative map. 

Fill Color 
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Change the color gradient by selecting a pre-made color palette (shown below), by ramping 
between selected rows, or by setting the color for individual classes by double-clicking on 
the color square for each class and setting custom class attributes (color and fill). 

 

  

  

Fill and Line Patterns 

For classified and qualitative color schemes, you can choose a fill pattern or line pattern that 
applies to all classes (global) or to individual classes.  For data sets with missing values, you 
can also choose from a similar set of options for how fill and borders are represented. 

Global fill patterns 

To set global fill patterns, you can choose a new pattern from the drop down list on the fill 
attributes dialog. The default choice is no pattern, the color completely fills the polygon. 
With a global fill pattern, if you choose hatched, all classes would be hatched but the colors 
would different.  Global choices affect all classes in your data, but do not control how 
missing values are shown. 

 

Set individual attributes for classes or missing values 

To set individual fill patterns for classes, double-click on the color square for each class or 
category. Then set custom class attributes (fill color and pattern, or line color and style). If 
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you choose to apply a global pattern after choosing an individual attribute for data classes, 
you will lose the custom individual-level scheme.  For missing values, click the Set button, 
then select a fill color and pattern, or a line color and line style.  Note that if you want to 
select a line color, the transparent line style must be set to a visible style so a color can be 
selected. 

 

  

Continuous Color 

  

Continuous Color 

The continuous color mode is for numeric data. It can be used to ramp between two colors to 
emphasize the difference between high and low values. You can use a diverging color 
scheme to ramp between intermediate thresholds (three colors is good for a standardized 
dataset such as a z-score). How is it different from classified color? 

You can use single color for polygon fill, point or line color, or polygon border attributes. In 
continuous color you can choose an existing palette or create your own. 
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Choosing a palette 

You can choose different palettes to create an informative map. These palettes have different 
numbers of color breaks (two for the first palettes that consist of a gradient between two 
colors, three for the three-color palettes, and then multiple for the spectrum palettes). After 
you choose a palette, you will want to check the break values. Click on the "Set color breaks" 
button to view and change the break values. 

  

  

  

Color Breaks 

Color breaks are the end and mid-points of the gradients used in continuous color. The 
legend for a continuous color scheme shows the break values and associated colors. 
Locations with values in between the breaks receive a blend of the two break colors. 

Two breaks 

 

Three breaks 

 

More 
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You can customize your palette by choosing the number of breaks, break values, and break 
colors. First, choose "Set color breaks" from the properties dialog. 

 

The number of breaks 

The number of breaks determines the range of colors in your map. The pre-made palettes 
have a set number of breaks associated with them (the number of colors in the name). A 
gradient can be between two break values, by rule the maximum and minimum values in the 
dataset. You can show a diverging color scheme by using three break values. Or you can 
choose a more complicated scheme with additional internal breaks. 

You can change the number of breaks by adding or removing them via the right click menu 
or the buttons at the bottom of the dialog.  You may not remove the first and last color breaks 
because a continuous color scheme requires at least two break values.  If you change these 
values while choosing your breaks, you have the option to set these colors back to the 
minimum or maximum values by right clicking.  Once you have added new breaks, you can 
set their colors and values. 
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Break values 

Change the break value by typing a new value in the cell. Or you can use equal intervals, 
quantiles (unique values), or Jenks to determine break values (see classification methods). 
The maximum and minimum break values are the maximum and minimum values in the 
dataset over all times. 

Break colors 

You can change the break color by double-clicking the color and choosing another. 

  

  

Classification Methods 

These classification methods are used to create classified maps and to create custom 
continuous color schemes. 

In the case of the classified color, width, or size mode, these methods determine how to 
assign observations to classes. In the case of the continuous color mode, these methods 
determine how to assign observations to classes. 

SpaceStat offers several ways to classify your data. 

Classification Description 

Equal Interval This method divides the values into four classes, for example, by 
dividing the range of the data (max-min) by 4 and creating the 
classes to be 1/4 of the range, 1/4-1/2 of the range, 1/2-3/4 of the 
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range, and 3/4-4/4 of the range. 

Quantile 
(unique values) 

This method divides the values into a set number of classes (4 = 
quartiles, 5 = quintiles...). This creates uneven distances between 
class borders but an equal number of unique values within each 
class. Note, for space-time datasets, the final number of regions in 
each class may not be the same, because the quantiles are applied 
over the entire temporal range of the dataset. 

Jenks' Natural 
Breaks 

Optimizes the breaks between classes for a given number of 
classes. This method compares the within-class to the between-
class sum of squares error to optimize class membership. 

Custom When you change the maximum and minimum values for the 
classification by typing in new class breaks, the classification 
method reverts to Custom. 

  

Classification 

  

About Classification 

Classified color groups the data into a series of classes. An alternative to classified color is 
continuous color, which represents all unique values in the data as colors along the gradient 
from break points you set. The image below shows two maps of the same data. The map on 
the left shows a continuous color scheme. The map on the right shows a classified color 
scheme. 

 

While using classified color groups decreases the resolution of the display of your data, it can 
allow for quicker identification of important categories, as the eye cannot recognize more 
than a few distinct categories from the continuous spectrum. 
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You can create a classified view of the data by changing the map properties options 
(choose "Properties" from the "Map" menu or the properties toolbar button). Then, go to the 
"Polygon Fill Attributes" and choose the "Classified" color mode. 

  

  

Classification Methods 

These classification methods are used to create classified maps and to create custom 
continuous color schemes. 

In the case of the classified color, width, or size mode, these methods determine how to 
assign observations to classes. In the case of the continuous color mode, these methods 
determine how to assign observations to classes. 

SpaceStat offers several ways to classify your data. 

Classification Description 

Equal Interval This method divides the values into four classes, for example, by 
dividing the range of the data (max-min) by 4 and creating the 
classes to be 1/4 of the range, 1/4-1/2 of the range, 1/2-3/4 of the 
range, and 3/4-4/4 of the range. 

Quantile 
(unique values) 

This method divides the values into a set number of classes (4 = 
quartiles, 5 = quintiles...). This creates uneven distances between 
class borders but an equal number of unique values within each 
class. Note, for space-time datasets, the final number of regions in 
each class may not be the same, because the quantiles are applied 
over the entire temporal range of the dataset. 

Jenks' Natural 
Breaks 

Optimizes the breaks between classes for a given number of 
classes. This method compares the within-class to the between-
class sum of squares error to optimize class membership. 

Custom When you change the maximum and minimum values for the 
classification by typing in new class breaks, the classification 
method reverts to Custom. 

  

  

About Jenks' natural breaks 
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The Jenks' natural breaks classification scheme determines the best arrangement of values 
into classes by iteratively comparing sums of the squared difference between observed values 
within each class and class means.  The "best" classification identifies breaks in the ordered 
distribution of values that minimizes within-class sum of squared differences.  For datasets 
with many values, such as counties across the United State, the iterative nature of Jenks' 
natural breaks method can lead to long calculation times. 

 

which can be substituted to 

 

Notation 

A is the set of values that have been 
ordered from 1 to N. 

1 ≤ i < j < N 

Meani..j is the mean of the class 
bounded by i and j. 

  

  

Changing your Classes 

The default method for dividing the data into classes is into equal intervals, 4 classes. 

Use the drop-down menus in the Polygon Fill Color tab to change the classification method, 
the number of classes, the color scheme applied to the classification, and the maximum and 
minimum values for each class. 

Hints & tips 

• Resetting the number of classes causes SpaceStat to reset all of the class ranges, so do 
that first before customizing class ranges. 

• The class ranges from the minimum value up to but not including the maximum value 
for all classes except the last class, which does include the highest value in the 
dataset. 

• You can change class maximum and minimum values by typing in the table cells. 
When you retype a class minimum or maximum value, SpaceStat automatically 
adjusts adjacent values. 
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Classified Color, Width, or Size 

Instead of a full gradient of color from minimum to maximum, the classified color groups or 
bins the values into a series of classes. While this decreases the resolution of your data, it can 
allow for quicker visual identification of important categories. 

The classified color mode is for numeric data. Its legend shows the ramp of colors between 
the maximum and minimum colors you specify (represented here by colored squares next to 
the ranges for each class.  You can use classified color for polygon fill, point or line color, or 
polygon border attributes; classified width mode for lines and polygon borders; and classified 
size mode for points.  We illustrate the concept with colors, below. 

   
Changing the fill color and patterns 

Within each color mode, you can choose different colors and fill patterns in the Map 
Properties Polygon Fill Tab to create an informative map. 

Fill Color 

Change the color gradient by selecting a pre-made color palette (shown below), by ramping 
between selected rows, or by setting the color for individual classes by double-clicking on 
the color square for each class and setting custom class attributes (color and fill). 

 

  

  

Color Ramping 
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In classified color, you can ramp between classes you select to create your own custom color 
scheme. Select two or more rows in the classification and then right click to ramp between 
the colors. You can set the end- or mid-points for the ramping by double-clicking the fill 
color and choosing another color. 

Two color ramping 

To ramp between two colors, Control-select the classes and then right click on one of them. 
Choose to ramp between selected rows. SpaceStat will assign intermediate colors to 
intermediate classes. 

 

Multi-color ramping 

You can also ramp between three or more classes, setting up your own diverging 
classification. Control select the classes and then right click one and choose to ramp between 
selected rows. 

 

  

  

Options for Showing Missing Values in Map View 

The default way for SpaceStat to represent missing values in polygon data is to use a cross-
hatched fill pattern, with transparent borders of a width of "1".  Similarly, as a default, 
SpaceStat displays missing data in point files as an "X" of a given size, color, and pattern. 
 All of these parameters, as well as a similar set for line files, can be changed through the  
Map Properties dialogs, under the Map pulldown menu in the Map window.   
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Note: missing values do not show up if you choose to color your polygons or points using the 
single color option, because this coloring option works at the geography level, rather than the 
dataset level.  To simplify these maps and emphasize the missing values, we colored the 
polygons and points with data using a classified color scheme, and then changed all the fill 
colors for all classes to be the same. 

Linking Missing Value Attributes 

In some cases, you may want to use a map to show two or more different datasets 
simultaneously, and can implement this by, for example, using one dataset to determine the 
fill color scheme, and another to determine the polygon border width.  If you keep the "link 
missing-value attributes" box checked on the General page within Map Properties for 
polygons, points, or lines, an object that is missing a value for any dataset will be shown in 
the map with all of the suite of parameters (i.e., fill color and pattern, line color and pattern, 
line width, or the appropriate parameters for point or line data) you choose for representing 
missing values.   Keeping this box checked will lead to "Missing Values" showing up as a 
single attribute category (moving to the left, out from under the color, line, etc. headings) in 
the legend.  If instead you want to be able to show which of your datasets is missing values 
for a particular object, uncheck this box - then the options you have used for representing 
missing values will be shown as a subcategory under attribute type.  Then, if one dataset 
controls border width and the other controls fill color, you will be able to tell by looking at 
the characteristics of how objects are drawn to see which datasets have missing values.   

Hiding Missing Values 

If you want to prevent objects with missing values from being drawn, check the "hide objects 
with missing values" box on the General page within Map Properties for polygons, points, or 
lines. 

Polygon Fill or Point/Line Color for Missing Values 

In the bottom right corner of the polygon fill attributes tab, the point color tab, and the line 
attributes tab you can choose how SpaceStat should fill polygons, or color points or lines, 
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that have missing values by clicking the "set" button.  For polygons, this will open the dialog 
box shown below, where you can choose the fill color and pattern.  When you click "ok", the 
box on the polygon fill page that applies to missing values will be updated to reflect the 
choice you just made. Note that the global fill style (just above the missing value selection 
area) will not override the choice you made for missing value fill.  A similar point/line color 
dialog is found when you go into map properties from a point- or line-based map. 

 

Polygon Border Color and Style for Missing Values 

In the bottom right corner of the polygon border attributes page, you can choose how 
SpaceStat should draw the borders of polygons with missing values by clicking the "set" 
button.  This will open the dialog box shown below, where you can choose the line color and 
style.  When you click "ok", the box on the polygon border page that applies to missing 
values will be updated to reflect the choice you just made. Note that the global line style (just 
above the missing value selection area) will not override the choice you made for missing 
value borders. 

 

Polygon Border Width and Line Width for Missing Values 
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The width of polygon borders for objects with missing values, or the width of lines with 
missing values can also differ from the width for polygons or lines with data.  A box for 
filling in a line width for objects with missing values is in the lower right corner of the 
polygon border width or line width page of Map Properties. 

Point Size and Symbols for Missing Values 

The size of points with missing values can be changed on the lower right corner of the point 
size tab that is found in the Map Properties options for point geographies.  Similarly, you can 
change the symbol for missing values (an "X" is the default) on the Map Properties, point 
symbol attributes tab. 

  

Scatter Plot 

  

Scatter Plot 

Scatter plots allow you to visualize the variation in one variable relative to the variation in a 
second variable.  In SpaceStat, you can make two kinds of scatter plots: plots of any two 
datasets in the same geography (over multiple times), or plots comparing values in the same 
dataset from two different times.  When you make a scatter plot, your output will consist of 
the set of locations from your focal geography plotted on an x and y axis based on their 
values for the two datasets or two times for the same dataset.  A Local Moran analysis 
produces a related figure, a Moran scatter plot. 

Like most views in SpaceStat, scatter plots for two datasets can be animated; use the 
animation toolbar to scroll through the temporal range of your data.  You can also 
synchronize the animation in two dataset scatter plots with animation in other views, such as 
maps.  Both types of scatter plot views are by default linked to other visualization tools, so 
that areas selected in one plot, map, or table, are also selected in other visible views.  For 
example, you may wish to select locations where values of both datasets are particularly 
high, and see where those values occur on the map.   

Scatter plot for two datasets over a range of times, 
with graph statistics window shown (right side). 

Two times (or "timeless") scatter 
plot with graph statistic window 
hidden (this also hides the regression 
line). 
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Graph statistics for scatter plots 

In addition to the plot, the scatter plot view includes a Graph Statistics window that shows 
the mean and standard deviation of each data set at the time shown in the animation toolbar 
when you compare two datasets, or for the one focal dataset at the two plotted times.  This 
window also shows two coefficients that measure the correlation between variables, the 
simple correlation coefficient, and Spearman's rank correlation coefficient.  The correlation 
coefficient page describes these measures in more detail.   By default, the statistics shown in 
this window are for all of the points in the scatter plot, but you can select a subset of points 
with the cursor, and then choose to show statistics calculated for this subset -- under "Show 
statistics for:", click on the open circle next to "Selection."  You can hide   or undock  the 
Graph Statistics window using the buttons in the upper right corner of the window, and can 
bring back the window after hiding it by clicking on "Graph Statistics" in the Graph pull-
down menu.   

The regression line 

When you activate the Graph statistics window, you will also activate the regression line 
within the plot.  This simple linear regression line (also called the least squares regression 
line) represents the "best fit" line through your data, and is useful as a description of the 
relationship between two datasets, or for predicting values if you have a dataset that can be 
thought of as "dependent" on another dataset (an independent set, plotted on the x-axis).  If 
you choose to show statistics for a selection, rather than the whole dataset, a second 
regression line will appear in orange.  One way to use the selection option is to compare the 
original line to the one for the subset of data -- this will allow you to examine the influence 
of a few points on the relationship between to datasets.  An example of this, as well as details 
on calculating the regression line, are presented on the regression line page. 

The animation and graph toolbars 
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The far left pull-down menu in the scatter plot window allows you to hide or show the 
Animation (shown by default) and Graph (hidden by default) toolbars.  Note that if you wish 
to change the time step size for animations, this option is available from the Animation pull-
down menu, but not from the toolbar.   

From the Graph pull-down menu or toolbar, or from the right click menu, you have the 
following options: 

• You can alter the look of your scatter plot by changing its properties.  Options here 
range from changes to the title and way things are selected, to changes in the fill, size, 
and symbols used for points.  For two dataset plots, you can use options within scatter 
plot properties to show variation in a covariate data set.  For example,  the plot image 
below illustrates the correlation between the log of the proportion of hispanic females 
in western US counties and rates of cervical cancer, with the log of proportion of 
population living below the poverty line included as a covariate determining the size 
of the plotted points. 

 

• You can print your scatter plot. 

• You can export an animated "two dataset" scatter plot as an .avi file. 

• You can copy a scatterplot to the clipboard as an image file, and then paste it into 
other software program files. 

  

  

Create a Scatter Plot 
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In SpaceStat, you can make two kinds of scatter plots: plots of any two datasets in the same 
geography (over multiple times), or plots comparing values in the same dataset from two 
different times.   

1. Click on "View>,  Scatter Plot" or click on the Scatter Plot  icon on the 
visualization toolbar. 

2. Then, select the geography that you want to use. 

3. Choose whether you want to plot two different datasests, or two times for a single 
dataset, and click on the circle next to your choice to activate the next set of dialog 
boxes. 

4. For two dataset plots, select the dataset to show on each axis from the pull-down 
menus.  To plot two times for a single dataset, use the pull-down menu to select the 
dataset, and then either type in or use the up and down areas to select the times. 

5. Hit "OK". 

 

  

  

Correlation Coefficients 

SpaceStat presents measures of simple linear correlation as a tool for interpreting the output 
of some plots (e.g., scatter plots), and analyses (e.g., aspatial linear regression).  These 
measures describe the extent to which there is a linear association between two variables 
plotted on an X and Y axis, but unlike for regression-based tools, a functional dependence 
between the two variables is not assumed.  These coefficients appear at the bottom of the 
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Graph Statistics page associated with scatter plots (see circled area in image below), and in 
the log output for regression.  Note that in scatter plots, you can view correlation coefficients 
for all of the data in the plot, or for a subset by clicking on the "Selection" option under 
"Show statistics for"-- in the image below, the coefficients shown are for just the selected 
points (shown in orange).  Also note that if you compare correlation coefficients form the 
scatter plot to ones shown in regression output, they may differ slightly due to differences in 
how missing values are handled.   

 

SpaceStat computes two measures of correlation - "r", or the "simple correlation coefficient", 
also known as the Pearson product moment correlation coefficient, and "rho", Spearman's 
rank correlation coefficient.   The simple correlation coefficient is appropriate for two data 
sets that do not seriously deviate from the assumption of a normal distribution (i.e., sampled 
from a bivariate normal population), while the Spearman's coefficient is a non-parametric 
approach that can be applied to data that do not meet the assumption of normality. 

For both coefficients, values range from -1 to 1, with values further from 0 indicating 
stronger associations between the two variables.  If the correlation coefficient is positive, 
then an increase in one variable is associated with an increase in the other variable (left graph 
in the figure below), while negative correlation coefficients indicate that as one variable 
increases, the other decreases (center figure).  Correlation coefficients near 0 (positive or 
negative) suggest that there is little association, or correlation, between the two variables 
(right figure, below). 
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The correlation coefficient is calculated as: 

 

To obtain the Spearman's rank correlation coefficient, this same equation is applied to the 
ranks for each value in the two datasets, rather than the actual data.  If it would be 
appropriate to apply either measure (i.e., the data do not deviate seriously from the 
assumption of bivariate normality), then the rank correlation coefficient is roughly 90% as 
powerful as the simple correlation coefficient (Zar 1999). 

  

  

Regression Lines in Scatter Plots 

The simple linear regression line (also called the least squares regression line) represents the 
"best fit" line through your data.  This line is useful as a description of the linear relationship 
between two datasets, or for predicting values if you have a dataset that can be thought of as 
"dependent" on another dataset (an independent set, plotted on the x-axis).  Here we will 
focus on the regression line as a tool for exploratory data analysis; see the sections on 
aspatial regression and geographically weighted regression for help on using these tools for 
predicting unsampled values with a "global" statistical model (aspatial regression) and 
describing how the relationship between variables changes across space (geographically-
weighted regression).  Regression lines are only visible on your scatter plot if you have the 
Graph Statistics window open:  To see the line, click on "Graph Statistics" on the "Graph" 
pulldown menu, which will activate the check-box, opening the window (see right side of 
image below).  Click on it again to remove the check-box, and hide the regression line and 
the Graph Statistics window.   

If you choose to show statistics for a selection, rather than the whole dataset, a second simple 
linear regression line will appear in orange (see below).   In this example, the selection option 
allows you to see how leaving out the three points shown in black (e.g., not selected) 
influences the slope of the best fit line. 
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Interpreting the regression line 

In exploratory analyses, the regression line is primarily used as an indicator of the nature of 
the relationship between two variables.  The slope of the line reflects the degree to which the 
variable plotted on the y axis changes linearly as a function of changes in the variable plotted 
on the x axis, and the direction of the slope indicates whether this change in y is in the same 
(positive slope) or opposite (negative slope) direction.  If there is no linear relationship 
between changes in x and y, then the regression line will be flat (zero slope).    

Calculation of the regression line 

The regression line for data shown in a scatter plot is based on an assumption that you have 
chosen to plot a dependent variable on the y-axis, and are interested in describing how values 
of this variable change as a function of an independent variable shown on the x-axis.  The 
equation that describes this line is: 

  

The y-hat is the value predicted from the line, the regression coefficient b0 is the y-intercept, 
and b1 is the slope.  These coefficients are estimated from the observed values using the 
following equations: 

 

The regression line in scatter plots is meant as a tool for exploring your data (not as a tool for 
predicting y values), and SpaceStat does not report the equation for the line.  If you want to 
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perform a regression analysis, you can use one of the aspatial or geographically-weighted 
regression techniques to estimate the regression coefficients.   

  

  

Moran Scatter Plot 

The Moran scatter plot provides a tool for visual exploration of spatial autocorrelation 
(Anselin 1996, 2002). It is produced when you perform a univariate or bivariate local Moran 
analysis. Anselin (2002) describes this as "the spatial lag of the variable on the vertical axis 
and the original variable on the horizontal axis" --the spatial lag refers to the values of a 
location's neighbors. 

You can obtain two different kinds of Moran scatter plots: 

1. Univariate (the same variable is plotted for the objects and their neighbors). 

2. Bivariate (one variable is plotted for the objects while another is plotted for 
neighbors). 

The Moran scatter plot displays standardized variables, not the raw data. Standardization is 
denoted by a (Z), for z-score, after the variable name. The Moran scatter plot uses the same 
color scheme for representing statistical values for each point as is described for locations in 
Univariate Local Moran maps: see "Interpreting Local Moran statistics".  In this example, 
there are many points reprsenting high-high clusters (red, upper right quadrant) and low-low 
clusters (medium blue, lower left quadrant), and only a few low-high (light blue, upper left 
quadrant) and high-low (pink, lower right quadrant) clusters.   

Click on the image below for more information. 
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Plot features 

x-axis standardized value for each geographic object 

y-axis mean standardized neighbor value 

points points for various locations are colored based on the "high-high/low low" 
classification scheme (e.g., red is high-high, gray is not significant, dark blue 
is low- low). 

origin because the data are z-scores, the raw data has been standardized so that its 
mean value is zero. (0,0) is the value at the cross-hairs of the graph. 

units the values in the graph correspond to standard deviations 

slope the slope of the best-fit (regression) line through the points is proportional to 
the global Moran's I for the dataset. The Moran's I value and significance can 
also be found in the log output. 

Graph statistics for Moran scatter plots 

In addition to the plot, the Moran scatter plot view includes a Graph Statistics window that 
shows the mean and standard deviation of each data set at the time shown in the animation 
toolbar.  Recall that when data are Z-transformed, the goal is a mean of zero and a standard 
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deviation of 1, but actual values may be slightly different (as in the image above, where the 
mean is a very small number, but not zero).  This window also shows two coefficients that 
measure the correlation between variables, the simple correlation coefficient, and Spearman's 
rank correlation coefficient.   When the Graph Statistics window is open, the best fit 
(regression) line also appears in the scatter plot.  By default, the statistics shown in this 
window are for all of the points in the scatter plot, but you can select a subset of points with 
the cursor, and then choose to show statistics calculated for this subset -- under "Show 
statistics for:", click on the open circle next to "Selection."  You can hide   or undock  the 
Graph Statistics window using the buttons in the upper right corner of the window, and can 
bring back the window after hiding it by clicking on "Graph Statistics" in the Graph pull-
down menu.   

Animation and linkage 

Like most views in SpaceStat, Moran scatter plots can be animated; use the animation toolbar 
to scroll through the temporal range of your data.  You can also synchronize the animation 
with animation in other views, such as maps.  Moran scatter plot views are by default linked 
to other visualization tools, so that areas selected in one plot, map, or table, are also selected 
in other visible views.   

The animation and graph toolbars 

The far left pull-down menu in the Moran scatter plot window allows you to hide or show the 
Animation (shown by default) and Graph (hidden by default) toolbars.  Note that if you wish 
to change the time step size for animations, this option is available from the Animation pull-
down menu, but not from the toolbar.   

From the Graph pull-down menu or toolbar, or the right-click menu, you have the following 
options: 

• You can alter the look of your Moran scatter plot by changing its  properties. 
 Options here range from changes to the title and way things are selected, to changes 
in the fill, size, and symbols used for points.  You can use options within scatter plot 
properties to show variation in a covariate data set, as is shown here in the description 
of "regular" scatter plots.    

• You can print a Moran scatterplot by choosing   "Print" from the same menu, 

• You can  copy an image of your plot to the clipboard, so it is ready to paste into 
other applications, or 

• You can  export an animated Moran scatter plot as an .avi file. 

  

Scatter Plot Properties 
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Scatter Plot Properties - General Tab 

Once you have created a scatter plot, you can customize its look by choosing  "Properties" 
from the "Graph" menu. You can change the title of the scatter plot at the top of the dialog 
box.  There are fewer scatterplot options when you compare the same dataset at two different 
times, and these options are described here.  On the "General" tab of Scatter plot properties, 
you will see options related to the appearance of selected points, the text and font shown on 
each axis, and the bounds and other characteristics of the plot axes.  To see how changes will 
affect your plot without closing the dialog box, use the "Apply" button in the lower right.   

Click on tabs and boxes in the image below for more information. 

 

Selected point attributes 

You can change the fill color, outline color, and point size for displaying the points you have 
selected on the scatter plot. 

Labels 

You can alter the text on the scatter plot axis labels by changing the wording or the font. 

Bounds 

You can specify the range of values displayed on the scatter plot (minimum and maximum 
values shown on the horizontal and vertical bounds) and the number of labelled tick marks. 
 Note that the default bounds are based on the range of values found over all times for two 
dataset scatter plots.   
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Axes 

You can create a set of axes (or cross-hairs) within a plot at an origin of your choice. For 
example, the Moran Scatterplot is typically shown with an internal set of axes with x and y 
origins both set at 0.  If you choose to add these axes, you can also add labels that indicate 
their origins on the original x and y axes. 

  

  

Scatter Plot Properties - Point Fill 

In the Scatter plot properties point fill dialog, you can choose a single color and fill mode for 
all of the points in your scatter plot, or choose a dataset to use for determining fill 
characteristics by selecting the dataset from the data sets column on the lower left.  In the 
example dialog box below, we use the covariate "LOGPOOR", or log of the proportion of 
residents below the poverty level, to determine the color of points (see further description of 
this plot here, where LOGPOOR was used to alter the point size, rather than the point color). 
 If you want all of the points to be the same, keep the "Color mode" at the default of "Single 
color/Transparent" and then choose your color by clicking on the fill color box to bring up 
your color options.   

If you choose to have the colors of points vary, your next step after selecting a covariate 
dataset will be to choose among several options for the color mode and color scheme (color 
scheme options are in the Color palette pull-down list).  Datasets can be represented in one of 
several color modes: qualitative, classified, or continuous.  To create "custom" categories, 
choose the classified option, choose custom for the classification method, and then enter the 
number of classes.  You can then type in Min and Max values for each group.  Once you 
have divided the data, you can further modify how each category is colored and filled by 
clicking on the colored box for each group (in the fill column).  You can left click on any 
individual colored block to change the color or fill for one group, or can choose to change the 
global fill pattern for points by pulling down the fill window. 

A box in the lower right allows you to choose a different color and fill pattern for missing 
values in your covariate dataset (locations that have missing values for the two main datasets 
will not appear on the plot at all).  In the point color dialog box, you can also choose to have 
SpaceStat interpolate values during animations to smooth the transitions between different 
colors if a point's class changes over time. 

Click on tabs and boxes in the image below for more information. 
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Scatter Plot Properties - Point Size 

On the "Point size" tab of Scatter plot properties, you can change the size of the points in the 
plot. You can make all points on your map the same size (increasing or decreasing the size 
from the default), or can use point size as a way of providing additional information about 
your dataset, as in the example described here, and implemented in the image below.  If you 
want to show points of different sizes, you need to first select a dataset for determining the 
size distribution (left side of dialog box), and then an appropriate size classification mode. 
 Once the dataset has been divided into categories, you can left click in the boxes under 
"size" to edit the sizes assigned to each category of your grouped data.  To see how changes 
will affect your plot without closing the dialog box, use the "Apply" button in the lower right. 
  

If you choose point sizes that vary in time, you can check the interpolate values box (lower 
left corner) to smooth the transitions in an animation or map movie.  Also, you can choose a 
size for points where the covariate dataset contains a missing value in the lower right corner. 

Choose "Preview" to view your selections in the map view (don't close the properties dialog 
box while you preview, or your changes will be lost).  When you have finished choosing a 
point size scheme, choose "OK" to apply your changes and close the dialog. If you press 
"Cancel" after "Preview" your changes will not be saved. 
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Click on tabs and boxes in the image below for more information. 

 

  

  

Scatter Plot Properties - Symbol 

In the point symbol tab, you can set how you want the points in your scatter plot to look by 
specifying their shape. If you want to specify something other than a single symbol for all of 
the points in your plot, you need to choose a covariate dataset to use for grouping points. 
 After you've chosen a dataset, you can either see classified or qualitative symbols, 
depending on your data type. Note that you can use a different dataset for the point color, 
size, and symbol dialogs, allowing you to show characteristics of more than one covariate 
dataset, but showing more than one covariate is likely to lead to a very confusing scatter plot. 

A box in the lower right allows you to choose a different symbol for missing values in your 
covariate dataset (the default is an "X").   

Choose "Preview" to view your selections to the map (don't close the properties dialog), then 
choose "OK" to apply your changes and close the dialog. If you press "Cancel" after 
"Preview" your changes will not be saved. 

Click on tabs and boxes in the image below for more information. 
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For single symbol, you can change the symbol for all points from the menu (below). For 
classified or qualitative symbols, you can accept the default choices or customize the look of 
each class in your scheme by left clicking in the box for each symbol.  The same set of 
choices is also available for indicating missing values in your covariate dataset. 

 

  

  

Scatter Plot Properties - Plots for two times or "timeless" plots 

Once you have created a scatter plot, you can customize its look by choosing  "Properties" 
from the "Graph" menu. There are more scatterplot options when you compare two different 
dataset at a range of times (rather than the same dataset at two different times), and these 
options are described here.  To see how changes will affect your plot without closing the 
dialog box, use the "Apply" button in the lower right.   

Click within the boxes below for more information. 
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Title 

You can change the title of the scatter plot at the top of the dialog box. 

Point attributes 

You can choose the symbol for points using the pull-down menu (see image below), and can 
change the point size, including the size that points appear when you have selected them 
("Selected size" , on the far right).  You can also choose the color for the point fill, or choose 
to no fill (check the "None" box). 

 

Labels 
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You can alter the text on the scatter plot axis labels by changing the wording or the font. 

Bounds 

You can specify the range of values displayed on the scatter plot (minimum and maximum 
values shown on the horizontal and vertical bounds) and the number of labelled tick marks. 
 Note that the default bounds are based on the range of values found in the dataset at the two 
specified times. 

Axes 

You can create a set of axes (or cross-hairs) within a plot at an origin of your choice. For 
example, the Moran Scatterplot is typically shown with an internal set of axes with x and y 
origins both set at 0.  If you choose to add these axes, you can also add labels that indicate 
their origins on the original x and y axis. 

  

Histogram 

  

Histogram 

You can make a histogram to display the distribution of any of the data in your project.  To 
create a histogram, choose "  Histogram" from the "View" menu or the   icon 
visualization toolbar, and then select the geography and dataset. 

Like most views in SpaceStat, the histogram can be animated; use the animation toolbar to 
scroll through the temporal range of your data.  The histogram view is also linked to other 
visualization tools.  For example, you may wish to select locations that comprise the upper 
tail of the distribution of a dataset, and see where those values occur on the map.  Finally, 
you can also time synchronize this plot so that it animates in conjunction with another view. 
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Graph statistics 

The Graph statistics box on the right side of histogram window provides values for a series of 
descriptive statistics for your dataset.  If you want to obtain descriptive statistics for a subset 
of values in the dataset, select a subset of the bins in the histogram and choose the Selection 
option in the Show statistics section within the Graph Statistics window.  You can undock the 
Graph Statistics window by clicking on the   symbol in the upper right corner, and hide it by 
clicking on the   button. Undocking allows you to move the window around; if you choose to 
close the window, you can view it again by clicking on Graph Statistics in the Graph drop-
down menu. 

In addition to presenting the number of locations in your dataset, the minimum, maximum, 
mean value, and the standard deviation, the Graph Statistics box also provides the values of 
three coefficients that describe the shape of the distribution of your data.  These are briefly 
described below.  For more information, see an introductory statistics text such as Remington 
and Schork (1985).   

• Coefficient of variation: A measure of variability calculated by dividing the mean 
value by the standard deviation.   

• Coefficient of skewness: A measure of the symmetry of the distribution around the 
mean value.  Typically this measure is used to help determine if the observations in a 
dataset meet the assumptions of a normal distribution.  Note that the data in the image 
above are slightly negatively skewed, and thus the value of the coefficient is negative. 
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• Coefficient of kurtosis:  A measure of the "heaviness" of the tails, or the peakedness 
of a distribution with respect to the length and height of the tails.  Distributions that 
are relatively flat and have short tails will have low kurtosis values, while those that 
are tall and pointy with long tapering tails will have high kurtosis values.   

 

The animation and graph toolbars 

The far left pull-down menu in the histogram window allows you to hide or show the 
Animation (shown by default) and Graph (hidden by default) toolbars.  Note that if you wish 
to change the time step size for animations, this option is available from the Animation pull-
down menu, but not from the toolbar.   

From the Graph drop-down menu or toolbar, you have the following options: 

• Change the look of your histogram, or change the window title and the axis label by 
choosing "Properties". 

• Print your histogram (you can also use Ctrl+P). 

• Export an animated histogram. 

• Copy a histogram to the clipboard, and then paste it into other software program 
files. 

• Turn the Graph Statistics window off or on (click on this line, and the window will 
toggle on or off). 
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Histogram Properties 

Once you have created a histogram, you can customize its look by choosing "Properties" 
from the "Graph" menu. You can change labels and titles, the number of bins and their labels, 
and set the vertical and horizontal bounds.  For all options, you can use the "Apply" button at 
the bottom of the box to see how your changes will look without closing the properties dialog 
box. 

In the top section of the Histogram properties window, you can change the title on the 
window holding the histogram, and change the text and font of the dataset label. 

 

Bins 

The default number of bins in the histogram is the square root of the number of observations 
or 4, whichever is greater. You can change the number of bins in the graph and choose 
whether to label the bins. With a large number of bins, the labels may overlap if the 
histogram is small. You can drag open the histogram window to reveal the bin labels. 
 Another option for finding out the values included in a bin is to select a bin or several bins, 
and then select "Show statistics for" and "Selection" in the Graph statistics window (right 
side of the image shown here).  The minimum and maximum values in this window will now 
just reflect data included in the selected bins.   

 

Vertical bound 

SpaceStat will automatically select the vertical upper bound based on the peak frequency 
value found in your dataset (across all times).  If you want more control, for example you 
want to create two histograms for different datasets that use the same vertical axis, check 
"use fixed vertical scale" and you can then specify the maximum value shown on the vertical 
edge. You can also change the number of labelled tick marks.   

 

Horizontal bounds 
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By default, SpaceStat will automatically select the horizontal upper and lower bounds based 
on the minimum and maximum values found in your dataset (across all times).  As with the 
vertical bounds, you can change this setting if you wish.  First, click on the check box (see 
image below) to toggle it "off", and then enter new minimum and maximum values for the 
horizontal bounds (range of data to be plotted) of your histogram. 

 

  

2D Histogram 

  

2D Histogram 

You can make a 2D histogram to display the relationship between the distributions of any 
two datasets in a geography. To create the 2D histogram, choose " 2D Histogram" from the 
"Graphics" menu or click the  icon visualization toolbar. 

The following dialog will appear: 

 

Choose the geography you would like to work with and the two datasets to be displayed on 
the graphic. You can select the number of bins for each axis and decide how to distribute the 
objects in the bins with either equal intervals or quantiles. 
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The display mode option determines the type of 2D histogram to create. Each cell will 
contain the mean value when you hover your mouse over a cell. You can choose to 
incorporate a third dataset into the graphic by selecting "Mean value of objects in cell". Each 
cell will report the mean value of the third dataset for the objects in that cell. 

There is also an option to report the row and column means or the proportion of objects in 
each row and column. To do so, go to the Graphic menu on the 2D histogram and choose 
"Show means/proportions in log". If you are using a third dataset in the 2D historgram, the 
means will be reported, otherwise the log will report the proportion of objects in each row 
and column. 

Like most views in SpaceStat, the 2D histogram can be animated; use the animation toolbar 
to scroll through the temporal range of your data. The 2D histogram view is also linked to 
other visualization tools. For example, you may wish to select objects in certain cells that 
comprise the upper tail of the distribution of both datasets, and see where those values occur 
on the map. Finally, you can also time synchronize this plot so that it animates in conjunction 
with another view. 

  

  

2D Histogram Properties 

Once you have created a 2D histogram, you can customize its look by choosing "Properties" 
from the "Graph" menu (or by right clicking on the graphic). You can change labels and 
titles, the number of bins, choose a color palette and set the vertical and horizontal bounds. 
For all options, you can use the "Apply" button at the bottom of the box to see how your 
changes will look without closing the properties dialog box. 
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If you choose to have the 2D histogram report the mean value of a third dataset, you have the 
option of calculating the bin significance in relation to this third datasets. It is possible to 
conduct Monte-Carlo randomizations to determine significance of the association between 
the third dataset and the axis datasets. For example, the lower left bin holds objects 
associated with the smallest values in each axis dataset. The mean value of the display 
dataset for the objects in this bin might be unusually large compared to the means in the other 
bins, suggesting a negative correlation. Using randomization we randomly and repeatedly 
shuffle the ids of the objects in each bin and recalculate each bin's mean using the shuffled 
ids to determine the objects' values. If the observed mean is larger than the shuffled means 
95% of the time then we can say that the display dataset's mean in that bin is larger than 
expected with a p-value of 0.05. 

  

Time Plot 

  

Time Plot 
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The time plot shows whether and how the values in a dataset change over time. You can 
make a time plot of any numeric data in your project. Unlike other views in SpaceStat, you 
can't animate the time plot, as it shows the entire time range of the data on the x-axis. 

• To create one, choose "  Time plot" from the "View" menu or just choose the  icon 
from the visualization toolbar. 

• Then, select the geography and dataset to view. 

For time slice data, the time plot will look like the example below, with stair-step lines that 
begin and end synchronously. The data is constant during the observation interval and then 
jumps between intervals to a new spot. For time series data, there will still be stair steps, but 
they won't be synchronous for all locations.  By default, the name of the dataset will appear 
first in the time plot title, followed by the geography (here "rates for white males" or RWM, 
and "state economic units", or SEAs).  You can change the title and other features of the plot 
by selecting "  Properties" from the "Graph" pulldown menu. 

 

You can select individual locations, lines, or regions in the plot. In the example above, one 
location is selected and is shown as an orange line.  If you had other graphs open at the same 
time, this location would be highlighted in those views as well. 

From this figure, we can see that the cancer rate in the dataset RWM increased over time, and 
the range of values also increased, since there is more spread across the y axis in later years. 
You can view the details for particular regions more clearly by selecting them or by creating 
a subset geography with fewer objects (in this case, SEAs) than the current time plot. 

Graph menu options 
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Options on the Graph drop-down menu and toolbar include: 

• Edit the appearance of your time plot via the properties menu. 

• Print the time plot by choosing "Print", or by typing Ctrl+P. 

• Copy a time plot to the clipboard as an image file so that you can use it in other 
programs. 

Most of these options are also available from a menu that appears if you right click within the 
time plot.  Note the Graph toolbar is hidden by default. To show this toolbar, select it from 
the toolbar drop-down menu. 

  

  

Time Plot Properties 

Once you have created a time plot, you can customize its look by choosing "Properties" from 
the "Graph" menu. You can specify the some general features, change the labels, and modify 
the bounds. 

 

You can change the title on the window holding the time plot by typing a new one in the title 
box. You can alter the line width, and the width of selected lines, and choose whether to 
connect observations for the same location over time.  The effect of connecting observations 
is easiest to see if you select one location prior to clicking this option - then hit "apply" at the 
bottom of the box, and if you like the effect, keep the box checked when you click "ok" to 
close the properties box. 

Labels 

 

You can alter the text on the labels by changing the wording or the font. 

Bounds 
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The bottom half of the Time plot properties dialog allows you to set the range of data 
displayed in the plot. The horizontal bound is time, and you can set the minimum and 
maximum dates and times displayed.  In the example above, the data does not vary on the 
order of hours, minutes, or seconds, so a time box does not appear. 

You can also specify the format for dates and times, and set the minimum and maximum 
values (bounds) for the vertical axis.   The last two windows allow you to choose the number 
of tick marks and associated labels that will appear on your plot.  You can try out changes to 
any of these options by using the Apply button, which will update the plot with out closing 
the properties window.  When you are satisfied with your changes, click Ok.   

  

Parallel Coordinate Plot 

  

Parallel Coordinate Plot 

You can make a parallel coordinate (PC) plot of any numeric data in your project. A PC plot 
is a multivariate view of the data, with parallel axes for several datasets. A line, like the one 
highlighted in orange in the image below, connect observations on a single object.  The 
vertical value axes are standardized such that they represent the total range of values for that 
dataset over time.  As a result, the range for each variable can be different, and the position 
of a line on one axis relative to an axis for another variable can not typically be used to 
compare values.  To illustrate this, we show the PC plot together with a map view, below, in 
which we have queried the state of Nevada.  Note that the views are automatically linked, in 
that selecting Nevada on the map highlights the line for Nevada in the PC plot.   

In the PC plot, you can see that Nevada in 1990 represents a peak value (these are for lung 
cancer rates) for the dataset "RWF", rate for white females.  However, looking at the query 
results in the map window shows that this peak cancer rate for white females in Nevada is 
47.5, but values for both white (RWM) and black (RBM) males are much higher for this state 
and time, even though they appear lower on their respective "value" axes in the PC plot. 
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Like most views in SpaceStat, the PC plot can be animated; use the animation toolbar to play 
through your temporal data.  Note that if you want to change the time step of the animation, 
this option is available from the Animation pull-down menu.  You can also time synchronize 
this plot so that it animates in conjunction with another view.    

When any dataset is missing in a time period, then PC plot shows all datasets as missing. 
Otherwise, the plot would be misleading (with lines crossing an empty axis). To see the 
subset of variables with data at that time, make a new PC plot with only those non-missing 
datasets. 

Graph menu options 

Options on the "Graph" pull-down menu and toolbar (hidden by default; you can show it by 
selecting it from the toolbar pull-down menu) include: 

• Change the text or font of your window title for the PC plot by clicking on the 
properties option. 

• Print the PC plot by choosing "Print", or by typing Ctrl+P. 

• Export a PC plot animation as .avi file. 

• Copy a PC plot to the clipboard as an image file so that you can use it in other 
programs. 

Most of these options are also available from a menu that appears if you right click within the 
PC plot boundaries.   
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Create a Parallel Coordinate Plot 

• To create a PC plot, choose "  PC Plot" from the "View" menu or just choose the 
  icon from the visualization toolbar. 

• Choose the geography from the pull-down menu. 

• Use your mouse pointer to select a dataset from the list of those available. When you 
select a dataset, it will move over into the graphed datasets column and disappear 
from the "available" list. To remove a dataset from the graphed datasets list, again, 
select it with your mouse. The order of your choices determines the order in the list, 
which is also the order of the datasets along the x axis of the PC plot. 

• Hit "OK" to view the PC plot. 

 

  

  

Box Plot 

A box plot is an exploratory data analysis tool that you can use for examining the statistical 
distribution of any of your numerical datasets. 

To create a box plot, choose "  Box plot" from the "View" menu or just choose the  icon 
from the visualization toolbar. Then, select the geography and dataset to view. Your output 
will consist of a graphic representation of the data, as well as information in a "Graph 
statistics" window that provides values for the key features shown in the plot. 
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The box plot displays the relationship between key measures that describe your dataset, 
including the median, the quartiles, maximum and minimum values, and a range of values 
identified as "outliers".  The median is the black line that bisects the "box" that gives the box 
plot it's name. The first (lower) and third (upper) quartiles, which are the medians of the 
lower and upper halves of the data, form the lower and upper bounds of the box. The data for 
individual locations are shown as grey bars inside the box and grey points outside the box. 
The "whiskers" on the box, the horizontal bars at the top and bottom, are placed at 1.5 x the 
interquartile range (see the illustration on the image below). Points outside the whiskers are 
considered outliers. The vertical line on which the box and whiskers sit is the range of the 
dataset over all times included in your SpaceStat project. 

Like most tools in SpaceStat, the box plot view is linked to other visualization tools.  For 
example, you may wish to select "outliers" in the upper tail of the distribution of a dataset, 
and see where those values occur on the map.  Like most views in SpaceStat, the box plot can 
be animated; use the animation toolbar , or the same options from the animation pull-down 
menu, to play through your temporal data. You can also time synchronize this plot so that it 
animates (see below) in conjunction with another view.    

 

Graph statistics for box plots 

The "Graph Statistics" box on the right side of the box plot window provides numeric values 
for many of the measures that define the box plot.  Note that if you want to find out other 
information, such as the range of values included within the set of upper or lower outliers, 
you can click on values within the box plot to select just those points in an outlier region, and 
then choose the "Selection" option in the "Show statistics for" box within the Graph Statistics 
window.  When you do this, the new minimum and maximum values (and all other values) 
will only be calculated from the subset of selected locations. 
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Note that you can "undock" the Graph Statistics window by clicking on the  symbol in the 
upper right corner, and hide it by clicking on the   button. Undocking allows you to move 
the window around, and later you can dock the window again. If you choose to close the 
window, you can view it again by clicking on "Graph Statistics" in the Graph pull-down 
menu. 

The animation and graph toolbars 

The far left pull-down menu in the box plot window allows you to hide or show the 
Animation (shown by default) and Graph (hidden by default) toolbars.   Note that if you wish 
to change the time step size for animations, this option is available from the Animation pull-
down menu.   

From the Graph pull-down menu or toolbar, you have the following options: 

• Change the window title and the axis label by choosing "Properties". 

• Print your box plot (you can also use Ctrl+P) 

• Copy a box plot to the clipboard as an image file so that you can use it in other 
programs. 

• Export an animated box plot. 

• Turn the Graph Statistics window off or on (click on the entry in the menu, and the 
window will toggle on or off). 

Most of these options are also available from a menu that will appear if you right click within 
the box plot window.   

  

Variogram Cloud 

  

Variogram Cloud 

The variogram cloud (Haslett et al. 1991) is a plot of the average dissimilarity between any 
two observations as a function of their separation in geographical space. The variogram cloud 
can be used in exploratory spatial data analysis to identify data pairs that differ more than 
what is observed on average over the entire study area. If several "outlying” data pairs 
involve the same observation, this indicates that this observation is substantially different 
from the neighboring ones, and may be a spatial outlier. You can make a variogram cloud of 
any of the data in your project, as long as these data are in a point geography.  For polygonal 
data (i.e., counties) a centroid geography must be created first.   
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Like most views in SpaceStat, the variogram cloud can be animated; use the animation 
toolbar to scroll through the temporal range of your data. If you can't see the animation 
toolbar within the variogram cloud window, it can be restored by checking the "Animation" 
option under the Toolbar menu.  As with other graphs and tables, values on the graph can be 
highlighted, and highlighted locations will be linked with the same data as they appear in 
other open data exploration views.  You can also synchronize the animation in a variogram 
cloud with that in another view. 

Identifying outliers with a variogram cloud 

The most useful way to use the variogram cloud for identifying outliers is to link it with a 
map view (remember to select a map with the same geography; below we show the centroids 
for state economic units, or SEAs).  When you have both the variogram cloud output (see 
creating a variogram cloud) and the map on your desktop, go into "Graph" and then 
"Properties" in the Variogram cloud window.  Then select the "connect point pairs in linked 
maps" option near the bottom of the Variogram cloud properties window.  With this option 
selected, you can highlight areas that "stand out" in the cloud because they are relatively 
close together but have very different values (see box of selected points in the variogram 
cloud, below).  In this case, the selected points highlight a set of low values (white points) for 
this dataset (lung cancer rate in white females) in Utah that are particularly low when 
compared to some sites with much higher cancer rates (dark gray and black points) in nearby 
states. 
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Variogram cloud calculation 

The dissimilarity between the values of the variable z measured at locations ua and ub is 
computed as half the squared difference between these values, [z(ua)-(ub)]2/2.  One might 
expect this dissimilarity to increase as the separation distance, h, increases, since nearby 
locations often have similar values (e.g., show spatial autocorrelation). Using the notation 
presented above, the distance between any pair of points is expressed as h ab= |u a - u b|. 
 When variogram clouds are created for areal data such as counties, the distance between any 
two areas (polygons) is estimated as the Euclidean distance between the corresponding 
geographic centroids.  The variogram cloud can also be used to evaluate spatial dependencies 
in different directions, i.e., to explore anisotropy (Chiles and Delfiner 1999).   

See "Create a variogram cloud" for a list of steps for creating a variogram cloud, including 
information on allocating pairs of spatial data into different groups for examination of 
anisotropy. 

Large data set limitations 

For very large datasets, the calculations become exceedingly slow; for this reason, creation of 
variogram clouds is currently limited to geographies with fewer than 5000 points.   

  

  

Create a variogram cloud 

To create a variogram cloud, choose "  Variogram Cloud" from the "View" menu or 
choose the   icon from the Visualization Toolbar. The following window will be displayed 
(click on image for additional help): 
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Choose the geography from the pull-down menu.  Note that this method only works on point 
data, so you may need to create a centroid geography if you are working with polygon 
coverages. 

Select a dataset from the list of those available. 

For a plot that includes all potential pairs of locations, leave the "Anisotropic" box empty. 
 To do anisotropic plots, see below. 

Hit "OK".  Your output graph will appear in a new window, and as a default the data will 
appear in the form of a 2D histogram (left image).  The image on the right shows the same 
data, but "2D histogram" has not been selected in the middle row of the window heading. 

Viewing the Variogram cloud as a 2D histogram vs. as a "cloud" 

As the number of observations in your data set increases, the number of data pairs becomes 
very large and the multitude of points can hardly be distinguished on the plot. Instead of 
displaying all the data pairs, the variogram cloud can be discretized into a given number of 
cells and the density of points within each cell is then plotted (2D histogram, left figure). 
This option appears at the top of the variogram cloud output window, and can be toggled 
back and forth to facilitate comparison between points and histograms with various number 
of divisions.  If you can't see the 2D histogram option, pull down the toolbar menu from 
within the variogram cloud window, and check the box next to "Graph." 
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Anisotropic variogram clouds 

When you choose the "Anisotropic" option, the variogram cloud is calculated by classes of 
direction, such that only pairs of points that meet this criterion (i.e., are within a certain range 
of angles from one another) are included in the cloud.  Specifically, each class is defined by 
an azimuth angle (measured counter-clockwise from the EW direction) and an angular 
tolerance that defines the range of directions (angular window) that are pooled together to 
create the graph; see Figure 1 below.  For example, in 2D variogram clouds, four equally 
spaced directions are usually considered; e.g. directions of azimuth 0, 45, 90 and 135 with an 
angular tolerance of 22.5°. A maximum acceptable horizontal deviation from the direction 
vector can also be specified through the use of a bandwidth parameter, or this can be left at 
the default value of "no limit". 

 

Figure 1.  Graphical description of the parameters used to allocate pairs of observations to 
different groups in order to create an anisotropic variogram cloud. 
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Variogram cloud properties 

As with other data views in SpaceStat, you can change the properties of a  variogram cloud 
by accessing the variogram cloud properties dialog box (select "Graph" and then "Properties" 
from within the variogram cloud window).  Note that at the bottom of the dialog box, there is 
an "Apply" button that allows you to view potential changes to your variogram cloud output 
without closing the properties window.   

Title and point symbols 

At the top of this dialog box, you can change the title on the variogram cloud window, and 
can change the symbols and size of all points in the cloud (if you want to see your data as 
points but they are appearing as pixels, you need to unselect the "2D histogram" option).  In 
the far right box on this line, you can also change the size that points appear once you have 
selected them. 

 

Plot labels 

Just below the options for how symbols are points are shown, you can change the text and 
font of the variogram cloud's plot labels. 

 

Horizontal and vertical bounds 

SpaceStat uses the distance and squared difference values calculated from your dataset (from 
all times) to set the default bounds for the data displayed in the figure. Specifically, the 
variogram cloud includes squared difference values computed for distances up to half the 
diagonal length of the rectangle that bounds the sampled locations.  If you want to change the 
horizontal or vertical bounds shown in the plot, check the "Fixed bounds" box, and then enter 
your preferred Min and Max values.  The bottom of this section of the dialog box also allows 
you to change the number of labelled tick marks shown in the variogram cloud plot.     
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Anisotropic cloud options 

This variogram properties dialog also gives you another chance to create an anisotropic 
variogram cloud by entering in constraints on what pairs of points will be shown.  See 
variogram cloud calculation for information on how variogram clouds can be used for 
examining anisotropy, and next see the guidance on entering values for anisotropic 
variograms if you are interested in comparing directional variogram clouds.  In the line for 
entering the angle (first of the three boxes), "CCW" stands for counter-clockwise.  The 
options below would produce a variogram focused on points for which location values vary 
primarily in the east-west direction. 

 

Connecting point pairs, and histogram appearance 

Just below the box for entering parameters for creating anisotropic variogram clouds, there is 
a checkbox on the left side for "connect point pairs in linked maps."  This option allows you 
to select a point or points from the variogram cloud and see the pair(s) of locations that these 
points represent.  This is a way of visualizing outliers in your data, and is described in 
"identifying outliers with a variogram cloud."  At the very bottom of the dialog box, there is 
another opportunity (like the one always present in the plot window) to toggle between a 
point and 2D-histogram version of the variogram cloud, and another opportunity to change 
the number of divisions in the histogram.   

 

  

  

Table 
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To view a table, choose "Table" from the "View" menu or hit the table  icon in the 
visualization toolbar. All data tables are linked to their corresponding layers in the map and 
all other data views, so you can select items in the table and see them highlighted in other 
views. 

Right clicking on column headers allows you to hide/show a column, sort the data, or invert 
the selection.  If any cells are selected when you click on the column header, then you will 
also see options to copy the selected information to the clipboard (for use in programs like 
Microsoft Excel), or to create a new subset geography.   Most of these options are also 
available if you right-click from within a cell.  You can also move dataset columns.   

You can also animate your table using controls on the Animation toolbar. 

Selecting objects 

To select an object, click on the row number on the left side of the table.  You can hold down 
the "Shift" key to select multiple consecutive objects in the table (locations), and can select a 
first and last object, and then release the shift key to select all objects in between.   To select 
individual objects (rather than all within a range), hold down the "Control" button and then 
click on individual row numbers.   

Moving columns 

To move datasets in the table, control-click the column heading (click the heading while 
holding down the control key) and drag or move the column where you want it. 

Sorting 

Right click on the column headings to sort your data in ascending or descending alphabetical 
or numeric order, or to return your dataset to it's original order.  You can also sort by double-
left clicking on the column header, but this will only put your data into ascending order. 

Hiding data 

You can hide datasets (columns) by right clicking on the table, and then choosing 
"Show/Hide Colunms" from the right click menu.  To hide a column, clear the check next to 
it in the window that appears. You can bring it back by checking the name in that same 
dialog. 

Copy 

You can copy data in tables and paste into other applications, by choosing "Copy" from the 
"Edit" or right-click menus or just using Control-C as you would in other software 
applications. Copying will only work if you have one area in the table selected (it can be 
many rows and columns, however). 
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Tool animation and linkage 
  

Animate Views 

SpaceStat allows you to view a slideshow or to scroll through time in any data visualization 
(map, box plot, scatter plot, histogram, table...). All toolbars can be docked or free-floating. 
For all views except the map, the animation is a slideshow, with abrupt changes between data 
values. Maps can be shown that way, or SpaceStat can smooth or interpolate the values for a 
map movie. 

 

Animation Toolbar 

Use the play, pause, stop, and forward frame and loop buttons to animate the datasets in your 
view. 

Play begins the slideshow, from the time shown on the display. 

Pause stops the slideshow but holds the current time in the display. To restart at this time, 
press play. 

Stop returns the slideshow to its first frame. 

Forward frame allows you to flip through the slideshow at your own speed. 

Loop indicates you want the slideshow to play continuously, rather than stopping after all 
of the slides have been shown. 

Time slider 

You can click and drag on the time slider to move the slideshow forward or backward in 
time. You can use it independently of the animation toolbar, or to adjust an animation while 
it's progressing. The animation will continue in the same time step size after you let go of the 
slider. 

Display date/time 

You can use the up and down arrow keys to change the date/time of the animation. In this 
example, you can click on and change the month, date and year. 

Animation step size 
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To change the interval of the time between steps that are visualized, go to "Animation> Set 
step size." You can set whether you want to visualize your data in intervals of year, month or 
day, or by hours, minutes or seconds. 

Use exact time 

If you choose to "use exact time," the animation will jump forward by a set time increment 
(say 365 days instead of a year, or 30 days instead of a month). If you leave "use exact time" 
cleared, the animation will jump forward by the step size from the initial date in the dataset. 
Thus, if the step size is 1 year and the first time is January 1, it will jump forward to the next 
January 1. If "use exact time" is checked, it will jump forward 365 days, and so the date will 
wander a bit from January 1 as leap years occur. 

  

  

Synchronize Views 

All of the views of the same dataset are linked together such that objects selected on one 
view are selected on the others. But, you can scroll through time independently on each 
graph. If you want to synchronize the times in your views, choose "Synchronize views" from 
the "Window" menu and choose which views to sync together.   

 

All of the open windows in your project will be listed in the pane on the left side of the 
dialog. Select a view and then specify which of the other views you want to synchronize with 
it by clicking on the name of the view, which will add a "check" to it's box (note that clicking 
right on the box will not add or remove the check mark). You can unsync views by clicking 
again on the view name to clear the checkbox. Synchronization will be 2-way unless you 
choose otherwise. 

• 2-way synchronization is the simplest strategy. In 2-way syncing, there is no primary 
view, you can change the time in any of the synced windows to update them all. For 
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example, when you check the scatterplot on the right when the map is selected on the 
left, the map is automatically checked for the scatterplot.   

• 1-way synchronization creates relationships between a primary view (identified on 
the left of the dialog) and secondary views (checked on the right). Changing the time 
on the secondary views will not update the time on the primary view, though 
changing the primary view time will update the secondary views' time. 

Once the views are synchronized, hitting the play button   will show a slideshow in all 
synchronized views. 

  

  

Linking 

One innovative feature of this software is how it links the views in separate windows. This 
linking allows you to simulatneously explore your data using a variety of different 
visualization tools. Select a set of regions in a map, say, and their positions in other views of 
the data are also highlighted (such as the table, box plot, histogram, Moran scatter plot, and 
scatter plot). You can then drag a selection box through any of the views and watch the other 
views echo what has been selected. 

In the image below, Florida has been selected on the map, and the values for Florida regions 
are shown in the linked scatter plot (left), histograms (bottom right) and time plot (bottom 
left). If you select individual data points or regions in any of the views, they are selected in 
all linked views. 

All views generated from the same data are linked together automatically. The number of 
selected objects will be shown in the status bar of all views (the map status bar also shows 
the coordinates of the cursor). The animation settings, however, are not synchronized, unless 
you choose to time-link the windows. 
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Docking, undocking, and layering windows and toolbars 

The data view, the weights view, the log view, the task manager, query windows, the map 
legend, and other windows can be moved or docked within the windows that contain them. 
When docked, the windows for each of these items is "locked" to a position and appears the 
same color as 

Undocked windows and toolbars have a title bar, while docked items are part of a larger 
window and have a handle. Most items in the interface start out docked until you change 
them. 
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Undocking 

• To undock a view or toolbar, double click on its handle to send it to its most recent 
undocked position. 

• Alternatively, you can undock a view or a toolbar by clicking its handle and dragging 
it into a new position. 

Docking 

• You can redock a view or toolbar by double clicking the title bar. This will send it to 
its most recent docked position. 

• Or, you can dock an item by clicking on its title bar and then dragging it to a new 
location. When being dragged, an undocked window has a thick shadow outline, 
when you reach a location where it can be docked, the shadow edge of the window 
will turn thin. The docking depends on the position of the cursor, not the position of 
the shadow edge. When you release the mouse the item will be docked to that edge. 
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Statistics 
SpaceStat currently offers several ways to explore and analyze your data. You can explore 
the data in a more descriptive manner by taking the difference of two specified datasets, or 
the same dataset at two specified times, calculating custom datasets, or by standardizing data 
with a z-score transformation, or converting data into a different point or polygon geography. 
You can also smooth the data. 

Several of the tools for data visualization, such as the histogram, scatter plot, and box plot, 
also provide descriptive statistics about your dataset (e.g., means, medians, standard 
deviations, etc.).  In addition, the graph statistics window for histograms provides values for 
coefficients of variation, skewness, and kurtosis, while the scatter plots graph statistics 
window presents values for simple and rank-based of correlation coefficients.   

You can examine population-level disparities in health outcomes using disparity statistics, or 
you can evaluate the spatial pattern through global and local clustering statistics. 

• Global clustering statistics describe the study region as a whole. 

o Besag and Newell's statistic r 

o Moran's I. 

• Local clustering statistics detect clustering in parts of the study area, with these there 
is a statistic for every location in the geography. 

o Besag and Newell's statistic l 

o Turnbull's statistic 

o Local Moran 

o Local G Test 

o Geary's C 

Finally, you can use aspatial regression and geographically weighted regression tools to 
assess variation in one variable (the dependent variable, y) at set levels of another variable or 
variables (independent, or x variables).  Three forms of regression are included in SpaceStat: 
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 traditional linear models, Poisson models, and logistic models.   You can also perform 
exploratory aspatial model building with model selection tools.   

  

  

Components of Statistical Methods 
It is not possible to prove something conclusively, instead, we can only disprove hypotheses 
(Popper 1959.) Statistical tests begin with a null hypothesis of no effect (e.g., no clustering). 
Then, the pattern of the data is used to evaluate this null hypothesis.   

Essential features of these methods (adapted from Waller and Jacquez 1995): 

• The null spatial model 

• The null hypothesis (Ho) 

• The alternative hypothesis (Ha) 

• The test statistic 

• The reference distribution 

Probability values (p-values) for the observed test statistics can be obtained by comparing 
them to their null distributions. This comparison gives a quantitative estimate of how 
unlikely the observed value is compared to the expected null distribution. If the patterns in 
the data are different enough from the prediction of the null hypothesis, then the null 
hypothesis can be rejected. "Enough" is a difficult concept, by convention people often 
choose "enough" to mean "expected by chance less than 5% of the time", or an alpha level of 
0.05. 

  

  

p-values 
P-values, short for probability values, provide an estimate of how unusual the observed 
values are. The p-value of a test statistic can be obtained by comparing the test statistic to its 
expected distribution under the null hypothesis (the null distribution). 

The interpretation of a test statistic balances the possibility of two types of errors. Declaring 
whether a p-value is statistically significant involves choosing the level of error with which 
you are comfortable. Alpha provides the threshold for significance. If the p-value for the 
observed value falls below alpha, then the observation is termed significant.    
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concept symbol or formula meaning 

type I error α, alpha (also called 
significance level) 

the probability of rejecting the null 
hypothesis when it is true 

type II error β, beta the probability of accepting the null 
hypothesis when it is false 

statistical 
power 

1 - β the power of a test indicates its ability to 
reject the null hypothesis when it is false 

The value 0.05 is the traditional alpha level, which can be interpreted to mean that results that 
are more extreme would occur by chance less than 5% of the time, if the null hypothesis were 
true. The figure below graphs 1,000 random numbers selected from a Poisson distribution 
(lambda = 3). The red line illustrates the alpha level of 0.05 for a one-tailed test. The p-value 
is less than alpha when the test statistic is higher than the cutoff. In that case, it is customary 
to reject the null hypothesis and accept an alternative hypothesis; for example, that the spatial 
pattern of the data suggests observations are clustered rather than randomly distributed in 
space. 

 

Statistical tests can be one-tailed, focusing on either the upper-tail or lower-tail of the 
distribution. One-tailed tests only evaluate whether the test statistic is higher or lower than 
expected (not both). Two-tailed tests evaluate whether the statistic diverges from a central 
value, and the alpha level is applied to both tails of the distribution. 
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Simes Correction 
Local clustering statistics calculated for a given section of a study area are not independent of 
one another, and hence their p-values in some instances (depending on one’s philosophical 
inclinations) should be corrected for multiple testing. 

Lack of independence arises in the test statistics for neighboring areas. Such statistics are not 
independent because the z-scores for these areas enter into calculation of the Local Moran 
statistics for the neighboring areas.  Their p-values should be adjusted for this lack of 
independence. 

SpaceStat adjusts the p-value using the Simes adjustment (Simes 1986), which is not as 
conservative as the Bonferroni correction. The Simes adjustment is calculated as in the 
equation below. 

pi' = (n + 1 - a)pi 

Here n is the number of p-values being considered (the number of neighbors + the central 
location), and a is the index (starting at 1) indicating the location in the sorted vector of the 
p-values for a location and its neighbors. 

  

  

Correlation Coefficients 
SpaceStat presents measures of simple linear correlation as a tool for interpreting the output 
of some plots (e.g., scatter plots), and analyses (e.g., aspatial linear regression).  These 
measures describe the extent to which there is a linear association between two variables 
plotted on an X and Y axis, but unlike for regression-based tools, a functional dependence 
between the two variables is not assumed.  These coefficients appear at the bottom of the 
Graph Statistics page associated with scatter plots (see circled area in image below), and in 
the log output for regression.  Note that in scatter plots, you can view correlation coefficients 
for all of the data in the plot, or for a subset by clicking on the "Selection" option under 
"Show statistics for"-- in the image below, the coefficients shown are for just the selected 
points (shown in orange).  Also note that if you compare correlation coefficients form the 
scatter plot to ones shown in regression output, they may differ slightly due to differences in 
how missing values are handled.   
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SpaceStat computes two measures of correlation - "r", or the "simple correlation coefficient", 
also known as the Pearson product moment correlation coefficient, and "rho", Spearman's 
rank correlation coefficient.   The simple correlation coefficient is appropriate for two data 
sets that do not seriously deviate from the assumption of a normal distribution (i.e., sampled 
from a bivariate normal population), while the Spearman's coefficient is a non-parametric 
approach that can be applied to data that do not meet the assumption of normality. 

For both coefficients, values range from -1 to 1, with values further from 0 indicating 
stronger associations between the two variables.  If the correlation coefficient is positive, 
then an increase in one variable is associated with an increase in the other variable (left graph 
in the figure below), while negative correlation coefficients indicate that as one variable 
increases, the other decreases (center figure).  Correlation coefficients near 0 (positive or 
negative) suggest that there is little association, or correlation, between the two variables 
(right figure, below). 

 

  

The correlation coefficient is calculated as: 
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To obtain the Spearman's rank correlation coefficient, this same equation is applied to the 
ranks for each value in the two datasets, rather than the actual data.  If it would be 
appropriate to apply either measure (i.e., the data do not deviate seriously from the 
assumption of bivariate normality), then the rank correlation coefficient is roughly 90% as 
powerful as the simple correlation coefficient (Zar 1999). 

  

Monte Carlo Randomizations 
  

Monte Carlo Randomization 

Monte Carlo randomization is one way to quantitatively evaluate observed data and test 
statistics. 

In general, Monte Carlo Randomization (MCR) procedures follow this sequence: 

1. Following the calculation of a statistic from the original dataset, observations are 
randomized (how many times?). 

2. The statistic is recalculated for the randomized data. 

3. Steps 1-2 are repeated a given number of times, amassing distributions that will be 
used to calculate p-values for the observed statistic. 

4. P-values are calculated by comparing the observed statistic to the reference 
distribution. 

  

  

Calculating Monte Carlo P-values 

The p-value is the relative ranking of the test statistic among the sample values from the 
Monte Carlo randomization. You can calculate p-values to see whether observed values are 
unusually large or small for the null distribution. This calculation compares the observed 
value to the upper and the lower tails of the null distribution. 
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Nruns is the 
total 
number of 
Monte 
Carlo 
simulations 

NGE is the 
number of 
simulations 
for which 
the statistic 
was greater 
than or 
equal to the 
observed 
statistic 

NLE is the 
number of 
simulations 
for which 
the statistic 
was lower 
than or 
equal to the 
observed 
statistic 

One (1) is 
added to the 
numerator 
and 
denominator 
because the 
observed 
statistic is 
included in 
the 
reference 
distribution. 

How many randomizations? 
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As you can see in the equations above, the number of randomizations sets the minimum p-
value you can resolve. There is a trade-off between precision and calculation time. More 
randomizations are slower, but the p-value is more precise. 

For instance, if you do 20 randomizations, the minimum possible p-value is 0.05. If you use 
the Simes correction, you may want to increase the number of randomizations, as the initial 
Monte Carlo p-values may be raised to adjust for multiple comparisons. 

  

  

Conditional Randomization 

This approach is used to redistribute data values among spatial regions in the any method 
which uses randomization.  In each randomization, the value is held fixed for each spatial 
region, and the remaining values are randomly assigned new locations. Thus, the randomness 
is conditional—all regions get randomized frequencies but one. This process is repeated as 
each region is evaluated in turn. 

Note that this approach may result in slightly different p-values when compared with 
previous version of SpaceStat.  Earlier versions did not use conditional randomization.   

  

Data Transformation 

Standardization 

  

Standardizing datasets: Z-Score 

A z-score is the difference between the observed and expected (mean) value of a variable, 
standardized by the standard deviation. You can calculate two kinds of z-scores in SpaceStat: 
a z-score using the instantaneous or time-slice mean, and one using the time-weighted mean 
over the entire dataset time range. 

Z-scores are distributed approximately normally, with a mean of 0 and a variance of 1.0. An 
added wrinkle in SpaceStat is that the z-score is taken at a specified time or range and the 
new dataset has that time stamp. 

Many statistics do not use raw data but standardized versions of the datasets. When you ask 
for an analysis requiring a z-score, SpaceStat will calculate it for you automatically during 
the other calculations. You can also create z-scores of your datasets separate from any other 
statistical method. 
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The Z-score equations 

 

• xi,t is the value of the variable x observed at location i at time t 

• xt is the mean of variable x at timet over all locations 

• x is the mean of variable x over all times 

• sx,t is the standard deviation of variable x at timet 

  

  

How to Get a Z-Score 

A z-score is the difference between the observed and expected (mean) value of a variable, 
standardized by the standard deviation. You can calculate two kinds of z-scores in SpaceStat: 
a z-score using the instantaneous or time-slice mean, and one using the time-weighted mean 
over the entire dataset time range. 

1. Go to the "Methods" menu and select "Standardization" then "Z-score (time slices)" 
or "Z-score (time-weighted)". 

2. In the "Input parameters" page of the Task Manager, select the geography and dataset 
you want to use. 

3. Specify the time range and increment for time-slice Z-score calculation only. (For 
time-weighted, SpaceStat uses the entire range of the dataset). 

4. Give a name to the new dataset. 

5. Then, press "Run method." 

 SpaceStat will create your new dataset. It will appear under in the data view, nested under 
the parent dataset. You can then treat it as you would any other dataset. 

  

Normal Score  
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Implementation of Normal Score Transform 

In the presence of highly skewed data, the normal score transform can prepare data for 
methods where normality is an assumption.  For example, the following histogram is the rate 
of lung cancer for black males in 1970.   

 

After applying the normal score transform to this dataset, the histogram is no longer skewed. 

 

Details of implementation 

Let {z(ua), α=1, ... ,N} be the N observations or original data in the source geography, and 
{w(uα), α=1, ... ,N} be the corresponding set of weights.  If there are no weights associated 
with the data, the default weights used will be w(uα)=1/N so that they sum to one.   
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The transform proceeds in 3 steps: 

1. The N observations are ranked from the smallest to the largest. 

SpaceStat offers a method for breaking normal-score ties with local means.  If there are ties 
in the data and you chooses to employ this option, you will need to specify a spatial weight 
set to define a neighborhood around each observation.  SpaceStat will then look at the local 
means around each of the tied observations.  The ties will be ranked based on the values of 
the neighbors surrounding each object.   

If you do not choose to break these ties, the ranking of the tied values will be indeterminate.   

2. Compute the cumulative frequency (pk quantile) for the observation of rank k as: 

 

 3. The normal score transform of the z-datum with rank k is the pk-quantile of the standard 
normal distribution: 

 

where G(.) is the cumulative standard normal distribution. Numerical approximations exist 
for the inverse of that function. 

  

  

  

Perform Normal Score Transform 

The Normal Score transform has a single panel for parameters.    
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Dataset:  Choose the geography and dataset that you wish to transform. 

Weight dataset (optional): You may also select another dataset from the same geography to 
provide weight information.   

Break normal-score ties with local means 

SpaceStat offers a method for breaking normal-score ties with local means.  If you do not 
choose to break these ties, the ranking of the ties will be indeterminate.   

 

If there are ties in the data and you choose to employ this option, you will need to specify a 
spatial weight set to define a neighborhood around each observation.  SpaceStat will then 
look at the local means around each of the tied observations.  It will rank the tied values 
based on the values of the neighbors surrounding each object.   

Review settings 

The review settings tab presents a summary of the previous tab so you may review the 
choices that you have selected.  If everything looks correct, select the Run button at the 
bottom of the page.   
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Normal Score Back Transform 

Let {y(uj), j=1, ... , M} be the set of normal score values. The objective is to back-transform 
these normal scores to obtain a set of values for the Z-variable: {z(uj), j=1, ... ,M}. The target 
distribution for the back-transformed data is defined by a set of K observations z(ui) and 
possibly a set of associated weights w(ui). 

1. The K observations from the reference dataset are ranked in order from smallest to largest. 
  

2. The cumulative frequency for the observation of rank k is computed as: 

 

where w is the (optional) weight specified in the task manager.   

This defines a set of K pairs (z(uk), pk). 

3. For each of the M normal scores, y(uj), the cumulative probability for that normal score is: 

 

where G(.) is the cumulative standard normal distribution. 

4.  The corresponding pj quantile in the target distribution is computed. Three situations can 
occur: 

• The probability pj is within the range of probabilities computed in step 2. Linear 
interpolation is thus used to calculate the back-transformed normal score: 

 

• The probability pj is smaller than the smallest probability p1 computed in Step 2. If 
no lower tail extrapolation model has been specified, then the back-transformed 
normal score is equal to zmin. If a lower tail extrapolation model (power model) 
exists, it is thus used to calculate the back-transformed normal score: 
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• The probability pj exceeds the largest probability pk computed in Step 2. If no upper 
tail extrapolation model has been specified, then the back-transformed normal score is 
equal to zmax. If an upper tail extrapolation model exists, it is thus used to calculate 
the back-transformed normal score.  The equation is similar to the one above.   

  

  

Perform Normal Score Back Transform 

The Normal Score Back Transform has a single panel for parameters.    

 

Dataset:  Choose the source geography and dataset of normal score values that you want to 
back transform.   

Reference dataset:  Choose the geography and dataset for the reference dataset whose 
distribution needs to be reproduced.  This is generally the same dataset (and an optional 
weight set) that was originally transformed, but SpaceStat offers flexibility in that you may 
choose another distribution if desired.   

Max/Min transformed value:  You will also need to provide the minimum and maximum 
values (zmin and zmax) for the back-transformed normal scores. By default, this would be 
the minimum and maximum of the dataset specified at the previous step. 

If the maximum probability computed for the reference dataset is larger than the maximum 
value supplied, the default behavior for SpaceStat is to give that probability the maximum 
value specified.  Alternatively, you may employ the use of a power model to extrapolate the 
upper tail.  You must provide the ω parameter, such that  ω ≤ 1. 
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Similarly, if the minimum probability computed is smaller than the minimum observation 
supplied, a lower tail extrapolation model may be specified.   A power model (with ω 
parameter ≥ 1) is allowed.   

  

Interpolation 

  

Scale Conversion/Interpolation (formerly Spatial Interpolation) 

The Scale Conversion/Interpolation methods are used to assign values observed in one 
geography their analogous values in a second geography.  SpaceStat allows you to 
convert/interpolate: 

->  data from a source polygon dataset to a polygon dataset with a different geography, 

->  data from a source point dataset to a destination file with a polygon geography, 

->  data from a source polygon dataset to destination file with a point geography, and 

->  data from a source point dataset to a destination file with a different point geography. 

You can also incorporate a weight dataset when you convert data, which is described below 
under weighted interpolation.  Typically, if you want to aggregate population data or any 
other type of count data, such as number of cases, you will not use a weight set, and you will 
not select the "normalize weights" option (see below). 

Details on the methods for Scale Conversion/Interpolation 

All of the scale conversion methods involve a series of steps in which SpaceStat manipulates 
both the temporal and spatial aspects of the data.  The general process for the conversion 
methods will be outlined first, followed by additional details for each type of conversion 
below.   When the method is run, SpaceStat first merges the time intervals for the source and 
destination geographies, and then successively merges time intervals for source and user-
supplied weight sets, resulting in a set of time intervals that have constant geographies and 
data.    

Next, for each destination polygon or point, SpaceStat determines which of the points or 
polygons in the source dataset will be used to determine its value (based on overlap or 
proximity).  We refer to the relative importance of each source point or polygon that goes 
into determining the value of a destination as this source's "geographic weight".  This step 
also identifies missing values in source or destination geographies.  If you have an additional 
weighting factor (e.g., population size) that you would like to apply, this value will be 
multiplied by the geometric weights.  A last optional step is that the weights for each 
destination point or polygon can be normalized (sum of all weights will equal one).   

181 



Statistical Methods 

->  polygon to polygon: The contribution of each source polygon's value to the value of 
the destination polygon (i.e., it's geographic weight) depends on the percent overlap of the 
source polygon with the polygon in the destination geography.  Thus, the value for a polygon 
within the destination geography is a weighted average of source polygon data with weights 
derived from the relative coverage of each of the source polygons within a particular 
destination polygon.   

->  point to polygon:  To determine geographic weights, SpaceStat takes the average value 
for all points falling within the boundaries of a given polygon.  Thus, for each source point, 
the geographic weight is one divided by the number of source points per destination polygon. 
 If one or more source points in a destination polygon are located on the boundary between 
two or more polygons, the geographic weight calculation takes this into account as well, and 
equals 1 divided by the number of source points per destination polygon multiplied by the 
number of polygons each source point overlaps.   

->  polygon to point:  The value assigned to points in the destination geography is the 
value for the polygon in the source geography with which the point overlaps.  If the point 
overlaps more than one polygon (i.e., occurs on a boundary between two or more polygons), 
the geographic weight for each source polygon is the inverse of the number of polygons 
overlapping the point.   

->  point to point:  To interpolate from a point geography to a different point geography, 
you can choose between a distance- and a nearest neighbor-based method.  For the distance 
method, you select a radius around each point in the destination geography, and points from 
the source geography within that distance will be used to determine the destination point's 
value.  The weighting for each source point is set to 1/(the number of points within the 
specified distance, multiplied by the number of destination points the source point "belongs" 
to).   Alternatively, you can specify a number of nearest neighbors rather than a distance, and 
the geographic weight applied to each value from the source geography will be 1/(the number 
of nearest neighbors multiplied by the number of destination points for which the source is a 
nearest neighbor).  Inverse distance weighting is also available 

Note that any of these source/destination geography combinations can also use a kriging 
method to interpolate values.   

Weighted interpolation 

SpaceStat allows you to interpolate source data to a destination geography using a weighting 
scheme that is a function of BOTH the geographic weight (described above for each form of 
interpolation), and an additional weighting factor (e.g., population size) that is assigned to 
each of the source points or polygons.  The final weight used to compute the point or polygon 
value's contribution to the destination geography is the product of the geographic weight and 
the weight assigned by the user.   

For example, SpaceStat can create a new polygon dataset with a SEA (state economic area) 
geography from a source data set of county-level data on cancer rates for black females 
(RBF), using the size of the black female population at risk (PBF) in the counties as a 
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weighting factor, and the normalize weights option.  As a result of this weighting scheme, if 
(for example) two counties encompass equal areas within an SEA, but county "A" has a 
population at risk that is twice as high as county "B", the cancer rate for the county "A" will 
be "double counted" relative to the county with the smaller population at risk ("B").   

Normalizing weights 

When you use your own weight set in an interpolation procedure, you will have the option of 
normalizing the weights.  This means that each individual weight value (geographic 
multiplied by user-assigned weight) is divided by the sum of the weights assigned to all of 
the units being interpolated. Thus, the sum of all weights will equal one.  This option allows 
you to compute a population-weighted average when applied to rate data weighted by a 
population dataset, or by other types of count data. 

New file creation 

When you run the interpolation method, SpaceStat produces two new files that are 
added to the data view.  The first set is listed under the destination geography, and is 
given the default name of "poly to poly mean", "point to poly mean", etc., depending 
on which form of interpolation you performed.  You can verify that the file is the one 
you just created by right clicking on the name, and then selecting "properties" to view 
the history of the new dataset, and can use "rename" from the right-click options to 
give it a more descriptive name (highly recommended if you will be interpolating more 
than one dataset).   

The second file created by invoking the interpolation method is listed below the source 
dataset, and will be named "overlapped poly ids" or "overlapped point ids."  You can 
use choose "Table" from the "View" menu or click the table  icon in the main toolbar 
to see the id of the destination polygon/point for each polygon/point in the source 
dataset.   

If the normalize weights option is set to "Yes" and you are not performing poly to point 
interpolation then a standard deviation dataset is also produced. 

Hint: if you pull the information into a table but don't see any values in the id column, 
check the time slider on the table to make sure that the time shown is within the 
interval over which you interpolated data sets. 

Missing values in interpolation procedures 

If any of the values for points or polygons in the source dataset are missing, the points 
or polygons that would include information from those locations are coded as missing 
values in the output file.  Similarly, destination polygons or points for which no source 
data are available (e.g., a polygon that does not overlap any source points/polygons) are 
reported as missing values.  A "bad" destination polygon, for example one with self-
intersecting boundaries, will also be coded as a missing value in output files.  If you are 

183 



Statistical Methods 

using a weight set, a destination point or polygon will be output as a missing value if 
any of the weights of its source points or polygons are missing.      

  

  

Perform Scale Conversion/Interpolation 

Scale conversion/interpolation methods are located under Methods -> Scale 
conversion/Interpolation.  Here we provide examples of the Task Manager screens for 
various applications of the interpolation methods. 

Input for Scale Conversion 

When the task manager opens for the method, it will start on the "Input" section. 

Click on the image below for more information on the parameters. 

 

Note that if either of the source or destination geographies consists of polygons, then the 
"Use source/destination geography centroids" option will force that geography to be 
treated as a point geography with the polygon’s values assigned to the centroid of that 
polygon. 

Conversion Panel 

There are three types of interpolation available:  assignment, average/sum, or kriging. 
 These options may vary depending on the combination of source and destination 
geography. 

Kriging method 

The kriging method is available for all source/destination geography combinations.   
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Define the number of kriging neighbors you would like to contribute to the interpolated 
value and the search distance window.  The number of neighbors will be limited to 
those that are within the search distance if SpaceStat cannot find the number of 
neighbors specified.  You may also name the variogram model that will be produced by 
this method.  You will be able to view this variogram model by right clicking on its 
name in the Variogram model view.   

Assingment method 

The assignment method is used when the conversion is to be from a polygon geography 
to a point geography.   

 

With the assignment interpolation method, each point from the destination geography 
that is contained within a polygon from the source geography will be assigned the value 
of the source polygon.   

You may also choose to use to weight your observations with a weight dataset from the 
source geography.  You may also normalize the weights if desired.   

Average/sum method 

The Average/sum method can be applied to the other source/destination geography 
combinations (polygon -> polygon, point-> point, and point-> polygon).   
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If you choose to normalize the weights, the values for the destination geography will be 
averaged.  If the weights are not normalized, this method will provide a sum of the 
objects interpolated to the point or polygon in the destination geography (helpful for 
aggregating counts to larger scale geographies).   

Point to Point Conversion 

The screen shots above have all related to geographies that are polygon -> point 
(Assignment method) or polygon/point -> polygon.  If the conversion is to be from a 
point geography to a point geography, the conversion panel will hold different 
parameters. 

  

If you choose the average/sum method instead of kriging, you must then choose from 
two different point interpolation methods: nearest neighbor and distance.  Define the 
number of neighbors or the distance range to select which source points will determine 
the value of your destination points.   

You may also choose to use inverse distance weighting and will be able to manipulate 
the inverse distance exponent.   

The same options to use a weight dataset and to normalize the weights are also 
available.   

Review Settings 

As always, the Review settings page presents a summary of the previous tabs so that 
you can review the choices you have selected.  If everything here looks correct, select 
the "Run" button at the bottom of the page.    
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Temporal Interpolation 

The temporal interpolation method requires the user to specify (1) a dataset (2) the 
time-averaging method (3) the start and end time for the procedure (4) the span of the 
destination time intervals - i.e. starting at the specified start time, what length will each 
output time interval be? The time-averaging method refers to how the data are 
combined -presently the options are either ”time-weighted average” or ”time 
aggregate”. The second of these could also be regarded as ”time-binning”. The method 
came from a desire to simplify complex time-dependent data. Mostly we will assume 
that the destination time intervals are typically greater than the source time intervals. 

For the "time - weighted average" approach, the idea is to weigh each datum by the 
fraction of the destination interval that the particular source interval length covers e.g. 
if the value of an observation was 150 from 1980 - 1990 and 50 from 1990-2000 and the 
destination interval is 1980-2000 then the time-weighted average will be 150/2+50/2 i.e. 
100. This would be important for rate-like quantities where the denominator is time 
 e.g. purchases per week. 

For the "time aggregate" approach where the data might be ”counts” the above 
example would imply that for example the number of purchases was 150 from 150 from 
1980 - 1990 and 50 from 1990-2000 so that the 1980-2000 total would be 150+50 = 200. 
Also if the data referred to rates as in the usual sense of counts/population then the time 
aggregate approach would be better. 

Detailed description 

Consider the following intervals -we shall retain the color coding in the analysis to 
distinguish between them and we separate out the overlap (intersection) intervals which 
represent periods in which the source data is constant. 
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After setting up the destination time intervals we obtain the overlap of each destination 
interval with the original source intervals and push this back into a vector of a vector of 
intervals defined as  src_ints[dest_ind][j]. 

 

  

 

But for the time aggregated average 

 

Notice that the summation is outside the quotient . The denominator reflects the fact 
that we are apportioning the source data to the destination interval according to how 
much of the original source interval overlaps the destination interval. If the original 
source interval lies entirely inside the destination interval then we add the sorce data to 
the data for that destination interval. In the code we retain the denominator by creating 
a map of src_ints[dest_ind][j] to the original source intervals. In the above example the 
results become 
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Perform Temporal Interpolation 

 

Source dataset: Choose the geography and dataset you would like to interpolate.   

Time averaging method:  There are two ways to temporally interpolate your data.   

The Time-weighted average method weighs each datum by the fraction of the 
destination interval that the particular source interval length covers.  This method is 
particularly useful or rate-like quantities where the denominator is time, e.g. deaths per 
year. 

The Time aggregate method may be more appropriate where the data might be 
"counts". 

Start time/End time:   Enter the time for which you would like the interpolation to be 
performed. 

Time step: Click on the "Set" button to set the time increment, which should be the 
span of each time interval (starting at the "start time") that you want the output 
dataset to have. 
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New file creation 

When you run the interpolation method, SpaceStat produces four new datasets that are 
added to the data view. The "Time interpolation mean" dataset gives the mean as 
calculated above. The "Time interpolation median", "Time interpolation max" and 
"Time interpolation min" datasets give the median, maximum and minimum values for 
each observation during each destination time interval. 

  

Smoothing 

  

About Smoothing 

SpaceStat allows you to smooth your data. Smoothing reduces the variability in your 
data, essentially reducing the extreme values more towards the mean of the dataset. 
There are several smoothing algorithms in the literature. SpaceStat implements the 
empirical Bayesian smoother which smooths values from low-population areas towards 
the mean (Clayton and Kaldor 1987, cited in Waller and Gotway 2004). 

Why smooth? 

Particularly with health data, we may have different levels of confidence in values at 
different locations. For example, in cancer mortality data, we may have more 
confidence that the mortality rate in a large population is representative of that 
population or is related to the underlying risk. Whereas the mortality rate derived from 
few deaths in a small population is much more subject to noise. Small numbers can 
create unstable rates. 

  

  

Empirical Bayesian Smoothing 

Empirical Bayesian smoothing takes the population in the region as an indicator of 
confidence in the data, with higher population providing a higher confidence in the value at 
that location. 

The empirical Bayesian smoother is one tool for dealing with rate instability associated with 
small sample sizes, and is described in detail in Waller and Gotway (2004). In SpaceStat, the 
smoother takes a rate dataset and a population-at-risk dataset and uses them to create three 
new datasets: two smoothed rate datasets (one using the local and one using the global mean) 
and a dataset of the local means. The smoothed datasets are calculated by the following 
formula: 
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Where  is the new smoothed rate estimate, m is the global (r) or local (ri) population-
weighted mean, C is the shrinkage factor, and r is the rate dataset. 

Shrinkage factor 

The shrinkage factor sets the relative importance of the observed value versus the expected 
value, which is either the global or the local mean. Terms are as defined above, and s2 is the 
global or local sample variance. 

When the population size, ni, is small, the shrinkage factor is near zero, and the estimated 
value is very close to the global or local mean. When the population size is large, the 
shrinkage factor is near 1 and the Bayesian smoother returns a value near the observed value. 

 

Missing values 

The estimate will be missing for the local smoother if the local mean cannot be calculated, 
due to missing population or missing rate values. 

  

  

Mean and Variance 

Values based on small populations are corrected to be near the global or the local mean in the 
empirical Bayesian smoother. SpaceStat calculates the global and local sample means and 
variances as shown below. 

Global 

 

Local 
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The population-weighted mean, r , is the sum of the rate times the population for each 
location, divided by the total population-at-risk. The local mean (with the i subscript) uses a 
spatial weights term, wij. This spatial weights set is binary, with 1 for all neighbors 
(including ego, so a location is included in the local mean surrounding it) and 0 for all non-
neighbors. 

The shrinkage factor also uses the weighted sample variance. The sample variance is the 
population multiplied by the squared difference of the rate for a location from the mean rate, 
divided by the total population. Again, the local sample variance uses a spatial weights set to 
calculate a variance for only neighboring locations. 

  

  

How to Smooth Your Data 

Choose "Smoothing > Empirical Bayesian Smoother" from the Methods menu. For SpaceStat 
to smooth your data, it needs be given a disease rate and a population dataset. You also 
specify the time(s), the spatial weights set to use, and how to name the results datasets. 

Click within the sections in the images below for more information. 

Input 

The task manager for the Empirical Bayesian Smoother opens with the Input page.  Note that 
the smoother requires a spatial weights set that includes ego in the weights, and only weight 
sets that meet this criterion will appear in the Spatial Weights set pull down menu.  If you 
choose to define a spatial weight set from this window, the "Includes ego as a neighbor" will 
be checked by default.  The "units multiplier" box  for smoothing refers to whether the 
disease rate incorporates a population multiplier. For the NCI cancer mortality data, the rate 
is for 100,000 person-years, so the "units multiplier" is by default set at 100,000. 
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Review settings 

The run method page presents a summary of the previous three pages so that you can review 
the choices you have selected.  If everything here looks correct, select the "Run" button at the 
bottom of the page. 

  

  

Empirical Bayesian Smoothing Results 

The set of four maps below show the raw data and the three new datasets produced by 
smoothing: 

• rates smoothed to the global mean (top right) 

• a dataset consisting of the local means (lower left) 

• rates smoothed to the local mean (lower right) 
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You can read more about interpreting these maps in the small numbers tutorial. 

  

  

Poisson Smoother 

Like the empirical Bayesian smoother the Poisson smoothing method is a tool for dealing 
with rate instability associated with small sample sizes.  In SpaceStat, the smoother takes a 
rate and a population dataset and performs a kriging analysis using the Poisson population 
adjustment.  The result is two datasets: an estimate dataset (the smoothed rate) and an 
estimate variance dataset.  Note that you can perform the same analysis manually using the 
kriging method with a Poisson variogram model. 

Input Panel 

The Input Panel for the Poisson smoother is identical to the input panel for Empirical 
Bayesian. 
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Rate dataset: Specify the rate dataset to be smoothed. 

Population dataset:  Specify an associated population dataset defining the population counts 
for each object. 

Start time: The start time of the analysis 

End time: The end time of the analysis 

Spatial weight set: Specify a spatial weight set defining each object's neighbors to be used in 
generating a smoothed rate.  The poisson smoother requies spatial weight sets which include 
the ego. 

Units multiplier: The denominator of the population dataset.  If the population values are "per 
100000 individuals" then the units multiplier should be 100000. 

Advanced Panel 

This panel allows you to use areal deconvolution in your smoothing. 

 

Polygon geographies using areal deconvolution produce a more appropriate variogram model 
for kriging.  Instead of calculating covariance between neighboring polygons based on their 
centroid distance, multiple points in each polygon are generated and the average of the 
covariances of the point pairs is used. 

Output Panel 

This panel provides the option to customize the name of the variogam model which is 
produced by this method. 
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You can examine this model after the smoothing analysis completes to insure the model fits 
the data reasonably well.  It will appear in the Variogram model view after the method has 
run.   

  

Difference 
  

Difference method 

A difference dataset is simply the difference between values for each location in two 
specified datasets at two specified times.  The easiest way to create a difference dataset is 
using the "Difference" method (Method -> Difference), as described here.  You can also 
calculate differences using the   "Derive new dataset" option from the Tools pulldown menu 
(or from the right-click menus for geographies) following instructions shown here.  Note one 
key difference between the two ways to calculate difference -- for the difference method, you 
need to specify times, even for datasets (i.e., males and female cancer rates) where you have 
data for many times.  If you create a derived dataset from the tools menu, you can subtract 
datasets without specifying a time, and thus you can explore how the difference between 
datasets changes over time. 

Here are two ways that difference datasets are commonly used: 

• To examine how values for different variables vary at a given time. For example, you 
can use the method to examine differences in lung cancer rates between women and 
men. 

• To observe how one dataset changes through time. For example, you could analyze 
how lung cancer incidence rates differ across years, as in the example below.  Note in 
this example, rates in all polygons were higher in 1980 than in 1960, so the difference 
is always positive.  In many cases, you will have both negative and positive values in 
your difference map. 
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For step-by-step information on how to use the difference method to create a difference 
dataset and a difference map, click here. 

  

  

Using the Difference Method 

The difference method is located under Methods -> Difference, and this tool provides the 
easiest way to create a difference dataset.  You can also follow directions here to create 
difference datasets using the  "Derive new dataset" option from the Tools menu, or from the 
menu that pops up when you right-click on a geography. 

How to create a difference dataset starting with two different datasets: 

In the dialog box below we demonstrate how to create a difference dataset for the State 
Economic Areas (SEA) geography.  Here we intend to subtract the lung cancer rate for white 
females in 1990 from the rate for white males in the same year (both datasets must be in the 
same geography; note that if you want to create a difference dataset across all times, you 
need to use the "Derive new dataset" approach).  At the bottom of the dialog, we have 
modified the default output name slightly by adding the years of the data that we used in the 
calculation. 
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Next, click the Run method bar to review the analysis (on the next tab of the task manager), 
and then click "Run."  The run will produce a new dataset with the name "SEA: RWM90 - 
SEA: RWF90" that will appear under SEA in the Data View.  You can right click on the 
dataset, which will give you the options of adding it to a map, or renaming, etc. 

 

Once the new dataset appears in the data view, you can view it in the table (excerpted 
below), or with any of the other visualization tools.  Note that in a project with multiple 
times, you need to be careful about the timeslider in the table if you want to be able to see 
your results.  In the example shown above, we have data only for 1990.  Note that another 
difference dataset (from the calculation described below) shows only dashes for "no data" in 
1990 (results for this set would be visible with the time set at 1980, the year for the first 
dataset--see below).  In the male/female example, the dataset for males was entered as Input 
dataset 1, so that values for females were subtracted from males.  Doing the analysis with 
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datasets in the reverse order would give the same results, except for the sign of the difference 
would be reversed.   

 

How to create a difference dataset for two times in the same dataset: 

In the dialog box below we demonstrate how to create a difference dataset for the same 
geography (SEAs), where we have subtracted the lung cancer rate for white males in 1960 
from the rate in 1980.  At the bottom, we have modified the default output name slightly by 
adding the years of the data that we used in the calculation.  The final dialog box for 
subtracting the cancer rate for white males (RWM) in 1960 from the rate for white males in 
1980 would look like the image above, and once you click Ok, a new dataset with the name 
RWM1980-RWM1960" would appear under SEA in the Data View (see the image above). 

 

To map these results (shown here), right click on the dataset (the location of the difference 
dataset, under SEA in the Data View, is shown in the image above), and select "add to map". 
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Local Clustering 

Local G 

  

About the Local G Test 

The local G statistics are used to test for spatial clustering (Getis and Ord 1992; Ord and 
Getis 1995). SpaceStat includes the G and the G*. The G detects rings of high or low values 
while the G* detects clusters. SpaceStat implements the local G statistics as generalized to 
more flexible spatial weights as in Ord and Getis (1995). 

 

Examples 

Jeffery et al. (2002) used the local G* statistic to examine the spatial pattern of mosquito 
vectors of the Ross River virus and the Barmah Forest virus on Russell Island, Queensland, 
Australia. They found significant clustering on the southern end of Russell Island. 

Ratcliffe and McCullagh (2001) located hotspots in crime in Nottinghamshire using the local 
G* statistic. They then compared statistical clusters with the perceived high crime areas.   

Ceccato and Persson (2002) used the local G to study spatial clustering of employment in 
Sweden. They found clusters of employment in areas with private businesses, and clusters of 
low employment in areas where the government is the main employer. 

  

  

Local G Statistics 
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Ho There is no clustering of high or low values around location i, test statistic is close 
to zero. 

Ha There is clustering of high or low values around location i. A significant positive 
value implies a clustering of high values, and a significant negative value indicates 
a clustering of low values. 

Statistic 

There are two variants of the local G statistic. The Gi statistic excludes the value at i ("ego") 
from the summation and is used for spread or diffusion studies, while the Gi* includes the 
value at i in the summation and is most often used for studies of clustering. SpaceStat 
implements the local G statistics as generalized to more flexible spatial weights in Ord and 
Getis (1995). In these equations, the xj,t are the values of a variable (x) observed at location j 
and time t. These values are multiplied by the spatial weights set, wij, that denotes which 
locations to include in the analysis and how to weight them. The sum of these observed 
values is subtracted from the expected value, the sample mean (x bar), multiplied by the sum 
of the weights. Then, this difference is divided by the standard deviation, which includes 
some weighting factors. 

Gi Gi* 

 

 

notation notation 

 

sample mean excluding 
location i ("ego")   sample 

mean 
including 
ego 

 

sum of the weights not 
including the ego  

sum of 
the 
weights 
including 
ego's 
weight 
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sample standard 
deviation, excluding ego 

 

sample 
standard 
deviation, 
including 
ego 

 

number of objects in the 
geography at time t 

 

number of 
objects in 
the 
geography 
at time t 

 

the sum of the squared 
weights, not including 
ego  

the sum 
of the 
squared 
weights, 
including 
ego 

Significance 

The significance of each Gi and Gi* value is evaluated using a Monte Carlo randomizations 
of the dataset. 

  

  

Calculate Local G Statistics 

Choose Local G from the Methods menu. For SpaceStat to calculate the Local G statistic, it 
needs to know for which dataset at which time(s), the spatial weights set to use, and how to 
name the results datasets. 

Click on the images below for more information. 

Input 

When the task manager opens for calculating the Local G, it will start on the "Input" section. 
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Advanced 

The advanced section allows you to change the alpha level and to choose whether to use the 
Simes correction. 

 

Output 

The output section of the task manager for the Local G asks for a name stem to use for output 
files.  The default name for analyses on the dataset "RWM" in the geography called "SE and 
Gulf Coast" is shown below. 
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Run method 

The run method page presents a summary of the previous three pages so that you can review 
the choices you have selected.  If everything here looks correct, select the "Run" button at the 
bottom of the page.   The map output from this run is shown in the image on the "Local G 
Results" page. 

  

  

Calculate Local G* Statistics  

Choose "Local G*" from the Methods menu. For SpaceStat to calculate the Local G* 
statistic, it needs to know for which dataset at which time(s), the spatial weights set to use, 
and how to name the results datasets. The G* requires a spatial weights set that includes ego 
in the weights set. 

Click on the images below for more information. 

Input 

When the task manager opens for calculating the Local G*, it will start on the "Input" 
section.  Recall that to calculate G*, you must use a spatial weights set that includes the value 
at the focal location i, or "ego."  If none of your spatial weight sets meet this criterion, then 
there will not be any sets in the pulldown menu, but you can use the "Define" button to create 
a new weight set. 
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Advanced 

The advanced section allows you to change the alpha level and to choose whether to use the 
Simes correction. 

 

Output 

The output section of the task manager for the Local G* asks for a name stem to use for 
output files.  The default name for analyses on the dataset "RWM" in the geography called 
"SE and Gulf Coast" is shown below. 
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Run method 

The run method page presents a summary of the previous three pages so that you can review 
the choices you have selected.  If everything here looks correct, select the "Run" button at the 
bottom of the page.   The map output from this run is shown in the image on the "Local G* 
Results" page. 

 

  

Results 
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Local G Results 

After you perform a Local G analysis, you will see several new datasets in the data view and 
a new map. The results datasets will have the time stamp or range you specified for the 
analysis. They will have missing values at all other times in your project, unless you 
calculate several Local G* statistics sequentially and give them the same name stem. 

Results 

SpaceStat will record information about the calculation in the log, including everything you 
set in the "Invoke Local G " dialog. 

You will also see 3 results datasets all preceded by the name stem you chose. 

G i This is the Gi statistic, for each location. 

Gi p-
value 

This is the Monte Carlo p-value for each G i statistic, calculated with the 
number of Monte Carlo randomizations you specified. 

Gi 
rings 

This is a categorical dataset, providing a label for each of the locations 
whether the location is the center of a significant ring of high or low 
values. 

Missing values indicate locations for which a G i statistic could not be calculated, areas with 
missing values or areas without neighbors. 

SpaceStat will also produce a map of the results, a "Local G Ring Map". It shows the G i 
rings dataset, those locations that have significant G i statistics. 
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Local G* Results 

After you perform a Local G* analysis, you will see several new datasets in the data view 
and a new map. The results datasets will have the time stamp or range you specified for the 
analysis. They will have missing values at all other times in your project, unless you 
calculate several Local G* statistics sequentially and give them the same name stem. 

Results 

SpaceStat will record information about the calculation in the log, including everything you 
set in the "Invoke Local G*" dialog. 

You will also see 3 results datasets all preceded by the name stem you chose.   

Gi* This is the Gi* statistic, for each location. 

Gi* p-
value 

This is the Monte Carlo p-value for each Gi* statistic, calculated with the 
number of Monte Carlo randomizations you specified. 

Gi* 
clusters 

This is a categorical dataset, providing a label for each of the locations 
whether the location is the center of a significant cluster of high values or 
low values. 

Missing values indicate locations for which a Gi* statistic could not be calculated, areas with 
missing values or areas without neighbors. 

SpaceStat will also produce a map of the results, a "Local G* Cluster Map". It shows the Gi* 
clusters dataset, those locations that have significant G i statistics. 
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Interpreting Local G statistics 

Unlike the Local Moran, the Local G only assesses positive spatial autocorrelation. 
 Locations that are the center of significant rings are labelled as significant rings in the Gi 
clusters dataset.  Areas that are significantly clustered are labelled with these categories in 
the Gi * clusters dataset. 

Gi 
category 

interpretation 

high ring "I'm at the center of a ring where the local mean is higher than the 
regional mean" 

low ring "I'm at the center of a ring where the local mean is lower than the 
regional mean." 

  

Gi* category interpretation 

high cluster "The local mean is higher than the regional meal" 

low cluster "The local mean is lower than the regional mean." 

  

Local Moran 

  

About Anselin's Local Moran statistic 

The local Moran test (Anselin 1995), detects local spatial autocorrelation. It can be used to 
identify local clusters (regions where adjacent areas have similar values) or spatial outliers 
(areas distinct from their neighbors). 

The Local Moran statistic decomposes Moran's I (Moran 1950) into contributions for each 
location, Ii. The sum of Ii for all observations is proportional to Moran's I, an indicator of 
global pattern. Thus, there can be two interpretations of Local Moran statistics, as indicators 
of local spatial clusters and as a diagnostic for outliers in global spatial patterns. 
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SpaceStat implements two types of Local Moran statistics, univariate and bivariate. The 
univariate Local Moran tests for spatial autocorrelation in a single variable in one time 
period. The bivariate Local Moran can test for spatial pattern in two variables in one time 
period, or spatio-temporal autocorrelation in one variable over time. 

The screenshot below shows the original data (upper left), and SpaceStat' map and scatter 
plot output for a univariate local Moran test on lung cancer rates.  See Local Moran Results 
for information on how to interpret this information. 

 

  

  

  

Local Moran: Statistic 

Ho There is no association between the value observed at a location and values 
observed at nearby sites, values of Ii,t are close to zero. 

Ha Nearby sites have either similar or dissimilar values, Ii,t is large and either positive 
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or negative. 

Test statistic 

Spatial association can be evaluated by comparing matrices of similarity where one matrix 
expresses spatial similarity (for example, a contiguity or spatial weights matrix) and the other 
expresses similarity of disease frequency values. Spatio-temporal association can be 
evaluated by examining the pattern in time to the pattern in values. The Local Moran statistic 
is based on the gamma index, a general index of matrix association (Anselin 1995). 

 

zi,t is the z-
score 
standardized 
dataset 
being tested 
for region i 
at time t. 

zj,t is the z-
score 
standardized 
dataset for 
region j at 
time t. For 
the 
univariate 
Local 
Moran, zi,t 
and zj,t refer 
to the same 
dataset. For 
bivariate 
Moran, they 
are two 
separate 
datasets or a 
single 
dataset at 
two time 
points (for 
that replace 
t with t +∆ 
in the 
formula). 
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wij is a 
spatial 
weight set 
denoting the 
strength of 
connection 
between 
areas i and j. 

The Local Moran statistic Ii,t will be positive when values at neighboring locations are 
similar, and negative if they are dissimilar. SpaceStat evaluates the significance of Local 
Moran statistic values with Monte Carlo randomizations, using conditional randomization. 

The impact of missing values in Local Moran analyses 

The spatial weight sets created by adjacency evaluations are independent of any values of 
datasets associated with the geography, including missing values.  Thus, if you have a dataset 
with missing values, calculations of the Local Moran statistics will be based on only those 
neighboring locations with data.  Because the statistics are evaluated for significance with 
Monte Carlo randomizations (i.e, the differences in the distribution of observed statistic 
values can influences whether a particular value is judeged as "rare", removing one or more 
locations from a geography (thus creating missing values) can change results for all 
locations.  You might observe this if you decide that a value or two represent outliers in your 
data, and re-run an analysis using missing values instead of the recorded ones.  You will find 
that results for locations close to the one where missing values now occur change, but results 
for other locations may change as well due to the change in the overall distribution of Ii,t . 

  

  

Calculate Univariate Local Moran Statistics  

Choose Local Moran > Univariate Local Moran from the Methods menu. For SpaceStat to 
calculate the Local Moran statistic, it needs to know which dataset at which time(s) you 
would like to analyze, the spatial weights set to use, and how to name the results datasets. 

Click within the sections in the images below for more information. 

Input 

When the task manager opens for calculating the Univariate Local Moran, it will start on the 
"Input" section. 
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Advanced 

The advanced section allows you to change the alpha level and to choose whether to use the 
Simes correction. 

 

Output 

The output section of the task manager for the Univariate Local Moran asks for a name stem 
to use for output files.  The default name for analyses on the dataset "RWM" in the 
geography called "SEA" (State Economic Areas) is shown below. 
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Run method 

The run method page presents a summary of the previous three pages so that you can review 
the choices you have selected.  If everything here looks correct, select the "Run" button at the 
bottom of the page.   The output from this run is shown in images on the Moran Scatterplot 
and Interpreting Univariate Local Moran Statistics pages. 

  

  

Calculate Bivariate Local Moran Statistics  

Choose Local Moran > Bivariate Local Moran from the Methods menu. For the bivariate 
Local Moran, you will need to choose a geography and 2 datasets --one to consider at the 
"ego" (location i in the statistic) and a second to consider at neighboring locations, the times, 
the spatial weights set to use, and how to name the results datasets. 

Click within the sections in the images below for more information. 

Input 

When the task manager opens for calculating the Bivariate Local Moran, it will start on the 
"Input" section. 
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Advanced 

The advanced section allows you to change the alpha level and to choose whether to use the 
Simes correction. 

 

Output 

The output section of the task manager for the Bivariate Local Moran asks for a name stem to 
use for output files.  The default name for analyses on the two times shown in the image of 
the input screen for the dataset "RWM" in the geography called "SEA" (State Economic 
Areas) is shown below. 

215 



Statistical Methods 

 

Run method 

The run method page presents a summary of the previous three pages so that you can review 
the choices you have selected.  If everything here looks correct, select the "Run" button at the 
bottom of the page.   The map output from this run is shown in the Interpreting Bivariate 
Local Moran Statistics pages; the run will also produce a Moran scatterplot. 

 

  

Results 

  

Local Moran Results 
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After you perform a Local Moran analysis, you will see several new datasets in the data 
view, a new map, and a Moran Scatterplot. You can map these datasets or view them in any 
of the other graphic views. The standardized and results datasets will have the time stamp 
you specified for the analysis. In essence, the resulting datasets are a new time slice variable. 
Unlike other datasets in your project, Local Moran resulting datasets only exist at the 
moment you calculated them, or for a range if the data and geographic objects do not change 
in a time interval. They will have missing values at all other times in your project, unless you 
calculate several Local Moran statistics sequentially and give them the same name stem. 

Standardized Datasets 

For a univariate Local Moran, SpaceStat creates two new variables from the original data—it 
creates a new variable, the standardized values of that variable for each location (z-score), 
and then it calculates the mean standardized neighbor value of that variable for each location. 
These new datasets will appear in the data view. 

For a bivariate Local Moran, it creates three new variables, the standardized form of each 
variable, plus the weighted neighbor values for the second variable or time chosen. 

Results 

You will also see 4 results datasets: "High-High/Low-Low", "Ii", "P value" and, 
"Significance Index". All of these results datasets are calculated from the standardized 
datasets above, so they all are named similarly. 

High-High / 
Low-Low 

This is a categorical dataset, providing a label for each of the 
locations whether the location is the center of a significant high-
high or low-low cluster, or whether it is a significant outlier (high-
low or low-high). This interpretation comes from the location on the 
Moran Scatterplot. 

Ii This is the Local Moran statistic value, Ii, for each location. 

P value This is the Monte Carlo p-value for each location, calculated with 
the number of Monte Carlo randomizations you specified. This p-
value is adjusted with the Simes correction if you request. 

Significance 
Index 

This is a categorical dataset that reports whether a location is 
significant at certain alpha levels (5% and 1%). 

Missing values indicate locations for which a Local Moran statistic could not be calculated. 
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Moran Scatter Plot 

The Moran scatter plot provides a tool for visual exploration of spatial autocorrelation 
(Anselin 1996, 2002). It is produced when you perform a univariate or bivariate local Moran 
analysis. Anselin (2002) describes this as "the spatial lag of the variable on the vertical axis 
and the original variable on the horizontal axis" --the spatial lag refers to the values of a 
location's neighbors. 

You can obtain two different kinds of Moran scatter plots: 

1. Univariate (the same variable is plotted for the objects and their neighbors). 

2. Bivariate (one variable is plotted for the objects while another is plotted for 
neighbors). 

The Moran scatter plot displays standardized variables, not the raw data. Standardization is 
denoted by a (Z), for z-score, after the variable name. The Moran scatter plot uses the same 
color scheme for representing statistical values for each point as is described for locations in 
Univariate Local Moran maps: see "Interpreting Local Moran statistics".  In this example, 
there are many points reprsenting high-high clusters (red, upper right quadrant) and low-low 
clusters (medium blue, lower left quadrant), and only a few low-high (light blue, upper left 
quadrant) and high-low (pink, lower right quadrant) clusters.   

Click on the image below for more information. 

 

  

Plot features 
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x-axis standardized value for each geographic object 

y-axis mean standardized neighbor value 

points points for various locations are colored based on the "high-high/low low" 
classification scheme (e.g., red is high-high, gray is not significant, dark blue 
is low- low). 

origin because the data are z-scores, the raw data has been standardized so that its 
mean value is zero. (0,0) is the value at the cross-hairs of the graph. 

units the values in the graph correspond to standard deviations 

slope the slope of the best-fit (regression) line through the points is proportional to 
the global Moran's I for the dataset. The Moran's I value and significance can 
also be found in the log output. 

Graph statistics for Moran scatter plots 

In addition to the plot, the Moran scatter plot view includes a Graph Statistics window that 
shows the mean and standard deviation of each data set at the time shown in the animation 
toolbar.  Recall that when data are Z-transformed, the goal is a mean of zero and a standard 
deviation of 1, but actual values may be slightly different (as in the image above, where the 
mean is a very small number, but not zero).  This window also shows two coefficients that 
measure the correlation between variables, the simple correlation coefficient, and Spearman's 
rank correlation coefficient.   When the Graph Statistics window is open, the best fit 
(regression) line also appears in the scatter plot.  By default, the statistics shown in this 
window are for all of the points in the scatter plot, but you can select a subset of points with 
the cursor, and then choose to show statistics calculated for this subset -- under "Show 
statistics for:", click on the open circle next to "Selection."  You can hide   or undock  the 
Graph Statistics window using the buttons in the upper right corner of the window, and can 
bring back the window after hiding it by clicking on "Graph Statistics" in the Graph pull-
down menu.   

Animation and linkage 

Like most views in SpaceStat, Moran scatter plots can be animated; use the animation toolbar 
to scroll through the temporal range of your data.  You can also synchronize the animation 
with animation in other views, such as maps.  Moran scatter plot views are by default linked 
to other visualization tools, so that areas selected in one plot, map, or table, are also selected 
in other visible views.   

The animation and graph toolbars 
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The far left pull-down menu in the Moran scatter plot window allows you to hide or show the 
Animation (shown by default) and Graph (hidden by default) toolbars.  Note that if you wish 
to change the time step size for animations, this option is available from the Animation pull-
down menu, but not from the toolbar.   

From the Graph pull-down menu or toolbar, or the right-click menu, you have the following 
options: 

• You can alter the look of your Moran scatter plot by changing its  properties. 
 Options here range from changes to the title and way things are selected, to changes 
in the fill, size, and symbols used for points.  You can use options within scatter plot 
properties to show variation in a covariate data set, as is shown here in the description 
of "regular" scatter plots.    

• You can print a Moran scatterplot by choosing   "Print" from the same menu, 

• You can  copy an image of your plot to the clipboard, so it is ready to paste into 
other applications, or 

• You can  export an animated Moran scatter plot as an .avi file. 

  

  

Interpreting univariate Local Moran statistics 

The four quadrants in the Moran scatter plot provide a classification of four types of spatial 
autocorrelation. Areas that are significant are labelled with these categories in the "High-
High/Low-Low" dataset produced in the Moran analysis, and are colored in the Moran 
scatter plot and Local Moran maps as well (non-significant locations appear gray). The 
interpretation will be different for the univariate and bivariate Local Moran. 

category scatter plot 
quadrant 

autocorrelation interpretation 

high-
high 

upper right 
(red) 

positive Cluster - "I'm high and my 
neighbors are high." 

high-low lower right 
(pink) 

negative Outlier - "I'm a high outlier 
among low neighbors." 

low-low lower left 
(med. blue) 

positive Cluster - "I'm low and my 
neighbors are low." 
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low-high upper left 
(light blue) 

negative Outlier - "I'm a low outlier 
among high neighbors." 

The map contains information on only those locations that have a significant Local Moran 
statistic. While every region in the dataset will be represented in the Moran Scatterplot, only 
those with Local Moran statistic p-values below 0.05 are be colored red or blue on the 
example map below. Regions with non-significant Local Moran statistics are colored gray. 
Any island locations are considered missing values because they have no adjacent neighbors. 

 

  

  

Interpreting bivariate Local Moran statistics 

The four quadrants in the Moran scatter plot provide a classification of four types of spatial 
autocorrelation. Areas that are significant are labelled with these categories in the "High-
High/Low-Low" dataset produced in the Moran analysis, and are colored in the scatter plot to 
indicate their category (non significant locations are colored gray). The interpretation will be 
different for the univariate and bivariate Local Moran. 

  

category 

scatter 
plot 

quadrant 
and 

color 

  

autocorrelation 

  

interpretation 
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high-
high 

upper 
right red 

positive cluster - "I'm high in [ego 
variable at ego time] and my 
neighbors are high in [neighbor 
variable at neighbor time]." 

high-low lower 
right pink 

negative outlier - "I'm a high outlier in 
[ego variable at ego time] 
among low neighbors in 
[neighbor variable at neighbor 
time]." 

low-low lower left 
med. blue 

positive cluster - "I'm low in [ego 
variable at ego time] and my 
neighbors are low in [neighbor 
variable at neighbor time]." 

low-high upper left 
light blue 

negative outlier - "I'm a low outlier in 
[ego variable at ego time] 
among high neighbors in 
[neighbor variable at neighbor 
time]." 

As stated above, in the Local Moran maps, only those regions with p-values below 0.05 are 
colored following the high/low coloring scheme described above (see map legend as well). 
Places with non-significant Local Moran statistics are colored gray, and if there were islands 
in the dataset they would be shown as missing values because they have no adjacent 
neighbors. 
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Missing Values in a Local Moran Analysis 

Missing values in Local Moran results come from locations for which the statistic cannot be 
calculated for one of several reasons: 

• Locations without contiguous neighbors (island polygons), or 

• Locations with missing values in the dataset analyzed. 

If a neighbor of an object has no data, the statistic will be calculated omitting the "missing" 
neighbor from the spatial weights and the calculations. 

  

Geary's C 

  

About Geary's C 

Geary’s C (Geary, 1954), also known as Geary’s Contiguity Ratio or the Geary index, along 
with Moran's I (Moran, 1948),  are possibly the best known measures to test for spatial 
autocorrelation.  Both methods follow the same structure in the Task Manager and can be 
found under Clustering from the Methods menu.   

The local ci statistic decomposes the global Geary’s C into contributions for each location, i. 
With many observations and normalized spatial weights, the average local c will equal the 
global C.  The sum of ci , for all observations is proportional to Geary’s C, an indicator of 
global pattern. 

The screenshot below shows the standardization of the original data (top), and SpaceStat’s 
map output (bottom) of the results of a Geary’s C analysis on white male lung cancer rates. 
 See Geary's C Results for information on how to interpret this information.   

223 



Statistical Methods 

 

  

  

Geary's C statistic 

Ho There is no association between the value observed at a location and values 
observed at nearby sites:  values of ci are close to one. 

Ha Nearby sites have either similar (ci is close to 0) or dissimilar values (ci is 
greater than 1). 

  

Formally, Geary's c is: 
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where N is the number of observations, wij  is the spatial weight corresponding to the 
observation pair (i, j), Xi  and Xj are observations for locations i and j (with mean   ) and 
W is a scaling constant such that,   

 

 (ie, the sum of all weights). 

Under the null hypothesis of no spatial autocorrelation the expected value for Geary’s C is 1. 
 A value of Geary's C which is less than 1 indicates positive spatial autocorrelation, while a 
value larger than 1 points to negative spatial autocorrelation.  Note that c is always non-
negative. 

Test statistic at the local level 

We define the local c statistic as follows.   

 

zi,t is the z-score standardized dataset 
being tested for region i at time t 

zj,t is the z-score standardized dataset for 
region j at time t 

wij is a spatial weight set denoting the 
strength of connection between areas i 
and j 

  

Our definition differs from Anselin (1994) by a factor of 2.  This ensures the expected value 
of the local statistic under the null hypothesis is 1, as for the global statistic, and can be 
interpreted similarly.  Thus, a local ci,t statistic close to 1 indicates that there is no significant 
autocorrelation between observation i and its neighbors, where ci < 1  indicates that the 
observation has neighbors which are significantly similar to it (positive spatial 
autocorrelation).  Likewise, ci  > 1, demonstrates that the observation is among neighbors 
which differ significantly from it  (negative spatial autocorrelation).  SpaceStat evaluates the 
significance of Local Geary’s statistic values with Monte Carlo randomizations, using 
conditional randomization. 
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The impact of missing values in Geary’s C analyses 

Spatial weight sets are independent of the values in the geography's datasets, including 
missing values.  If you have a dataset with missing values, calculations of the Geary’s C 
statistics will be based only on those neighboring locations with data.  SpaceStat will not 
substitute another neighbor for the location with the missing value.  The statistics are 
evaluated for significance with Monte Carlo randomizations (i.e, the differences in the 
distribution of observed statistic values can influences whether a particular value is judged as 
"rare").   Removing one or more locations from a geography (thus creating missing values) 
can change results for all locations.  You might observe this if you decide that a value or two 
represent outliers in your data, and re-run an analysis using missing values instead of the 
recorded ones.  You will find that results for locations close to the one where missing values 
now occur change, but results for other locations may change as well due to the change in the 
overall distribution of ci. 

  

  

Calculate Geary's C statistic 

Choose Clustering > Geary’s C from the Methods menu. For SpaceStat to calculate the 
Geary’s C statistic, it will need to know which dataset at which time(s) you would like to 
analyze, the spatial weights set to use, and how to name the results datasets.  Click on the 
sections of the dialogs below to learn more about how to calculate this statistic. 

Input 

When the task manager opens for calculating the Geary’s C, it will start on the "Input" 
section 
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.   

  

Advanced 

The advanced section allows you to change the alpha level and to choose whether to use the 
Simes correction. 

 

Output 

The output section of the task manager for Geary’s C asks for a name stem to use for the 
output dataset folder.  If you calculate several statistics for different times, SpaceStat can put 
all of the results under the same dataset. 
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The default name for the Geary's C dataset folder will be Geary(geography name: dataset 
name). 

Run method 

The run method tab presents a summary of the previous tab so you may review the choices 
that you have selected.  If everything looks correct, select the Run button at the bottom of the 
page.   

  

  

Geary's C Results 

After you perform a Geary’s C analysis, you will see several new datasets in the data view, a 
new map, and a table in the Log View.  You can map the new datasets or view them in any of 
the other graphic views. The standardized and results datasets will have the same time range 
you specified for the analysis. Geary’s C datasets exist during the time range for which the 
data is unchanged and will recalculate the statistic if an object moves or a data value changes. 
 For any given subinterval, data objects are unchanging.  The results datasets will have 
missing values at all other times in your project. 

Datasets 

For Geary’s C, SpaceStat creates four new variables from the original data: the standardized 
values of that variable for each location (z-score), the ci value for each observation, the p-
value associated with that ci  statistic, and a categorical dataset named "Ci significance", 
which describes whether the observation is non-significant, or if it is demonstrating positive 
or negative spatial autocorrelation.  These variables will all appear in a folder with the name 
you specified in the Output tab of the Task Manager.  The folder will be placed under the 
original variable used in the analysis.   

 

Map 

After running Geary’s C, SpaceStat will create a map of the categorical dataset describing 
whether the p-values are significant or not.  Non-significant objects are colored grey.  If the 
p-values are indeed significant, SpaceStat colors the observations which demonstrate positive 
spatial autocorrelation as green while observations demonstrating negative spatial 
autocorrelation are purple.   
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Missing values indicate locations for which a Geary’s C analysis could not be calculated.   

Table in Log View 

The log will report all the information used to run the method, which is the same information 
presented in the Run method tab of the task manager.   

 

After this summary, the log will also report list the value of the global Geary’s C for each 
time slice with which you calculated the statistic.  It will also list the p-value associated with 
the statistic.  P-values which are significant at the alpha level you defined will be highlighted 
in red.     

  

Case-pop Clustering Methods 

Turnbull 
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About Turnbull's Statistic 

Turnbull's method detects local spatial clusters in case and population-at-risk data. This 
method can be applied to point or polygon geographies. Previously, this method was only 
available for point geographies. 

 

Populations within the study area are scanned for clusters of cases. A circular window is 
centered on each region in turn and expanded to include neighboring regions until the total 
aggregated population within the window equals a user-defined threshold. Then whether 
there are more cases in that population than would be expected by chance is evaluated using 
Monte Carlo randomizations. 

  

  

Turnbull's Statistic 

Ho The number of cases in the locations follow a Poisson distribution with a 
common rate, but they are not statistically independent, as the areas overlap 

Ha The number of cases in the locations exceeds that predicted by a Poisson 
distribution with a common rate 

Test statistic 

This is a local clustering method, which produces a test statistic for each location in the 
dataset. This test statistic is the observed case count in the window centered on a particular 
location (Turnbull et al. 1990). This case count is calculated for a user-specified population 
threshold. In essence, the statistic is searching for clusters of cases in a pre-determined 
population. 

• For point geographies, a circular window is centered on each point location in turn, 
and this window is expanded to include the center point's nearest neighbors until the 
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population threshold has been reached. The last location added to the window may 
contribute only a fraction of its population and case count to the window. The 
proportion of each neighbor included is listed as the weights in the cluster set. 

• For polygon geographies, a window is centered on each polygon in turn, and this 
window is expanded to include the proportion of the first order queen neighbors 
needed to reach the population threshold. If the first order queen neighbors are 
included and the population is not sufficient, the second order neighbors are included, 
etc. The proportion of each neighbor included is listed as the weights in the cluster 
set. 

Those locations which have a population-at-risk above the population threshold cannot be 
evaluated for clustering. These locations require a higher population threshold. 

The significance of each window's case count is found through Monte Carlo randomization. 
The data are randomized by drawing from a Poisson distribution with the expected value 
being the average rate for the dataset multiplied by the population in the cluster. 

  

  

Calculate Turnbull's Statistic  

Choose Turnbull from "Case-Pop Method" in the Methods menu. For SpaceStat to calculate 
the Turnbull statistic, it needs to know for which datasets at which time(s), the threshold 
cluster population count to use, and how to name the results datasets. 

Click within the sections in the images below for more information. 

Input 

When the task manager opens for calculating the Turnbull statistic, it will start on the "Input" 
section. 
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Advanced 

The only option in advanced section for the Turnbull statistic is to change the alpha level. 

 

Output 

The output section of the task manager asks for a name stem to use for output files.  The 
default name for Turnbull ("TB") results for the datasets indicated in the "Input" dialog 
(above) is shown in the box below. 
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Run method 

The run method page presents a summary of the previous three pages so that you can review 
the choices you have selected.  If everything here looks correct, select the "Run" button at the 
bottom of the page.   The map output from this run is shown in the image on the "Turnbull 
Results" page. 

  

  

Turnbull Results 

After you perform a Turnbull analysis, you will see three new datasets in the data view, a 
cluster set in the spatial weights and cluster sets view, and a new map. 

 

The new datasets are: the test statistic, p-values, and a significance dataset. The test statistic 
is the number of cases in the window centered on that location. The p-value is the Monte 
Carlo p-value, which comes from comparing the observed test statistic to the reference 
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distribution created by randomizing the cases across the study area. The significance dataset 
filters the results into several categories: missing (locations with no data), non-significant, 
significant (at the alpha level specified in the advanced parameters), and "pop > threshold". 
When the population in the location is greater than the population threshold, it cannot be 
evaluated for clustering. In essence, this is a signal you need to raise your population 
threshold and re-test the data. 

Map and cluster set 

The map shows the significance dataset. You can also use the view spatial weights option to 
see the cluster set created by your Turnbull analysis.  Right click on the map to reveal the 
"Show object neighbors" option, and then choose the appropriate geography (States in the 
example below).  The choice of weight sets will now include your Turnbull cluster set, which 
you can select by clicking on the name (see below). 

 

The cluster set for each location is the set of points or polygons that were required to meet 
the population threshold for the ego location. The weights for each of the locations in the set 
will be listed in the Log View as you click on them in the map. 

• For point geographies, the weights will be 1 except for the last location, which may 
have a fractional weight. 

• For polygon geographies, the weight of the ego location will be 1 if it is a significant 
cluster (locations that have populations greater than the threshold will have fractional 
weights, they need to be discounted to meet the threshold. The included neighbors 
will also be listed with their weight. 

You can turn off the cluster set by choosing "Show object neighbors" and then clearing the 
checkbox next to the cluster set's name. 

  

Besag and Newell 

  

About Besag and Newell's Statistics 
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Besag and Newell's method can detect local or global spatial clusters in case and population-
at-risk data. It can only be used on point geographies, such as centroids. When you initiate a 
Besag and Newell analysis, you get both local and global analysis output. 

This method scans the data for collections of cases that appear to be unusual clusters. To do 
so, it centers a circular window on each point location in turn. This window is then expanded 
to include neighboring regions until the total number of cases in the window reaches a user-
specified threshold, k. Then, the population size inside the window is compared to that 
expected under the expected (average) disease frequency.    

  

  

Besag and Newell's Statistics 

Ho The number of cases in an area follows a Poisson distribution with a common rate. 

Ha For some areas, the number of cases exceeds that predicted by a Poisson 
distribution with a common rate. 

Test statistics 

This method assesses clustering at the local and global scale using two test statistics:   l for 
the local scale and r for the global scale. Thus, use l to evaluate local scale clustering, and 
use r to examine global-scale clustering. This method is designed for case and population-at-
risk count data aggregated into regions with small population sizes. Regions could be census 
tracts, zip codes, or towns. 

The l statistic describes the extent of local clustering, the number of regions needed to 
aggregate at least k cases, with k defined by the user. If the cases are in a cluster, you can 
imagine there would be fewer regions to aggregate to find a set number of cases than if they 
were not clustered. The r statistic is simply the total number of clusters found in the local-
scale analysis. 
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Notes 

Waller and Turnbull (1993) show that the significance of  l depends on the level of 
aggregation and the chosen value of k. 

  

  

Besag and Newell's l 

Besag and Newell's method calculates two statistics: l is the local statistic, the number of 
regions required for the window centered over an individual region to contain k cases. To 
evaluate whether the k cases form a cluster, the method looks to see whether the number of 
cases in the window is unlikely for the window's population at risk. 

The null hypothesis is that there is no clustering, so that a common Poisson disease rate 
exists across the study area. Thus, the case count inside the window should be proportional to 
the population at risk, otherwise the null hypothesis can be rejected. Following Besag and 
Newell (1991), the null spatial model is that cases are distributed among the areas in the 
study proportional to population size and with a common disease rate. SpaceStat calculates a 
probability for l under the null spatial model. 

  

This expression calculates the probability that l has reached or exceeded the value predicted 
by the null hypothesis (L). It is 1 minus the probability that l is less than L, i.e., the 
probability that there are fewer than k cases in the area. The probability of 0 through k-1 
cases is found by summing the Poisson term from x = 0 to x = k-1. Lambda, (  ), is the 
average or expected case count, the average or expected disease frequency multiplied by the 
population-at-risk. The term e indicates the exponential function. 

When you perform a Besag and Newell analysis, SpaceStat will calculate l and its 
significance for all clusters. It will list all clusters that have a probability less than the 
significance level you specify, alpha. The default alpha is 0.05. 

  

  

Besag and Newell's r 

The Besag and Newell's method calculates two statistics:  l, and r.  The global statistic, r, is 
the total number of clusters found in the local-scale analysis. 
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To get the observed r, SpaceStat counts the significant local clusters. 

Assessing the p-value 

SpaceStat evaluates r by comparing it to Monte Carlo randomizations of the geography. 
SpaceStat generates a reference distribution to evaluate r by repeatedly randomizing the data 
and recalculating r for each randomization. The data are randomized by drawing from a 
Poisson distribution with the expected value being the average rate for the dataset multiplied 
by the population in the cluster. 

  

  

Calculate Besag and Newell's Statistics  

Choose Besag and Newell from "Case-Pop Method" in the Methods menu. For SpaceStat to 
calculate the Besag and Newell statistics, it needs to know for which datasets at which 
time(s), the threshold cluster case count to use,  and how to name the results datasets. You 
need to have a point geography to use Besag and Newell. If you do not, generate a centroid 
geography from your polygons first. 

Click within the sections in the images below for more information. 

Input 

When the task manager opens for calculating the Besag and Newell statistic, it will start on 
the "Input" section. 

 

Advanced 
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The only option in advanced section for the Besag and Newell statistics is to change the 
alpha level. 

 

Output 

The output section of the task manager asks for a name stem to use for output files.  The 
default name for Besag and Newell results for the datasets indicated in the "Input" dialog 
(above) is shown in the box below. 

 

Run method 

The run method page presents a summary of the previous three pages so that you can review 
the choices you have selected.  If everything here looks correct, select the "Run" button at the 
bottom of the page.   Output from this method is shown in the image on the "Besag and 
Newell Results" page. 

  

  

Besag and Newell's Analysis Results 
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After you perform a Besag and Newell analysis, you will see two new datasets in the data 
view, a cluster set in the spatial weights and cluster sets view, a new map, and r results in the 
Log View. 

 

The new datasets are: the local test statistics and their p-values. The test statistic, l, is the 
number of regions in the window for the ego location. The p-value is the Monte Carlo p-
value, which comes from comparing the observed test statistic to the reference distribution 
created by randomizing the cases across the study area and recalculating l. 

Map and cluster set 

The map shows the p-value dataset, classified into significance levels. A location that has a 
significant l statistic is colored red, while nonsignificant locations are grey. The significant 
cluster may include several neighbors, not just the point colored red. When you click on the 
map, you will see the cluster set for each point (significant or non-significant) created by 
your Besag and Newell analysis. The cluster set for each location is the set of points that 
were required to meet the case threshold for the ego location. The weights for each of the 
locations in the set will be listed in the Log View. 

You can turn off the cluster set by choosing "Show object neighbors" and then clearing the 
checkbox next to the cluster set's name. 

Global results 

Information about the global statistic, r , is written into the Log View. The Log View will 
contain the number of significant local clusters and its p-value. Significant p-values indicate 
that there is significant global clustering, more significant local clusters in the geography 
than you would expect by chance. 

  

Case-control Methods 

Jacquez' Q 
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About Jacquez' Q 

Q-statistics were developed for evaluating space-time clustering in residential histories of 
case-control data (Jacquez et al., 2005, 2006).  The statistics use nearest neighbor 
relationships to evaluate local and global clustering at any moment in the life-course of the 
residential histories of cases (or focus locations) relative to the residential histories of 
controls.   

Representing residential histories as space-time threads (those locations where people lived 
throughout the study period) instead of spatial point distributions (a disconnected set of 
points in space time) is one of the unique features of Jacquez' Q.  Notice also that duration of 
place of residence is part of the data representation in the figure below - how long a person 
resides at a given location clearly may impact their exposure (Nuckols, Airola et al. 2009). 

 

Residential histories are viewed as space-time step functions.  The axes x and y define a 
geographic domain (e.g. longitude and latitude decimal degrees), the t axis represents time 
(e.g. date).    The study extends from time t0 to time tT. The residential histories for persons i 
and j are shown as step functions through space-time.  For example, person i  begins the 
study residing at location xi, yi, t0.  They remain at that geographic coordinate until the 
instant before time t1, when they move to xi, yi, t1.  The duration of time they reside at this 
first place of residence is ω0. 

  

  

Implementation of Q 

The Q statistics are built up from an easily understood quantity calculated for each individual 
case or focus location, at each time interval in the residential history.  Since each case or 
location of interest is surrounded by neighbors (either a fixed number, k, of nearest 

240 



SpaceStat 4.0 Documentation 

neighbors, or all neighbors within a defined distance) the basic Q statistic, Qit , is the number 
of nearest neighbors that are cases during time interval, t, and not controls.  (The time 
intervals themselves are calculated by combining all the residential histories for cases and 
controls to determine the sequence of intervals within which all neighbor relationships 
remain unchanged.  This insures that each Qit is valid for the duration of its associated 
interval.)   

We can combine the individual Qit statistics in several ways:  

• We can sum all of them within each time interval, yielding the Qt statistic, which 
provides a global index of case clustering through time.  The units for the Qt statistic are 
cases, since it represents the total number of all neighboring cases during a time interval.   

• For an individual-level index of clustering we can calculate each case's duration-weighted 
sum of its Qit's, yielding the Qi statistic.  A normalized version of the Qi is obtained by 
dividing each Qi by the duration of its exposure period.  The units of the Qi are case-time 
units (e.g. case-years) representing the number of years an individual spends near 
neighboring cases.  The units of the normalized Qi are cases since its the average number 
of neighboring cases encountered through time. 

• Finally, the sum of all the Qi statistics equals Q, which is a global measure of clustering 
over space and time.  Like the Qi , the units are case-time units.  The normalized Q is the 
average number of neighboring cases each case in the population experiences over time.   

A variant of the Q statistic is the Qf statistic.  Rather than following cases through time 
tallying up the number of neighboring cases, we instead track separate "focus" locations 
through time.  These might correspond to industrial sites that are sources of pollution, or 
other risk factors pertinent to the investigation, such as suspected transmission sites for 
infectious diseases (e.g. sources of cholera contaminated water). Each focus site then yields a 
Qfit statistic during each time interval, and these can be combined to yield Qft and Qfi 
statistics.  Here i refers to a particular focus location, and t to a particular time interval.  Qf is 
the sum of all the Qfi statistics. 

As equations, here are the various Q statistics using k nearest neighbors: 

 

As discussed, Qit is the count, at time t, of the number of k, nearest neighbors of case i that 
are cases, and not controls.  Individuals i and j have case-control identifiers,ci and cj defined 

to be 1 if and only if a participant i is a case, and 0 otherwise.  The term  is a binary 
spatial proximity metric that is 1 when participant j is a k nearest neighbor at time t of 
participant i; otherwise it is 0.  Since a given individual i may have k unique nearest 
neighbors, the Qit statistic is in the range 0...k.   
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When i is a control, Qit= 0.  When i is a case, low values indicate cluster avoidance (e.g. a 
case surrounded by controls), and large values indicate a cluster of cases.  When Qit = k, at 
time t all of the k nearest neighbors of case i are also cases. 

 

Qi is the duration-weighted sum of a case's Qit's through time.  In Equation 2, ωt is the 
duration of the time interval associated with Qit. 

 

Qt is defined in Equation 3 as a time-specific statistic that provides an overall measure of 
case clustering when all of the participants are considered together.  It is the sum, over all 
cases, of the subject-specific and time-specific measure of case clustering in Equation 1. 
 Analogous to Cuzick and Edwards test (Cuzick and Edwards 1990), Qt evaluates global 
clustering of cases at time t, such that the amount of case-clustering observed when all of the 
participants are considered together is evaluated.   

 

Equation 4 provides a global test that sums over the complete set of life course statistics from 
Equation 2.  It is used to evaluate whether there is significant life-course clustering of cases 
when all of the participants are considered together.   

To summarize, Qit is used to identify when and where an individual is a center of a local 
cluster of cases.  Qi identifies which individuals tend to be centeres of clusters over their life-
course, but not when those clusters occurs.  Qt identifies which time periods display 
significant global clustering and finally, the global Q identifies whether global clustering 
tends to occur over the entire residential histories, but not when or where the clustering 
occurs.   

Statistical significance is determined by randomizing the case-control identifiers over the 
residential histories under the null hypothesis of no association between places of residence 
and case-control status. Only case-control status is randomized, we maintain the integrity of 
the individual residential histories, which are then used to calculate the Q statistics. The 
randomization procedure is repeated over many iterations (e.g. 999) to build up distributions 
of the Q-statistics under the null hypothesis. Notice the range of possible p-values is 
determined by the number of randomizations of the null hypothesis applied. For example, 
999 randomizations will generate a minimum p-value of 0.001. 
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Calculate Q Statistic 

SpaceStat provides many ways to customize Jacquez' Q to your particular inquiry.  The Task 
Manager separates the method into related panels that we describe below.   

Input  

The first panel contains the geography and the case control dataset that you want to analyze. 
This dataset must be of integer form, and comprised of 0s and some case status indicator.  0s 
will be coded as controls and any non-zero integer will be considered a case.  (If your 
case/control dataset is not recorded as an integer, you can right click on the dataset in the 
Data view panel and chose to convert data type to integer).  

 

If you are using the Qf method, you will need to provide one other paremeter, the focus 
geography. 
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The randomization method allows you to choose between ID shuffling and using a case-
weight dataset.   

The randomization method offers two approaches for determining the significance of the 
observed data.  Id shuffling mixes up the case-control identifiers during randomization so 
each actual case might have more or fewer cases than was observed.  This allows the method 
to compare the observed case count around each individual with a distribution of case counts 
that might be expected at random. 

 

The case-weight option allows the specification of a dataset which defines a weight for each 
individual when choosing cases.  While the total number of cases selected during 
randomization remains the same, some individuals might be more likely to be a case based 
on other factors and this information is used to bias the selection of cases.  Frequently, the 
weight dataset will be the output of a logistic regression which might predict the probability 
of being a case based on factors such as diet and smoking.  Note that if all the case weights 
are the same, the randomization will be equivalent to id shuffling.   

Each randomization method allows for the user to select the number of randomizations and 
the alpha level.  There are two options for determining the neighbors of a particular case. 
 The k nearest neighbor method will consider the closest k objects to be the neighbors of a 
case.  If there are ties in distance for the final neighbor, SpaceStat distributes the remaining 
weight amongst the points which are tied for nearest neighbor status.  
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If you select to use the Distance method to determine neighbors, you will need to input a 
range and all objects found within that range around a case are considered to be its neighbors. 
  

The start and end times define the temporal bounds for the analysis.   

Test for number of significant statistics 

Issues regarding multiple testing arise with the Q statistic both because of the many tests 
conducted across space and because every individual is tested for each of its residential time 
periods as well as whenever any of its neighbors move.   

 

One way to address multiple testing is to evaluate the significance of the number of 
significant individual statistics found;  following the multiple-testing parameter specify the 
number of randomizations to use.  (These are taken from the randomizations generated when 
testing the observed data for significance).  For each run, a randomization is treated as the 
observed data and the number of significant Qit, Qi and Qt statistics (when compared to the 
other randomizations) is tallied.  At the end, the actual number of significant statistics is 
compared to the distribution created from these runs.  The log reports whether the number of 
significant primary statistics (Qit, Qi, and Qt) is significant as well as several combinations 
of them.  It also reports the three most significant locations (for Qi), times (for Qt) and time-
locations (Qit).  In the context of multiple testing, you should be hesitant, for example, to 
declare every significant Qi meaningful if the number of significant Qi's was not significant.   

Exposure Period 

Continuous 

This type of exposure period looks at each individual from the start time thru the end time, 
generating Qit's each time the individual moves or its neighbor arrangement changes. 

Retrospective 
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In some analyses, you might want to limit when neighbors around cases are examined.  The 
retrospective exposure option allows you to define an exposure period followed by a latency 
period which ends at the diagnosis date.  Only when an individual is in its exposure period 
will its neighbors be examined to see how many of them are cases in their own exposure 
periods.  You can specify that the final observation date for each person should be taken as 
the date of diagnosis, or you can use a diagnosis-date dataset if available.  The date-of-
diagnosis dataset needs to be in the same time format as the residential history geography. 
 For example, if th etime format is dates, then the syntax of the integer values in the dataset 
needs to be YYYYMMDD, YYYYMM, or YYYY, where YYYY is a year such as 1955, 
MM is a month, and DD is the day of the month. 

By age 

 

The by-age exposure option provides a way to compare individuals to their neighbors when 
they were all the same age, even if they weren't adjacent to one another in calendar time.  A 
new age-indexed geography is created when this option is chosen and the output datasets are 
added to it.  A date-of-birth dataset can be used (analogous to the date-of-diagnosis dataset in 
the retrospective option) or SpaceStat can treat the first observation as an individual's 
birthday.  The state and end age parameters define the age-exposure window. 
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By cohort 

This option allows you to restrict the analysis to an exposure period that is defined by 
calendar time.  This might be appropriate when modelling discrete periods of exposure to a 
contaminant or pathogen.   

Review Settings 

The review settings panel presents a summary of the parameters entered so you may review 
the choices that you have selected.  If everything looks correct, select the Run button at the 
bottom of the page.   

  

  

Q Flavors 

A Diagnostic Framework for Q-statistics in Relation to Disease Processes 

So how might one use the Q-statistics to gain insights into specific etiologic hypotheses? 
 Suppose we proceed and evaluate the 3 Q statistics 

• Qit the local statistic  
• Qi the life-course statistic, and  
• Qt the large-scale spatial cluster statistic.   

Notice the subscript i is a case identifier, so Qit and Qi make statements regarding clustering 
about individual cases.  How might these be used to generate inferences regarding space-time 
cluster processes? 

Suppose we have n participants in a study, n1 of which are cases and n0 of which are 
controls.  The beginning of the study period is t=0, the end is t=T.  Consider the sets defined 
as follows: 

 

(Equation 6) 

 

(Equation 7) 

 

(Equation 8) 
  

Here   is the set of all Qit that are statistically significant at the type I error level α,  is the 
set of all Qi that are statistically significant at α, and   is the set of all Qt that are 
statistically significant at α.  It turns out that Qt and Qi are global statistics that assess case-
clustering at specific times (e.g. Qt) and over the life course of specific cases (e.g. Qi) such 
that 
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(Equation 9) 

 

(Equation 10) 
  

Hence the global statistics are the sums of the local statistics Qit.  There thus is a mapping of 
sets of the local statistics Qit to sets of significant statistics  and .  This mapping is 
comprised of those Qit that contribute to the significant  (through Equation 9) and 
those Qit that contribute to the significant  (through Equation 10).  With this understood we 
now can consider the following operations: 

 

(Equation 11) 

 

(Equation 12) 

 

(Equation 13) 

 

(Equation 14) 
  

Notice the result of these set operations will be sets of the local statistics Qit that contribute to 
the sets of significant global statistics that are the operands of Equations 11-14.  These 
operations are represented in the following figure. 

 

  

  

Q Results 

The results of running the Q method can change depending on the settings used. 

If you run the Q method with a continuous, retrospective or "by cohort" exposure period 
option, the method will produce new datasets under the original case/control dataset used in 
the method.  Results will also be recorded in the log. 
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The method adds Qi, Qt, and Qit datasets to the original geography, and their associated p-
value datasets. The method also creates a mean-Qi dataset.  Note that the Qi and Qit statistics 
are individual-specific, while the Qt statistic applies to all individuals in a particular time 
slice.  If you were to look at the table of datasets for the geography after running the Q 
method, the Qi and Qit statistics would change for each individual, but every object in the 
geography would have the same Qt at any given time.   

 

The Q method will also identify the top three individuals with the most significant Qi cluster, 
as well as the three most significant Qt intervals.  This information will appear in the log, 
along with the global Q, its p-value, and the normalized Q.   

 

If you elected to test for the number of significant statistics in the Input panel, the p-values 
associated with the number of significant Qi , Qt , and Qit statistics will also be recorded in 
the log.  The method will also test for the significance of the number of significant Qit's 
which were also part of significant Qi's, significant Qt's, and both significant Qi's and Qt's.   

If you choose to run Q with a "By age" exposure period, the method will produce the same 
Qi, Qt, Qit statistics with their p-values and the mean Qi -- but these datasets will be in a new 
age-indexed geography.  If your original geography was Residential history, the new 
geography will be called Residential history (age-indexed).  The results in the log are the 
same.  

The Qf method produces similar results to the Q method but datasets are placed under the 
focus geography, not the residential history geography.   
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Global Clustering 

Moran's I 

  

About Moran's I 

 

  

Moran's I (Moran 1950) is a weighted correlation coefficient used to detect departures from 
spatial randomness. Departures from randomness indicate spatial patterns, such as clusters. 
The statistic may identify other kinds of pattern such as geographic trend. 

Moran's I tests for global spatial autocorrelation in group-level data. Positive spatial 
autocorrelation means that nearby areas have similar rates, indicating global spatial 
clustering. Nearby areas have similar rates when their populations and exposures are alike. 
When rates in nearby areas are similar, Moran's I will be large and positive. When rates are 
dissimilar, Moran's I will be negative. 

  

Besag and Newell 

  

About Besag and Newell's Statistics 
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Besag and Newell's method can detect local or global spatial clusters in case and population-
at-risk data. It can only be used on point geographies, such as centroids. When you initiate a 
Besag and Newell analysis, you get both local and global analysis output. 

This method scans the data for collections of cases that appear to be unusual clusters. To do 
so, it centers a circular window on each point location in turn. This window is then expanded 
to include neighboring regions until the total number of cases in the window reaches a user-
specified threshold, k. Then, the population size inside the window is compared to that 
expected under the expected (average) disease frequency.    

  

  

Besag and Newell's Statistics 

Ho The number of cases in an area follows a Poisson distribution with a common rate. 

Ha For some areas, the number of cases exceeds that predicted by a Poisson 
distribution with a common rate. 

Test statistics 

This method assesses clustering at the local and global scale using two test statistics:   l for 
the local scale and r for the global scale. Thus, use l to evaluate local scale clustering, and 
use r to examine global-scale clustering. This method is designed for case and population-at-
risk count data aggregated into regions with small population sizes. Regions could be census 
tracts, zip codes, or towns. 

The l statistic describes the extent of local clustering, the number of regions needed to 
aggregate at least k cases, with k defined by the user. If the cases are in a cluster, you can 
imagine there would be fewer regions to aggregate to find a set number of cases than if they 
were not clustered. The r statistic is simply the total number of clusters found in the local-
scale analysis. 
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Notes 

Waller and Turnbull (1993) show that the significance of  l depends on the level of 
aggregation and the chosen value of k. 

  

  

Besag and Newell's l 

Besag and Newell's method calculates two statistics: l is the local statistic, the number of 
regions required for the window centered over an individual region to contain k cases. To 
evaluate whether the k cases form a cluster, the method looks to see whether the number of 
cases in the window is unlikely for the window's population at risk. 

The null hypothesis is that there is no clustering, so that a common Poisson disease rate 
exists across the study area. Thus, the case count inside the window should be proportional to 
the population at risk, otherwise the null hypothesis can be rejected. Following Besag and 
Newell (1991), the null spatial model is that cases are distributed among the areas in the 
study proportional to population size and with a common disease rate. SpaceStat calculates a 
probability for l under the null spatial model. 

  

This expression calculates the probability that l has reached or exceeded the value predicted 
by the null hypothesis (L). It is 1 minus the probability that l is less than L, i.e., the 
probability that there are fewer than k cases in the area. The probability of 0 through k-1 
cases is found by summing the Poisson term from x = 0 to x = k-1. Lambda, (  ), is the 
average or expected case count, the average or expected disease frequency multiplied by the 
population-at-risk. The term e indicates the exponential function. 

When you perform a Besag and Newell analysis, SpaceStat will calculate l and its 
significance for all clusters. It will list all clusters that have a probability less than the 
significance level you specify, alpha. The default alpha is 0.05. 

  

  

Besag and Newell's r 

The Besag and Newell's method calculates two statistics:  l, and r.  The global statistic, r, is 
the total number of clusters found in the local-scale analysis. 
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To get the observed r, SpaceStat counts the significant local clusters. 

Assessing the p-value 

SpaceStat evaluates r by comparing it to Monte Carlo randomizations of the geography. 
SpaceStat generates a reference distribution to evaluate r by repeatedly randomizing the data 
and recalculating r for each randomization. The data are randomized by drawing from a 
Poisson distribution with the expected value being the average rate for the dataset multiplied 
by the population in the cluster. 

  

  

Calculate Besag and Newell's Statistics  

Choose Besag and Newell from "Case-Pop Method" in the Methods menu. For SpaceStat to 
calculate the Besag and Newell statistics, it needs to know for which datasets at which 
time(s), the threshold cluster case count to use,  and how to name the results datasets. You 
need to have a point geography to use Besag and Newell. If you do not, generate a centroid 
geography from your polygons first. 

Click within the sections in the images below for more information. 

Input 

When the task manager opens for calculating the Besag and Newell statistic, it will start on 
the "Input" section. 

 

Advanced 
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The only option in advanced section for the Besag and Newell statistics is to change the 
alpha level. 

 

Output 

The output section of the task manager asks for a name stem to use for output files.  The 
default name for Besag and Newell results for the datasets indicated in the "Input" dialog 
(above) is shown in the box below. 

 

Run method 

The run method page presents a summary of the previous three pages so that you can review 
the choices you have selected.  If everything here looks correct, select the "Run" button at the 
bottom of the page.   Output from this method is shown in the image on the "Besag and 
Newell Results" page. 

  

  

Besag and Newell's Analysis Results 
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After you perform a Besag and Newell analysis, you will see two new datasets in the data 
view, a cluster set in the spatial weights and cluster sets view, a new map, and r results in the 
Log View. 

 

The new datasets are: the local test statistics and their p-values. The test statistic, l, is the 
number of regions in the window for the ego location. The p-value is the Monte Carlo p-
value, which comes from comparing the observed test statistic to the reference distribution 
created by randomizing the cases across the study area and recalculating l. 

Map and cluster set 

The map shows the p-value dataset, classified into significance levels. A location that has a 
significant l statistic is colored red, while nonsignificant locations are grey. The significant 
cluster may include several neighbors, not just the point colored red. When you click on the 
map, you will see the cluster set for each point (significant or non-significant) created by 
your Besag and Newell analysis. The cluster set for each location is the set of points that 
were required to meet the case threshold for the ego location. The weights for each of the 
locations in the set will be listed in the Log View. 

You can turn off the cluster set by choosing "Show object neighbors" and then clearing the 
checkbox next to the cluster set's name. 

Global results 

Information about the global statistic, r , is written into the Log View. The Log View will 
contain the number of significant local clusters and its p-value. Significant p-values indicate 
that there is significant global clustering, more significant local clusters in the geography 
than you would expect by chance. 

  

Disparity Statistics 
  

About the Disparity Statistics 
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SpaceStat includes two related methods for assessing the magnitude and statistical 
significance of disparities, or differences, between rates.  From a public health perspective, 
The Centers for Disease Control and Prevention (CDC) defines a disparity as "the quantity 
that separates a group from a reference point on a particular measure of health that is 
expressed in terms of a rate, proportion, mean, or some other quantitative measure" (Keppel 
et al. 2004, p. 7).  Our implementation of these tools follows the CDC's suggested standard 
approach for defining the rate and the reference population.  When combined with several 
options for dealing with multiple statistical tests, the disparity statistics implemented in 
SpaceStat provide three major advances over other measures that have been used to contrast 
disease patterns in two sub-populations in the same locations.  First, the techniques in 
SpaceStat allow you to examine both absolute and relative differences in disparities, which 
helps address problems associated with characterizing and interpreting changes in rates over 
time.  For example, if overall rates of some disease are decreasing, leading to a decline in the 
absolute difference between population groups, you may still see an increase in the relative 
disparity between groups.  Thus, using both an absolute and relative rate is recommended by 
the CDC (Keppel et al. 2004).  Second, for cases where disparities are strong, we have 
implemented techniques for going beyond the original statistics to evaluate exceedance of 
thresholds in disparity.  Third, we provide three options for dealing with problems associated 
with multiple testing, which can lead to increased false positives (detections of disparities 
that are not actually present) due to the large number of tests applied in geographies with 
many spatial units (Goovaerts et al. 2007).   

Through a simulation study comparing six test statistics that assess absolute and relative 
differences between cancer rates measured in distinct subpopulations, Goovaerts et al. (2007) 
found the (1) absolute, or difference statistic, and the (2) relative, or ratio statistic 
implemented in SpaceStat consistently showed higher power and fewer false positives than 
other measures.  Interestingly, these researchers found that, for their datasets, these measures 
actually had lower false positive rates when NOT corrected for multiple testing.  Used 
together, these two statistics provide a balanced approach that helps avoid misleading 
conclusions regarding changes in the magnitude of disparities over time or across geographic 
areas, and produce realistic assessments of the proportion of false positives (type 1 error rate, 
or alpha value).  Although the need to control for multiple testing was not supported in this 
simulation study, other data sets and applications may show different patterns.  Thus, 
SpaceStat also provides three options for controlling for multiple testing when performing 
disparity analyses (changing the alpha, an extended Simes correction, and a False Detection 
Rate correction).  Goovaerts et al. 2007 also demonstrated that one-tailed hypothesis tests can 
be useful tools for comparing a-priori hypotheses regarding the direction and magnitude of 
differences between two sets of rates.  With SpaceStat you now have the ability to test 
whether a difference between rates exceeds a certain threshold, rather than simply testing for 
a difference in rates. 

Below, we display output from a disparity analysis on lung cancer mortality rates for black 
males (target population in the analysis) in comparison to the value for white males 
(reference population) in counties in the southeastern US.  The pair of maps shown below 
display the calculated differences in rates.  These maps are not automatically generated, but 
can easily be produced by adding the two of the output files (the file labeled "RD", for rate 
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difference, and the file labeled "RR" for rate ratio) to a map -- here we have classified the 
data into five quantiles (see Map Properties).   

 

The set of maps shown below are automatically generated when you run a disparity analysis, 
and in this case show whether the disparity statistic for each county was significant at p = 
0.05 (with no correction for multiple tests). The map in the center indicates mismatches in 
the detection of significant disparities by the two methods.  Note that many counties at the 
northern edge of this study area had missing values, and that the two statistics gave very 
similar results for this more common cancer---you might expect more mismatches across the 
two disparity measures when working with data on rare cancers. 

 

Click here to see the disparity equations, or here to look into tests with thresholds. 
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To see how to fill in the task manager boxes, click here. 

  

  

Disparity Statistics 

As described in the overview, SpaceStat includes two statistics for assessing disparity 
between different populations in various measures of health, such as cancer rates.  The first is 
an absolute measure of differences between two rates, and the second is a relative measure, 
or ratio, which allows assessment of whether disparities between groups are shrinking or 
expanding relative to changes in mortality rates.  The formulas presented here follow the 
form and notation of Goovaerts et al. 2007, including the subscript "I" for the absolute 
measure, and "VI" for the relative measure.  The only difference between SpaceStat' 
implementation of these techniques and the published version is that, in the absolute 
measure, Goovaerts et al. (2007) take the absolute value of the numerator.  The formulas here 
correspond to the "usual" situation of a two-sided test; for one-sided tests of hypotheses, see 
versions of these statistics that test differences in disparities relative to a threshold value that 
you specify. 

Standardization of disparity comparisons 

Note that The Centers for Disease Control and Prevention (CDC) have outlined a method for 
comparing disparities that attempts to standardize how these comparisons are made, so that 
analyses can be more easily compared across studies and over time (Keppel et al. 2004). 
 First, they suggest that disparities should be compared in terms of adverse events (e.g., 
mortality rates rather than survival rates; to follow the same suggestion with education data, 
you might compare drop-out rates rather than graduation rates).  This standard is important 
because you can get very different results if you switch to the opposite form of the data, 
because one type of rate typically has a much smaller magnitude than the other, so the same 
absolute difference would be represent a very different proportion of the rate.  Second, they 
suggest the reference population should be defined as the group with the "best" or most 
favorable rate (Keppel et al. 2004).   We have followed these guidelines in our 
implementation of the disparity statistics.  Of course, when looking at a large geography, you 
may have variation across space and/or time in which of the two populations being compared 
has lower rates.  To follow the CDC suggestions strictly, we would switch the Target and 
Reference accordingly in each calculation, but this would hinder our ability to explore space-
time patterns in disparity in a meaningful way.  So, we suggest choosing the population that 
is higher at most locations/times as your Target.     

Absolute Disparity Statistic (Rate Difference) 

The absolute disparity statistic for the geographic unit vj is calculated as: 
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Each rate, z 1(v j) and z 2 (v j ), is computed as the ratio d(v j )/ n(v j ) , where d(v j ) is the 
number of recorded mortality cases and n(v j ) is the size of the population at risk. 

Relative Disparity Statistic (Rate Ratio) 

The second disparity measure included in SpaceStat quantifies relative differences between 
rates measured in different groups.  The formula for this measure is shown below -- note the 
subscript "VI" has been retained from the original reference.  The variables are defined under 
the Absolute Disparity Statistic (above). 

  

Significance - The Two-sided Test 

The significance of the two disparity statistics shown above is assessed using the following 
procedure, where G(.) is the cumulative probability distribution of the standard normal 
variable. 

  

Corrections for Multiple Tests 

When applied to geographic data, evaluations of the significance of test statistics for 
measures like disparity can easily exceed hundreds of individual tests.  Multiple testing 
corrections reduce the significance level applied to each test so that the overall false positive 
rate is kept to less than or equal to the user-specified significance level alpha (typically 0.05, 
or 1 in 20 comparisons).  Methods to correct for multiple testing differ in their ease of 
implementation and their stringency. The more stringent or conservative a correction, the 
fewer false positives are allowed, but this reduction in type I error comes at a cost, in that it 
leads to a potential high rate of false negatives (type II errors), which in this application 
would mean that additional observations of disparities would go undetected.  SpaceStat 
allows you to choose among four options for correction: (1) no correction, (2) the Extended 
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Simes Correction (most conservative), (3) the False Discovery Rate (more powerful), (4) 
modifying your alpha level. 

The Extended Simes Correction 

The Simes Correction, described here for applications to local clusters, can be extended 
across geographies (rather than just across neighbors in the clustering procedures) to account 
for large numbers of individual tests.  This procedure arose after work by Holm (1979), in 
which the author proposed an 'improved Bonferroni procedure'; in other words, that 
procedure that would modify the p-value needed to reject the null hypothesesis that was less 
stringent than dividing your chosen alpha (typically 0.05) by the number of tests performed 
(for 10 tests, would then need a P smaller than 0.005 to be considered "significant").  Similar 
stepwise procedures soon followed, such as the Simes' procedure (Simes 1986) and the 
'extended Simes procedure' (Swets 1988).  The approach implented in SpaceStat starts by 
ranking all p-values from small P(1) to large P(N). The magnitude of the alpha adjustment 
then decreases as the rank k of the p-value increases, i.e. the division factor applied to alpha 
is (N-k+1).   

The False Discovery Rate 

Instead of controlling type 1 errors (rate of false positives), the False Discovery Rate controls 
the expected proportion of true null hypotheses rejected out of the total number of rejections. 
 FDR approaches are thus less restrictive and more powerful than family-wise alpha-
protecting tools like the Bonferroni procedure and the Extended Simes Correction.  In 
SpaceStat, we have implemented an approach developed by Benjamini and Hochberg (1995). 
 These authors proposed a stepwise FDR procedure for independent tests in which the first 
step is to rank all p-values by ascending order and apply a correction that decreases as the 
rank k of the p-value increases, i.e. the division factor is k/N.  Unlike the Extended Simes, the 
decision rule is sequential, and involves checking that the p-value of rank k does not exceed 
the adjusted significance level, starting with the larger p-value (k=N).  Once this condition 
has been met for a given rank k', the adjusted significance level   is set to  and 
applied to all tests of hypothesis. The decision rule can then be formulated as: 

  

Rate Multipliers and Zero Populations in Disparity Analyses 

In many datasets, such as those available from NIH (e.g., the National Atlas of Cancer 
Mortality), the rate includes a multiplier, such as 100,000.  For this reason, when you go 
through the steps of calculating disparity statistics, a box at the bottom of the Input page 
provides a place for you to identify the "Disease Rate Multiplier," and one of the calculation 
steps will be applying the multiplier to the rate in the selected dataset to obtain a count of 
occurrences (e.g., cancer mortalities) that can then be divided by the population size.   

If one of the two populations at risk is zero, the disparity statistic is not computed and 
SpaceStat generates a missing value for that region. 
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Click here to see information about 1-sided tests (exceedance of thresholds in disparity). 

Click here to see how to run a disparity analysis. 

  

  

Exceedance of Thresholds in Disparity 

In some situations, such as the prostate cancer mortality example shown in Goovaerts et al. 
2007, the disparity between rates is so large and systematic that two-tailed tests primarily 
serve to confirm an obvious pattern.  To further explore patterns in disparities, SpaceStat 
incorporates techniques developed in this paper to look at exceedances of specific thresholds 
of change in both absolute and relative differences in rates.   Note that these tests are again 
set up in a way that follows the CDC's suggested standard approach, so you can only identify 
positive threshold values. 

One-tailed test for Absolute Disparity (Rate Differences) 

In the example described above, the standard two-tailed test (testing whether one set of rates 
differs from another, in either direction) simply confirms a pattern that is readily apparent 
when prostate cancer rates for black and white males are displayed in county geography 
maps.  When differences are this strong, it is often more interesting to test whether disparities 
exceed particular thresholds, symbolized by .   Exceedance of a particular threshold of 
differences between absolute disparity values (abbreviated as RD, for Rate Difference) can 
be tested in SpaceStat using the following one-tailed test: 

  

For example, setting =10 would lead to the identification of counties where the black male 
mortality rate exceeds the rate for white males by 10 deaths/100,000 people (these analyses 
were done on cancer rates with a 100,000 multiplier).  Goovaerts et al. (2007) modified the 
absolute (RD)  and relative (rate ratio, or RR) disparity statistics to allow this type of 
hypothesis test.  The revised formula for the absolute disparity statistic is: 

  

One-tailed Test for Relative Disparity (Rate Ratios) 

Similarly, the relative difference in rates can be evaluated with a one-sided test to evaluate 
the following hypothesis: 
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where the disparity threshold, , is now expressed as a proportion.  Thus, this test allows 
you to set  at 0.2, and evaluate whether the mortality rate for black males is significantly 
greater than 120% of the rate for white males.  The statistic for relative rates is as follows: 

  

Significance Values for the One-sided Tests 

The significance of the two disparity statistics shown above is assessed using the following 
procedure, where G(.) is the cumulative probability distribution of the standard normal 
variable. 

 

To see how to fill out the pages in the task manager to calculate disparity statistics, click 
here. 

  

  

Calculate Disparity Statistics  

To start, choose Disparity from the Methods menu.  The disparity statistic can be applied to 
datasets in both polygon and point geogaphies.  For SpaceStat to calculate the disparity 
statistic, it needs a disease rate or count, and a population dataset for the reference and target 
populations, the rate multiplier (if inherent in your disease rate data), the time(s), how to 
correct for multiple tests, and your input on how to name the results folder. 

The reference population is the one to which you are comparing the target population. If 
you're interested in whether, say, cancer rates in black females are different from rates in 
white females, based on the CDC's suggested standards for disparity analyses, you would 
look to see which population had the most favorable rate (in this case, white females), and 
use this population as the reference. 

Click within the sections in the images below for more information. 

Input 
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When the task manager opens for calculating the Disparity statistic, it will start on the 
"Input" section.  Here you will enter your reference and target datasets, choose which 
disparity statistics to generate (we recommend doing both, so you can compare--strong 
differences are most likely with datasets for events like rare cancers, which can have unstable 
rates due to variation in the population sizes across your geography), and choosing the start 
and end times and rate multiplier.  As a default, the rate multiplier is set at the value used by 
the National Cancer Institute for expressing cancer mortality rates (X deaths per 100,000 
people).  Make sure to change this value if it does not apply to your data. 

 

Advanced 

The advanced section for the Disparity statistics asks you to choose between two-tailed (do 
the two rates differ, either in absolute or relative magnitude?) and one-tailed tests (does the 
absolute or relative difference in rates exceed a particular threshold?).  In addition, you can 
change the alpha level, which is one way of addressing the problem of multiple testing, or 
choose the FDR or extended Simes methods to correct for multiple tests. If you select a one-
tailed test, you then also need to indicate the relevant thresholds for each statistic.  Note that 
the difference threshold should be in the same units as your dataset (i.e., do not account for 
the rate multiplier, if there is one), and the ratio threshold should be a ratio, not a percentage. 
 The 0.10 value entered below means that the statistic would test for a 10% exceedance in the 
target rate relative to the reference.  Values for either can be zero, so you can simply test 
whether the target rate exceeds the reference rate (one-sided test, rather than testing if the two 
differ).  The threshold (one-sided) tests implemented in SpaceStat are designed for situations 
where the target rate exceeds that in the reference population (a standard approach suggested 
by the CDC), so by threshold values must always be positive.  The form of data, and choice 
of Reference and target populations should thus be chosen to make the difference positive.   
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Output 

The output section of the task manager for the Disparity statistic asks for name for the output 
folder.  The default name is "Disparity"; here we have made this name a bit more descriptive. 

 

Run method 

The run method page presents a summary of the previous three pages so that you can review 
the choices you have selected.  If everything here looks correct, select the "Run" button at the 
bottom of the page.   The map output from this run is shown in the image on the "Disparity 
Results" page, and map output from the two-tailed test for the same datasets is shown on the 
"About the Disparity Statistics" page. 
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Disparity Results 

After you run a disparity analysis, SpaceStat will produce a report in the log, and 9 new 
datasets (if you choose "both" tests here --4 if you choose one test), and three maps.   

Disparity Datasets 

The new datasets be placed in a folder with the default name "Disparity" (which you may 
have renamed here).  This folder will appear beneath the dataset that you entered as the 
"Target" on the input page. The first four datasets, labeled RD (Rate Difference) refer to the 
absolute statistic, while the next for (RR, for Rate Ratio) refer to the relative statistic.  Within 
these two sets of datasets, the RD or RR file give the actual difference in rates or ratios, the 
"statistic" sets report the calculated value of the relevant statistic, the "P values" sets give the 
p-values, and the "significance" set is a categorical representation of whether each location 
showed significant disparities (as defined by your alpha value and your method for dealing 
with multiple tests).  Finally, the RR-RD matches dataset compares the two significance 
datasets to see how well the results match for the two statistics.  By default, the significance 
and matches datasets appear in maps after you run the analysis (see below).   
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Disparity Maps 

As noted above, three of the output datasets will automatically be mapped for you -- the RD 
(rate difference) significance values, the RR (rate ratio) significance values, and the RR-RD 
matches.  You can right click on any of the other datasets to add a map of those values as 
well.  Below, we show these three output maps for the one-sided analysis conducted on the 
"Calculate" page.  On the "About" page, in addition to the three maps that are automatically 
created, we show the differences in rate (RD) and in ratios (RR) datasets produced by the 
two-sided test on the same datasets (lung cancer rates in black males, with the rate for white 
males as a reference). The missing values fill pattern indicate locations for which a disparity 
statistic could not be calculated, such as areas missing population-at risk values. 
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Multivariate Modeling 

Discriminant Analysis 

  

About Discriminant Analysis 

The discriminant analysis method provides a way to predict group membership based on a 
linear combination of the provided datasets.  A training geography, where the group 
membership of the observations are known, is used to create a classification scheme that can 
then be applied to a target geography containing observations where the group membership 
is unknown. 

The method can also apply the classification scheme back onto the training geography in 
order to gain a better understanding of the accuracy of the classification. 

  

  

Implementation of Discriminant Analysis 
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Let {si; i = 1, ... , L} 

Note that the geographical coordinates of the location u being classified are not taken. 

There is no uncertainty if p(u;si'|Bz)=1. 

The uncertainty is maximum if all L classes have the same probability of occurrence at u: 
p(u;si'|Bz)=1/L for all i. 

  

  

Performing Discriminant Analysis 

Select Discriminant Analysis under the Methods menu (it is listed under the Multivariate 
Modeling heading). 

Discriminant Models 

When the task manager opens for discriminant analysis, it will start on the "Discriminant 
models" section.  Here you must choose your geography (if your project contains more than 
one), and then indicate whether you would like to create, modify, or delete a model.  You can 
create a suite of models that all share the same geography within one "tab" in the task 
manager, and these will all appear with the default name "DA model" on this page unless you 
change the name in the Create Discriminant Model dialog.  To modify an existing model, 
highlight it, and then click the "Modify" button.  Similarly select a model and click on the 
"Delete" button to remove it from the list.  Additional models can be created and saved and 
they will all be listed in this window.  Note that if you choose the method again from the 
methods pull-down menu, a new discriminant analysis tab will appear and will list the same 
suite of models. 
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Define a new model 

When you click the "Create" button in the initial task manager page, a dialog will open where 
you define the dependent and independent variables that will be included in your 
discriminant model.  You can also use the instructions below to modify a model you have 
already created. 
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This dialog will report the name of the geography you have chosen in the previous dialog 
window.  Here you may also change the name of your Discriminant model. 

The group variable option will allow you to select as group membership one of the integer-
based datasets in the current geography.  You are then able to choose from the list of 
available datasets which one you would like to include in the classification system (i.e. to 
create the discriminant functions).  Use the left and right arrows to select datasets or remove 
them. 

Discriminant Model Settings 

Once you have defined your model, you will move on to the discriminant model settings 
panel. 
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You will select the target geography in this panel.  This is the geography to which the 
classification scheme will be applied.  If the target and training geography are the same, a 
"leave-one-out" approach will be used where each observation's group membership is deleted 
and predicted using the other observations. 

This panel has an option to use pooled covariance matrices for all classes which is 
recommended for small training datasets. 

You may set the prior probabilities to be equal so that each class has a priori the same 
probability to prevail at a location, or the probabilities can be proportional to the sample size. 
 The latter option is recommended if the dataset is assumed to be representative of the 
proportion of different classes within the study area. 

You may select to smooth the class probability datasets.  This can be helpful when 
classifying rasters since the geographical coordinates of each location/pixel u being classified 
are not taken into account in this method.  Since neighboring pixels are classified 
independently of each other, this can lead to noise and a salt-and-pepper effect in the 
classified image.  This option allows you to attenuate that noise by replacing each class 
probability by the arithmetical average of the class probabilities for that pixel u and the 
adjacent pixels.  After smoothing, the new set of L probabilities are re-scaled to guarantee 
they all sum to 1. 

If you choose to match time intervals, then SpaceStat will process objects in the target 
geography which have a corresponding interval in the training geography.  If you do not use 
this option, the discriminant model built from the first training data interval will be applied to 
all intervals in the target geography. 

This tab also controls the start/end time for your analysis, as well as providing an option to 
name the folder which will contain the output datasets from the method. 
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Review Settings 

The review settings panel allows you to see all the settings used and may alert you to a 
parameter that has not been filled in correctly.  If everything is correct, click the "Run" 
button to run the method. 

 

  

  

Discriminant Analysis Results 

Once the method has run, three datasets will appear in the Data View. 

"Most likely class" reports for each location in the target geography the class with the highest 
probability of occurrence.  The maximum probability values are included in the "maximum 
probability" dataset. 

The "entropy dataset" provides a measure of uncertainty associated with the classification at 
each location.  These values can range from 0 (no uncertainty) to 1 (maximum uncertainty). 

Leave one out 

If both the training and target geography are the same, SpaceStat will be able to assess the 
accuracy of the classification by comparing the classification to the actual class (i.e. group 
membership) at that location.  The discriminant procedure will remove each object at a time 
and classify it using the other observations.  Results are reported in a frequency table that 
lists for each reference class the proportion of pixels that are allocated to the different classes 
by the model.  In the best case scenario (perfect classification), the diagonal elements of that 
table would be 100% and all the off-diagonal elements would be zero.  This table is reported 
in the Log View along with the error percentages by group and the contribution to the linear 
discriminant functions. 

  

Principal Component Analysis 
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About Principal Component Analysis 

Principal Component Analysis, or PCA, is a data transformation method which can be used 
when explanatory variables in an analysis are suspected of displaying multi-collinearity. 
 This means that two or more of these variables are correlated and can lead to large and 
erratic parameter estimates when used as individual predictors in a regression model.  The 
PCA method derives linear combinations of the explanatory variables of which just a few 
may be enough to capture the covariance properties of the full set of variables. This would 
then allow the user to reduce the number of variables in any subsequent regression model. 

  

  

Implementation of Principal Components 

The principal components of a set of variables are created by finding the linear combination 
of a set of explanatory variables that captures the majority of the variance in the data.   

The full set of Principal Components is defined by taking the appropriate linear combinations 

 

where the Z-scored variables 

 

are centered on the individual variable means and scaled by the individual variable standard 
errors. The observations are labeled by n=1..N where N denotes the total number of 
observations while the range of the other indices i,j is over the number of variables i,j = 1 ... 
p.   

The coefficients lij are obtained by maximizing the covariance matrix of the new components 
which can be expressed in terms of the correlation matrix for the original data. 

These components can be found via the eigen-value decomposition of the correlation matrix, 
defined as: 
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We can write this in terms of the ”Z-scored” observation matrix: 

 

It then remains to find the eigen-values and eigenvectors of ρ. 

In SpaceStat the eigenvalues and eigenvectors are found from the observation matrix using 
Singular Value Decomposition X = U Σ VT ��where the U denotes an N by p orthogonal 
matrix, V denotes a p by p orthogonal square matrix and Σ denotes a p by p diagonal matrix. 

Inserting the decomposition into the correlation matrix leads to 

 

which is solved by 

 

This allows one to conclude that the eigenvectors are just the columns Vi while the 
eigenvalues are equal to 

 

The elements of each eigenvector yield weights that are used to construct new variables as 
weighted sums of the original ones. There are as many so-called principal components as 
original variables. 

  

  

Calculate Principal Components 

To calculate the principal components of a set of variables in your data, go to the Methods 
menu and select Principal Components from the drop down menu.   

PCA models 

The first tab in the Task Manager for Principal Component Analysis is the PCA models tab. 
 Choose the geography with which you would like to work and click the Create button to 
begin your analysis.  The following dialog will appear. 
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You can change the name of your PCA model in the PCA model name field, otherwise the 
default name "PCA model" will be used.  If you plan on creating multiple PCA models, it 
will be helpful to name them differently. 

All the numeric datasets which are included in your geography will appear in the left panel of 
the dialog.  To select a dataset to be included in your principal component analysis, choose a 
dataset and select the arrow pointing to the right.  You can also double click on a dataset to 
shift it to the right column where the PCA variables are listed.  If you decide you would like 
to remove a dataset from the PCA analysis, click on the dataset so it is highlighted and then 
click the left-facing arrow.  The dataset should return to the Available variables panel.  You 
may also double click on a dataset in the right panel to return it to the left panel.   

Once you have selected all the datasets you would like to include in your PC analysis, click 
the OK button.   

You will return to the PCA models tab of the Task Manager.  To create a new model, click 
the Create button.  To modify a current model, select the model name and click the Modify 
button.  To delete a model from this window, select the model and click the Delete button.   

PCA settings 

In this tab, you can set the start and end times for your analysis.  SpaceStat will calculate the 
principal components for your model for each unique time slice.  If your data does not 
change during the time period you selected, you will have a single PC analysis.   
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You may also name your Output folder in this tab.  This will be helpful if you have more 
than one analysis that you are working with.   

Run 

The Run tab summaries the choices made earlier in the Task Manager.  If everything looks 
correct, click the Run button.   

  

  

Principal Component Results 

Principal component analysis produces as many datasets as were used when running the 
analysis.  These datasets will appear in a folder with the default name "PCA results".  This 
folder can be found under the geography in which you ran that analysis.  These components 
are now datasets that are part of your geography and can be used for further analysis.   

The PCA method will also generate a scatterplot of the first two principal components. 
 Further results will be found in the Log View.   

Log View Results 

The first entry will be a summary of the settings used when you ran the method.  This is the 
same information that can be found on the Run tab of the Task Manager.  SpaceStat will then 
list the variables you used when you ran the analysis 

A separate PCA analysis will be run for each time slice that can be defined between the start 
and end times you specified.  The first output will be the correlation matrix for the original 
datasets included in your PCA.   

 

SpaceStat will then list the eigenvalues associated with each component as well as the 
proportion of variance explained by each component, and the cumulative proportion of 
variance.  Decisions about how many components to include are often based on how many 
components it takes to cover a substantial proportion of the variance.  Other cut-off methods 
include using all components who’s eigenvalues are greater than 1 (or sometimes .7). 
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Finally, SpaceStat reports eigenvectors of the Pearson Correlation matrix, which will explain 
the loadings of the original variables and how they contribute to the components.   

 

  

Regression 

Aspatial Regression 

  

About Aspatial Regression 

Regression methods are a set of tools for assessing variation in one variable (the dependent 
variable, y) at set levels of another variable or variables (independent, or x variables).  A 
simple regression line is included in scatter plots (when you have the Graph Statistics option 
selected) to aid in data exploration --here we discuss a more formalized approach to applying 
regression techniques to your data.  Unlike measures of correlation, like those that also 
accompany the scatter plots in SpaceStat, these tools assume that there is a functional 
dependence of values of the dependent variable on the level of the independent variable or 
variables.  Aspatial regression can be used to predict a dependent variable in terms of 
continuous and/or categorical independent variables, and to determine the relative 
importance of various independent variables in predicting y, including the importance of 
squared and interaction terms.  Note that for SpaceStat to recognize a dataset as categorical, 
it must be a string (alphanumeric) dataset type. 

Comparison with geographically weighted regression 

"Aspatial" forms of regression are applied to all of the data within your dataset.  In other 
words, they give you a measure of the global rather than local relationships between 
variables.  If the relationship across space between the independent variable(s) and dependent 
variables does not change, the aspatial methods described here will give you results that are 
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very similar to the results from the suite of methods that do allow you to generate local 
estimates, referred to as geographically weighted regression (GWR) techniques.  We have 
implemented aspatial and geographically weighted regression using a unified approach, so 
you can run a GWR with equal weighting across space, and achieve the same results as you 
would have gotten from aspatial regression.  To facilitate comparison, the dialog box in 
SpaceStat' task manager is shared between aspatial and GWR methods so that the same 
regression model can be used with both without having to retype the model structure. 
 Remember that GWR is currently only available for point geographies, so if you want to be 
able to go back and forth between aspatial and GWR analyses for a polygon geography, 
perform your aspatial analyses on the polygon centroids. 

As implied above, an important limitation of aspatial regression is that it ignores the spatial 
coordinates of the observations in the analysis.  Aspatial regression methods are included in 
SpaceStat because they are commonly used, and because they provide a comparison with 
results obtained from GWR. 

Choosing the form of the regression model 

Regression methods are thoroughly discussed in many general statistical texts (e.g., 
Remington and Schork 1985, Zar 1999, Devore 2003) and in advanced, regression-focused 
texts (e.g., Kutner et al. 2004 ) and have been used to analyze data from a wide range of 
fields. 

Three items will control the form of the regression model: 

1. The nature of the dependent variable y: 

• Continuous (linear or Gaussian model) 

• Positive integer counts and rates (Poisson model) 

• Binary variables (logistic model) 

2. The nature of the explanatory, or "x" variable or variables: 

• Continuous 

• Categorical 

3.  The number of independent variables: 

• Single variable (simple form) 

• Multiple variables (multivariate form). 
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The help topics on regression are divided into sections on the three forms of aspatial 
regression that are included in SpaceStat: traditional linear models, Poisson models, and 
logistic models.    

When you perform aspatial regression in SpaceStat, you can also choose between running the 
exact model that you define ("Full model"), or you can choose to do exploratory model 
building with one of the model selection tools. 

  

  

Overview of Aspatial Regression Output 

When you run an aspatial regression model, SpaceStat will produce output that will appear in 
two different locations; a summary of your model and the tables of statistics produced in the 
analyses will appear in the log view, while new datasets will be sent to the data view.  This 
basic overview of regression applies whether you choose the "Full model" option, or choose 
to do exploratory model building with one of the model selection tools. 

Evaluation of your model and the individual parameters 

Information about the model fit, the importance of various regression coefficients, and their 
associated standard errors and p-values, are presented in tables in the log view.  Also, 
SpaceStat reports a table of correlation coefficients that describes the correlation between 
individual terms (numeric datasets) in the regression model.  Note that significance values in 
regression output are reported as "0.0" if they are smaller than 0.000001.  There are some 
variations in the output presented for the various model types; pick one of the following links 
to see example output for linear, Poisson, and logistic models, respectively. 

The aspatial regression results folder 

The data view lists three datasets that are created for each regression model run: "Estimated 
mean", "Residuals", and "Std err of mean", an abbreviation for the standard error of the 
mean. As shown below, these datasets will appear in a folder with the default title of 
"Aspatial regression results" that will be shown under the dependent variable for your 
regression model.  These datasets will also appear if you open the data table for your 
geography.   

If you right click on any dataset, you can: Add it to a new or existing map, rename or remove 
it, convert it to a different type (e.g., from a decimal to a string dataset), or view it's 
properties.  Specifically, the properties for datasets created by regression analyses repeat the 
information that appears in the run method window when you perform the analysis.  You will 
likely find the scatterplot, histogram, and box plot to be useful tools for examining your 
output datasets.  The R-squared and significance values listed in the log view provide 
information on the explanatory power of the independent variables included in your model, 
and the characteristics (i.e., parsimony) of the regression model.   How models and individual 
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parameters of models are evaluated are described in more detail in the "Implementation" 
pages of each regression model form (linear, Poisson, and logistic). 

 

Note, however, that if you use the scatterplot and look at the correlation coefficients shown 
in the statistics window, the values may differ slightly from what was given in the regression 
output that appeared in your log view; this difference (when it occurs) is due to a differences 
in how missing values are treated (see here for more details).   

  

  

Categorical Data in Regression Analyses 

It is relatively straightforward to understand regression using continuous independent 
variables:  For example a simple aspatial linear regression model involves finding the best fit 
of a straight line through a set of points in the x-y plane, fitting a single intercept and slope. 
 A simple GWR model would repeat this approach across multiple overlapping 
neighborhoods in a spatial dataset, but would still be fitting a single intercept and slope to 
these subsets of the data.   However, regression using categorical dependent variables differs 
in that a different regression parameter must be chosen for each of the categories represented 
in a categorical dataset.  Details related to this process of coding of categorical variables are 
described below.  Note that for SpaceStat to recognize a dataset as categorical, it must be a 
string (alphanumeric) dataset type. 

Reference cell vs. Effect cell parameterization 

In SpaceStat, there are two options for handling how categorical variables are coded for 
parameterization of the coefficients; reference cell and effect cell parameterization.  Both 
options link the different regression coefficients to individual on-off variables for each of the 
categories within the categorical dataset.  Using reference cell parameterization for a variable 
with three categories would introduce two indicator or "dummy" variables that take either the 
value zero or one for the first two categorical values.  Specifically, one category would be 
coded "0 1" and a second would be "1 0", and both indicator variables (codes) would be zero 
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for the third category (0 0).  This final code (0 0) is assigned to the category chosen to be the 
reference cell (see below).  Note that with either reference cell or effect cell coding, your 
code will always have the same number of digits as your degrees of freedom (the number of 
categories minus 1).  For example, in a dataset with four categories, the reference cell would 
be coded "0 0 0" rather than "0 0".    

As shown here in the SpaceStat interface for aspatial linear regression, when you run a 
regression with categorical data, you will need to pick which category will be the reference 
cell.  A regression model with an intercept and an independent variable with three categories 
would then have a total of 3 coefficients (1 for the reference cell, which acts as the intercept, 
and two for the categories with codes that include 1), and the resulting matrix of values that 
SpaceStat uses to estimate coefficients would avoid the problem of singularity. The second 
coding option, effect–cell coding, assigns the values -1 for each of the two variables when 
data lie in the third category, so the three possible codes expressed with the two coding 
variables are 0 1, 1 0, and -1 -1).  Again, this coding avoids the problem of having too many 
parameters in the matrix used to perform the maximum likelihood estimation. 

The choice of coding depends upon the goals of your analysis.  To give a very simple 
example, say you are trying to predict your dependent variable "y" using just the independent 
variable "gender" in an aspatial linear model.  Working with the traditional linear regression 
equation, you would have: 

 

If you picked reference cell coding, and chose males as the reference value (i.e., the category 
coded as 0), then for females your dependent variable would equal b0 + b1, while for males y 
would equal just b0, because multiplying the b1 by zero would cause it to drop out.  In effect, 
the y values are the means for each of the two categories, and a t-test (i.e., a two sample F-
test) for b1 will test the hypothesis that the mean for females is significantly different from 
the mean for males.  Alternatively, if you picked effect cell coding, then if you chose males 
as the reference cell, they would be coded -1, and females would be coded 1.  For females, 
your dependent variable would still equal b0 + b 1, but the y for males would equal b0 - b1. 
 You would still end up with the result being the mean of each category, but your 
significance test for the coefficient associated with each categorical level would test the 
hypothesis that the mean for females is significantly different from the mean for the WHOLE 
GROUP (males plus females). 

Categorical variables in model selection (stepwise regression) 

Even though SpaceStat creates an indicator variable for each category in a categorical 
dataset, the dataset is treated as one unit in the model selection procedures (e.g., forward and 
backward stepwise regression, best model selection).  This means that categorical variables, 
or interaction terms that include categorical variables, will drop or add the entire variable or 
interaction term and evaluate changes in model fit, rather than dropping one categorical level 
at a time.  When you are using these tools, you will still be able to choose between reference 
cell and effect cell parameterization.    
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Complications with models that include categorical variables 

Complications arise with the parameterization of regression coefficients when combinations 
of categorical variables are used in the regression model. Suppose you wish to model the 
weight of a cat or dog using (a) gender (b) animal type, and (c) the combination (interaction) 
of gender and animal type.  For the interaction term, SpaceStat would parameterize the four 
possible combinations of categories using an intercept and three on-off variables with the 
fourth (e.g., male*dog) as a reference value.  However, trying to parameterize this model 
with two variables, and the interaction term would lead to five parameters for only four 
categories, and a regression matrix where the entries in one column are always equal to the 
sum of the entries in two other columns. 

A similar problem arises when the regression model involves the product of categorical and 
continuous variables, for example animal weight versus the product of animal type (cat or 
dog) and height. In this case the reference cell parameterization would only allow a non-zero 
slope for one of the two animal types since the reference value does not have a variable 
assigned to it.  Therefore, for products of categorical and continuous variables, the 
categorical reference value has to be reintroduced so that a linear dependence on height can 
be allowed for that category. Again if you tried to model regression against both the height, 
and the product of height and animal type, then over-parameterization would occur and 
SpaceStat will flag the regression model as having a singular regression matrix. 

Here's the bottom line:  Don't define a model with categorical linear variables in combination 
with a fully categorical interaction term, and don't use the same continuous variable as a 
linear term and in an interaction with a categorical term. 

Details on the handling of overparameterized models 

When the model that you have defined includes too many parameters (and regression matrix 
inversion fails because the regression matrix is singular), SpaceStat adopts the procedure of 
trimming the model of excess parameters so that you can obtain valid estimates of the 
dependent variable and its standard error. Specifically, the Singular Valued Decomposition 
(SVD) procedure is used to obtain the number of singular elements in the regression matrix, 
as well as lists of parameters that are linearly related to each other. The parameters at the end 
of each list are then removed and the regression matrix is tested again to ensure that the 
number of singular elements has been reduced. The procedure is then repeated until no more 
singularities remain in the regression matrices. 

For a singular regression matrix, the SVD procedure does not produce the only valid 
estimates of the dependent variable. Other combinations of the regression model coefficients 
that are linearly dependent on each other could be removed just as well - consequently the 
reduced model parameterization is not unique. Therefore the Type III ANOVA results 
(presented for aspatial regression) will represent the sum of squares for an arbitrarily reduced 
model and should not be regarded as unique. 
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Non-geographical Weights in Regression 

In geographically weighted regression (GWR), a distance function is used to "weight" values 
observed at neighboring locations so that you can identify local patterns in relationships 
between independent and dependent variables.  In a similar way, you can weight 
observations in an aspatial regression or GWR so that some observations "matter" more than 
others when building a regression model.  One example of when you might want to use a 
weight dataset is in a regression analysis using disease rate data.  In many cases, these 
datasets show strong variation across space in the population size, which acts as the 
denominator in the rate calculation.  However, the higher the population size, the more 
confident you can be that your rate is not overly influenced by just a few occurrences of the 
disease (i.e., the small numbers problem, as described in this tutorial).  So, if you are working 
with rates and have a population size dataset for the same geography, you may want to try a 
model that includes this weighting factor.    

You would enter the weight dataset in the "Regressions settings" page of the Task manager. 

 

  

Aspatial Regression - Linear 
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About Aspatial Linear Regression 

In traditional linear regression, a statistical model is fit to a set of N observations such that a 
dependent variable y can be expressed in terms of one or more independent variables, and a 
residual, or error, term.  Independent variables can be continuous and/or categorical, and you 
can also include squared terms, interaction effects, and weights in your model.  Note 
however that some combinations of categorical variables lead to overspecified models, so 
read the categorical variables page to learn about common pitfalls to avoid when defining 
your model. 

Assumptions of linear regression models include (1) independent observations; (2) normally 
distributed variables; (3) and homoscedasticity (similar variances in the dependent variable 
across different values or levels of the independent variable(s)). 

The figure below shows a dataset of N=23 points, plotted so that y, the variable we would 
like to be able to predict, is shown on the vertical axis, and a single independent variable (x) 
is shown on the horizontal axis.  The goal of the linear regression modeling exercise is to find 
the linear function that provides the best prediction of y; that is, it produces the smallest 
errors, measured as the squared difference between the observed value of y, and the value of 
y from the regression line at the same value of x.  Note that the term "linear" refers to the 
linear combination of parameters in the model, and that the graph that results from a linear 
regression model does not have to be a straight line.   

 

A general equation for aspatial linear regression 

In the linear regression model, the independent variable observations are regarded as fixed, 
and all other variables (y, and the error term) are considered random.  One way of expressing 
a linear regression model with an unspecified number of independent variables is shown 
below.  You may be familiar with formulas that separate out a b0 (y-intercept) term from the 
rest of the regression parameters, such as the equation for the simple linear regression line 
that appears here in the SpaceStat help.  This parameter is still included in the formula below, 
in that the "x" part of the "bjxij" component drops out when j=0.   
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Output from linear regression 

SpaceStat output from linear regression includes R-squared (and adjusted R-squared) values, 
which measure the fit of the model as a whole, and significance values (p-values) for the 
whole model, and for individual terms in the model.  The output is described in more detail 
here, including examples from the SpaceStat log view. 

To find out more about how linear regression is implemented in SpaceStat, click here. 

To skip the details and learn about how to perform aspatial linear regression, click here. 

  

  

Implementation of Linear Regression in SpaceStat 

In SpaceStat, a program designed for analysis of space-time datasets, we have implemented 
aspatial forms of regression as special cases of geographically weighted regression; the case 
where the neighborhood includes all of the locations in your focal geography.  This linkage 
with geographically-weighted regression means that SpaceStat retains weighting options for 
aspatial linear regression, although these weight values no longer have any functional 
dependence on location (spatial neighborhood).  Examples of when you might choose to use 
a weighting function in aspatial regression are described here.  We'll start the description of 
how regression is implemented with the general equation we have used to represent aspatial 
linear regression models, and then review the approach SpaceStat uses to obtain parameter 
estimates, sums of squares, R-squared, and p-values.   

 

Obtaining the parameter estimates 
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SpaceStat computes parameter estimates for linear regression using a maximum likelihood 
approach.  Used in this context, "likelihood" refers to the probability that the dependent 
variable can be predicted from the independent variable(s).  Given the probability function 
for a single observation, we can write the joint probability function (likelihood function) as a 
product of the individual probabilities.  In the following equations, the brackets around the 
beta, which symbolizes the regression coefficients, indicates that we are estimating two or 
more regression coefficients. 

  

Next, we need to define the probability function for the individual observations (on the right 
side of our equation above), which is shown below.  For linear regression, probability 
densities are normally distributed (Gaussian), with a zero mean for the residuals and a 
variance which can differ between observations (note the "i" subscript for the variance 
components of the equation).  Recall that the symbol  (pi), represents a constant 
(approximately 3.14).   

 

To estimate parameter values, we use -2 times the logarithm of the Likelihood, because this 
form has properties that facilitate the likelihood estimation process.  In addition to making 
this change, we also change how the variance is expressed to allow the incorporation of 
weights.  Recall we are focused here on aspatial regression, but the formulation here parallels 
that for geographically weighted regression, and can accommodate non-spatial weights.  The 
variance in the equation above can vary by observation; in the equation below, we have 
replaced the original variance expression with one that includes a constant variance and a 
weighting factor that varies by observation (see highlighted part of the equation).  Thus, we 
can now think of the non-constant variance as being equivalent to a weighting factor that 
varies by observation times a constant variance. 

286 



SpaceStat 4.0 Documentation 

 

To solve for the regression coefficients (parameter estimates), SpaceStat finds values for 
these coefficients that minimize the weighted sum of squares.  The actual computation of the 
parameter estimates involves operations on a suite of matrices and vectors, and is 
summarized below.  Note that X with the superscript "T" refers to the transposed X matrix.    

 

Referring back to the regression equation above, the independent variable observation matrix 
X is regarded as a fixed quantity linking the random error (assumed to have a mean of 0 and a 
variance ) with the observed values of the dependent variable Y, and with the regression 
coefficients.  Hence, the mean value and standard error of the regression parameters can be 
obtained in terms of the regression parameters themselves, the inverse of the combination 
(XTWX)-1 and the error variance .  The expected value of the dependent variable at each 
location comes from the product of the independent variable matrix and the vector of the 
least squares regression coefficients.  These expected values of y are then used to calculate 
the residual sum of squares and total sum of squares (see below).   

Evaluating the model:  Calculating sums of squares 

As described above, after obtaining the parameter estimates, SpaceStat calculates the 
estimated mean, standard error, and residual error for the dependent variable (y) at each 
observation.  These values are then used to calculate the residual sum of squares (RSS) and 
the total sum of squares (TSS) using the formulas below.  Recall that "N" is the number of 
observations, and "M" is the number of independent variables. In the TSS formula, the y-bar 
term represents the mean value of the dependent variable observations.   
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Model R-squared and adjusted R-squared values 

The residual sum of squares and the total sum of squares are used to calculate the model R-
squared value, an overall measure of the strength of the association between the model 
developed using the independent variables, and the observed values of the dependent variable 
y.  Along with R-squared, SpaceStat also reports an adjusted R-squared value.  The adjusted 
R-square is a measure of model fit that allows you to compare across models with the same 
dependent variable using different numbers of independent variables.  The adjustment 
involves multiplying the R-squared value by the ratio of the number of observations, N, 
divided by N-M (1 is subtracted from both, as shown below).  As the number of observations 
increases, especially for models with a small number of predictor variables, the difference 
between the R-squared and adjusted R-squared values will approach zero. 

 

Significance of the regression model 

The significance of the overall model is assessed by calculating the F-value (see formula 
below), and then comparing that test statistic to values from an F distribution.  Higher F-
values are associated with lower p-values.  In other words, if your independent variables 
explain a large proportion of the variance in your dependent variable (i.e., small residual 
variance), your calculated F-value will be high, and will be associated with a low probability 
of having attained this F-value by chance.  The p-value reported by SpaceStat should then be 
compared to your pre-set alpha level (typically 0.05).  If the p-value is smaller than your 
alpha, you can conclude that your model provides reliable predictions of the dependent 
variable.  However, if your model includes more than one independent variable, this result 
does not help you to understand the relative importance of each in making reliable 
predictions. 
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The ANOVA table   

In addition to reporting the significance of the model as a whole, SpaceStat also uses an 
Analysis of Variance (ANOVA) approach to evaluate the importance of individual terms 
within the regression model.  Specifically, SpaceStat calculates the Type III (Marginal) Sum 
of Squares.   The Type III sum of squares for a term in the model equals the residual sum of 
squares (RSS) for the full model without that term minus the RSS for the full model, divided 
by the degrees of freedom for that term to get the Type III Mean square.  In other words, this 
method allows you to assess the effect of individual terms in the regression model by 
comparing the effect of including them in the full model to the result obtained (in terms of 
model fit) without that term.  An example ANOVA table is shown on the linear regression 
output page. 

Note that for continuous variables, your degrees of freedom will be 1, but you may have 
higher degrees of freedom with categorical variables (number of categories - 1).   Once 
SpaceStat has calculated the Type III mean square for a regression term, it then normalizes 
this value by the mean square error, producing a Type III F-value.  As described above for 
the model as a whole, these "term-specific" F-values are compared to a reference F 
distribution to calculate p-values.  For categorical variables (even those appearing in products 
with other variables), the individual category values are combined together into one term in 
the ANOVA table.  When the p-value for a specific term is smaller than your alpha value, 
you can conclude that term makes a significant contribution to your regression model.   

Some software programs offer different approaches for calculating the sums of squares.  In 
most cases that are likely to be of interest to SpaceStat users, the Type III approach is 
appropriate.   However, in some special cases, such as if you are working with categorical 
data from a nested sampling design, another ANOVA approach (e.g., Type 1 or Type II) may 
be more appropriate.  If this is the case with your data, you should consider using a software 
package that is more specifically tailored to ANOVA so that you can choose your sum of 
squares calculation method. 

Significance of individual terms in the regression model 

Having obtained the parameter estimates through the Maximum Likelihood estimation 
procedure, the individual significance of each can be obtained by using the regression matrix 
to relate their standard errors to the model's error variance.  As the parameter is obtained as a 
sample estimate, a t-distribution with N-M-1 degrees of freedom is used to obtain the 
individual parameter estimate p-values.  Click here to see an example of a table of parameter 
estimates from the linear regression output page. 

  

  

Perform Aspatial Regression 
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Aspatial regression methods are located under Methods -> Regression -> Aspatial regression. 
 You choose among the various types of regression (linear, Poisson, and logistic) within the 
regression settings page of the Task Manager.  Note that methods for setting up and running 
a forward stepwise, backward stepwise, or best subset regression analysis are almost exactly 
the same as those shown here, but we repeat these instructions on the "Perform" page for 
those methods using a different dataset. 

In this example, we are working with a set of smoothed cervix cancer data rates aggregated at 
the county level for states in the western U.S.  We will demonstrate creating and running a 
regression model with three independent variables: percent of the population that is Hispanic, 
the percent of the population that does not have health insurance (Noins), and a categorical 
dataset that describes the ratio of the general population to the number of doctors (MDratio). 
 As the percent uninsured may show a pattern that varies across ethnic groups, our model 
also includes the interaction between "HISPANIC" and "Noins."   

Creating and managing regression models 

When the task manager opens for Aspatial regression, it will start on the "Regression 
models" section.  Here, you must choose your geography (if your project contains more than 
one), and then indicate whether you would like to create, modify, or delete a regression 
model.  You can create a suite of models that all share the same geography, dependent 
variable, and form (linear, Poisson, or logistic) within one Aspatial regression "tab" in the 
task manager, and these will all appear with the default name "Regression model" on this 
page, unless you change the name (see below).  To modify an existing model, highlight it, 
and then hit the "Modify" button.  Similarly, select a model and then click on delete to 
remove it from the list.  Additional models can be created and saved, and they will all be 
listed in this window.  Note that if you choose the regression method again from the methods 
pull down window, a new regression tab will appear, and will list the same suite of models 
(note the two tabs shown below).  You can delete this extra tab without losing your saved 
models. 

Defining a new regression model 

When you click on the "Create" button in the initial task manager page for Aspatial 
regression, a dialog will open where you define the dependent and independent variables that 
will be included in your regression model.  You can also use the instructions below to modify 
a model you have already created. 

Click on the boxes below for brief definitions, and for links to detailed information on 
defining the terms in your model. 
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Selecting model terms. 

The window titled "Independent variables" lists all of the datasets associated with the 
geography that you selected in the first task manager window for regression.  To use one or 
more of these datasets as a term in your model, click on it to select it.  To select more than 
one dataset (for adding an interaction term), hold down the "Ctrl" button as you click on 
each.  When the dataset name is selected, you can then use the buttons on the right to add that 
dataset as a linear term (i.e., as an "x"), as a squared term (i.e., as an x2), or as part of an 
interaction term in which it will be multiplied by one or more other independent variables.  In 
the example above, we have selected the three linear terms (HISPANIC, Noins, and 
MDratio), and included the HISPANIC dataset in an interaction terms with Noins (percent 
uninsured).  As you add various terms, they will appear in the three boxes in the center of the 
task manager window.  You can delete terms that you have created by selecting them and 
then using the delete button on your keyboard. 

Categorical variables:  Select the reference value and parameterization type. 

Directly below the windows where the regression model terms are listed is a section that only 
applies to categorical variables; in this area you will choose a reference value and a 
parameterization type (coding system).  These options are explained in detail in the help 
section on categorical data in regression.  To fill in these options for your categorical 
variables, first select the categorical dataset ("MD_Ratio_CAT" in the example above). 
 When a categorical dataset is selected, you will be able to scroll through the names of the 
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categories within that set in the box to the left of "Reference value for...".  Next, for that same 
categorical dataset, you choose a reference cell or effect cell approach to coding by clicking 
on the respective circle to the left of your choice.  If you have more than one categorical 
term, including interaction terms that incorporate a categorical dataset, you will need to 
repeat this process for all of these terms.  If you forget to do this step, SpaceStat will run the 
model using the default settings of the middle category as the reference value, with the 
reference cell parameterization type. 

Fix intercept at zero check box. 

Check this box if you want to force your linear regression model through the origin (0,0). 
 This option should not be applied to Poisson or logistic regression, or to linear regression 
with only categorical terms.  If you do check the box with a Poisson or logistic model, or for 
a model with categorical terms, SpaceStat will proceed as if the box had not been checked. 
 Note that if you have chosen to fix your intercept at zero, SpaceStat will report the R2 for 
this "no intercept" model as "-".  This is because calculations of R2 in the no-intercept models 
tend to be larger than models with an intercept, or in some cases can be negative.  Details on 
this topic are presented in Kutner et al. 2004. 

After you have finished creating or modifying your regression model, click "ok" to return to 
the first page of the task manager for regression, and then click on the "Regression settings" 
tab to complete the process of defining your model.   

Regression settings. 

After you have identified the datasets to be used in your model, you will need to define other 
settings, including the regression type (linear, Poisson, or logistic), any weight sets you 
would like to use, and the time settings.  When you have completed this page, click on the 
last section, "Run Method".  Recall that here we are demonstrating runs of the exact model 
you specified ("Full model"), but click on best subset model selection tools, or stepwise 
methods to switch over to this set of instructions. 

Click on boxes within the image below for more information. 
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Run Method 

When you click on "Run Method", the task manager will present a summary of the model 
you have just created or modified.  If you agree with the model definition that appears in this 
window, then click on the "Run" button at the bottom of the window to run the model.  Note 
that the information shown here will be repeated in the log at the beginning of your Aspatial 
regression output. 
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Now that you have run the model, look in the log view to see your results.  There are some 
variations in the output presented for the various model types; pick one of the following links 
to see example output for linear, Poisson, and logistic models, respectively. 

  

  

Aspatial Linear Regression Output 

Here, we will show the output from the model we used to illustrate running a regression 
model on the "Perform" page.  The only change we have made from the previous description 
is that we have added the word "Linear" to the model title and to the name of the output 
folder to help us differentiate them from models and output using the other two model types. 
  

Summary of the model run 

After clicking to the run method page and then selecting "Run", we see the following output 
in the log view, beginning with the summary of the model run. 
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Fit and significance of the model as a whole 

Below the review of the model run information, SpaceStat presents the summary of the 
predictive ability and significance of the model as a whole for the first time period.  The 
dataset described here only includes one time period, but if you analyzed a set with several 
time periods, you would see several sets of output, separated by date. 

 

Specifically, SpaceStat lists the model R-squared and adjusted R-squared values, which are 
measures of the strength of the model's predictive ability.  Recall from the "perform" page 
that if you have chosen to fix your intercept at (0,0), SpaceStat will report the R2 for your "no 
intercept" model as "-".  These R-squared measures, and the method used to calculate the 
significance of the full model, are described under Model R-squared, and Significance, 
respectively, on the Implementation of Linear Regression page.  Note that significance values 
in regression output are reported as "0.0" if they are smaller than 0.000001 (see the "P value", 
above).  Thus, the results shown here indicate that our model does a respectable job of 
predicting cervix cancer risk, with an R-square of 0.44.  The model is also highly significant, 
with a p-value less than 0.000001.   

The ANOVA table 

The next item in the output is the Analysis of Variance, or ANOVA table, which allows us to 
evaluate the importance of each individual term in building up the regression model.  This 
first column of this table ("Source") lists all of the terms included in your model - recall this 
model of cervix cancer risk included three linear terms, the percent of the population that is 
Hispanic, the percent of the population that does not have health insurance (Noins), the ratio 
of the general population to the number of doctors (MDratio, categorical). and the interaction 
between "HISPANIC" and "Noins." 
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The next column, labeled "D.F." presents the degrees of freedom associated with each term. 
 This value is one for each continuous variable, and for interactions between two or more 
continuous variables.  For categorical variables, the degrees of freedom equals the number of 
categories minus one (our levels for "MD_Ratio" are high, medium, and low).  The degrees 
of freedom for an interaction term is calculated by multiplying the degrees of freedom from 
each component.  The next two columns, Type III SS (sum of squares) and Mean Square, are 
used to determine an F-value, which is compared to an F-distribution to calculate the p-value 
(last column); this is described in more detail on the implementation page.   This p-value 
represents the probability of obtaining an F-value as extreme as the test statistic by chance 
alone, under the null hypothesis of no effect of the term on the dependent variable (cervix 
cancer risk).  In this example, the first two linear terms are significant (in reference to an 
alpha of 0.05), but the MDratio term is not, and the interaction term is just above the 0.05 
cut-off, with a p-value of 0.065. 

Significance of individual model parameters 

The next table in the output for aspatial linear regression provides the parameter estimates, 
standard errors, and p-values for each parameter in the model.  See the implementation page 
for a description of how the p-values are derived.  Note that as described on the categorical 
variables in regression analyses page, a parameter is estimated for each level of a categorical 
variable, except for the level that is chosen as the reference value (we chose "medium"). 

 

Looking at the p-values, we see that in addition to the significant terms identified from the 
ANOVA table, the model intercept is also significant.  For the continuous variables, the p-
values are the same as in the ANOVA table, but individual parameter estimates and p-values 
are shown for the two non-reference values for the categorical variable, MD_Ratio_CAT. 

Table of correlation coefficients 
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Finally, the last table produced as part of the output for aspatial linear regression shows the 
correlation coefficient for each pair of numeric variables in your model.  This is helpful for 
understanding how different independent variables are related, and can be used to identify 
terms that could be dropped from the model due to high correlation with other terms 
(colinearity).   

 

In this example, all of the correlations between the pairs of continuous independent variables 
is low, 0.18.  Recall that CERVIX-RIS is the name of our dependent variable, smoothed 
cervix cancer risk. 

Note that these values may differ from correlation coefficients presented in the graph 
statistics window due to the effect of missing values.  In the case of the regression model, the 
correlation will not include data from ANY of the variables at observations where one or 
more value is missing, while only missing values in the two datasets being compared will 
influence the correlation coefficient in the graph statistics window in a scatter plot. 

  

Aspatial Regression - Logistic 

  

About Aspatial Logistic Regression 

Logistic regression is a form of generalized linear models that has been developed 
specifically for predicting the value of dependent variables that are binary (categorical with 
two possible values) such as yes/no, male/female, presence/absence, or diseased/healthy 
response variables.  Independent variables in a logistic regression can be continuous and/or 
categorical, and you can also include interaction effects and weights in your model.  Note 
however that some combinations of categorical variables lead to overspecified models, so 
read the categorical variables page so that you know what to avoid when defining your 
model.  Assumptions of logistic regression models include (1) independent observations; and 
that (2) independent variables are linearly related to the log odds (logit) of the dependent 
variable. 

To perform logistic regression, data must be coded as 0 or 1 (of type numeric, not string). 
 The mean of the sample is equal to the proportion of 1s in the sample, and this mean is also 
the probability of drawing a case labeled as 1 at random from your data.  Examples of 
applications include a model to predict probability of disease incidence (yes or no on a per-
individual basis), with groundwater contamination level as an independent variable, or a 
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model to predict the sex of birds (for species where it is not readily apparent) based on 
measurements of weight, and wing and bill length.   

As is true for simple linear regression, the goal is to model a relationship between the 
independent (predictor) variable(s) and the dependent (response) variable.  More specifically, 
the goal for logistic regression is to predict the category for the dependent variable from the 
suite of independent variables that provides the best balance between model performance and 
model complexity.  However, rather than directly estimating the category of the response 
variable at a given value of the predictor, for logistic regression, you estimate the probability 
that an observation has a code of 1.  Specifically, this tool predicts the log odds that an 
observation will be a 1 (probability = P) rather than a 0 (probability = 1 - P).   Because all of 
the y values in your dataset are either 0 or 1, scatterplots such as the one shown in the 
description of linear regression are not very useful for binary data.  Instead, you might do a 
histogram of the frequency of "1s" in your dataset, and a curve fit to your graph would have 
an expected shape similar to the logistic curve shown below. 

 

A general equation for logistic regression 

In SpaceStat' logistic regression, the relationship between the independent variable(s) and the 
probability that observations of your dependent variable will be coded 1 is described with a 
logistic curve of the form shown above.  Note that the regression coefficients, which are the 
parameters that you are trying to estimate during the regression procedure, are part of a 
power function that controls the shape of the logistic curve.  SpaceStat uses maximum 
likelihood estimation to work with this transformed variable (transformed from the 1s and 0s 
to a logit variable - the natural log of the odds of the dependent variable being coded 1). 
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Click here to compare this formula to the one for linear regression. 

Output for logistic regression 

Similar to linear regression, SpaceStat output for logistic regression includes calculation of 
two pseudo R-squared values that describe the strength of the model as a whole, and 
significance values (p-values) for the whole model, and for individual terms in the model. 
 The output is described in more detail here, including examples from the SpaceStat log 
view. 

To find out more about how logistic regression is implemented in SpaceStat, click here. 

To skip the details and learn about how to perform aspatial logistic regression, click here. 

  

  

Implementation of Logistic Regression 

As described here in the overview of logistic regression, the goal of this statistical tool is to 
parameterize a non-linear relationship between one or more independent variables, and the 
probability that a binary variable will be coded as 1 rather than 0 (e.g., the data value is yes 
rather than no, or diseased rather than without disease).  This statistical tool uses the logit as 
its link function - the logit link function constrains the probability values (predictions of y) to 
a range from 0 - 1.  Some software packages offer variants of logistic regression that can be 
applied to nominal response variables with more than two categories, but these advanced 
methods are not currently implemented in SpaceStat. 
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Obtaining the parameter estimates 

For logistic regression in SpaceStat, the regression formulation is carried out in terms of 
maximum likelihood (L) estimation.  A "likelihood" is a probability (and must have a value 
within the range of 0 - 1); in this case the probability that the dependent variable can be 
predicted from the independent variables.  As indicated in the equation below, the maximum 
likelihood estimator uses a Bernoulli distribution to define a joint probability distribution 
from the individual dependent variable observations.   In the following equations, the 
brackets around the beta, which symbolizes the regression coefficients, indicate that we are 
estimating two or more regression coefficients. 

 

The goal of maximum likelihood estimation is to maximize the Log-Likelihood (lnL), which 
has a value between 0 and negative infinity (negative, because you are taking the log of a 
value that is less than 1). Maximum likelihood estimation is an iterative process.  Recall also 
from our overview that we are treating aspatial regression as a the "global" version of 
geographically-weighted regression; as a result, we need to account for weighting factors (w) 
in our estimation.  The weighted log-likelihoods for logistic regression can be obtained by 
raising each individual probability to the power of a weight factor, taking the product over 
observations, and then taking the logarithm. 

 

To estimate the regression coefficients, SpaceStat uses the Taylor expansion of the equation 
above, and then the maximum likelihood algorithm determines the direction and sign of 
changes in the regression coefficients which will increase the lnL.  After starting from an 
arbitrary set of coefficient estimates, the initial function is estimated and the residuals are 
evaluated.  From these results, the algorithm modifies the coefficient values, and generates a 
new set of residuals which are compared to previous values.  This process continues until 
there is little change in the lnL. There is a possibility that this process will not lead to 
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convergence due to what is called a "ridge-effect"; in this case, the Log-likelihood remains 
constant as coefficients are varied. 

Evaluating the model 

Overall model quality is assessed for logistic regression models using negative 2 times the 
natural log of the likelihood function (-2lnL); in general, as the model fit improves, -2lnL will 
decrease in magnitude.  Other names for -2lnL include the likelihood ratio, deviance chi-
square, and the model's measure of goodness of fit.  Values of -2lnL have approximately a 
chi-square distribution, and as a result this distribution is used for significance testing of the 
overall model.  In effect -2lnL plays the same role as the residual sum of squares (RSS) in 
linear regression (i.e., it reflects the unexplained variance between predicted and observed 
values).   The -2lnL value forms the basis of the likelihood ratio test (described below), 
which as the name suggests, is a significance test based on the difference between the 
likelihood ratios of two forms of a model. 

Measures of model fit 

For logistic regression, SpaceStat presents two calculations that play the role of R-squared in 
linear regression.  Thus, these values describe the strength of a particular suite of independent 
variables and coefficients as predictors of the log odds of obtaining a 1 at a particular 
value(s) of the independent variables. The first of these is the "Cox and Snell R-Squared", 
shown below.  As the -2lnL value for the "Full" model ("Intercept" refers to the intercept-
only model) increases, the Cox and Snell R-squared result will approach one. Since the result 
can never actually reach one, the "Nagelkerke R-Squared" is also shown; this descriptor takes 
Cox and Snell value and divides by the result with the model -2lnL set to zero. 

 

Significance of the full model: the model chi-square test 

For logistic regression a comparison is made between the value of -2lnL (likelihood ratio) of 
the full model and the likelihood ratio for a "worst model," defined as the model which fits 
the probability using a single constant value (the intercept only model).  The significance of 
the difference between these two values of -2lnL is then evaluated using a chi-square 
distribution with the full model degrees of freedom, minus 1 for the constant, to obtain a p-
value.  The p-value that is returned for this test can then be compared to your pre-set alpha 
value (typically 0.05).  A p-value that is smaller than your alpha indicates that the model you 
created is significantly better at predicting the log odds of obtaining "1" as your predicted 
value than a model based on just a constant value.  Another way to think of this test is as a 
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test of the null hypothesis that all of the regression coefficients in your model except for the 
constant equal zero. 

Significance of individual terms in the regression model 

For logistic regression, SpaceStat presents the parameter estimates, parameter standard errors 
and p-values (using a chi-squared distribution).  As described above for evaluating the 
significance of the entire logistic regression model, likelihood ratio tests are used to evaluate 
the significance of individual parameters in the model.  The basic idea of these significance 
tests is the same as the test of significance of the full model, except in this case the test is 
based on the difference in -2lnL for an overall model and a nested model where one 
independent variable has been dropped.  If the test for a particular parameter is not 
significant, this means that the coefficient for that variable can be considered not 
significantly different from zero, and that you can drop this variable from your model 
without a reduction in model performance.  Note that you can't use this approach to compare 
two non-nested models. 

  

  

Perform Aspatial Regression 

Aspatial regression methods are located under Methods -> Regression -> Aspatial regression. 
 You choose among the various types of regression (linear, Poisson, and logistic) within the 
regression settings page of the Task Manager.  Note that methods for setting up and running 
a forward stepwise, backward stepwise, or best subset regression analysis are almost exactly 
the same as those shown here, but we repeat these instructions on the "Perform" page for 
those methods using a different dataset. 

In this example, we are working with a set of smoothed cervix cancer data rates aggregated at 
the county level for states in the western U.S.  We will demonstrate creating and running a 
regression model with three independent variables: percent of the population that is Hispanic, 
the percent of the population that does not have health insurance (Noins), and a categorical 
dataset that describes the ratio of the general population to the number of doctors (MDratio). 
 As the percent uninsured may show a pattern that varies across ethnic groups, our model 
also includes the interaction between "HISPANIC" and "Noins."   

Creating and managing regression models 

When the task manager opens for Aspatial regression, it will start on the "Regression 
models" section.  Here, you must choose your geography (if your project contains more than 
one), and then indicate whether you would like to create, modify, or delete a regression 
model.  You can create a suite of models that all share the same geography, dependent 
variable, and form (linear, Poisson, or logistic) within one Aspatial regression "tab" in the 
task manager, and these will all appear with the default name "Regression model" on this 
page, unless you change the name (see below).  To modify an existing model, highlight it, 
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and then hit the "Modify" button.  Similarly, select a model and then click on delete to 
remove it from the list.  Additional models can be created and saved, and they will all be 
listed in this window.  Note that if you choose the regression method again from the methods 
pull down window, a new regression tab will appear, and will list the same suite of models 
(note the two tabs shown below).  You can delete this extra tab without losing your saved 
models. 

Defining a new regression model 

When you click on the "Create" button in the initial task manager page for Aspatial 
regression, a dialog will open where you define the dependent and independent variables that 
will be included in your regression model.  You can also use the instructions below to modify 
a model you have already created. 

Click on the boxes below for brief definitions, and for links to detailed information on 
defining the terms in your model. 

 

Selecting model terms. 

The window titled "Independent variables" lists all of the datasets associated with the 
geography that you selected in the first task manager window for regression.  To use one or 
more of these datasets as a term in your model, click on it to select it.  To select more than 
one dataset (for adding an interaction term), hold down the "Ctrl" button as you click on 
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each.  When the dataset name is selected, you can then use the buttons on the right to add that 
dataset as a linear term (i.e., as an "x"), as a squared term (i.e., as an x2), or as part of an 
interaction term in which it will be multiplied by one or more other independent variables.  In 
the example above, we have selected the three linear terms (HISPANIC, Noins, and 
MDratio), and included the HISPANIC dataset in an interaction terms with Noins (percent 
uninsured).  As you add various terms, they will appear in the three boxes in the center of the 
task manager window.  You can delete terms that you have created by selecting them and 
then using the delete button on your keyboard. 

Categorical variables:  Select the reference value and parameterization type. 

Directly below the windows where the regression model terms are listed is a section that only 
applies to categorical variables; in this area you will choose a reference value and a 
parameterization type (coding system).  These options are explained in detail in the help 
section on categorical data in regression.  To fill in these options for your categorical 
variables, first select the categorical dataset ("MD_Ratio_CAT" in the example above). 
 When a categorical dataset is selected, you will be able to scroll through the names of the 
categories within that set in the box to the left of "Reference value for...".  Next, for that same 
categorical dataset, you choose a reference cell or effect cell approach to coding by clicking 
on the respective circle to the left of your choice.  If you have more than one categorical 
term, including interaction terms that incorporate a categorical dataset, you will need to 
repeat this process for all of these terms.  If you forget to do this step, SpaceStat will run the 
model using the default settings of the middle category as the reference value, with the 
reference cell parameterization type. 

Fix intercept at zero check box. 

Check this box if you want to force your linear regression model through the origin (0,0). 
 This option should not be applied to Poisson or logistic regression, or to linear regression 
with only categorical terms.  If you do check the box with a Poisson or logistic model, or for 
a model with categorical terms, SpaceStat will proceed as if the box had not been checked. 
 Note that if you have chosen to fix your intercept at zero, SpaceStat will report the R2 for 
this "no intercept" model as "-".  This is because calculations of R2 in the no-intercept models 
tend to be larger than models with an intercept, or in some cases can be negative.  Details on 
this topic are presented in Kutner et al. 2004. 

After you have finished creating or modifying your regression model, click "ok" to return to 
the first page of the task manager for regression, and then click on the "Regression settings" 
tab to complete the process of defining your model.   

Regression settings. 

After you have identified the datasets to be used in your model, you will need to define other 
settings, including the regression type (linear, Poisson, or logistic), any weight sets you 
would like to use, and the time settings.  When you have completed this page, click on the 
last section, "Run Method".  Recall that here we are demonstrating runs of the exact model 
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you specified ("Full model"), but click on best subset model selection tools, or stepwise 
methods to switch over to this set of instructions. 

Click on boxes within the image below for more information. 

 

Run Method 

When you click on "Run Method", the task manager will present a summary of the model 
you have just created or modified.  If you agree with the model definition that appears in this 
window, then click on the "Run" button at the bottom of the window to run the model.  Note 
that the information shown here will be repeated in the log at the beginning of your Aspatial 
regression output. 
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Now that you have run the model, look in the log view to see your results.  There are some 
variations in the output presented for the various model types; pick one of the following links 
to see example output for linear, Poisson, and logistic models, respectively. 

  

  

Aspatial Logistic Regression Output 

For logistic regression, SpaceStat presents the parameter estimates, parameter standard errors 
and p-values (using a chi-squared distribution). In addition, the output includes the parameter 
odds ratio along with odds ratio confidence intervals. 

Here, we will show the output from a new model focused on predicting lung cancer risk in 
females in western counties.  Recall that as described in the "About" page for logistic 
regression, we need to use a dependent variable that is binary (takes a numeric "code" value 
of 1 or 0).  So, for the logistic model we have converted a continuous lung cancer risk dataset 
to a binary dataset (F_LUNG_ABOVE_26) by assigning a 1 to all observations with a risk of 
26 or higher (e.g., 26 cases per 100,000 people, roughly the median value for this dataset), 
and 0 to all lower risks observations.  We also have a new independent variable, 
"SmokevrF", which is the percent of females in the county that have ever smoked, and two of 
the same independent variables from our Cervix cancer example in the "Perform" page, 
"PoorCat", a categorical version of the proportion of the population with income below the 
federal poverty level, and MDratio, the ratio of population size to the number of doctors in 
each county.  In this model, we have not included a squared or interaction term, and have 
chosen the "medium" category in PoorCat as our reference value, with Reference cell as our 
Parameterization type. 
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Next, on the settings page, we chose "logistic" as our model type rather than "linear".  The 
only other change in how we performed the logistic regression compared to the linear cervix 
cancer example is that we added the word "Logistic" to the model title and to the name of the 
output folder to help us differentiate them from models and output using the other two model 
types.   

Summary of the model run 

After clicking to the run method page and then selecting "Run", we see the following output 
in the log view, beginning with the summary of the model run. 

 

Fit and significance of the model as a whole 
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Below the review of the model run information, SpaceStat presents the summary of the 
predictive ability and significance of the model as a whole for the first time period.  The 
dataset described here only includes one time period, but if you analyzed a set with several 
time intervals, you would see output for each period. 

 

The first table in the output for logistic regression presents the -2Log-Likelihood table, which 
plays the same role as the sum of squares in linear regression.  The first data column in this 
table shows the value for the Intercept only model, which is similar to the total sum of 
squares in linear regression; the second data column shows the result for the Full model, 
which is akin to linear regression's residual sum of squares.  The difference between these is 
used in a Likelihood Ratio test (the third small table shown in the output, above) to determine 
the significance of the overall model; the p-value for this test is determined from a chi-
squared distribution. 

Like the model R-squared and adjusted R-squared values in aspatial linear regression, output 
for logistic regression includes two measures of the strength of the model's predictive ability: 
the Cox & Snell and Nagelkerke R-squared values.  Thus, the results shown here indicate that 
our model does a reasonable job (with room for improvement) of predicting the log-odds of a 
county having a lung cancer rate above our threshold, with fit values of 0.23 (Cox and Snell) 
and 0.31 (Nagelkerke).  The Likelihood Ratio test (bottom table) is highly significant, with a 
p-value of 0.000003 (note that p-values in regression output are reported as "0.0" if they are 
smaller than 0.000001). 

Significance of individual model parameters 

The next table in the output for aspatial logistic regression provides the parameter estimates, 
standard errors, p-values, odds ratios, and 95% Confidence Intervals (C.I.) for each 
parameter in the model.  See the implementation page for a description of how the P-values 
are derived.  Note that as described in the page on categorical variables in regression, a 
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parameter is estimated for each level of a categorical variable, except for the level that is 
chosen as the reference value.   In SpaceStat, the Odds ratios for categorical variables are 
presented relative to the category chosen as the reference value, so if, for example, you chose 
the lowest category as your reference value, they may appear unusually large if you are used 
to interpreting output from other software programs that calculate odd relative to the "mean" 
category. 

 

This p-value represents the smallest level of significance that would lead to rejection of the 
null hypothesis that the parameter estimate equals zero.  Similar to what we found in the 
linear regression output, here the intercept and the two continuous variables are significant, 
with the smoking-related variable having the highest p-value.  Neither of the parameter 
estimates for our categorical variable, PoorCat, was signficant. The next column to the right 
of the p-value shows the Odds ratio, which is the regression parameter exponentialized.  The 
95% Confidence Intervals are obtained from the regression parameters' standard error. 

Table of correlation coefficients 

Finally, the last table produced as part of the output for aspatial logistic regression shows the 
correlation coefficient for each pair of numeric variables in your model.  This is helpful for 
understanding how different independent variables are related, and can be used to identify 
terms that could be dropped from the model due to high correlation with other terms 
(colinearity).   

 

In this example, there is a only a 0.22 correlation between MDratio and SmokevrF; this level 
of relationship would likely not raise the "red flag" of colinearity. 

Note that these values may differ from correlation coefficients presented in the graph 
statistics window due to the effect of missing values.  In the case of the regression model, the 
correlation will not include data from ANY of the variables at observations where one or 
more value is missing, while only missing values in the two datasets being compared will 
influence the correlation coefficient in the graph statistics window in a scatter plot. 
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Aspatial Regression - Poisson 

  

About Aspatial Poisson Regression 

Poisson regression is a form of generalized linear models that assumes that your data follow 
a Poisson distribution.  This distribution describes the probability of events occurring in time 
or space when the pattern of these occurrences is random, and is often a good fit for count 
and rate data.  With Poisson regression, you are building a model to estimate a count or rate 
using relationships between your independent (predictor) variable(s) and the expected value 
of your Poisson variable.  Example applications include models to predict counts of the 
number of people visiting a hospital emergency room at different times of day, or to predict 
rates, such as death rate (count of deaths divided by person-years) from independent data on 
contaminant concentrations.  Independent variables in a Poisson regression can be continuous 
and/or categorical, and you can also include interaction effects and weight variables in your 
model.  Note however that some combinations of categorical variables lead to overspecified 
models, so read that page so that you know what to avoid when defining your model. 
 Assumptions of Poisson regression models include (1) independent observations; and (2) 
independent variables are linearly related to the log of the dependent variable. 

The Poisson distribution 

A Poisson random variable has a probability density function, f(y), that can be described by 
the following formula: 

 

Here the parameter lambda is the estimated value of y, e is the natural log, and the 
denominator of the equation is y factorial (!), or yi multiplied by (yi - 1), (yi - 2),... 2, 1.   

The shape of the Poisson distribution varies with the expected value per interval (in space or 
time) of occurrences of the event that is being counted.  Small expected values, such as 1, 
show a highly skewed distribution, while distributions for higher expected values appear 
more symmetrical.  This pattern is illustrated below for three datasets with expected values 
per interval of 1 (blue), 2 (red), and 4 (orange). Recall that the values that can be observed 
are all integers, so consider the lines connecting the points in the figure below as just a way 
to visualize the shape of the distribution; they do not indicate a continuous function. 
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A key characteristic of this distribution is that it's mean and variance are equal, so this is an 
important first check to apply to your data to help you decide if a Poisson model would be 
appropriate.  In addition to this check, data that can be characterized with a Poisson 
distribution have several traits that makes applying traditional linear regression inappropriate. 
 First, their distribution may be skewed towards small values, as described above and shown 
in the figure.  For example, this tool is often applied to counts of territorial animal species, 
where the number of individuals observed at a count location is usually zero or one because 
territory owners keep others out of the defended space.  However, a binary variable (as used 
in logistic regression) would not be appropriate, because where individuals interact in space, 
like at territory boundaries, you may record counts of 2, 3, 4, and so on.  A second 
characteristic of data for which a Poisson distribution provides a better fit than traditional 
regression (Gaussian) is non-symmetric distribution of errors.  The Poisson distribution takes 
only positive values, while negative values are fine in simple linear regression.  Finally, the 
variance of a Poisson distribution increases as the mean increases, violating the simple linear 
regression assumption of homoscedasticity. 

A general equation for aspatial Poisson regression 

The general equation for Poisson regression uses a Poisson probability distribution for the 
individual dependent variable observations.  The equation differs from traditional regression 
in that the left hand side is the logarithm of the expected value (or mean, symbolized as ) of 
the dependent variable’s response – note that this is the same expected value that 
parameterizes the Poisson distribution function, as illustrated in the figure above. 

 

Output from Aspatial Poisson regression 

SpaceStat output from Poisson regression includes calculation of model deviance, which 
measures the fit of the model as a whole, p-values for the whole model, and p-values for 
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individual terms in the model.  The output is described in more detail here, including 
examples from the SpaceStat log view. 

To find out more about how aspatial Poisson regression is implemented in SpaceStat, click 
here. 

To skip the details and learn about how to perform Poisson regression, click here. 

  

  

Implementation of Poisson Regression 

As described here in the overview of Poisson regression, the goal of this statistical tool is to 
parameterize a relationship between one or more independent variables, and the expected 
value (mean) of a discrete (integers only) dependent variable that follows a Poisson 
distribution.  This statistical tool uses the log as its link function; taking the log of the 
function produces a linear combination of predictors, so again this is a form of linear model. 
 The log link funtion also constrains the expected values to positive numbers.  As shown in 
the overview of Poisson regression, a general formula can be written as: 

 

Obtaining the parameter estimates 

For  regression in SpaceStat, the regression formulation is carried out in terms of maximum 
likelihood (L) estimation.  A "likelihood" is a probability (and must be have a value within 
the range of 0 - 1); in this case the probability that the dependent variable can be predicted 
from the independent variables.  As indicated in the equation below, the maximum likelihood 
estimator uses a Poisson distribution to define a joint probability distribution from the 
individual dependent variable observations.   In the following equations, the brackets around 
the beta, which symbolizes the regression coefficients, indicate that we are estimating two or 
more regression coefficients. 
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The goal of maximum likelihood estimation is to maximize the Log-Likelihood (lnL), which 
has a value between 0 and negative infinity (negative, because you are taking the log of a 
value that is less than 1). Maximum likelihood estimation is an iterative process.  Recall also 
from our overview that we are treating aspatial regression as a the "global" version of 
geographically-weighted regression; as a result, we need to account for weighting factors (w) 
in our estimation.  The weighted log-likelihoods for logistic regression can be obtained by 
raising each individual probability to the power of a weight factor, taking the product over 
observations, and then taking the logarithm. 

 

To estimate the regression coefficients, SpaceStat uses the Taylor expansion of the equation 
above, and then the maximum likelihood algorithm determines the direction and sign of 
changes in the regression coefficients which will increase the lnL.  After starting from an 
arbitrary set of coefficient estimates, the initial function is estimated and the residuals are 
evaluated.  From these results, the algorithm modifies the coefficient values, and generates a 
new set of residuals which are compared to previous values.  This process continues until 
there is little change in the lnL. There is a possibility that this process will not lead to 
convergence due to what is called a "ridge-effect"; in this case, the Log-Likelihood stays 
constant as coefficients are varied. 

Evaluating the full model 

To evaluate the significance of the full Poisson regression model, SpaceStat presents the 
difference (deviance) between the log-likelihood of the full model and that of a "perfectly-
fitted" model in which the Poisson mean at each observation is set equal to the observed 
value. The deviance is divided by the number of degrees of freedom and this quotient is then 
compared with unity to judge the goodness of fit.  An example of the output table showing 
the deviance value is shown here.  Values for deviance/DF that are greater than 1 indicate 
that the variance is larger than the mean (overdispersion), while values smaller than one 
suggest the true variance is smaller than the mean (underdispersion).  Strong evidence of 
either over- or underdispersion suggests that a Poisson model is not a good fit for your data. 

Significance of individual terms in the Poisson regression model 

For Poisson regression, SpaceStat presents the parameter estimates, parameter standard errors 
and p-values (using a chi-squared distribution); click here to see an example.  Likelihood 
ratio tests are used to evaluate the significance of individual parameters in the model.  The 
basic idea of these significance tests is the same as the test of significance of the full model, 
except the tests are based on the difference in -2lnL for an overall model and a nested model 
where one term has been dropped.  If the test for a particular parameter is not significant, this 
means that coefficient for that variable can be considered to not be significantly different 
from zero, and that you can drop this variable from your model without a reduction in model 
performance.   
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Perform Aspatial Regression 

Aspatial regression methods are located under Methods -> Regression -> Aspatial regression. 
 You choose among the various types of regression (linear, Poisson, and logistic) within the 
regression settings page of the Task Manager.  Note that methods for setting up and running 
a forward stepwise, backward stepwise, or best subset regression analysis are almost exactly 
the same as those shown here, but we repeat these instructions on the "Perform" page for 
those methods using a different dataset. 

In this example, we are working with a set of smoothed cervix cancer data rates aggregated at 
the county level for states in the western U.S.  We will demonstrate creating and running a 
regression model with three independent variables: percent of the population that is Hispanic, 
the percent of the population that does not have health insurance (Noins), and a categorical 
dataset that describes the ratio of the general population to the number of doctors (MDratio). 
 As the percent uninsured may show a pattern that varies across ethnic groups, our model 
also includes the interaction between "HISPANIC" and "Noins."   

Creating and managing regression models 

When the task manager opens for Aspatial regression, it will start on the "Regression 
models" section.  Here, you must choose your geography (if your project contains more than 
one), and then indicate whether you would like to create, modify, or delete a regression 
model.  You can create a suite of models that all share the same geography, dependent 
variable, and form (linear, Poisson, or logistic) within one Aspatial regression "tab" in the 
task manager, and these will all appear with the default name "Regression model" on this 
page, unless you change the name (see below).  To modify an existing model, highlight it, 
and then hit the "Modify" button.  Similarly, select a model and then click on delete to 
remove it from the list.  Additional models can be created and saved, and they will all be 
listed in this window.  Note that if you choose the regression method again from the methods 
pull down window, a new regression tab will appear, and will list the same suite of models 
(note the two tabs shown below).  You can delete this extra tab without losing your saved 
models. 

Defining a new regression model 

When you click on the "Create" button in the initial task manager page for Aspatial 
regression, a dialog will open where you define the dependent and independent variables that 
will be included in your regression model.  You can also use the instructions below to modify 
a model you have already created. 

Click on the boxes below for brief definitions, and for links to detailed information on 
defining the terms in your model. 
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Selecting model terms. 

The window titled "Independent variables" lists all of the datasets associated with the 
geography that you selected in the first task manager window for regression.  To use one or 
more of these datasets as a term in your model, click on it to select it.  To select more than 
one dataset (for adding an interaction term), hold down the "Ctrl" button as you click on 
each.  When the dataset name is selected, you can then use the buttons on the right to add that 
dataset as a linear term (i.e., as an "x"), as a squared term (i.e., as an x2), or as part of an 
interaction term in which it will be multiplied by one or more other independent variables.  In 
the example above, we have selected the three linear terms (HISPANIC, Noins, and 
MDratio), and included the HISPANIC dataset in an interaction terms with Noins (percent 
uninsured).  As you add various terms, they will appear in the three boxes in the center of the 
task manager window.  You can delete terms that you have created by selecting them and 
then using the delete button on your keyboard. 

Categorical variables:  Select the reference value and parameterization type. 

Directly below the windows where the regression model terms are listed is a section that only 
applies to categorical variables; in this area you will choose a reference value and a 
parameterization type (coding system).  These options are explained in detail in the help 
section on categorical data in regression.  To fill in these options for your categorical 
variables, first select the categorical dataset ("MD_Ratio_CAT" in the example above). 
 When a categorical dataset is selected, you will be able to scroll through the names of the 
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categories within that set in the box to the left of "Reference value for...".  Next, for that same 
categorical dataset, you choose a reference cell or effect cell approach to coding by clicking 
on the respective circle to the left of your choice.  If you have more than one categorical 
term, including interaction terms that incorporate a categorical dataset, you will need to 
repeat this process for all of these terms.  If you forget to do this step, SpaceStat will run the 
model using the default settings of the middle category as the reference value, with the 
reference cell parameterization type. 

Fix intercept at zero check box. 

Check this box if you want to force your linear regression model through the origin (0,0). 
 This option should not be applied to Poisson or logistic regression, or to linear regression 
with only categorical terms.  If you do check the box with a Poisson or logistic model, or for 
a model with categorical terms, SpaceStat will proceed as if the box had not been checked. 
 Note that if you have chosen to fix your intercept at zero, SpaceStat will report the R2 for 
this "no intercept" model as "-".  This is because calculations of R2 in the no-intercept models 
tend to be larger than models with an intercept, or in some cases can be negative.  Details on 
this topic are presented in Kutner et al. 2004. 

After you have finished creating or modifying your regression model, click "ok" to return to 
the first page of the task manager for regression, and then click on the "Regression settings" 
tab to complete the process of defining your model.   

Regression settings. 

After you have identified the datasets to be used in your model, you will need to define other 
settings, including the regression type (linear, Poisson, or logistic), any weight sets you 
would like to use, and the time settings.  When you have completed this page, click on the 
last section, "Run Method".  Recall that here we are demonstrating runs of the exact model 
you specified ("Full model"), but click on best subset model selection tools, or stepwise 
methods to switch over to this set of instructions. 

Click on boxes within the image below for more information. 
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Run Method 

When you click on "Run Method", the task manager will present a summary of the model 
you have just created or modified.  If you agree with the model definition that appears in this 
window, then click on the "Run" button at the bottom of the window to run the model.  Note 
that the information shown here will be repeated in the log at the beginning of your Aspatial 
regression output. 
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Now that you have run the model, look in the log view to see your results.  There are some 
variations in the output presented for the various model types; pick one of the following links 
to see example output for linear, Poisson, and logistic models, respectively. 

  

  

Aspatial Poisson Regression Output 

SpaceStat output from Poisson regression includes calculation of model deviance, which 
measures the fit of the model as a whole, and p-values for the whole model, and p-values for 
individual terms in the model. 

Here, we will show the output from a model similar to the one used to illustrate running a 
regression model on the "Perform" page of the help.  However, as described in the "About" 
page for Poisson regression, we will now use a Poisson distribution to fit our model, so we 
want to apply the model to a dataset that comes close to meeting the assumption of having 
equal mean and variance.  So, in this case an unsmoothed set of cervix cancer risk data 
(CERVIX) was used instead of the smoothed set shown on the "Perform" page (CERVIX-
RIS).  Otherwise, the "Regression Model" and "Define Model" pages for Aspatial regression 
within the Task manager would look the same as the example, although we changed the 
name of the model to "CERVIX CANCER - POISSON.  Next, on the settings page, we chose 
"Poisson" as our model type rather than "linear".  The only other change in how we 
performed the Poisson regression is that we added the word "Poisson" to the output folder to 
help us differentiate our output files from those produced with the other model types.   

Summary of the model run 

318 



SpaceStat 4.0 Documentation 

After clicking to the run method page and then selecting "Run", we see the following output 
in the log view, beginning with the summary of the model run. 

 

Fit and significance of the model as a whole 

Below the review of the model run information, SpaceStat presents information on the model 
fit, and the model Log Likelihood value, for the first time period.  The dataset described here 
only includes one time period, but if you analyzed a set with several time intervals, you 
would see output for each period. 

As described in the "Implementation" page for Poisson regression, to evaluate the 
significance of the full Poisson regression model, SpaceStat presents the difference 
(deviance) between the log-likelihood of the full model and that of a "perfectly–fitted" model 
in which the Poisson mean at each observation is set equal to the observed value. The 
deviance is divided by the number of degrees of freedom and this quotient is then compared 
with unity (1) to judge the goodness of fit.  (Recall that in a Poisson distribution, the mean 
and the variance are equal, implying that the deviance/DF should also be about 1).   

 

Here, the Deviance/DF is quite close to one, suggesting that it is appropriate to try to fit a 
Poisson model to this dependent variable. 

Significance of individual model parameters 

The next table in the output for aspatial Poisson regression provides the parameter estimates, 
standard errors, and p-values for each parameter in the model.  See the implementation page 
for a description of how the p-values are derived.  Note that as described in the page on 
categorical variables in regression, a parameter is estimated for each level of a categorical 
variable, except for the level that is chosen as the reference value.    
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In contrast to what we found using a linear model with smoothed cervix cancer rates (see 
results here), not one of the parameters in our model, including the intercept, was significant 
(all p-values were greater than 0.19).  This suggests we need to start looking for some 
different independent variables to include in our model, or that we should stick with the 
smoothed data, for which a linear model was more appropriate. 

Table of correlation coefficients 

Finally, as with the other two methods, the last table produced as part of the output for 
aspatial Poisson regression shows the correlation coefficient for each pair of numeric 
variables in your model.  This is helpful for understanding how different independent 
variables are related, and can be used to identify terms that could be dropped from the model 
due to high correlation with other terms.   

 

Here you can see that the correlations between our two continuous variables and the 
dependent variable (CERVIX) are quite a bit lower than they were with the smoothed version 
of the same dataset (CERVIX-RIS) that we found in the linear regression output.  This is an 
example of the deleterious effect of the "small numbers problem," which is described further 
in the small numbers tutorial.  As before, the correlation between HISPANIC and Noins is 
not high enough to prompt concern about colinearity. 

Note that these values may differ from correlation coefficients presented in the graph 
statistics window due to the effect of missing values.  In the case of the regression model, the 
correlation will not include data from ANY of the variables at observations where one or 
more value is missing, while only missing values in the two datasets being compared will 
influence the correlation coefficient in the graph statistics window in a scatter plot. 

  

Best Subset and Stepwise Regression 
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About Model Selection Tools 

Methods such as best subset and stepwise regression are tools that build and compare suites 
of regression models, often through some form of automatic procedure.  The user specifies 
the response (dependent) variable, and a suite of potential predictor (independent) variables, 
and through repeated application of a set of rules for selection, the method outputs a "best" 
set of predictors.  These data mining techniques have been included in SpaceStat as tools for 
exploratory model-building, but note that many statisticians criticize the validity of the 
output (i.e., p-values, R-squared values) and inferences from these approaches (to see some 
common criticisms, click here).   We view these tools as having a place within the data 
exploration toolbox:  In early stages of modeling relationships within your geographic data, 
you can use best subset or stepwise regression to compare a variety of models, and then trace 
how the fit of various models changes with changes in your variable values over time. 

Options for automatic model selection in SpaceStat 

We have divided the regression model selection tools into three groups (1) "best subset" 
approaches, (2) forward stepwise or forward selection, and (3) backward stepwise or 
backward removal.  When you run an aspatial regression model, you have the choice of using 
the "Full model", or of choosing one of these tools from a dialog box on the regression 
settings page.  Choosing "best subset" will activate another window in which you will choose 
among methods for model selection, while choosing forward or backward stepwise 
regression will activate two windows where you will enter p-values that SpaceStat will use to 
evaluate whether terms should be dropped or added to the model.  For "stepwise" methods, 
this process is iterative, but you can choose p-values to achieve what other statistical tools 
call forward selection or backward removal by choosing either forward or backward stepwise 
from the pull-down menu, and then specifying extremely permissive "P to stay" (P = 1) or 
restrictive "P to enter" (P = 0) values (see forward selection and backward removal for 
details). 

When using model selection tools, you can run any type of model (linear, logistic, or 
Poisson), and include any variables associated with the source geography (numeric or 
categorical variables).   As with aspatial regression using the "full model" option, you can 
also create squared or interaction terms, and can choose the type of coding used for 
categorical variables.  Note also that although groups/levels within a categorical variable will 
have individual parameter estimates, each categorical variable is dropped or added from a 
model as one unit (i.e., categories are not dropped individually).  Finally, you can still select 
the zero-intercept option with best subset/stepwise regression for models using sets of 
numeric variables for which you know the dependent variable will be zero when the 
independent variables are all zero. 

Model selection measures and tools 

The tools for model selection use several of the measures described in pages on 
implementation of aspatial regression as ways to rank models, such as R-squared and 
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adjusted R-squared for linear regression, Cox and Snell R-squared for logistic regression, and 
log-Likelihood for Poisson regression.  Output for all of these tools will also include a 
measure called Mallows' C(p), a subsetting criterion developed by Colin Mallows that is 
intended to help avoid the problem of colinearity (see below) within subset models.  Mallows 
C(p) (just shown as C(p) in output tables) is defined as the residual sum of squares with P 
regression terms in the model (a subset of K included in the full model), divided by the error 
variance for the full model, plus twice the number of regression degrees of freedom minus 
the total number of observations. For the full model (with K terms), C(p) is equal to the 
number of regression degrees of freedom.  Values of C(p) that are similar to P are considered 
good candidate models.  Other measures that are only included in output from the best subset 
option are described on the best subset page. 

A general rule for exploring models with stepwise and best subset tools: avoid colinearity 

Although SpaceStat can handle fairly large numbers of datasets when running the model 
selection tools, it is a good idea to minimize colinearity (correlation among predictor 
variables).  This general principle is true for all regression models, but is particularly likely to 
occur and cause problems if you are working with large numbers of variables.  Although 
colinearity does not lead to major problems with prediction, it can be a real problem if you 
want to evaluate the importance of individual predictors (the goal of selection tools), because 
the high correlation among variables makes it hard to find reliable estimates of each 
variable's coefficient.   

One way to quickly evaluate correlation among a large number of datasets is to complete a 
"full model" regression, and then examine the correlation matrix that this procedure 
produces.  If you find that two variables are highly correlated with each other, it is probably 
best to only use one of them in the group you input during a stepwise or best model run.  To 
see if one performs better than another, you can always run the stepwise process twice, 
substituting one for the other and comparing the results. 

Follow the links below to see more information on each of the tool types: 

Best subset 

Forward stepwise and forward selection 

Backward stepwise and backward removal 

  

  

Criticisms of Best Subset and Stepwise Regression Tools 

Criticisms of these approaches include: 
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1. The entry and removal of variables from stepwise models is achieved through 
evaluation of p-values from F-tests or chi-squared tests, but there is no correction for 
the fact that many tests are completed during the variable selection process.  Many 
techniques exist for dealing with the "multiple tests" problem (see the Simes 
correction for one example), but similar approaches are not applied to these tools for 
comparing regression models.   

2. These approaches are often strongly affected by the presence of collinearity among 
datasets, and R-squared values tend to be biased to be high. 

3. Similarly, p-values that are presented as output from these tests are conditional upon 
previous steps where variables have been excluded or included.  The output from 
SpaceStat (and other statistical tools) does not include any modification based on the 
number of variables evaluated or tests performed. 

4. These techniques are often viewed as using computational power rather than brain 
power (thinking about relationships among relevant variables) to drive model 
building and evaluation. 

This overview was based on a helpful summary of critiques by many statisticians (mostly 
negative, and including references) created by Dr. Rich Ulrich, found here (at 
http://www.childrens-mercy.org/stats/faq/faq12.asp). 

  

Best Subset 

  

About Best Subset Selection 

The Best Subset tool for exploring regression models carries out calculations for all models 
with or without each of the regression terms that you have specified in the regression model 
dialog.  SpaceStat then orders the suite of models in a table according to the selection 
criterion that you choose (the table also lists values of the other criteria available for that 
form of regression).  The options for selection criteria for each model form (linear, Poisson, 
and logistic) are activated in the regression settings dialog when you select the Best subset 
option.  As the number of models to compares grows rapidly as you increase the number of 
potential predictor variables, this method may become very slow with 10 or more variables. 
 Recall too that issues of colinearity are a major concern for exploratory model building, 
which is an even better reason than analysis speed to look at a correlation matrix and reduce 
the number of variables you include. 

The selection criteria for linear models are: 
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1. Largest R-squared.  This option selects the model with the largest reduction in 
residual sum of squares, and will favor the model with the largest number of terms in 
the model. 

2. Largest adjusted R-squared.  This option  the mean square errors with and without the 
regression terms in the model and punishes models with too many terms. 

3. Smallest AIC (Akaike information criterion).  The AIC is another tool that trades off 
model fit and model complexity.  For linear regression, this is the residual sum of 
squares (RSS) penalized by two times the number of regression term degrees of 
freedom (k = the number of regression parameters).  The general formula for AIC = 
2k-2ln(L); assuming model errors are normally and independently distributed, this can 
be expressed as AIC = 2k + nln(RSS/n), where n = the number of locations. 

4. Smallest Mallows C(p)- this measure is similar to AIC, and penalizes models for 
having higher numbers of terms.  Mallow C(p)equals the residual sum of squares with 
"p" regression terms in the model, divided by the error variance for the full model 
plus twice the number of regression degrees of freedom minus the total number of 
observations. For the full model, C(p) is equal to the number of regression degrees of 
freedom. Similar C(p) values similar to the one for the full model are considered an 
indication of good candidate models. 

The selection criteria for logistic models are: 

1. Largest Cox and Snell R-squared, which is similar in concept to an R-squared; it 
describes the strength of the model at predicting 0 or 1 values. 

2. Largest Score Chi-Squared test.  The score chi-square is an approximation to the log-
likelihood difference between two models and is used in some statistical programs 
because it is quicker to calculate than the exact log-likelihood difference.  It also 
increases with increasing model fit, and the choice of best model using Score Chi-
squared and Cox and Snell R-squared are likely to be equivalent. 

3. Smallest SIC (Schwartz Information Criterion, also known as the BIC, for Bayesian 
Information Criterion).  The SIC is an increasing function of the residual sum of 
squares, and an increasing function of the number of parameters to be estimated ( k), 
so it punishes models for having more parameters.  The formula for the SIC = -2ln L 
+k ln(n), where n is the number of locations, and L is the maximized value of the 
likelihood function for the model. 

4. Smallest AIC (see above). 

The selection criteria for Poisson models include 2-4 for logistic (above), and: 

1.  Largest log-Likelihood.  Poisson regression does not have a measure equivalent to R-
squared, so SpaceStat rates the model with the largest log-likelihood calculation as 
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"best".  SpaceStat presents the difference (deviance) between the log-likelihood of the 
subset model and that of a "perfectly-fitted" model for this final model in the output, 
as is typically presented for Poisson regression. 

  

  

Perform Best Subset Selection 

The process for performing a Best Subset aspatial regression analysis is identical to that 
described on the "Perform Aspatial Regression" page, except that if you choose the Best 
Subset option, you will activate a few additional sections of the regression settings page.  To 
minimize switching back and forth between Help pages, we repeat the aspatial regression 
intructions here, using a different example model.  To begin, select "Aspatial regression" 
methods by pulling down the Methods menu and choosing Regression -> Aspatial regression. 
 As with the "full model" version of aspatial regression, you will choose among the various 
types of regression (linear, Poisson, and logistic) within the regression settings page of the 
Task Manager.   

In this example, we are working with lung cancer rates for white males (RWM_LUNG) 
aggregated at the county level for states in the eastern U.S., averaged for the years 1970-
1994.   We will demonstrate creating and running the Best Subset procedure with a suite of 
seven independent variables that were freely available, and provide a useful example (but are 
not ideal for a real analysis, because they correspond to different dates).  Five of these come 
from the Center for Disease Control and Prevention's Behavioral Risk Factor Surveillance 
System Survey (CDC BRFSSS, 2004) -- per capita income (PCINCOME), percent of the 
population over 65 (PEROVER65), percent of the male population that ever smoked 
(SMOKEVRM), and percent of the population that is obese (OBESE).  In addition, we have 
radon risk data (three categories) from the EPA's Radon Program, as well as the log of 
concentrations of xylenes (LOGXYLENES) and tetrachlororethylene (LOGTETRACHLOR) 
from the EPA's 1997 National Emission Inventory.  We put these data together in a model to 
simulate steps you might go through when exploring potentially interesting patterns in male 
lung cancer, and have assigned them all to a time of 1994 so that they can be combined in the 
same analysis. 

One step that we strongly suggest if you have lots of potential variables that may be highly 
correlated is to first put all of the potential variables you would like to explore in a model 
(following the directions here or on the "Perform Aspatial Regression" page) and then run a 
"full model".  This will provide you with a correlation matrix for all of the variables so that 
you can see which are highly correlated, and then avoid building models with variables that 
appear redundant.  This step is important because the presence of colinearity can lead to poor 
estimation of coefficients, and is especially likely when you explore large numbers of 
potential predictors using Stepwise and Best Subset model building tools.   

Creating and managing regression models 
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When the task manager opens for Aspatial regression, it will start on the "Regression 
models" section.  Here, you must choose your geography (if your project contains more than 
one), and then indicate whether you would like to create, modify, or delete a regression 
model.  You can create a suite of models that all share the same geography, dependent 
variable, and form (linear, Poisson, or logistic) within one Aspatial regression "tab" in the 
task manager, and these will all appear with the default name "Regression model" on this 
page, unless you change the name (see below).  To modify an existing model, highlight it, 
and then hit the "Modify" button.  Similarly, select a model and then click on delete to 
remove it from the list.  Additional models can be created and saved, and they will all be 
listed in this window.  Note that if you choose the regression method again from the methods 
pull down window, a new regression tab will appear, and will list the same suite of models 
(note the two tabs shown below).  You can delete this extra tab without losing your saved 
models. 

 

Defining a new regression model 

When you click on the "Create" button in the initial task manager page for Aspatial 
regression, a dialog will open where you define the dependent and independent variables that 
will be included in your regression model.  You can also use the instructions below to modify 
a model you have already created. 

Click on the boxes below for brief definitions, and for links to detailed information on 
defining the terms in your model. 
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Selecting model terms. 

The window titled "Independent variables" lists all of the datasets associated with the 
geography that you selected in the first task manager window for regression.  To use one or 
more of these datasets as a term in your model, click on it to select it.  To select more than 
one dataset (for adding an interaction term), hold down the "Ctrl" button as you click on 
each.  When the dataset name is selected, you can then use the buttons on the right to add that 
dataset as a linear term (i.e., as an " x"), as a squared term (i.e., as an x2), or as part of an 
interaction term in which it will be multiplied by one or more other independent variables.  In 
the example above, we have selected the seven variables described above as linear terms.  As 
you add various terms, they will appear in the three boxes in the center of the task manager 
window.  You can delete terms that you have created by selecting them and then using the 
delete button on your keyboard. 

Categorical variables:  Select the reference value and parameterization type. 

Directly below the windows where the regression model terms are listed is a section that only 
applies to categorical variables; here you will choose a reference value and a 
parameterization type (coding system).  These options are explained in detail in the help 
section on categorical data in regression.  To fill in these options for your categorical 
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variable(s), first select the categorical dataset ("RADON_CAT" in the example above --note 
that even though this looks like an integer variable, it is coded as alphanumeric/string). 
 When a categorical dataset is selected, you will be able to scroll through the names of the 
categories within that set in the box to the left of "Reference value for...".  Next, for that same 
categorical dataset, you choose a reference cell or effect cell approach to coding by clicking 
on the respective circle to the left of your choice.  If you have more than one categorical 
term, including interaction terms that incorporate a categorical dataset, you will need to 
repeat this process for all of these terms.  If you forget to do this step, SpaceStat will run the 
model using the default settings of reference cell parameterization, with the middle category 
(alphabetically), or last value (for numbers coded as strings) as the reference value. 

Fix intercept at zero check box. 

Check this box if you want to force your linear regression model through the origin (0,0). 
 This option should not be applied to Poisson or logistic regression, or to linear regression 
with only categorical terms.  If you do check the box with a Poisson or logistic model, or for 
a model with categorical terms, SpaceStat will proceed as if the box had not been checked. 
 Note that if you have chosen to fix your intercept at zero, SpaceStat will report the R2 for 
this "no intercept" model as "-".  This is because calculations of R2 in the no-intercept models 
tend to be larger than models with an intercept, or in some cases can be negative.  Details on 
this topic are presented in Kutner et al. 2004. 

After you have finished creating or modifying your regression model, click "ok" to return to 
the first page of the task manager for regression, and then click on the "Regression settings" 
tab to complete the process of defining your model.   

Regression settings. 

After you have identified the datasets to be used in your model, you will need to define other 
settings, including the regression type (linear, Poisson, or logistic), the type of model 
selection tool you want to use, any weight sets you would like to use, and the time settings. 
 When you have completed this page, click on the last section, "Run Method". 

Click on boxes within the image below for more information. 
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Run Method 

When you click on "Run Method", the task manager will present a summary of the model 
you have just created or modified.  If you agree with the model definition that appears in this 
window, then click on the "Run" button at the bottom of the window to run the model.  Note 
that the information shown here will be repeated in the log at the beginning of your best 
subset regression output. 
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Now that you have run the model, look in the log view to see your results.  There are some 
variations in the output presented for the various model types, and it may be helpful to first 
review the typical output for a "Full model" run of a linear, Poisson, or logistic model before 
trying to understand the output from best subset regression. 

Click here to proceed to the page describing Best Subset output. 

  

  

Best Subset Selection Output 

Here, we will show the output from the model we used to illustrate running Best Subset 
regression analysis on the "Perform" page.  The general overview of aspatial regression 
output also applies to Best Subset regression, and descriptions of output from "full model" 
runs of linear, logistic, and Poisson aspatial regression will also be important pages to review 
when you run Best Subset model selection tools. 

Summary of the model run 

After clicking to the run method page and then selecting "Run", we see the following output 
in the log view, beginning with the summary of the model run. 
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Best subset summary 

The first output table from the Best Subset tool provides the top ten models as ordered by the 
selection criterion that you selected on the model settings page of the regression dialog.  In 
this example we chose AIC, and the top model listed has the lowest value.  This model is the 
same one selected (from the same suite of datasets) by the forward stepwise and backward 
selection methods.  To review all of the selection criteria for the various model types, click 
here.  Using the Best Subset tool, you can see that there are only slight variations among 
models that share the key variables (PCINCOME, and to a lesser extent PEROVER65, and 
RADON_CAT); these top models include various subsets of the other four variables.  This 
approach gives a more nuanced view of the data than did the stepwise procedures, as you can 
see that two variables that those tools did not include (LOG-TETRACHLOR and 
SMOKEVR) are each components of models in the top 3 (see below).    

 

The next table (shown below) describes the properties of the "best" model, and this model is 
the one for which the three output datasets appear in the Data view (in an output folder below 
the response variable, RWM_LUNG). 
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Significance of individual model parameters 

The next table in the output for Best Subset regression provides the parameter estimates, 
standard errors, and P-values for each parameter in the model.  See the implementation page 
for the particular form of regression that you used (linear, logistic, and Poisson) for a 
description of how the p-values are derived.   Recall that significance values in regression 
output are reported as "0.0" if they are smaller than 0.000001, and, as described on the 
categorical variables page, a parameter is estimated for each level of a categorical variable, 
except for the level that is chosen as the reference value (we chose the radon category "2"). 

   

To compare this output to output from the Stepwise approaches, click here for Forward, and 
here for Backward Stepwise. 

  

Forward Stepwise 

  

About Forward Stepwise and Forward Selection 

In the forward stepwise model selection procedure, variables are sequentially added to an 
"empty" (intercept only) model.  In contrast, backward procedures start with all of the 
variables in the model, and proceed by removing them.  To simplify the description, this 
overview describes the process for stepwise linear regression, with modifications that apply 
to logistic and Poisson regression presented below. 

The forward stepwise procedure 

In the first round of forward stepwise iterations, the regression terms (i.e., datasets that you 
selected in the model definition step) are each added to the starting model, and the regression 
calculation is performed to find the improvement in the residual sum of squares for each of 
these resulting models relative to the intercept only model.  For each new model, SpaceStat 
calculates a p-value for the change in the sum of squares; this calculation is based on an F-
distribution and incorporates the degrees of freedom in the regression term and the error 
variance.  When all of the one-term models have been created, the forward stepwise 
procedure selects the variable associated with the lowest p-value model as the first round 
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candidate for entry into the model.  This variable’s p-value is then compared to the "p to 
enter" cut-off value you have specified in the stepwise procedure dialog box, and if it is 
lower than the cut-off, the candidate term will enter the regression model.  This one-term 
model provides a new starting model for the next round.  If in this or in any of the subsequent 
rounds the lowest candidate p-value is not lower than the "p to enter" value specified in the 
regression dialog, then the forward stepwise procedure will stop. 

Initially, subsequent rounds follow the same procedure as the first:  The terms not already in 
the model are examined in turn to see to what extent adding them to the model improves 
model fit.  The candidate term (dataset) that provides the greatest improvement (i.e., is 
associated with the lowest p-value from an F-test) is again compared against the "p to enter" 
to determine if it should be added to the model.  However, in addition to testing whether 
terms can be added, the stepwise procedure also examines every model with more than one 
term by looping through each of the terms in the model, and again on the basis of an F-
distribution, calculating the p-value for removal.  Specifically, the p-value for removal is 
based on comparing the resulting increase in residual sum of squares to the error variance of 
the larger model. The term with the highest p-value becomes the candidate for removal from 
the model.  If the largest p-value is larger than the "p to stay" value you supplied in the 
dialog, then the term is removed from the model. 

SpaceStat allows as many rounds of this procedure as there are possible regression terms in 
your starting model (i.e., as many rounds as the number of terms you defined in the model 
definition step). If a term (already added) is later removed from the model, SpaceStat 
augments the number of remaining rounds to give all of the remaining terms a chance to 
enter.  If, however, during a particular round, the same terms is removed and then added, this 
event will trigger an end to the forward stepwise regression procedure.  The integrity of the 
results obtained in forward stepwise regression depends on the choice of "p to enter" and "p 
to stay"; for the process to work, the "p to stay" value should never be made smaller than the 
"p to enter" value. 

Forward selection 

Setting the "p to stay" value to 1 ensures that no term already in the model will be allowed to 
leave. This reduces to the "Forward Selection" procedure used in other software packages' 
stepwise regression tools. 

Logistic and Poisson forward stepwise regression 

Rather than an F-test, to determine whether variables enter or leave logistic regression and 
Poisson models, SpaceStat calculates the exact log-likelihood difference attributable to the 
focal variable. The log-likehood is evaluated with a chi-squared test to determine 
significance relative to the "p to enter" and "p to stay" cut offs you set in the regression 
settings.    

Click here to see how to perform stepwise regression.  
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Perform Stepwise Aspatial Regression 

The process for performing a stepwise aspatial regression analysis is identical to that 
described on the "Perform Aspatial Regression" page, except that if you choose forward or 
backward stepwise regression, you will activate a few additional sections of the regression 
settings page.  To minimize switching back and forth between Help pages, we repeat those 
methods here with a different example.  To begin, select Aspatial regression methods by 
pulling down the Methods menu and choosing Regression -> Aspatial regression.  As with 
the "full model" version of aspatial regression, you will choose among the various types of 
regression (linear, Poisson, and logistic) within the regression settings page of the Task 
Manager.   

In this example, we are working with lung cancer rates for white males (RWM_LUNG) 
aggregated at the county level for states in the eastern U.S., averaged for the years 1970-
1994.   We will demonstrate creating and running stepwise regression models with a suite of 
seven independent variables that were freely available and provide a useful example (but are 
not ideal for actual evaluation of patterns, as they correspond to different dates).  Five of 
these come from the Center for Disease Control and Prevention's Behavioral Risk Factor 
Surveillance System Survey (CDC BRFSSS, 2004) -- per capita income (PCINCOME), 
percent of the population over 65 (PEROVER65), percent of the male population that ever 
smoked (SMOKEVRM), and percent of the population that is obese (OBESE).  In addition, 
we have radon risk data (three categories) from the EPA's Radon Program, as well as the log 
of concentrations of xylenes (LOGXYLENES) and tetrachlororethylene 
(LOGTETRACHLOR) from the EPA's 1997 National Emission Inventory.   We put these 
data together in a model to simulate steps you might go through when exploring potentially 
interesting patterns in male lung cancer, and have assigned them all to a time of 1994 so that 
they can be combined in the same analysis. 

One step that we strongly suggest if you have lots of potential variables that may be highly 
correlated is to first put all of the potential variables you would like to explore in a model 
(following the directions here or on the "Perform Aspatial Regression" page) and then run a 
"full model".  This will provide you with a correlation matrix for all of the variables so that 
you can see which are highly correlated, and then avoid building models with variables that 
appear redundant.  This step is important because the presence of colinearity can lead to poor 
estimation of coefficients, and is especially likely when you explore large numbers of 
potential predictors using stepwise and best subset model building methods.   

Creating and managing regression models 

When the task manager opens for Aspatial regression, it will start on the "Regression 
models" section.  Here, you must choose your geography (if your project contains more than 
one), and then indicate whether you would like to create, modify, or delete a regression 
model.  You can create a suite of models that all share the same geography, dependent 
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variable, and form (linear, Poisson, or logistic) within one Aspatial regression "tab" in the 
task manager, and these will all appear with the default name "Regression model" on this 
page, unless you change the name (see below).  To modify an existing model, highlight it, 
and then hit the "Modify" button.  Similarly, select a model and then click on delete to 
remove it from the list.  Additional models can be created and saved, and they will all be 
listed in this window.  Note that if you choose the regression method again from the methods 
pull down window, a new regression tab will appear, and will list the same suite of models 
(note the two tabs shown below).  You can delete this extra tab without losing your saved 
models. 

 

Defining a new regression model 

When you click on the "Create" button in the initial task manager page for Aspatial 
regression, a dialog will open where you define the dependent and independent variables that 
will be included in your regression model.  You can also use the instructions below to modify 
a model you have already created. 

Click on the boxes below for brief definitions, and for links to detailed information on 
defining the terms in your model. 
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Selecting model terms. 

The window titled "Independent variables" lists all of the datasets associated with the 
geography that you selected in the first Task Manager window for regression.  To use one or 
more of these datasets as a term in your model, click on it to select it.  To select more than 
one dataset (for adding an interaction term), hold down the "Ctrl" button as you click on 
each.  When the dataset name is selected, you can then use the buttons on the right to add that 
dataset as a linear term (i.e., as an "x"), as a squared term (i.e., as an x2), or as part of an 
interaction term in which it will be multiplied by one or more other independent variables.  In 
the example above, we have selected the eight variables described above as linear terms.  As 
you add various terms, they will appear in the three boxes in the center of the task manager 
window.  You can delete terms that you have created by selecting them and then using the 
delete button on your keyboard. 

Categorical variables:  Select the reference value and parameterization type. 

Directly below the windows where the regression model terms are listed is a section that only 
applies to categorical variables; in this area you will choose a reference value and a 
parameterization type (coding system).  These options are explained in detail in the help 
section on categorical data in regression.  To fill in these options for your categorical 
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variables, first select the categorical dataset ("RADON_CAT" in the example above --note 
that even though this looks like an integer variable, it is coded as alphanumeric/string). 
 When a categorical dataset is selected, you will be able to scroll through the names of the 
categories within that set in the box to the left of "Reference value for...".  Next, for that same 
categorical dataset, you choose a reference cell or effect cell approach to coding by clicking 
on the respective circle to the left of your choice.  If you have more than one categorical 
term, including interaction terms that incorporate a categorical dataset, you will need to 
repeat this process for all of these terms.  If you forget to do this step, SpaceStat will run the 
model using the default settings of reference cell parameterization, with the middle category 
(alphabetically) or last category (for numbers coded as strings) as the reference value. 

Fix intercept at zero check box. 

Check this box if you want to force your linear regression model through the origin (0,0). 
 This option should not be applied to Poisson or logistic regression, or to linear regression 
with only categorical terms.  If you do check the box with a Poisson or logistic model, or for 
a model with categorical terms, SpaceStat will proceed as if the box had not been checked. 
 Note that if you have chosen to fix your intercept at zero, SpaceStat will report the R2 for 
this "no intercept" model as "-".  This is because calculations of R2 in the no-intercept models 
tend to be larger than models with an intercept, or in some cases can be negative.  Details on 
this topic are presented in Kutner et al. 2004. 

After you have finished creating or modifying your regression model, click "ok" to return to 
the first page of the task manager for regression, and then click on the "Regression settings" 
tab to complete the process of defining your model.   

Regression settings. 

After you have identified the datasets to be used in your model, you will need to define other 
settings, including the regression type (linear, Poisson, or logistic), the type of model 
selection tool you want to use, any weight sets you would like to use, and the time settings. 
 When you have completed this page, click on the last section, "Run Method". 

Click on boxes within the image below for more information. 
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Run Method 

When you click on "Run Method", the Task manager will present a summary of the model 
you have just created or modified.  If you agree with the model definition that appears in this 
window, then click on the "Run" button at the bottom of the window to run the model.  Note 
that the information shown here will be repeated in the log at the beginning of your stepwise 
regression output. 
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Now that you have run the model, look in the log view to see your results.  There are some 
variations in the output presented for the various model types, and it may be helpful to first 
review the typical output for a "Full model" run of a linear, Poisson, or logistic model before 
trying to understand the output from stepwise regression. 

To see the output for this model run with forward stepwise, click here; for backward stepwise 
results, click here. 

  

  

Forward Stepwise Regression Output 

Here, we will show the output from the model we used to illustrate running a forward 
stepwise linear regression analysis on the "Perform" page.  The general overview of aspatial 
regression output also applies to forward stepwise regression, and descriptions of output from 
"Full model" runs of linear, logistic, and Poisson aspatial regression will also be important 
pages to review when you run stepwise models. 

Summary of the model run 

After clicking to the run method page and then selecting "Run", we see the following output 
in the log view, beginning with the summary of the model run. 

339 



Statistical Methods 

 

Summary of entries and removals from the model 

The first data table in output from forward stepwise regression shows the order in which 
variables entered the model, and related measures of model fit.  See pages on implementation 
of linear, logistic, and Poisson regression to review the measures shown in the table.  C(p) is 
described here. 

 

From this table, you can see that five of our seven variables were selected to be in the final 
model, with per capita income having the highest contribution to model fit (selected first, 
highest partial R-squared and lowest p-value).  Interestingly, the smoking-related variable did 
not make it into this model of lung cancer, which shows the importance of scale (level of data 
aggregation).  The next table (shown below) describes the properties of this "best" model, 
and this model is the one for which the three output datasets appear in the Data view (in an 
output folder below the response variable, RWM_LUNG). 

 

Significance of individual model parameters 

The next table in the output for forward stepwise regression provides the parameter 
estimates, standard errors, and p-values for each parameter in the model.  See the 
implementation page for the particular form of regression that you used (linear, logistic, and 
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Poisson) for a description of how the p-values are derived.  Recall that significance values in 
regression output are reported as "0.0" if they are smaller than 0.000001, and, as described on 
the categorical variables in regression analyses page, a parameter is estimated for each level 
of a categorical variable, except for the level that is chosen as the reference value (we chose 
"2"). 

   

To compare this output to output from the other model selection approaches, click here for 
Best Subset, and here for Backward Stepwise. 

  

Backward Stepwise 

  

About Backward Stepwise and Backward Removal 

In the backward stepwise model selection procedure, variables are sequentially removed 
from a full (all regression terms included) model.  In contrast, forward procedures start with 
an empty (intercept only) model, and proceed by adding terms.  To simplify the description, 
this overview describes the process for stepwise linear regression, with modifications that 
apply to logistic and Poisson regression presented below. 

The backward stepwise procedure 

In the first round of backward stepwise iterations, the regression terms (i.e., datasets that you 
selected in the model definition step) are each removed from the "full" starting model, and 
the regression calculation is performed to find the improvement in the residual sum of 
squares for each of these resulting models relative to the starting model.  For each new 
model, SpaceStat calculates a p-value for the change in the sum of squares; this calculation is 
based on an F-distribution and incorporates the degrees of freedom in the regression term and 
the error variance.  When all of the models missing one term have been created, the 
backward stepwise procedure selects the term associated with the highest p-value as the first 
round candidate for removal from the model.  This variable’s p-value is then compared to the 
"p to stay" cut-off value you have specified in the stepwise procedure dialog box, and if it is 
higher than the cut-off, the candidate term will be removed from the regression model.  This 
provides a new starting model for the next round. If in this or in any of the subsequent rounds 
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the highest candidate p-value is not higher than the "p to stay" value you have specified in the 
regression dialog, then the backward stepwise procedure will stop.   

The subsequent rounds start with the same procedure; the terms still in the model are 
examined in turn to see what their p-values are for removal from the model. The highest p-
value candidate is again compared against the "p to stay" to determine if it is to be removed 
from the model. Once more than one term has been removed from the model, SpaceStat will 
loop through each of the terms that have been removed and, on the basis of an F-distribution, 
calculate the p-value associated with restoring the term into the model.  Again, this p-value is 
calculated by comparing the resulting decrease in residual sum of squares associated with the 
model that now includes the term that had previously been removed to the error variance of 
the larger model.  The term with the lowest p-value becomes the candidate for restoration 
into the model, and if this p-value is smaller than the "p to enter" value you have entered in 
the dialog box, then the term will be restored to the model. 

SpaceStat allows as many rounds of this procedure as there are possible regression terms in 
your proposed model (i.e., as many rounds as the number of terms you defined in the model 
definition step). If a term "returns (is later added after having been removed), SpaceStat 
augments the number of remaining rounds to allow all the remaining terms to have a chance 
to be removed.  If, however, during a particular round, the same term is restored and then 
removed, this event will trigger an end to the backward stepwise regression procedure.  The 
integrity of the results obtained in backward stepwise regression depends on the choice of "p 
to enter" and "p to stay"; the "p to stay" value should not be made smaller than the "p to 
enter" value. 

Backward removal 

Setting the "p to enter" value to 0 ensures that no term removed from the model will be 
allowed to return. This reduces the backward stepwise procedure to the "Backward Removal" 
procedure used in other software. 

Logistic and Poisson backward stepwise regression 

Rather than an F-test, to determine whether variables enter or leave logistic regression and 
Poisson models, SpaceStat calculates the exact log-likelihood difference attributable to the 
focal variable. The log-likehood is evaluated with a chi-squared test to determine 
significance relative to the "p to enter" and "p to stay" cut offs you set in the regression 
settings.    

Click here to see how to perform stepwise regression.  

  

  

Perform Stepwise Aspatial Regression 
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The process for performing a stepwise aspatial regression analysis is identical to that 
described on the "Perform Aspatial Regression" page, except that if you choose forward or 
backward stepwise regression, you will activate a few additional sections of the regression 
settings page.  To minimize switching back and forth between Help pages, we repeat those 
methods here with a different example.  To begin, select Aspatial regression methods by 
pulling down the Methods menu and choosing Regression -> Aspatial regression.  As with 
the "full model" version of aspatial regression, you will choose among the various types of 
regression (linear, Poisson, and logistic) within the regression settings page of the Task 
Manager.   

In this example, we are working with lung cancer rates for white males (RWM_LUNG) 
aggregated at the county level for states in the eastern U.S., averaged for the years 1970-
1994.   We will demonstrate creating and running stepwise regression models with a suite of 
seven independent variables that were freely available and provide a useful example (but are 
not ideal for actual evaluation of patterns, as they correspond to different dates).  Five of 
these come from the Center for Disease Control and Prevention's Behavioral Risk Factor 
Surveillance System Survey (CDC BRFSSS, 2004) -- per capita income (PCINCOME), 
percent of the population over 65 (PEROVER65), percent of the male population that ever 
smoked (SMOKEVRM), and percent of the population that is obese (OBESE).  In addition, 
we have radon risk data (three categories) from the EPA's Radon Program, as well as the log 
of concentrations of xylenes (LOGXYLENES) and tetrachlororethylene 
(LOGTETRACHLOR) from the EPA's 1997 National Emission Inventory.   We put these 
data together in a model to simulate steps you might go through when exploring potentially 
interesting patterns in male lung cancer, and have assigned them all to a time of 1994 so that 
they can be combined in the same analysis. 

One step that we strongly suggest if you have lots of potential variables that may be highly 
correlated is to first put all of the potential variables you would like to explore in a model 
(following the directions here or on the "Perform Aspatial Regression" page) and then run a 
"full model".  This will provide you with a correlation matrix for all of the variables so that 
you can see which are highly correlated, and then avoid building models with variables that 
appear redundant.  This step is important because the presence of colinearity can lead to poor 
estimation of coefficients, and is especially likely when you explore large numbers of 
potential predictors using stepwise and best subset model building methods.   

Creating and managing regression models 

When the task manager opens for Aspatial regression, it will start on the "Regression 
models" section.  Here, you must choose your geography (if your project contains more than 
one), and then indicate whether you would like to create, modify, or delete a regression 
model.  You can create a suite of models that all share the same geography, dependent 
variable, and form (linear, Poisson, or logistic) within one Aspatial regression "tab" in the 
task manager, and these will all appear with the default name "Regression model" on this 
page, unless you change the name (see below).  To modify an existing model, highlight it, 
and then hit the "Modify" button.  Similarly, select a model and then click on delete to 
remove it from the list.  Additional models can be created and saved, and they will all be 
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listed in this window.  Note that if you choose the regression method again from the methods 
pull down window, a new regression tab will appear, and will list the same suite of models 
(note the two tabs shown below).  You can delete this extra tab without losing your saved 
models. 

 

Defining a new regression model 

When you click on the "Create" button in the initial task manager page for Aspatial 
regression, a dialog will open where you define the dependent and independent variables that 
will be included in your regression model.  You can also use the instructions below to modify 
a model you have already created. 

Click on the boxes below for brief definitions, and for links to detailed information on 
defining the terms in your model. 
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Selecting model terms. 

The window titled "Independent variables" lists all of the datasets associated with the 
geography that you selected in the first Task Manager window for regression.  To use one or 
more of these datasets as a term in your model, click on it to select it.  To select more than 
one dataset (for adding an interaction term), hold down the "Ctrl" button as you click on 
each.  When the dataset name is selected, you can then use the buttons on the right to add that 
dataset as a linear term (i.e., as an "x"), as a squared term (i.e., as an x2), or as part of an 
interaction term in which it will be multiplied by one or more other independent variables.  In 
the example above, we have selected the eight variables described above as linear terms.  As 
you add various terms, they will appear in the three boxes in the center of the task manager 
window.  You can delete terms that you have created by selecting them and then using the 
delete button on your keyboard. 

Categorical variables:  Select the reference value and parameterization type. 

Directly below the windows where the regression model terms are listed is a section that only 
applies to categorical variables; in this area you will choose a reference value and a 
parameterization type (coding system).  These options are explained in detail in the help 
section on categorical data in regression.  To fill in these options for your categorical 
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variables, first select the categorical dataset ("RADON_CAT" in the example above --note 
that even though this looks like an integer variable, it is coded as alphanumeric/string). 
 When a categorical dataset is selected, you will be able to scroll through the names of the 
categories within that set in the box to the left of "Reference value for...".  Next, for that same 
categorical dataset, you choose a reference cell or effect cell approach to coding by clicking 
on the respective circle to the left of your choice.  If you have more than one categorical 
term, including interaction terms that incorporate a categorical dataset, you will need to 
repeat this process for all of these terms.  If you forget to do this step, SpaceStat will run the 
model using the default settings of reference cell parameterization, with the middle category 
(alphabetically) or last category (for numbers coded as strings) as the reference value. 

Fix intercept at zero check box. 

Check this box if you want to force your linear regression model through the origin (0,0). 
 This option should not be applied to Poisson or logistic regression, or to linear regression 
with only categorical terms.  If you do check the box with a Poisson or logistic model, or for 
a model with categorical terms, SpaceStat will proceed as if the box had not been checked. 
 Note that if you have chosen to fix your intercept at zero, SpaceStat will report the R2 for 
this "no intercept" model as "-".  This is because calculations of R2 in the no-intercept models 
tend to be larger than models with an intercept, or in some cases can be negative.  Details on 
this topic are presented in Kutner et al. 2004. 

After you have finished creating or modifying your regression model, click "ok" to return to 
the first page of the task manager for regression, and then click on the "Regression settings" 
tab to complete the process of defining your model.   

Regression settings. 

After you have identified the datasets to be used in your model, you will need to define other 
settings, including the regression type (linear, Poisson, or logistic), the type of model 
selection tool you want to use, any weight sets you would like to use, and the time settings. 
 When you have completed this page, click on the last section, "Run Method". 

Click on boxes within the image below for more information. 
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Run Method 

When you click on "Run Method", the Task manager will present a summary of the model 
you have just created or modified.  If you agree with the model definition that appears in this 
window, then click on the "Run" button at the bottom of the window to run the model.  Note 
that the information shown here will be repeated in the log at the beginning of your stepwise 
regression output. 
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Now that you have run the model, look in the log view to see your results.  There are some 
variations in the output presented for the various model types, and it may be helpful to first 
review the typical output for a "Full model" run of a linear, Poisson, or logistic model before 
trying to understand the output from stepwise regression. 

To see the output for this model run with forward stepwise, click here; for backward stepwise 
results, click here. 

  

  

Backward Stepwise Regression Output 

Here, we will show the output from the same model we used to illustrate running a forward 
stepwise linear regression analysis on the "Perform" page, except we will use backward 
stepwise regression with a change in the "pto enter" and "p to stay" values (0.05 for both 
instead of 0.15).  The general overview of aspatial regression output also applies to forward 
stepwise regression, and descriptions of output from "Full model" runs of linear, logistic, and 
Poisson aspatial regression will also be important pages to review when you run stepwise 
models. 

Summary of the model run 

After clicking to the run method page and then selecting "Run", we see the following output 
in the log view, beginning with the summary of the model run. 
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Summary of entries and removals from the model 

The first data table in output from forward stepwise regression shows the order in which 
variables entered the model, and related measures of model fit.  See pages on implementation 
of linear, logistic, and Poisson regression to review the measures shown in the table.  C(p) is 
described here. 

 

From this table, you can see that two of our seven variables were removed from the full 
model.  This result mirrors the forward selection results shown here, in which the other five 
variables were listed as added.  Since both tools came up with the same final model (even 
though we used more restrictive p-values for the backward procedure), all of the rest of the 
output is the same. 

The next table (shown below) describes the properties of this "best" model, and this model is 
the one for which the three output datasets appear in the Data view (in an output folder below 
the response variable, RWM_LUNG). 

 

Significance of individual model parameters 

The next table in the output for forward stepwise regression provides the parameter 
estimates, standard errors, and p-values for each parameter in the model.  See the 
implementation page for the particular form of regression that you used (linear, logistic, and 
Poisson) for a description of how the p-values are derived.  Recall that significance values in 
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regression output are reported as "0.0" if they are smaller than 0.000001, and, as described on 
the categorical variables in regression analyses page, a parameter is estimated for each level 
of a categorical variable, except for the level that is chosen as the reference value (we chose 
"2"). 

   

To compare this output to output from the other model selection approaches, click here for 
Best Subset, and here for Backward Stepwise. 

  

Geographically Weighted Regression 

  

About Geographically Weighted Regression 

As described here, aspatial regression methods are a set of tools for assessing variation in one 
variable (the dependent variable, y) at set levels of another variable or variables 
(independent, or x variables).  In contrast, Geographically Weighted Regression (GWR) 
techniques are forms of spatial data analysis that allow you to evaluate how the relationship 
between a dependent variable and one or more explanatory variables changes as a function 
of the location u in space.  More specifically, these tools allow you to explore the influence 
of values of your dependent variable at locations neighboring a focal location on the values 
estimated for coefficients of the independent variables.   

So, instead of the conventional "stationary" model, for example y= b0 + b1x in the case of 
linear regression with a single explanatory variable, the geographically weighted regression 
model is built within local overlapping windows centered on the location u: y(u)=b0(u) + 
b1(u)x. To attenuate the impact of distant observations in the computation of the local 
regression, each observation used in the regression receives a weight that is a function of its 
proximity to the center of the window.  Thus, while aspatial regression methods are 
simultaneously applied to all of the data within your dataset, and give you a global measure 
of the relationship among variables, GWR produces local measures of the importance of 
various predictors that can be mapped and compared.   If there is no variation across space in 
the best-fit local model, parameter estimates produced by GWR and aspatial regression will 
be the same.  Due to the focus on local relationships, and the strong influence of how "local" 
is defined on GWR results (i.e., through choice of neighbor relationships and bandwidths), 
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GWR is often thought of as a tool for exploring patterns in your data and generating 
hypothesis for further testing, rather than as a tool for testing a priori hypotheses 
(Fotheringham et al. 2002).   

GWR in SpaceStat can be used to predict a dependent variable in terms of continuous and/or 
categorical independent variables, and to determine the relative importance of various 
independent variables in predicting y, including the importance of squared and interaction 
terms.  Note that for SpaceStat to recognize a dataset as categorical, it must be a string 
(alphanumeric) dataset type.  Currently this tool is only implemented for point datasets; to 
use polygon data you will first need to create a centroid geography.  Similarly, if you want to 
be able to use models created in aspatial regression for GWR (or vice-versa) when working 
with data for a polygon geography, perform your aspatial analyses on the polygon centroids. 

The SpaceStat approach to GWR 

GWR has been pioneered by A. Stewart Fotheringham and Martin Charlton (National Center 
for Geocomputation, National University of Ireland), and Chris Brunsdon (University of 
Glamorgen, UK).  Our implementation of this tool is based primarily upon their book on the 
topic, but we have made some changes, (a few are detailed here), which follow from the way 
in which many in the public health and environmental science fields are likely to use these 
tools.  Our approach to GWR uses a unified framework for including both geographical 
weighting, and an extra non-geographical weight dataset that allows for user-supplied 
knowledge of the ratio variances at each source point.  One example of this type of weight set 
is the use of population data as a weight set for mortality rates, which has the effect of 
assigning higher "confidence" to mortality rates derived from areas with higher populations. 
 Our goal was to treat this type of weighting together with geographic weighting within a 
unified framework.  As a result, SpaceStat uses a maximum weighted likelihood approach to 
calculate the regression parameters, parameter variances, parameter R-square, expected y-
values, residuals and y-standard errors as well as the "local model"  R-square. This approach 
boils down to treating geographically weighted regression as a local extension of weighted 
aspatial regression. As a consequence GWR can be straightforwardly extended to non-linear 
regression procedures such as logistic and Poisson regression with parameter values and 
parameter variances calculated from a weighted log-likelihood formulation. 

Choosing the form of the regression model 

Three items will control the form and output from a geographically weighted regression 
model: 

1. The nature of the dependent variable y: 

• Continuous (linear or Gaussian model) 

• Positive integer counts (Poisson model) 

• Proportions or rates (logistic model) 
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2. The nature of the explanatory, or "x" variable or variables 

• Continuous 

• Categorical 

3. The weight function(s) 

• Geographical weights that control how neighboring locations influence values at 
specific locations 

• Non-spatial weights to account for the reliability of data (e.g., population size for 
disease rate data) 

  

  

Choosing the Geographic Weight 

SpaceStat offers several different options for geographic weighting of the data associated 
with the variables in a GWR model.  Some weighting choices require the user to specify an 
"area of influence", or bandwidth.  One simple approach to geographic weighting is to 
choose a set number of neighbors, or a set distance from the focal location, and then weight 
all of the neighbors captured in this definition as "1" and all others as "0".   Other approaches 
refine this "all or none" scheme by allowing you to use a weighting function to weight the 
points closest to the focal point more heavily than others farther away but still in the 
"neighborhood." 

Choosing the number of neighbors or distance range 

As described above, you can standardize how many points are used in each local regression 
calculation (choose the number of neighbors option), or standardize the maximum distance 
between a focal point and the most distant neighbor that will be included in the local model 
calculations (the range option).   

Choosing the weighting function 

As described above, you can choose to use an "all or none" scheme (all points that meet the 
nearest neighbor number, or range, criteria receive a weight of 1, others receive a 0), or a 
more complicated weighting function.  SpaceStat includes Gaussian and bi-square "falloff" in 
weight as a functions of distance from the focal point, using a fixed bandwidth that you set, 
or one that SpaceStat finds to be optimal (see below).   You can also fix the number of 
neighbors and choose a bi-square falloff with an adaptive bandwidth; in this case, the 
bandwidth for each target point is set at the distance to the farthest of the allowed neighbors 
(using the range option here gives a bandwidth that is close to the user-specified range). 
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Choosing the bandwidth 

If you choose a geographic weighting scheme with a bandwidth that is constant over the 
entire geography, then you will need to use the "Bandwidth settings" page in the task 
manager.  On this page, you can choose a specific value (a distance, in the same units as your 
point geography), or you can allow SpaceStat to determine the optimal value.  To determine 
the optimal value, SpaceStat uses a cross-validation procedure that minimizes the quantity: 

  

Here the predicted values are calculated from a local geographically weighted regression that 
does not include variable values from the target location.  The sum from each step in the 
optimization procedure, which tests a set of bandwidths in the range of bandwidths that you 
choose on the bandwidth settings page, is output to the log view.  If you do not specify a 
range, then the minimum bandwidth will be set to the minimum separation between points in 
the geography, and the maximum bandwidth will be set to the diagonal of the bounding 
rectangle of the geography.  When searching for the optimum bandwidth, we suggest that 
you start with a small number of bandwidth steps over a wide range, and then narrow down 
the range being explored. 

  

  

Non-geographical Weights in Regression 

In geographically weighted regression (GWR), a distance function is used to "weight" values 
observed at neighboring locations so that you can identify local patterns in relationships 
between independent and dependent variables.  In a similar way, you can weight 
observations in an aspatial regression or GWR so that some observations "matter" more than 
others when building a regression model.  One example of when you might want to use a 
weight dataset is in a regression analysis using disease rate data.  In many cases, these 
datasets show strong variation across space in the population size, which acts as the 
denominator in the rate calculation.  However, the higher the population size, the more 
confident you can be that your rate is not overly influenced by just a few occurrences of the 
disease (i.e., the small numbers problem, as described in this tutorial).  So, if you are working 
with rates and have a population size dataset for the same geography, you may want to try a 
model that includes this weighting factor.    

You would enter the weight dataset in the "Regressions settings" page of the Task manager. 

353 



Statistical Methods 

 

  

  

Categorical Data in Regression Analyses 

It is relatively straightforward to understand regression using continuous independent 
variables:  For example a simple aspatial linear regression model involves finding the best fit 
of a straight line through a set of points in the x-y plane, fitting a single intercept and slope. 
 A simple GWR model would repeat this approach across multiple overlapping 
neighborhoods in a spatial dataset, but would still be fitting a single intercept and slope to 
these subsets of the data.   However, regression using categorical dependent variables differs 
in that a different regression parameter must be chosen for each of the categories represented 
in a categorical dataset.  Details related to this process of coding of categorical variables are 
described below.  Note that for SpaceStat to recognize a dataset as categorical, it must be a 
string (alphanumeric) dataset type. 

Reference cell vs. Effect cell parameterization 

In SpaceStat, there are two options for handling how categorical variables are coded for 
parameterization of the coefficients; reference cell and effect cell parameterization.  Both 
options link the different regression coefficients to individual on-off variables for each of the 
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categories within the categorical dataset.  Using reference cell parameterization for a variable 
with three categories would introduce two indicator or "dummy" variables that take either the 
value zero or one for the first two categorical values.  Specifically, one category would be 
coded "0 1" and a second would be "1 0", and both indicator variables (codes) would be zero 
for the third category (0 0).  This final code (0 0) is assigned to the category chosen to be the 
reference cell (see below).  Note that with either reference cell or effect cell coding, your 
code will always have the same number of digits as your degrees of freedom (the number of 
categories minus 1).  For example, in a dataset with four categories, the reference cell would 
be coded "0 0 0" rather than "0 0".    

As shown here in the SpaceStat interface for aspatial linear regression, when you run a 
regression with categorical data, you will need to pick which category will be the reference 
cell.  A regression model with an intercept and an independent variable with three categories 
would then have a total of 3 coefficients (1 for the reference cell, which acts as the intercept, 
and two for the categories with codes that include 1), and the resulting matrix of values that 
SpaceStat uses to estimate coefficients would avoid the problem of singularity. The second 
coding option, effect–cell coding, assigns the values -1 for each of the two variables when 
data lie in the third category, so the three possible codes expressed with the two coding 
variables are 0 1, 1 0, and -1 -1).  Again, this coding avoids the problem of having too many 
parameters in the matrix used to perform the maximum likelihood estimation. 

The choice of coding depends upon the goals of your analysis.  To give a very simple 
example, say you are trying to predict your dependent variable "y" using just the independent 
variable "gender" in an aspatial linear model.  Working with the traditional linear regression 
equation, you would have: 

 

If you picked reference cell coding, and chose males as the reference value (i.e., the category 
coded as 0), then for females your dependent variable would equal b0 + b1, while for males y 
would equal just b0, because multiplying the b1 by zero would cause it to drop out.  In effect, 
the y values are the means for each of the two categories, and a t-test (i.e., a two sample F-
test) for b1 will test the hypothesis that the mean for females is significantly different from 
the mean for males.  Alternatively, if you picked effect cell coding, then if you chose males 
as the reference cell, they would be coded -1, and females would be coded 1.  For females, 
your dependent variable would still equal b0 + b 1, but the y for males would equal b0 - b1. 
 You would still end up with the result being the mean of each category, but your 
significance test for the coefficient associated with each categorical level would test the 
hypothesis that the mean for females is significantly different from the mean for the WHOLE 
GROUP (males plus females). 

Categorical variables in model selection (stepwise regression) 

Even though SpaceStat creates an indicator variable for each category in a categorical 
dataset, the dataset is treated as one unit in the model selection procedures (e.g., forward and 
backward stepwise regression, best model selection).  This means that categorical variables, 
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or interaction terms that include categorical variables, will drop or add the entire variable or 
interaction term and evaluate changes in model fit, rather than dropping one categorical level 
at a time.  When you are using these tools, you will still be able to choose between reference 
cell and effect cell parameterization.    

Complications with models that include categorical variables 

Complications arise with the parameterization of regression coefficients when combinations 
of categorical variables are used in the regression model. Suppose you wish to model the 
weight of a cat or dog using (a) gender (b) animal type, and (c) the combination (interaction) 
of gender and animal type.  For the interaction term, SpaceStat would parameterize the four 
possible combinations of categories using an intercept and three on-off variables with the 
fourth (e.g., male*dog) as a reference value.  However, trying to parameterize this model 
with two variables, and the interaction term would lead to five parameters for only four 
categories, and a regression matrix where the entries in one column are always equal to the 
sum of the entries in two other columns. 

A similar problem arises when the regression model involves the product of categorical and 
continuous variables, for example animal weight versus the product of animal type (cat or 
dog) and height. In this case the reference cell parameterization would only allow a non-zero 
slope for one of the two animal types since the reference value does not have a variable 
assigned to it.  Therefore, for products of categorical and continuous variables, the 
categorical reference value has to be reintroduced so that a linear dependence on height can 
be allowed for that category. Again if you tried to model regression against both the height, 
and the product of height and animal type, then over-parameterization would occur and 
SpaceStat will flag the regression model as having a singular regression matrix. 

Here's the bottom line:  Don't define a model with categorical linear variables in combination 
with a fully categorical interaction term, and don't use the same continuous variable as a 
linear term and in an interaction with a categorical term. 

Details on the handling of overparameterized models 

When the model that you have defined includes too many parameters (and regression matrix 
inversion fails because the regression matrix is singular), SpaceStat adopts the procedure of 
trimming the model of excess parameters so that you can obtain valid estimates of the 
dependent variable and its standard error. Specifically, the Singular Valued Decomposition 
(SVD) procedure is used to obtain the number of singular elements in the regression matrix, 
as well as lists of parameters that are linearly related to each other. The parameters at the end 
of each list are then removed and the regression matrix is tested again to ensure that the 
number of singular elements has been reduced. The procedure is then repeated until no more 
singularities remain in the regression matrices. 

For a singular regression matrix, the SVD procedure does not produce the only valid 
estimates of the dependent variable. Other combinations of the regression model coefficients 
that are linearly dependent on each other could be removed just as well - consequently the 
reduced model parameterization is not unique. Therefore the Type III ANOVA results 
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(presented for aspatial regression) will represent the sum of squares for an arbitrarily reduced 
model and should not be regarded as unique. 

  

  

Mapping GWR Output as Polygons 

In many cases, you will be performing GWR on centroid geographies that were created from 
polygon geographies.  Although you can view your results by mapping the centroid-based 
output, you will often want to use point to polygon aggregation to convert this information 
back to polygons for visualization.    To do this, select the Aggregation method from the 
Methods menu, and enter the centroid geography, followed by the output of interest, in the 
two boxes that follow "Source dataset" at the top of the Task Manager window.  Then enter 
your polygon geography in the "Destination geography" box.   This will produce a dataset 
called "point to poly mean" (described here in the "Perform Aggregation" page) that you can 
add to a map. 

Here is a comparison of maps using centroids vs. conversion back to county polygons. 

 

  

  

Differences in SpaceStat GWR vs.  Fotheringham et al.'s GWR 

This page reviews two differences in how GWR is implemented in SpaceStat, versus how the 
same techniques are described in the primary reference on the topic, Fotheringham et al. 
2002.  We will use the acronym "FGWR" to refer to the Fotheringham et al. formulation. 

357 



Statistical Methods 

Global versus local standard errors 

Regression parameter standard errors are calculated in FGWR using the global error 
variance, defined as the sum of the squares of the residuals (resulting from the regression 
calculation) at each of the target points. SpaceStat uses the local variance defined as the sum 
of the squares of the residuals resulting from the regression calculation at the source points to 
calculate local standard errors, and hence local p-values for the regression parameters.  We 
suggest that the SpaceStat approach should more accurately reflect the degree of non-
stationarity encapsulated in the geographical weighted calculation. 

Weight factors in Poisson and logistic GWR 

Non-geographical weight datasets are treated differently in SpaceStat and FGWR (as 
implemented in the software GWR 3).  This is due to the treatment of non-geographical 
weights in FGWR as offsets (at least in the case of Poisson regression). However in logistic 
FGWR, the inclusion of extra weight datasets leads to output that is identical to that obtained 
when the weight datasets were excluded. For linear regression the inclusion of extra weight 
datasets yields identical results in FGWR and SpaceStat either for fixed kernel linear 
regression between different geographies or for linear regression on the same geography with 
either fixed or adaptive kernels. 

  

Geographically Weighted Regression - Linear 

  

About Linear Geographically Weighted Regression 

Geographically weighted linear regression can be thought of as the local version of aspatial 
linear regression:  Instead of just one global regression equation for the entire dataset, this 
technique generates parameter estimates for each neighborhood within your spatial dataset. 
 Calculation of local relationships requires choice of a spatial weighting factor, a value that 
determines how strongly values measured at nearby locations influence the regression 
equation calculation, and your definition of neighborhood, which will define how many other 
points are used to estimate the local regression lines.  In aspatial regression the weighting 
factor is set to one for all values in the dataset, and the neighborhood is extended to the entire 
geography, so values from all locations contribute equally to the regression equation.   

In linear GWR, statistical models are fit to sets of N observations (defined by your choice of 
neighborhood) such that a dependent variable y can be expressed in terms of one or more 
independent variables, and a residual, or error, term.  Independent variables can be 
continuous and/or categorical, and you can also include squared terms, interaction effects, 
and weights in your model.  Note however that some combinations of categorical variables 
lead to overspecified models, so read that page to learn about common pitfalls to avoid when 
defining your model. 
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The figure below shows a dataset of N=23 points, plotted so that y, the variable we would 
like to be able to predict, is shown on the vertical axis, and a single independent variable (x) 
is shown on the horizontal axis.  The goal of the linear regression modeling exercise (at a 
local or global scale) is to find the linear function that provides the best prediction of y; that 
is, it produces the smallest errors, measured as the squared difference between the observed 
value of y, and the value of y from the regression line at the same value of x.  Note that the 
term "linear" refers to the linear combination of parameters in the model, and that the graph 
that results from a linear regression model does not have to be a straight line.   

 

A general equation for linear regression 

As in the description of aspatial linear regression, to describe linear GWR we start with the 
general equation for a linear regression model.  In this model, the independent variable 
observations are regarded as fixed, and all other variables (y, and the error term) are 
considered random.  One way of expressing a linear regression model with an unspecified 
number of independent variables is shown below.  You may be familiar with formulas that 
separate out a b 0 (y-intercept) term from the rest of the regression parameters, such as the 
equation for the simple linear regression line that appears here in the SpaceStat help.  This 
parameter is still included in the formula below, in that the "x" part of the "b j x ij" 
component drops out when j=0.   

 

Output from linear regression 

SpaceStat output from linear GWR includes R-squared (and adjusted R-squared) values, 
which measure the fit of the model as a whole, and significance values (p-values) for the 
whole model, and for individual terms in the model.  The output is described in more detail 
here, including examples from the SpaceStat log view. 
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To find out more about how linear GWR is implemented in SpaceStat, click here. 

To skip the details and learn about how to perform linear GWR, click here. 

  

  

Implementation of Linear Geographically Weighted Regression 

As described in the About GWR page, SpaceStat takes a unified approach to all regression 
methods, allowing a model to be specified with both geographic and non-geographic weights. 
 This approach means that as long as an aspatial analysis has been performed on a point 
dataset (such as a set of polygon centroids), the same model can be run using both aspatial 
and geographically weighted regression (GWR) methods.  When all points have the same 
geographic weight, the results for the aspatial and geographically weighted models will be 
the same.  Thus, our description of the implementation of the various forms of GWR (linear, 
described on this page, Poisson, and logistic) is very similar to the implementation pages for 
the aspatial form.   

We'll start the description of how linear GWR is implemented with the general equation 
(below), and then review the approach SpaceStat uses to obtain parameter estimates, sums of 
squares, R-squared, and p-values.   

 

Obtaining the local parameter estimates 

SpaceStat computes local parameter estimates for linear GWR using a maximum likelihood 
approach.  Used in this context, "likelihood" refers to the probability that the dependent 
variable can be predicted from the independent variable(s).  Given the probability function 
for a single observation, we can write the joint probability function (likelihood function) as a 
product of the individual probabilities.  In the following equations, the brackets around the 
beta, which symbolizes the regression coefficients, indicates that we are estimating two or 
more regression coefficients. 
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Next, we need to define the probability function for the individual observations (on the right 
side of our equation above), which is shown below.  For linear regression, probability 
densities are normally distributed (Gaussian), with a zero mean for the residuals and a 
variance which can differ between observations (note the "i" subscript for the variance 
components of the equation).  Recall that the symbol  (pi), represents a constant 
(approximately 3.14).   

 

To estimate parameter values, we use -2 times the logarithm of the Likelihood, because this 
form has properties that facilitate the likelihood estimation process.  In addition to making 
this change, we also change how the variance is expressed to allow the incorporation of both 
geographic and non-geographic weights.  The variance in the equation above can vary by 
observation; in the equation below, we have replaced the original variance expression with 
one that includes a constant variance and a weighting factor that varies by observation (see 
highlighted part of the equation).  Thus, we can now think of the non-constant variance as 
being equivalent to a weighting factor that varies by observation, times a constant variance. 

 

To solve for the regression coefficients (parameter estimates), SpaceStat finds values for 
these coefficients that minimize the weighted sum of squares.  The actual computation of the 
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parameter estimates involves operations on a suite of matrices and vectors, and is 
summarized below.  Note that X with the superscript " T" refers to the transposed X matrix. 

 

Referring back to the regression equation above, the independent variable observation matrix 
X is regarded as a fixed quantity linking the random error (assumed to have a mean of 0 and a 
variance ) with the observed values of the dependent variable y, and with the regression 
coefficients.  Hence, the mean value and standard error of the regression parameters can be 
obtained in terms of the regression parameters themselves, the inverse of the combination ( 
XTWX)-1 and the error variance .  The expected value of the dependent variable at each 
location comes from the product of the independent variable matrix and the vector of the 
least squares regression coefficients.  These expected values of y are then used to calculate 
the residual sum of squares and total sum of squares (see below).   

Evaluating the local model:  Calculating sums of squares 

As described above, after obtaining the local parameter estimates, SpaceStat calculates the 
estimated mean, standard error, and residual error for the dependent variable (y) at each 
observation.  These values are then used to calculate the residual sum of squares (RSS) and 
the total sum of squares (TSS) using the formulas below.  Recall that "N" is the number of 
observations, and "M" is the number of independent variables. In the TSS formula, the "y-
bar" term represents the mean value of the dependent variable observations.  Recall that these 
calculations are done repeatedly across the "neighborhoods" in your dataset, and the results 
can be mapped.   

 

Local Model R-squared, and R-squared for coefficients 

The residual sum of squares and the total sum of squares are used to calculate local model R-
squared values, a measure of the strength of the association between the model developed 
using the geographically weighted independent variables, and the geographically weighted 
observed values of the dependent variable y.  R-squared values are reported for results using 
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the whole model, and for results for each estimated parameter (regression coefficient) alone. 
 For aspatial linear regression, SpaceStat also reports an adjusted R-squared value, but this is 
not available for GWR models.   

 

Significance of the regression model and the ANOVA table 

In contrast to the "global" tool, aspatial regression, GWR does not produce local significance 
values for the overall model.  In part, this is because the relationship between different 
independent variables and the dependent variable can vary in different ways across space, 
and these measures would mask this variation.   Production of local ANOVA tables 
(described here for aspatial linear regression) would lead to excessive amounts of output in 
the log view (a table for each point in your dataset). 

Local significance of model coefficients  

After SpaceStat has calculated the parameter estimates through the Maximum Likelihood 
estimation procedure, local measures of the individual significance of each can be obtained 
by using the regression matrix to relate their standard errors to the local model's error 
variance.  As the regression coefficient values are obtained as sample estimates, a t-
distribution with N-M-1 degrees of freedom is used to obtain the coefficient p-values. 

  

  

Perform Geographically Weighted Regression 

Geographically weighted regression methods are located under Methods -> Regression -> 
Geographically weighted regression.  You choose among the various types of GWR (linear, 
Poisson, and logistic) within the regression settings page of the Task Manager.   

As a general practice, we suggest running all new models with the aspatial regression method 
first, as some efforts to identify model coefficients using the Maximum Likelihood approach 
will fail to coverge (see here for more information).  Failure to converge is most likely when 
using logistic regression, and if a model won't converge in an aspatial form, it will also 
probably not converge in GWR, and will take much longer to run before failing. 

In this example, we are working with a set of breast cancer mortality rates for white females 
aggregated at the county level for states in the northeastern U.S.  We will demonstrate 
creating and running a regression model with two linear independent variables: the number 
of physicians per 1000 patients (MDRATIO), and the log of xylene (a group of benzene 
derivatives found in petroleum) releases in tons/year, which has been log transformed.  To 
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illustrate the use of an interaction term, our model also includes the interaction between the 
percent of county residents living below poverty level, and the median age of residents in the 
county.  The county data began as a polygon geography, but were converted to a centroid 
coverage for these analyses. 

Creating and managing regression models 

When the task manager opens for GWR, it will start on the "Regression models" section. 
 Here, you must choose your geography (if your project contains more than one point 
coverage), and then indicate whether you would like to create, modify, or delete a regression 
model.  You can create a suite of models that all share the same geography, dependent 
variable, and form (linear, Poisson, and logistic) within one Geographically weighted 
regression "tab" in the task manager, and these will all appear with the default name 
"Regression model" on this page, unless you change the name (see below).  Note that any 
aspatial regression models that you have created using a point geography will also appear in 
this window.  To modify an existing model, highlight it, and then hit the "Modify" button. 
 Similarly, select a model and then click on delete to remove it from the list.  Additional 
models can be created and saved, and they will all be listed in this window.  Note that if you 
choose the regression method again from the methods pull down window, a new regression 
tab will appear, and will list the same suite of models (an example of this is shown here, for 
aspatial regression).  You can delete this extra tab without losing your saved models. 

Defining a new regression model 

When you click on the "Create" button in the initial task manager page for Geographically 
weighted regression, a dialog will open where you name your model, and then define the 
dependent and independent variables that the model will include.  You can also use the 
instructions below to modify a model you have already created. 

Click on the boxes below for brief definitions, and for links to detailed information on 
defining the terms in your model. 
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Selecting model terms. 

The window titled "Independent variables" lists all of the datasets associated with the 
geography that you selected in the first task manager window for regression.  To use one or 
more of these datasets as a term in your model, click on it to select it.  To select more than 
one dataset (as shown in the image above, for adding an interaction term), hold down the 
"Ctrl" button as you click on each.  When the dataset name is selected, you can then use the 
buttons on the right to add that dataset as a linear term (i.e., as an "x"), as a squared term (i.e., 
as an x2), or as part of an interaction term in which it will be multiplied by one or more other 
independent variables.  In the example above, we have selected the two linear terms 
(XYLENE, and MDRATIO), and included an interaction term (%POVERTY * 
MEDIAN_AGE).  As you add various terms, they will appear in the three boxes in the center 
of the task manager window.  You can delete terms that you have created by selecting them 
and then using the delete button on your keyboard. 

Categorical variables:  Select the reference value and parameterization type. 
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Directly below the windows where the regression model terms are listed is a section that only 
applies to categorical variables; in this area you will choose a reference value and a 
parameterization type (coding system).  The model shown here does not include a categorical 
variable, but the options are explained in detail in the help section on categorical data in 
regression.  To fill in these options for your categorical variables, first select the categorical 
dataset (see "MD_Ratio_CAT" in the aspatial regression example, here).  When a categorical 
dataset is selected, you will be able to scroll through the names of the categories within that 
set in the box to the left of "Reference value for...".  Next, for that same categorical dataset, 
you choose a reference cell or effect cell approach to coding by clicking on the respective 
circle to the left of your choice.  If you have more than one categorical term, including 
interaction terms that incorporate a categorical dataset, you will need to repeat this process 
for all of these terms.  If you forget to do this step, SpaceStat will run the model using the 
default settings of the middle category as the reference value, with the reference cell 
parameterization type. 

Fix intercept at zero check box. 

Check this box if you want to force your linear regression model through the origin (0,0). 
 This option should not be applied to Poisson or logistic regression, or to linear regression 
with only categorical terms.  If you do check the box with a Poisson or logistic model, or for 
a model with categorical terms, SpaceStat will proceed as if the box had not been checked. 
 Note that if you have chosen to fix your intercept at zero, SpaceStat will report the R2 for 
this "no intercept" model as "-".  This is because calculations of R2 in the no-intercept models 
tend to be larger than models with an intercept, or in some cases can be negative.  Details on 
this topic are presented in Kutner et al. 2004. 

After you have finished creating or modifying your regression model, click "ok" to return to 
the first page of the task manager for geographically weighted regression, and then click on 
the "Regression settings" tab to complete the process of defining your model.   

Regression settings. 

After you have identified the datasets to be used in your model, you will need to define other 
settings, including the output geography (the same as your source, or another point 
geography in your project).  You can choose an output geography that differs from your 
source geography, but if you do so, SpaceStat will not be able to calculate the dependent 
variable's expected values, residuals, and standard errors.  See the output page for GWR for 
more information.   

The next boxes on the Regression settings page requests the regression type (linear, Poisson, 
and logistic), and the identity of any weight sets you would like to use.   

Next, you will need to define the geographic weighting scheme that will be used in your 
analysis.  This process includes two basic steps -- defining the neighbor method (nearest 
neighbor or distance range, abbreviated as range in the pull down menu), and defining the 
regression weight method (the options are shown in the image below, to the right of 
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"Regression weight method").   If you choose to use a range rather than a nearest neighbor 
approach for defining neighbors, the box marked "neighbor count" in the image below will 
instead ask for "Range".  Here you can accept the default of 10, or enter a new distance value 
(in the same units as the coordinates for your centroid geography).  The Gaussian and 
Bisquare-Fixed options will require a bandwidth, which you will specify (or have SpaceStat 
optimize) on the bandwidth settings tab. 

Click on the boxes below for brief definitions, and for links to detailed information on 
defining your geographic weights. 

 

Bandwidth settings 

If you choose a weighting scheme that requires a bandwidth, you will specify the bandwidth 
on the "bandwidth settings" page.  This process is described in detail here.  The default is for 
you to specify a bandwidth ("Specify" will be shown where it says "Calculate optimum" in 
the image below).  The default value for the "Specify" option is the maximum distance 
between two points in your geography; similarly, the default ranges under the "Set optimum" 
option are the minimum and maximum distance between points. The calculate optimum 
method uses a cross-validation procedure, with the number of cross-validation calculations 
set by your entry for "bandwidth steps." 
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More settings 

The creatively named "More settings" page allows you to specify non-geographical weight 
datasets, start and end times, the types of output datasets produced, and the name of the 
output folder that will appear below your dependent variable in the dataview.  Specific 
information on how the output datasets are calculated is shown on the "Implementation" 
pages for each model type (linear, logistic, and Poisson). 

When you have completed this page, click on the last section, "Run Method". 

Click on boxes within the image below for more information. 
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Run Method 

When you click on "Run Method", the task manager will present a summary of the model 
you have just created or modified.  If you agree with the model definition that appears in this 
window, then click on the "Run" button at the bottom of the window to run the model.  Note 
that the information shown here will be repeated in the log at the beginning of your GWR 
regression output. 
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Now that you have run the model, look in the log view to see what happened.  In some cases, 
especially with logistic models, your model will not converge.  The log will also give you 
information on the cross-validation procedure to find optimum bandwidths.  There are some 
variations in the output presented for the various model types; pick one of the following links 
to see example output for linear, Poisson, and logistic models, respectively. 

  

  

Geographically Weighted Regression Output 

Unlike aspatial regression output, output from running a GWR analysis does not include a 
"global" result in the log view.  Since the point of this type of analysis is to evaluate how the 
relationships among variables vary across space, all of your output (except for a description 
of your model run that appears in the log) will be in a GWR output folder that will appear 
below your dependent variable in the Data view. 
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Here, we will show the output from the model we used to illustrate running a GWR model on 
the "Perform" page.   

Summary of the model run 

After clicking to the run method page and then selecting "Run", we see the following output 
in the log view, beginning with the summary of the model run.  Note that below the 
summary, the log shows the first five steps of the Cross-validation process to determine the 
optimum bandwidth for our Bisquare-fied regression weighting method. 

 

Output datasets 
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At a minimum, GWR produces output datasets for the dependent variable's expected values, 
residuals, and standard errors (highlighted in orange in the image below).  Checking the 
"Output regression term datasets" will add correlation coefficients between the dependent 
and each independent variable, along with each variable's weighted means (datasets 
highlighted in blue below).  Checking the "Output independpent variable statistics" option 
will add datasets (highlighted in pink) for each regression coefficient, the associated p-
values, regression parameter R-squareds (linear models only), and the local model R-
squareds (linear models only).  Note that if you roll the cursor over the dataset name, a popup 
box will give you additional information.  In the image below, the cursor is over the 
"Coefficient 2 P value" dataset, and the popup box tells you that this p-value dataset refers to 
the MDRATIO variable.  Note that significance values in regression output are reported as 
"0.0" if they are smaller than 0.000001.   

All of the new datasets will appear if you open the data table for your geography.  If you 
right click on any dataset, you can: Add it to a new or existing map, rename or remove it, 
convert it to a different type (e.g., from a decimal to a string dataset), or view it's properties. 
 Specifically, the properties for datasets created by regression analyses repeat the information 
that appears in the run method window when you perform the analysis.  You can also use the 
aggregation method to convert the dataset to a polygon geography to make interpreting your 
results easier. 

  

Geographically Weighted Regression - Poisson 

  

About Poisson Geographically Weighted Regression 

Poisson geographically weighted regression is a local form of generalized linear models that 
assumes that your data follow a Poisson distribution.  This distribution describes the 
probability of events occurring in time or space when the pattern of these occurrences is 
random, and is often a good fit for count and rate data.  With Poisson regression, you are 
building a model to estimate a count or rate using relationships between your independent 
(predictor) variable(s) and the expected value of your Poisson variable.  Example 
applications include models to predict counts of the number of people visiting a hospital 
emergency room at different times of day, or to predict rates, such as death rate (count of 
deaths divided by person-years) from independent data on contaminant concentrations. 
 Independent variables in a Poisson regression can be continuous and/or categorical, and you 
can also include interaction effects and non-geographic weight variables in your model.  Note 
however that some combinations of categorical variables lead to overspecified models, so 
read that page so that you know what to avoid when defining your model.  Assumptions of 
Poisson regression models include (1) independent observations; and (2) independent 
variables are linearly related to the log of the dependent variable. 

The Poisson distribution 
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A Poisson random variable has a probability density function, f(y), that can be described by 
the following formula: 

 

Here the parameter lambda is the estimated value of Y, e is the natural log, and the 
denominator of the equation is y factorial (!), or yi multiplied by (yi - 1), (yi - 2),... 2, 1.   

The shape of the Poisson distribution varies with the expected value per interval (in space or 
time) of occurrences of the event that is being counted.  Small expected values, such as 1, 
show a highly skewed distribution, while distributions for higher expected values appear 
more symmetrical.  This pattern is illustrated below for three datasets with expected values 
per interval of 1 (blue), 2 (red), and 4 (orange). Recall that the values that can be observed 
are all integers, so consider the lines connecting the points in the figure below as just a way 
to visualize the shape of the distribution; they do not indicate a continuous function. 

 

A key characteristic of this distribution is that it's mean and variance are equal, so this is an 
important first check to apply to your data to help you decide if a Poisson model would be 
appropriate.  In addition to this check, data that can be characterized with a Poisson 
distribution have several traits that makes applying linear regression inappropriate.  First, 
their distribution may be skewed towards small values, as described above and shown in the 
figure.  For example, this tool is often applied to counts of territorial animal species, where 
the number of individuals observed at a count location is usually zero or one because 
territory owners keep others out of the defended space.  However, a binary variable (as used 
in GWR logistic regression) would not be appropriate, because where individuals interact in 
space, like at territory boundaries, you may record counts of 2, 3, 4, and so on.  A second 
characteristic of data for which a Poisson distribution provides a better fit than traditional 
regression (Gaussian) is non-symmetric distribution of errors.  The Poisson distribution takes 
only positive values, while negative values are fine in simple linear regression.  Finally, the 
variance of a Poisson distribution increases as the mean increases, violating the simple linear 
regression assumption of homoscedasticity. 

A general equation for GWR Poisson regression 
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The general equation for Poisson regression uses a Poisson probability distribution for the 
individual dependent variable observations.  The equation differs from traditional regression 
in that the left hand side is the logarithm of the expected value (or mean, symbolized as ) of 
the dependent variable’s response.  Note that this is the same expected value that 
parameterizes the Poisson distribution function, as illustrated in the figure above. 

 

Output from Aspatial Poisson regression 

SpaceStat output from GWR Poisson regression includes regression coefficients and p-values 
for individual terms in the model.  The output is described in more detail here, including 
examples from the SpaceStat log view. 

To find out more about how GWR Poisson regression is implemented in SpaceStat, click 
here. 

To skip the details and learn about how to perform Poisson regression, click here. 

  

  

Implementation of Poisson GWR 

As described in the About GWR page, SpaceStat takes a unified approach to all regression 
methods, allowing a model to be specified with both geographic and non-geographic weights. 
 This approach means that as long as an aspatial analysis has been performed on a point 
dataset (such as a set of polygon centroids), the same model can be run using both aspatial 
and geographically weighted regression (GWR) methods, and when all points have the same 
geographic weight, the results will be the same.  Thus, our description of the implementation 
of the various forms of GWR (Poisson, described here, linear, and logistic) is very similar to 
the implementation pages for the aspatial form.   

As described here in the overview of Poisson regression, the goal of this statistical tool is to 
parameterize a relationship between one or more independent variables, and the expected 
value (mean) of a discrete (integers only) dependent variable that follows a Poisson 
distribution.  This statistical tool uses the log as its link function; taking the log of the 
function produces a linear combination of predictors, so again this is a form of linear model. 
 The log link funtion also constrains the expected values to positive numbers.  As shown in 
the overview of Poisson regression, a general formula can be written as: 
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Obtaining the parameter estimates 

For all regression in SpaceStat, the regression formulation is carried out in terms of 
maximum likelihood ( L) estimation.  A "likelihood" is a probability (and must have a value 
within the range of 0 - 1); in this case the probability that the dependent variable can be 
predicted from the independent variables.  As indicated in the equation below, the maximum 
likelihood estimator uses a Poisson distribution to define a joint probability distribution from 
the individual dependent variable observations.   In the following equations, the brackets 
around the beta, which symbolizes the regression coefficients, indicate that we are estimating 
two or more regression coefficients. 

 

The goal of maximum likelihood estimation is to maximize the Log-Likelihood (lnL), which 
has a value between 0 and negative infinity (negative, because you are taking the log of a 
value that is less than 1). Maximum likelihood estimation is an iterative process.  Recall from 
our overview that we need to account for both geographic and non-geographic weighting 
factors (w) in our estimation.  The weighted log-likelihoods for logistic regression can be 
obtained by raising each individual probability to the power of a weight factor, taking the 
product over observations, and then taking the logarithm. 

 

To estimate the regression coefficients, SpaceStat uses the Taylor expansion of the equation 
above, and then the maximum likelihood algorithm determines the direction and sign of 
changes in the regression coefficients which will increase the lnL.  After starting from an 
arbitrary set of coefficient estimates, the initial function is estimated and the residuals are 
evaluated.  From these results, the algorithm modifies the coefficient values, and generates a 
new set of residuals which are compared to previous values.  This process continues until 
there is little change in the lnL.   There is a possibility that this process will not lead to 
convergence due to what is called a "ridge-effect"; in this case, the Log-Likelihood stays 
constant as coefficients are varied. 
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Evaluating the full model 

To evaluate the significance of the full aspatial Poisson regression model, SpaceStat presents 
the difference (deviance) between the log-likelihood of the full model and that of a 
"perfectly–fitted" model in which the Poisson mean at each observation is set equal to the 
observed value.  There is not a local version of this statistic. 

Significance of individual terms in the Poisson regression model 

For Poisson GWR regression, SpaceStat presents the parameter estimates, parameter standard 
errors and p-values (using a chi-squared distribution).  Likelihood ratio tests are used to 
evaluate the significance of individual parameters in the model.  The basic idea of these 
significance tests is the same as the test of significance of the full model (described here for 
aspatial Poisson regression), except the tests are based on the difference in -2lnL for an 
overall model and a nested model where one term has been dropped.  If the test for a 
particular parameter is not significant, this means that coefficient for that variable can be 
considered to not be significantly different from zero, and that you can drop this variable 
from your model without a reduction in model performance.   

  

  

Perform Geographically Weighted Regression 

Geographically weighted regression methods are located under Methods -> Regression -> 
Geographically weighted regression.  You choose among the various types of GWR (linear, 
Poisson, and logistic) within the regression settings page of the Task Manager.   

As a general practice, we suggest running all new models with the aspatial regression method 
first, as some efforts to identify model coefficients using the Maximum Likelihood approach 
will fail to coverge (see here for more information).  Failure to converge is most likely when 
using logistic regression, and if a model won't converge in an aspatial form, it will also 
probably not converge in GWR, and will take much longer to run before failing. 

In this example, we are working with a set of breast cancer mortality rates for white females 
aggregated at the county level for states in the northeastern U.S.  We will demonstrate 
creating and running a regression model with two linear independent variables: the number 
of physicians per 1000 patients (MDRATIO), and the log of xylene (a group of benzene 
derivatives found in petroleum) releases in tons/year, which has been log transformed.  To 
illustrate the use of an interaction term, our model also includes the interaction between the 
percent of county residents living below poverty level, and the median age of residents in the 
county.  The county data began as a polygon geography, but were converted to a centroid 
coverage for these analyses. 

Creating and managing regression models 
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When the task manager opens for GWR, it will start on the "Regression models" section. 
 Here, you must choose your geography (if your project contains more than one point 
coverage), and then indicate whether you would like to create, modify, or delete a regression 
model.  You can create a suite of models that all share the same geography, dependent 
variable, and form (linear, Poisson, and logistic) within one Geographically weighted 
regression "tab" in the task manager, and these will all appear with the default name 
"Regression model" on this page, unless you change the name (see below).  Note that any 
aspatial regression models that you have created using a point geography will also appear in 
this window.  To modify an existing model, highlight it, and then hit the "Modify" button. 
 Similarly, select a model and then click on delete to remove it from the list.  Additional 
models can be created and saved, and they will all be listed in this window.  Note that if you 
choose the regression method again from the methods pull down window, a new regression 
tab will appear, and will list the same suite of models (an example of this is shown here, for 
aspatial regression).  You can delete this extra tab without losing your saved models. 

Defining a new regression model 

When you click on the "Create" button in the initial task manager page for Geographically 
weighted regression, a dialog will open where you name your model, and then define the 
dependent and independent variables that the model will include.  You can also use the 
instructions below to modify a model you have already created. 

Click on the boxes below for brief definitions, and for links to detailed information on 
defining the terms in your model. 
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Selecting model terms. 

The window titled "Independent variables" lists all of the datasets associated with the 
geography that you selected in the first task manager window for regression.  To use one or 
more of these datasets as a term in your model, click on it to select it.  To select more than 
one dataset (as shown in the image above, for adding an interaction term), hold down the 
"Ctrl" button as you click on each.  When the dataset name is selected, you can then use the 
buttons on the right to add that dataset as a linear term (i.e., as an "x"), as a squared term (i.e., 
as an x2), or as part of an interaction term in which it will be multiplied by one or more other 
independent variables.  In the example above, we have selected the two linear terms 
(XYLENE, and MDRATIO), and included an interaction term (%POVERTY * 
MEDIAN_AGE).  As you add various terms, they will appear in the three boxes in the center 
of the task manager window.  You can delete terms that you have created by selecting them 
and then using the delete button on your keyboard. 

Categorical variables:  Select the reference value and parameterization type. 
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Directly below the windows where the regression model terms are listed is a section that only 
applies to categorical variables; in this area you will choose a reference value and a 
parameterization type (coding system).  The model shown here does not include a categorical 
variable, but the options are explained in detail in the help section on categorical data in 
regression.  To fill in these options for your categorical variables, first select the categorical 
dataset (see "MD_Ratio_CAT" in the aspatial regression example, here).  When a categorical 
dataset is selected, you will be able to scroll through the names of the categories within that 
set in the box to the left of "Reference value for...".  Next, for that same categorical dataset, 
you choose a reference cell or effect cell approach to coding by clicking on the respective 
circle to the left of your choice.  If you have more than one categorical term, including 
interaction terms that incorporate a categorical dataset, you will need to repeat this process 
for all of these terms.  If you forget to do this step, SpaceStat will run the model using the 
default settings of the middle category as the reference value, with the reference cell 
parameterization type. 

Fix intercept at zero check box. 

Check this box if you want to force your linear regression model through the origin (0,0). 
 This option should not be applied to Poisson or logistic regression, or to linear regression 
with only categorical terms.  If you do check the box with a Poisson or logistic model, or for 
a model with categorical terms, SpaceStat will proceed as if the box had not been checked. 
 Note that if you have chosen to fix your intercept at zero, SpaceStat will report the R2 for 
this "no intercept" model as "-".  This is because calculations of R2 in the no-intercept models 
tend to be larger than models with an intercept, or in some cases can be negative.  Details on 
this topic are presented in Kutner et al. 2004. 

After you have finished creating or modifying your regression model, click "ok" to return to 
the first page of the task manager for geographically weighted regression, and then click on 
the "Regression settings" tab to complete the process of defining your model.   

Regression settings. 

After you have identified the datasets to be used in your model, you will need to define other 
settings, including the output geography (the same as your source, or another point 
geography in your project).  You can choose an output geography that differs from your 
source geography, but if you do so, SpaceStat will not be able to calculate the dependent 
variable's expected values, residuals, and standard errors.  See the output page for GWR for 
more information.   

The next boxes on the Regression settings page requests the regression type (linear, Poisson, 
and logistic), and the identity of any weight sets you would like to use.   

Next, you will need to define the geographic weighting scheme that will be used in your 
analysis.  This process includes two basic steps -- defining the neighbor method (nearest 
neighbor or distance range, abbreviated as range in the pull down menu), and defining the 
regression weight method (the options are shown in the image below, to the right of 

379 



Statistical Methods 

"Regression weight method").   If you choose to use a range rather than a nearest neighbor 
approach for defining neighbors, the box marked "neighbor count" in the image below will 
instead ask for "Range".  Here you can accept the default of 10, or enter a new distance value 
(in the same units as the coordinates for your centroid geography).  The Gaussian and 
Bisquare-Fixed options will require a bandwidth, which you will specify (or have SpaceStat 
optimize) on the bandwidth settings tab. 

Click on the boxes below for brief definitions, and for links to detailed information on 
defining your geographic weights. 

 

Bandwidth settings 

If you choose a weighting scheme that requires a bandwidth, you will specify the bandwidth 
on the "bandwidth settings" page.  This process is described in detail here.  The default is for 
you to specify a bandwidth ("Specify" will be shown where it says "Calculate optimum" in 
the image below).  The default value for the "Specify" option is the maximum distance 
between two points in your geography; similarly, the default ranges under the "Set optimum" 
option are the minimum and maximum distance between points. The calculate optimum 
method uses a cross-validation procedure, with the number of cross-validation calculations 
set by your entry for "bandwidth steps." 
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More settings 

The creatively named "More settings" page allows you to specify non-geographical weight 
datasets, start and end times, the types of output datasets produced, and the name of the 
output folder that will appear below your dependent variable in the dataview.  Specific 
information on how the output datasets are calculated is shown on the "Implementation" 
pages for each model type (linear, logistic, and Poisson). 

When you have completed this page, click on the last section, "Run Method". 

Click on boxes within the image below for more information. 
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Run Method 

When you click on "Run Method", the task manager will present a summary of the model 
you have just created or modified.  If you agree with the model definition that appears in this 
window, then click on the "Run" button at the bottom of the window to run the model.  Note 
that the information shown here will be repeated in the log at the beginning of your GWR 
regression output. 
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Now that you have run the model, look in the log view to see what happened.  In some cases, 
especially with logistic models, your model will not converge.  The log will also give you 
information on the cross-validation procedure to find optimum bandwidths.  There are some 
variations in the output presented for the various model types; pick one of the following links 
to see example output for linear, Poisson, and logistic models, respectively. 

  

  

Geographically Weighted Regression Output 

Unlike aspatial regression output, output from running a GWR analysis does not include a 
"global" result in the log view.  Since the point of this type of analysis is to evaluate how the 
relationships among variables vary across space, all of your output (except for a description 
of your model run that appears in the log) will be in a GWR output folder that will appear 
below your dependent variable in the Data view. 
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Here, we will show the output from the model we used to illustrate running a GWR model on 
the "Perform" page.   

Summary of the model run 

After clicking to the run method page and then selecting "Run", we see the following output 
in the log view, beginning with the summary of the model run.  Note that below the 
summary, the log shows the first five steps of the Cross-validation process to determine the 
optimum bandwidth for our Bisquare-fied regression weighting method. 

 

Output datasets 
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At a minimum, GWR produces output datasets for the dependent variable's expected values, 
residuals, and standard errors (highlighted in orange in the image below).  Checking the 
"Output regression term datasets" will add correlation coefficients between the dependent 
and each independent variable, along with each variable's weighted means (datasets 
highlighted in blue below).  Checking the "Output independpent variable statistics" option 
will add datasets (highlighted in pink) for each regression coefficient, the associated p-
values, regression parameter R-squareds (linear models only), and the local model R-
squareds (linear models only).  Note that if you roll the cursor over the dataset name, a popup 
box will give you additional information.  In the image below, the cursor is over the 
"Coefficient 2 P value" dataset, and the popup box tells you that this p-value dataset refers to 
the MDRATIO variable.  Note that significance values in regression output are reported as 
"0.0" if they are smaller than 0.000001.   

All of the new datasets will appear if you open the data table for your geography.  If you 
right click on any dataset, you can: Add it to a new or existing map, rename or remove it, 
convert it to a different type (e.g., from a decimal to a string dataset), or view it's properties. 
 Specifically, the properties for datasets created by regression analyses repeat the information 
that appears in the run method window when you perform the analysis.  You can also use the 
aggregation method to convert the dataset to a polygon geography to make interpreting your 
results easier. 

  

Geographically Weighted Regression - Logistic 

  

About Logistic Geographically Weighted Regression 

Logistic regression is a form of generalized linear models that has been developed 
specifically for predicting the value of dependent variables that are binary (categorical with 
two possible values) such as yes/no, male/female, presence/absence, or diseased/healthy 
response variables.  Independent variables in a logistic regression can be continuous and/or 
categorical, and you can also include interaction effects and weights in your model.  Note 
however that some combinations of categorical variables lead to overspecified models, so 
read that page so that you know what to avoid when defining your model.  Assumptions of 
logistic regression models include (1) independent observations; and that (2) independent 
variables are linearly related to the log odds (logit) of the dependent variable. 
 Geographically weighted logistic regression can be thought of as the local version of aspatial 
logistic regression:  Instead of just one global regression equation for the entire dataset, this 
technique generates parameter estimates for each neighborhood within your spatial dataset. 
 Calculation of local relationships requires choice of a spatial weighting factor, a value that 
determines how strongly values measured at nearby locations influence the regression 
equation calculation, and your definition of neighborhood, which will define how many other 
points are used to estimate the local regression lines.  In aspatial logistic regression the 
weighting factor is set to one for all values in the dataset, and the neighborhood is extended 
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to the entire geography, so values from all locations contribute equally to the regression 
equation.   

To perform logistic regression, data must be coded as 0 or 1 (of type numeric, not string). 
 The mean of the sample is equal to the proportion of 1s in the sample, and this mean is also 
the probability of drawing a case labeled as 1 at random from your data.  Examples of 
applications include a model to predict probability of disease incidence (yes or no on a per-
individual basis), with groundwater contamination level as an independent variable, or a 
model to predict the sex of birds (for species where it is not readily apparent) based on 
measurements of weight, and wing and bill length.   

As is true for simple linear regression, the goal is to model a relationship between the 
independent (predictor) variable(s) and the dependent (response) variable.  More specifically, 
the goal for logistic regression is to predict the category for the dependent variable from the 
suite of independent variables that provides the best balance between model performance and 
model complexity.  However, rather than directly estimating the category of the response 
variable at a given value of the predictor, for logistic regression, you estimate the probability 
that an observation has a code of 1.  Specifically, this tool predicts the log odds that an 
observation will be a 1 (probability = P) rather than a 0 (probability = 1 - P).   Because all of 
the y values in your dataset are either 0 or 1, scatterplots such as the one shown in the 
description of linear regression are not very useful for binary data.  Instead, you might do a 
histogram of the frequency of "1s" in your dataset, and a curve fit to your graph would have 
an expected shape similar to the logistic curve shown below. 

 

A general equation for logistic regression 

In SpaceStat' logistic regression, the relationship between the independent variable(s) and the 
probability that observations of your dependent variable will be coded 1 is described with a 
logistic curve of the form shown above.  Note that the regression coefficients, which are the 
parameters that you are trying to estimate during the regression procedure, are part of a 
power function that controls the shape of the logistic curve.  Next, SpaceStat will use 
maximum likelihood estimation to this transformed variable (from the 1s and 0s to a logit 
variable - the natural log of the odds of the dependent variable being coded 1). 
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Click here to compare this formula to the one for linear regression. 

Output for logistic regression 

Similar to aspatial Poisson regression, SpaceStat output for GWR logistic regression includes 
calculation of parameter estimates, and significance values (p-values) for individual terms in 
the model.  The output is described in more detail here, including examples from the 
SpaceStat log view. 

To find out more about how GWR logistic regression is implemented in SpaceStat, click 
here. 

To skip the details and learn about how to perform GWR, click here. 

  

  

Implementation of Logistic GWR 

As described here in the overview of logistic GWR, the goal of this statistical tool is to 
parameterize a local non-linear relationship between one or more independent variables, and 
the probability that a binary variable will be coded as 1 rather than 0 (e.g., the data value is 
yes rather than no, or diseased rather than without disease).  This statistical tool uses the logit 
as its link function - the logit link function constrains the probability values (predictions of y) 
to a range from 0 - 1.   
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Obtaining the parameter estimates 

For logistic regression in SpaceStat, the regression formulation is carried out in terms of 
maximum likelihood (L) estimation.  A "likelihood" is a probability (and must have a value 
within the range of 0 - 1); in this case the probability that the dependent variable can be 
predicted from the independent variables.  As indicated in the equation below, the maximum 
likelihood estimator uses a Bernoulli distribution to define a joint probability distribution 
from the individual dependent variable observations.   In the following equations, the 
brackets around the beta, which symbolizes the regression coefficients, indicate that we are 
estimating two or more regression coefficients. 

 

The goal of maximum likelihood estimation is to maximize the Log-Likelihood (lnL), which 
has a value between 0 and negative infinity (negative, because you are taking the log of a 
value that is less than 1). Maximum likelihood estimation is an iterative process.  Recall from 
our overview that we need to account for both geographic and non-geographic weighting 
factors (w) in our estimation.  The weighted log-likelihoods for logistic regression can be 
obtained by raising each individual probability to the power of a weight factor, taking the 
product over observations, and then taking the logarithm. 

  

To estimate the regression coefficients, SpaceStat uses the Taylor expansion of the equation 
above, and then the maximum likelihood algorithm determines the direction and sign of 
changes in the regression coefficients which will increase the lnL.  After starting from an 
arbitrary set of coefficient estimates, the initial function is estimated and the residuals are 
evaluated.  From these results, the algorithm modifies the coefficient values, and generates a 
new set of residuals which are compared to previous values.  This process continues until 
there is little change in the lnL.   There is a possibility that this process will not lead to 
convergence due to what is called a "ridge-effect"; in this case, the Log-likelihood remains 
constant as coefficients are varied. 

Evaluating the global model 

Overall model quality is assessed for logistic regression models using negative 2 times the 
natural log of the likelihood function (-2lnL); in general, as the model fit improves, -2lnL will 
decrease in magnitude.  Other names for -2lnL include the likelihood ratio, deviance chi-
square, and the model's measure of goodness of fit.  Values of -2lnL have approximately a 
chi-square distribution, and as a result this distribution is used for significance testing of the 
overall model.  In effect -2lnL plays the same role as the residual sum of squares (RSS) in 
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linear regression (i.e., it reflects the unexplained variance between predicted and observed 
values).   The -2lnL value forms the basis of the likelihood ratio test (described below), 
which as the name suggests, is a significance test based on the difference between the 
likelihood ratios of two forms of a model. Likelihood ratios are not calculated for local 
models, but we recommend that you start with the aspatial version of logistic models --in part 
because the GWR versions often do not converge--prior to working with GWR models. 

Measures of global model fit and significance 

For aspatial logistic regression, SpaceStat presents two calculations that play the role of R-
squared in linear regression, and a full model chi-square test, which are described here in 
aspatial logistic regression.  Again, we suggest working with an aspatial logistic version first, 
so it will likely be useful to review this related information. 

Significance of individual terms in the local regression model 

For logistic GWR, SpaceStat presents the parameter estimates, parameter standard errors and 
p-values (using a chi-squared distribution).  As described above for evaluating the 
significance of the entire aspatial logistic regression model, likelihood ratio tests are used to 
evaluate the significance of individual parameters in the model.  The basic idea of these 
significance tests is the same as the test of significance of the full model, except in this case 
the test is based on the difference in -2lnL for an overall model and a nested model where one 
independent variable has been dropped.  If the test for a particular parameter is not 
significant, this means that the coefficient for that variable can be considered not 
significantly different from zero, and that you can drop this variable from your model 
without a reduction in model performance.  Note that you can't use this approach to compare 
two non-nested models. 

  

  

Perform Geographically Weighted Regression 

Geographically weighted regression methods are located under Methods -> Regression -> 
Geographically weighted regression.  You choose among the various types of GWR (linear, 
Poisson, and logistic) within the regression settings page of the Task Manager.   

As a general practice, we suggest running all new models with the aspatial regression method 
first, as some efforts to identify model coefficients using the Maximum Likelihood approach 
will fail to coverge (see here for more information).  Failure to converge is most likely when 
using logistic regression, and if a model won't converge in an aspatial form, it will also 
probably not converge in GWR, and will take much longer to run before failing. 

In this example, we are working with a set of breast cancer mortality rates for white females 
aggregated at the county level for states in the northeastern U.S.  We will demonstrate 
creating and running a regression model with two linear independent variables: the number 
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of physicians per 1000 patients (MDRATIO), and the log of xylene (a group of benzene 
derivatives found in petroleum) releases in tons/year, which has been log transformed.  To 
illustrate the use of an interaction term, our model also includes the interaction between the 
percent of county residents living below poverty level, and the median age of residents in the 
county.  The county data began as a polygon geography, but were converted to a centroid 
coverage for these analyses. 

Creating and managing regression models 

When the task manager opens for GWR, it will start on the "Regression models" section. 
 Here, you must choose your geography (if your project contains more than one point 
coverage), and then indicate whether you would like to create, modify, or delete a regression 
model.  You can create a suite of models that all share the same geography, dependent 
variable, and form (linear, Poisson, and logistic) within one Geographically weighted 
regression "tab" in the task manager, and these will all appear with the default name 
"Regression model" on this page, unless you change the name (see below).  Note that any 
aspatial regression models that you have created using a point geography will also appear in 
this window.  To modify an existing model, highlight it, and then hit the "Modify" button. 
 Similarly, select a model and then click on delete to remove it from the list.  Additional 
models can be created and saved, and they will all be listed in this window.  Note that if you 
choose the regression method again from the methods pull down window, a new regression 
tab will appear, and will list the same suite of models (an example of this is shown here, for 
aspatial regression).  You can delete this extra tab without losing your saved models. 

Defining a new regression model 

When you click on the "Create" button in the initial task manager page for Geographically 
weighted regression, a dialog will open where you name your model, and then define the 
dependent and independent variables that the model will include.  You can also use the 
instructions below to modify a model you have already created. 

Click on the boxes below for brief definitions, and for links to detailed information on 
defining the terms in your model. 
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Selecting model terms. 

The window titled "Independent variables" lists all of the datasets associated with the 
geography that you selected in the first task manager window for regression.  To use one or 
more of these datasets as a term in your model, click on it to select it.  To select more than 
one dataset (as shown in the image above, for adding an interaction term), hold down the 
"Ctrl" button as you click on each.  When the dataset name is selected, you can then use the 
buttons on the right to add that dataset as a linear term (i.e., as an "x"), as a squared term (i.e., 
as an x2), or as part of an interaction term in which it will be multiplied by one or more other 
independent variables.  In the example above, we have selected the two linear terms 
(XYLENE, and MDRATIO), and included an interaction term (%POVERTY * 
MEDIAN_AGE).  As you add various terms, they will appear in the three boxes in the center 
of the task manager window.  You can delete terms that you have created by selecting them 
and then using the delete button on your keyboard. 

Categorical variables:  Select the reference value and parameterization type. 
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Directly below the windows where the regression model terms are listed is a section that only 
applies to categorical variables; in this area you will choose a reference value and a 
parameterization type (coding system).  The model shown here does not include a categorical 
variable, but the options are explained in detail in the help section on categorical data in 
regression.  To fill in these options for your categorical variables, first select the categorical 
dataset (see "MD_Ratio_CAT" in the aspatial regression example, here).  When a categorical 
dataset is selected, you will be able to scroll through the names of the categories within that 
set in the box to the left of "Reference value for...".  Next, for that same categorical dataset, 
you choose a reference cell or effect cell approach to coding by clicking on the respective 
circle to the left of your choice.  If you have more than one categorical term, including 
interaction terms that incorporate a categorical dataset, you will need to repeat this process 
for all of these terms.  If you forget to do this step, SpaceStat will run the model using the 
default settings of the middle category as the reference value, with the reference cell 
parameterization type. 

Fix intercept at zero check box. 

Check this box if you want to force your linear regression model through the origin (0,0). 
 This option should not be applied to Poisson or logistic regression, or to linear regression 
with only categorical terms.  If you do check the box with a Poisson or logistic model, or for 
a model with categorical terms, SpaceStat will proceed as if the box had not been checked. 
 Note that if you have chosen to fix your intercept at zero, SpaceStat will report the R2 for 
this "no intercept" model as "-".  This is because calculations of R2 in the no-intercept models 
tend to be larger than models with an intercept, or in some cases can be negative.  Details on 
this topic are presented in Kutner et al. 2004. 

After you have finished creating or modifying your regression model, click "ok" to return to 
the first page of the task manager for geographically weighted regression, and then click on 
the "Regression settings" tab to complete the process of defining your model.   

Regression settings. 

After you have identified the datasets to be used in your model, you will need to define other 
settings, including the output geography (the same as your source, or another point 
geography in your project).  You can choose an output geography that differs from your 
source geography, but if you do so, SpaceStat will not be able to calculate the dependent 
variable's expected values, residuals, and standard errors.  See the output page for GWR for 
more information.   

The next boxes on the Regression settings page requests the regression type (linear, Poisson, 
and logistic), and the identity of any weight sets you would like to use.   

Next, you will need to define the geographic weighting scheme that will be used in your 
analysis.  This process includes two basic steps -- defining the neighbor method (nearest 
neighbor or distance range, abbreviated as range in the pull down menu), and defining the 
regression weight method (the options are shown in the image below, to the right of 
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"Regression weight method").   If you choose to use a range rather than a nearest neighbor 
approach for defining neighbors, the box marked "neighbor count" in the image below will 
instead ask for "Range".  Here you can accept the default of 10, or enter a new distance value 
(in the same units as the coordinates for your centroid geography).  The Gaussian and 
Bisquare-Fixed options will require a bandwidth, which you will specify (or have SpaceStat 
optimize) on the bandwidth settings tab. 

Click on the boxes below for brief definitions, and for links to detailed information on 
defining your geographic weights. 

 

Bandwidth settings 

If you choose a weighting scheme that requires a bandwidth, you will specify the bandwidth 
on the "bandwidth settings" page.  This process is described in detail here.  The default is for 
you to specify a bandwidth ("Specify" will be shown where it says "Calculate optimum" in 
the image below).  The default value for the "Specify" option is the maximum distance 
between two points in your geography; similarly, the default ranges under the "Set optimum" 
option are the minimum and maximum distance between points. The calculate optimum 
method uses a cross-validation procedure, with the number of cross-validation calculations 
set by your entry for "bandwidth steps." 
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More settings 

The creatively named "More settings" page allows you to specify non-geographical weight 
datasets, start and end times, the types of output datasets produced, and the name of the 
output folder that will appear below your dependent variable in the dataview.  Specific 
information on how the output datasets are calculated is shown on the "Implementation" 
pages for each model type (linear, logistic, and Poisson). 

When you have completed this page, click on the last section, "Run Method". 

Click on boxes within the image below for more information. 
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Run Method 

When you click on "Run Method", the task manager will present a summary of the model 
you have just created or modified.  If you agree with the model definition that appears in this 
window, then click on the "Run" button at the bottom of the window to run the model.  Note 
that the information shown here will be repeated in the log at the beginning of your GWR 
regression output. 
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Now that you have run the model, look in the log view to see what happened.  In some cases, 
especially with logistic models, your model will not converge.  The log will also give you 
information on the cross-validation procedure to find optimum bandwidths.  There are some 
variations in the output presented for the various model types; pick one of the following links 
to see example output for linear, Poisson, and logistic models, respectively. 

  

  

Geographically Weighted Regression Output 

Unlike aspatial regression output, output from running a GWR analysis does not include a 
"global" result in the log view.  Since the point of this type of analysis is to evaluate how the 
relationships among variables vary across space, all of your output (except for a description 
of your model run that appears in the log) will be in a GWR output folder that will appear 
below your dependent variable in the Data view. 
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Here, we will show the output from the model we used to illustrate running a GWR model on 
the "Perform" page.   

Summary of the model run 

After clicking to the run method page and then selecting "Run", we see the following output 
in the log view, beginning with the summary of the model run.  Note that below the 
summary, the log shows the first five steps of the Cross-validation process to determine the 
optimum bandwidth for our Bisquare-fied regression weighting method. 

 

Output datasets 
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At a minimum, GWR produces output datasets for the dependent variable's expected values, 
residuals, and standard errors (highlighted in orange in the image below).  Checking the 
"Output regression term datasets" will add correlation coefficients between the dependent 
and each independent variable, along with each variable's weighted means (datasets 
highlighted in blue below).  Checking the "Output independpent variable statistics" option 
will add datasets (highlighted in pink) for each regression coefficient, the associated p-
values, regression parameter R-squareds (linear models only), and the local model R-
squareds (linear models only).  Note that if you roll the cursor over the dataset name, a popup 
box will give you additional information.  In the image below, the cursor is over the 
"Coefficient 2 P value" dataset, and the popup box tells you that this p-value dataset refers to 
the MDRATIO variable.  Note that significance values in regression output are reported as 
"0.0" if they are smaller than 0.000001.   

All of the new datasets will appear if you open the data table for your geography.  If you 
right click on any dataset, you can: Add it to a new or existing map, rename or remove it, 
convert it to a different type (e.g., from a decimal to a string dataset), or view it's properties. 
 Specifically, the properties for datasets created by regression analyses repeat the information 
that appears in the run method window when you perform the analysis.  You can also use the 
aggregation method to convert the dataset to a polygon geography to make interpreting your 
results easier. 

  

Spatial Regression 

  

About Spatial Regression 

Spatial Regression in SpaceStat builds upon the ordinary least squares model for linear 
regression, while taking the spatial dimension into account while modeling the data.  There 
three flavors of regression offered are ordinary least squares with diagnostics, spatial lag, and 
spatial error models.   

Ordinary least squares is similar in approach to the Aspatial regression method, except it also 
offers a suite of diagnostic tests.  These tests will asses the regular assumptions of OLS 
(heteroskedascity, normality, etc) and will also evaluate whether or not the introduction of a 
spatial component would help the precision of the model.   

Spatial lag assumes that the dependent variable, y, is a function of a set of explanatory 
variables and the value of the dependent variable in neighboring regions.  This implies the 
dependent variable appears on both sides of the model equation.  An example of this could be 
housing prices, which would be influenced by the price of neighboring units.  Diagnostic 
tests also come along with this model, to see if spatial error may have better results with the 
data.   
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Spatial error relaxes the assumption that error terms are independent, such that high and 
positive error terms tend to have high and positive error terms at neighboring places.  The 
spatial error model deals with spatial autocorrelation as a "nuisance" to be neutralized so that 
efficient estimates can be obtained.  Diagnostic tests assessing spatial lag models will also be 
run with this method.   

  

  

Implementation of Spatial Regression 

The Spatial regression method in SpaceStat has three types of regression:  Ordinary Least 
Squares, Spatial lag and Spatial Error.   

Ordinary Least Squares (OLS) 

The implementation of OLS is no different from Aspatial Linear Regression and your 
parameter estimates will be the same after running the same model in either method.   

The difference between these two options is that the OLS method will also run diagnostics 
which test some of the usual assumptions of OLS (heteroskedascity, non-normality, etc). 
 The diagnostics will also use a spatial weight set to assess whether or not a spatial 
component would improve the results of the model.   

Spatial Lag 

The spatial lag model assumes that the dependent variable at a particular location is not only 
explained by the independent variables in the model but also by the values of the dependent 
variable itself at neighboring locations. The regression model is in matrix form (for NT 
observations) 

y = ρW1y + Xβ + ε 

Here y denotes the dependent variable matrix, X denotes a matrix of independent variable 
observations, β denotes the regression coefficients and the error terms ε are normally 
distributed with zero mean and variance σ2. The coupling to neighboring values of the 
dependent variable takes place through the spatial weights matrix W1 (which are usually 
row-standardized) and is modulated via the lag parameter ρ. 

The log-likelihood can be written 

 

where the first two terms denote the normalization contributions that depend on the trace of 
the logs of the weight matrices and the last term (corresponding to a sum of squares) contains 
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mixtures of residuals, weight matrices and regression coefficients ε = Ay - Xβ  with the lag 
term written A = 1 - ρW1. 

Minimizing the log-likelihood with respect to the elements of β determines the regression 
coefficients as β = (XTX)-1XTAy with the predicted values of the dependent variable given by 
E(y) = A-1Xβ. The remaining parameters are determined by substituting the regression 
coefficients back into the log-likelihood and using a bisection search to find the optimal 
value of the lag parameter. Lastly we require the eigenvalues of the spatial weights matrix for 
the normalization contribution 

 

  

Spatial Error 

For spatial error the model appears the same as for OLS or aspatial regression 

y = Xβ + ε 

but assumes that correlations between the errors ε at neighboring observations can be 
specified by the spatial weights matrix modulated by a spatial error coefficient λ, namely 
ε = λW2 ε + µ where W2  denotes the spatial weights matrix and the remaining errors µ 
have variance σ2. The rest of the notation is the same as in the spatial lag case. 

The log-likelihood can be written 

 

where the spatial weights normalization component is 

 

again expressed in terms of the eigen-values of the spatial weights matrix. 

Writing the error terms in the form µ = Βε where Β = 1 − λW2 we can obtain the regression 
coefficients from minimizing the log-likelihood as β = (XTBTBX)-1XTBTBy  which has the 
form expected from a generalized least squares treatment. Substituting this back into the log-
likelihood leads to an expression that can be minimized using a bisection search to locate the 
optimal value of the spatial error parameter λ. 
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Diagnostics with Spatial Regression 

When you run a spatial regression analysis in SpaceStat, a variety of diagnostic tests will be 
calculated along with your model results (Anselin 1988a,b).  For ordinary least squares 
regression these deal with non-normality, heteroskedasticity, and spatial dependence. For 
spatial lag and spatial error regression these deal with heteroskedasticity and spatial 
dependence. For spatial lag (error) the spatial dependence tests are against spatial error (lag) 
tendencies. 

Most of these tests are formulated along the lines of Lagrange multiplier tests (Aitchison and 
Silvey 1960), with the tendencies against heteroskedasticity or spatial dependence for an 
optimal "full" model being evaluated using the slope and curvature of the log-likelihood at 
the current "non-full" model’s optimization point. In the case of spatial regression, the slope 
and curvature refer to the score and Fisher information (via the Hessian) for the appropriate 
log likelihood function. Lagrange multiplier tests are known to be asymptotically equivalent 
to Likelihood Ratio tests (Silvey 1959). 

Ordinary least squares regression 

The non-normality test carried out is the Jarque-Bera test (Kiefer and Salmon 1983) which 
examines the OLS residuals for skewness and kurtosis. 

Heteroskedasticity is tested using the Breusch-Pagan test (Breusch and Pagan 1979) which is 
derived from Lagrange Multiplier arguments, and can be represented as a chi-squared test 
using as statistic half the model sum of squares of an auxiliary regression. This auxiliary 
regression has a dependent variable and a set of independent variables.  The dependent 
variable is the standardized square of the OLS residuals (divided by the OLS variance and 
then measured relative to 1.0). The independent variables are the squares of the original OLS 
independent variables which determine the auxiliary regression matrix. This is also referred 
to as the random coefficients model (Hildreth and Houck 1968). The degrees of freedom in 
the chi-squared test are equal to those of the regression model minus one. 

In the present version of Spacestat, the user does not have the option of specifying the 
heteroskedastic variables. 

For situations where there is considerable non-normality the Breusch-Pagan test is less 
reliable than the Koenker-Bassett test (Koenker and Bassett 1982) which normalizes the 
Breusch-Pagan statistic by half the mean of the squares of the Breusch-Pagan dependent 
variable. This is reported in SpaceStat along with the Breusch-Pagan statistic. A further test 
of heteroskedasticity is the White test (White 1980) in which a regression is carried out of the 
square of the OLS residuals against all cross-products of the original regression variables. 
The White statistic is then equal to the product of R squared from this regression multiplied 
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by the number of observations, with the number of degrees of freedom for the chi-square test 
given by the number of new regression variables in the White test. 

The tests against spatial dependence in OLS are the following: first a Moran’s I test is carried 
out on the residuals using the correct asymptotic expression for the variance (Cliff and Ord 
1973). Next are reported Lagrange multiplier tests for spatial dependence (Anselin et al 
1996) against (a) spatial error alone (Burridge 1980), (b) spatial error with spatial lag present 
(Robust LM error)(c) spatial lag alone, and spatial lag in the presence of spatial error (Robust 
LM lag). Also given is a test for both spatial lag and spatial error (LM SARMA). 

Spatial lag regression and spatial error regression 

Again, the Breusch-Pagan test is used to examine the standardized square of the OLS 
residuals regressed against the square of the original coefficients.  But also given are the 
spatial versions of this test where we adjust the Hessian entering the Lagrange multiplier 
analysis for the residual couplings of the auxiliary regression variable matrix (from the 
random coefficients model) to deviations in the spatial lag (error) parameters terms (Anselin 
1988a,b). 

Next a likelihood ratio test is given for the spatial lag or spatial error model in question. The 
difference in the calculated log-likelihood between the model in question and the OLS 
version of the model is used as the statistic for chi-squared test with the number of degrees of 
freedom of the regression model minus one. 

Finally are given the Lagrange multiplier tests spatial dependence. These models take the 
optimized spatial lag (error) models and examine spatial tendencies towards spatial error 
(lag) using Lagrange multiplier tests. In each case the Hessians have to be corrected for 
residual coupling of the error (lag) terms to the parameter variances in the spatial lag (error) 
model (Anselin 1988a,b). 

  

  

Performing Spatial Regression 

Spatial regression methods are located under Methods -> Regression -> Spatial regression.   

Creating and managing regression models 

When the Task manager opens for Spatial regression, it will start on the Regression models 
tab.  Here, you must choose your geography (if your project contains more than one), and 
then indicate whether you would like to create, modify, or delete a regression model.  You 
can create a suite of models that all share the same geography and datasets within one Spatial 
regression tab in the task manager, and these will all appear with the default name Regression 
model on this page, unless you change the name.   
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To modify an existing model, highlight it, and then click the Modify button.  Similarly, select 
a model and then click on delete to remove it from the list.  Additional models can be created 
and saved, and they will all be listed in this window.  Note that if you choose the regression 
method again from the methods pull down window, a new regression tab will appear, and 
will list the same suite of models (note the two tabs shown below).  You can delete this extra 
tab without losing your saved models. 

 

Defining a new regression model 

When you click on the "Create" button in the initial task manager page for Spatial regression, 
a dialog will open where you define the dependent and independent variables that will be 
included in your regression model.  You can also use the instructions below to modify a 
model you have already created. 
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Click on the boxes below for brief definitions, and for links to detailed information on 

defining the terms in your model.   

     

Selecting model terms. 

The window titled "Independent variables" lists all of the datasets associated with the 
geography that you selected in the first task manager window for regression.  To use one or 
more of these datasets as a term in your model, click on it to select it.  To select more than 
one dataset (for adding an interaction term), hold down the "Ctrl" button as you click on 
each.  When the dataset name is selected, you can then use the buttons on the right to add that 
dataset as a linear term (i.e., as an "x"), as a squared term (i.e., as an x2), or as part of an 
interaction term in which it will be multiplied by one or more other independent variables.  In 
the example above, we have selected the four linear terms (PCT_BachUp, PCT_Blk, 
PCT_Vac and PCT_WF_UnE).  As you add various terms, they will appear in the three 
boxes in the center of the task manager window.  You can delete terms that you have created 
by selecting them and then using the delete button on your keyboard. 

Categorical variables:  Select the reference value and parameterization type. 

Directly below the windows where the regression model terms are listed is a section that only 
applies to categorical variables; in this area you will choose a reference value and a 
parameterization type (coding system).  These options are explained in detail in the help 
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section on categorical data in regression.  To fill in these options for your categorical 
variables, first select the categorical dataset.  When a categorical dataset is selected, you will 
be able to scroll through the names of the categories within that set in the box to the left of 
"Reference value for...".  Next, for that same categorical dataset, you choose a reference cell 
or effect cell approach to coding by clicking on the respective circle to the left of your 
choice.  If you have more than one categorical term, including interaction terms that 
incorporate a categorical dataset, you will need to repeat this process for all of these terms.  If 
you forget to do this step, SpaceStat will run the model using the default settings of the final 
category as the reference value, with the reference cell parameterization type. 

Fix intercept at zero check box. 

Check this box if you want to force your linear regression model through the origin (0,0). 
 This option should not be applied to linear regression with only categorical terms.   

After you have finished creating or modifying your regression model, click "ok" to return to 
the first page of the task manager for regression, and then click on the "Regression settings" 
tab to complete the process of defining your model.   

Regression settings. 

After you have identified the datasets to be used in your model, you will need to define 
further settings in the Regression settings tab.  Here you will choose the type of spatial 
regression you would like to use: Ordinary Least Squares, Spatial Lag, or Spatial Error.  You 
will also define a spatial weight set in this tab, along with the time settings, and an output 
folder name.   

 

When you have completed this page, click on the last section, Run Method.   
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Run Method 

When you click on Run Method, the task manager will present a summary of the model you 
have just created or modified.  If you agree with the model definition that appears in this 
window, then click on the Run button at the bottom of the window to run the model.  Note 
that the information shown here will be repeated in the log at the beginning of your Spatial 
regression output. 

Now that you have run the model, look in the log view to see your results.  There are some 
variations in the output presented for the various model types; pick one of the following links 
to see example output for OLS or for Spatial Lag/Error models, respectively. 

  

  

Spatial Regression Results 

Data View Results 

All three forms of spatial regression will produce three datasets: the estimated mean, the 
standard error of the mean, and the residuals.  These datasets will be collected in a folder 
under the dependent dataset in the Data View.  This folder will have the name you specified 
in the Output folder name on the Regression settings tab.        

Log View Results 

The type of spatial regression determines which set of results appear in the Log View.  All 
three types will list the parameters used in the method, which is the same information 
displayed in the Rum method tab.  The log will also report the datasets used in the model. 
 Then the log will report various model results for each time valid time interval.   

Ordinary Least Squares 

If you ran the ordinary least squares model, the first entry will be a table of model properties 
which will demonstrate various measures of overall model fit.   
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Next, the log will report a table of model parameters, including the coefficient, the standard 
error, the z-value and the p-value.  P-values which are significant at the alpha .05 level will 
be highlighted in red.   

 

The next two tables in the log present tests for some of the assumptions of linear regression: 
normality and constant variance of the error terms.  The normality of the errors is assessed by 
the Jarque-Bera test, where a significant p-value suggests the presence of non-normality. 

Three tests are given to assess heteroskedasticity, or non-constant variance.  These are the 
Breusch-Pagan test, the Koenker-Bassett test, and the White test.  Again, a significant p-
value suggests the presence of non-constant variance.   

 

The final table for the OLS model present diagnostics for spatial dependence.  These tests use 
the spatial weight set given in the Regression setttings tab and assess whether the model 
might improve with the introduction of a spatial component. 
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These tests are described in the section on diagnostics.   

Spatial Lag and Spatial Error 

Both spatial lag and spatial error models will present a model properties table, but with less 
assessments than their OLS counterparts. 

 

The model parameters table will be similar to the OLS table except the lag model will have 
an estimate of the rho coefficient (shown below) and the error model will have an estimate of 
the lambda coefficient (not shown). 

 

Both lag and error models will use the Breusch-Pagan test as well as the Spatial B-P test to 
assess heteroskedasticity. 

 

The next test is a likelihood ratio test for the model in question, either spatial lag or spatial 
error.  The difference in the calculated log-likelihood between the given model and the OLS 
version of the model is used as the statistic.   

The final test is the Lagrange multiplier test for spatial dependence.  This test takes the given 
model and examines spatial tendencies towards the alternate model.  In the table pictured 
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below, we see the likelihood ratio test for the spatial error model and thus the Lagrange 
Multiplier test on spatial lag dependence.   

 

Again, these tests are discussed in further detail on the diagnostics page.   

  

Mixed Models 

  

About Mixed Model Regression 

SpaceStat’s mixed model regression (or multi-level regression) is an extension of aspatial 
regression that allows the model’s regression coefficients to vary across geographical 
boundaries.  As in aspatial regression, the main output consists of the regression coefficients 
(but now including details of their geographical variation). Residual datasets are listed in the 
data view for the user to analyze spatial patterns using the extensive suite of geo-spatial 
methods provided in SpaceStat. The regression analysis is carried out for each time interval 
in which the data change allowing one to visualize the progress of the regression results and 
spatial patterns through time. The types of mixed model regression that can be carried out in 
SpaceStat are linear, logistic and Poisson regression, together with the option of including 
dispersion for both logistic and Poisson regression. 

  

  

Mixed Model Requirements 

To carry out the method you must have 

1. Observations at the lower level - these may be individual observations, or they may 
constitute data at the census tract or block group level. As a first step you would always 
carry out a-spatial regression on these observations. 
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2. An upper level geography or its proxy. In other words you need to be able to specify a 
meaningful set of upper level units, into which the lower level units should be grouped. 

Obvious candidates for mixed model regression would be students within school catchments 
areas, individuals within counties, congressional districts within states. The dependent 
variables would be at the lower level (e.g. individual case/controls) with predictors (such as 
income, pollutant levels) also at the lower level. The regression coefficients of the lower 
level predictors can then be allowed to vary across geographical boundaries. (Predictors 
might also exist at the upper level but these should then be assigned to the lower level data 
using the scale conversion/interpolation method). 

Mixed model regression then assumes that the regression coefficients which vary across 
boundaries (the "random coefficients") do so according to some unknown global distribution. 
Maximum likelihood methods are used to access this distribution. 

  

  

Perform Mixed Model Regression 

Here we describe the settings that need to be specified to run the method. Open the project 
and go to Methods -> Regression -> Mixed model regression.  There are two panels. 

Regression Models Panel 

1. Select the geography corresponding to the lower level observations. Under the 
"Regression model" listbox a list of the names of saved regression models will be 
displayed. Select one of these - in the "Model  definition" window the details of each 
the listed models are given. If there are models listed click on the "Modify" button - if 
the list is empty click on the "Create" button. 
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2. You are now in the dialog entitled "Define mixed model". 
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At the top is the model name which may be edited to your liking. Below that is a 
dropdown for the dependent variable. Select a dependent variable (or dataset). 

Next is a dropdown entitled "Upper level selection method" - there are two choices 
here: "Subject field" or "Upper level geography". In SpaceStat you can sort lower 
level data either by subject field or higher level geography. The subject field must be 
an integer that labels which of the upper level units each of the lower level 
observations belongs to. If you wish to sort the lower level data by a higher level 
geography then this is done automatically in SpaceStat.  All you have to do is specify 
the Upper level geography name. 

Choosing either "Subject field" or "Upper level geography" will enable either the 
"Subject field" or "Upper level geography" dropdowns that are next. Choose the 
subject field if there is one with your data, or if a higher level geography is included 
in the project pick the appropriate one. Please note that sensible choices for the upper 

412 



SpaceStat 4.0 Documentation 

level units must be made.  The maximum likelihood calculation will not converge 
otherwise. 

Next is the selection of independent variables which operates in the same way as for 
a-spatial, GWR and spatial regression models.  You will see a non-editable list of 
datasets remaining in the lower level geography. You can highlight one of these and 
click on the "Add linear term" or "Add squared term" buttons and to create your list 
of predictors. To create an interaction term select on dataset, hold down "Ctrl" key 
and select another dataset and click the "Add interaction term" button.  The "Linear 
terms", "Squared terms" and "Interaction terms" lists will display all terms currently 
in the model. These lists allow the user to remove existing terms by right-clicking and 
selecting "Remove". If a term is categorical then selecting it will enable the 
"Reference value" selection dropdown and the "Parameterization type" radio buttons. 
These are discussed in the help section on a-spatial regression. 

At the bottom is a box entitled "Term status- fixed or random". As regression terms 
are added to the model they are also added to this window. To the left of each term is 
a checkbox. Checking the box for a particular term will make that term "fixed" so that 
the regression coefficients will not be allowed to vary across the upper level units. 
Therefore the coefficients will be the same across the entire geography. Setting the 
box to unchecked will make that term "random" so its coefficients will be allowed to 
vary across the upper level geography units with a variance to be determined by 
maximum likelihood.  Always at the top of this list is the "Fix intercept" box. Again 
leaving this unchecked will allow the constant regression term (the intercept) to vary 
across upper level units. As a rule of thumb this is the first item to be left random in 
analyzing and exploring different mixed models. Usually the variance in the intercept 
is most often found to be significant. 

Note that at least one of the regression terms must be random (unchecked) for the 
model to be run. Otherwise one may just as well use aspatial regression. If there are 
no random terms a warning dialog appears when the user tries to run the model. 

At this point the OK button should be enabled and on clicking OK the regression 
model is created. The "Model definition" window displays the details of the current 
regression model. Next is the Regression Settings tab which is concerned mainly with 
computational details. 

Regression settings tab 
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1. Regression type:  Default = Linear   

You will need to inspect this setting. 

At the top is the regression type dropdown - this refers to linear, logistic or Poisson. 
The logistic and Poisson types can also be run with a dispersion parameter. Logistic 
mixed model regression requires the dependent variable to take values of 1 or 0. 

2. Estimation procedure:  Default = ML   

There are two likelihood based approaches: ML refers to the maximum likelihood 
approach while REML refers to the restricted maximum likelihood approach. The 
REML approach, although the default in most mixed model software, can take much 
longer than ML if the number of upper level units is large. Consequently we set the 
default to ML.  In cases where the REML approach is too slow under the Newton-
Raphson estimation algorithm the user is recommended to set the estimation 
algorithm to EM. 
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3. Variance structure:  Default = Variance components 

This refers to the type of correlations expected between the random coefficients in the 
model. The output for the variances and covariances of the random coefficients is 
shown in the "Covariance Parameter Estimates" table in the Log view along with 
standard errors and p-values. There are two choices here (1) Variance components 
and (2) Unstructured. The default setting (Variance components) assumes that the 
variations of each of the random coefficients across the upper level units are 
uncorrelated with variations in the other random coefficients. 

The more general "Unstructured" setting assumes that there may be correlations 
between the variations of the regression coefficients across geographical units. The 
sign of an off-diagonal unstructured covariance parameter indicates whether regions 
with a positive value of one random regression coefficient are going to have a 
corresponding positive or negative value in another random regression coefficient. 
One can also see this reflected in a scatter-plot of the two sets of estimated random 
coefficients that are listed in the data view under the upper level geography. If the 
regression is run using the Variance components setting the scatter-plot will display 
no (or very little) correlation. 

The default Variance components setting should always be used first to test for 
vanishingly small variances in any of the random regression coefficients.  Such 
random coefficients should be set to "fixed" and the model run again. To do this the 
user should go back to the "Regression models" tab, select the regression model, click 
on the Modify button to open up the regression model dialog and check the checkbox 
next to the miscreant regression term in the "Term status- fixed or random" window. 

Once the random coefficients in the model are all found to have non-vanishing 
variances the user can safely explore correlations between the random coefficients 
using the "Unstructured" setting. 

4. Estimation algorithm:  Default = Newton-Raphson. 

The two choices are (1) Newton-Raphson and (2) EM. The default Newton-Raphson 
approach uses a trust-region optimization approach to find the values of the random 
coefficients for which the likelihood is maximized using first and second derivatives 
of the log-likelihood. The EM approach uses an older but slower estimation-
maximization algorithm. This setting is advised for REML estimation when there are 
a large number of upper level units and the user is carrying out exploratory analysis. 
It is also expected to converge under more general circumstances than the Newton-
Raphson approach. However the default Newton-Raphson converges much faster. 
The user is encouraged to try both algorithms if time permits. The Log view displays 
the log-likelihood at each iteration. 
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In either case the standard errors of the random coefficients are found from the 
Hessian obtained as the second derivative of the log-likelihood (either for ML or 
REML). 

5. Convergence criterion: Default = E-10 

This refers to the point at which the maximum likelihood iteration procedure is 
judged to have converged. The number refers to the fractional change in log-
likelihood at which the iterations will stop. The user can vary this setting to assess the 
convergence properties of the model. 

6. Maximum iterations: Default = 30 

For linear regression this gives the maximum number of iterations that are allowed to 
attain convergence. For logistic and Poisson regression two such dropdowns appear 
because a double set of nested iteration procedures is used. The user can increase the 
maximum number of iterations if necessary to achieve convergence. 

7. &  

8. Start and End times: 

You will need to inspect this setting. 

The dates and times of the datasets in the model at which the regression analysis is to 
begin and end. In SpaceStat the number of time intervals can be large so analyses can 
take a long time. If the user is unfamiliar with the spacing of the time intervals in the 
project they can use the time plot feature or animate a map of the data. The user is 
advised to pick short intervals to run the method as a first step, especially if there are 
a lot of time intervals. 

9. Output folder name: Default = "Mixed model regression results" 

This folder appears in the data view under the dependent variable dataset. The lower 
level datasets for the predicted means, residuals and standard errors are in this folder. 

10. Output random coefficients to log: Default = No 

Choose "Yes"  if you want to see the estimates for the random coefficients in each of 
the upper units printed in the log view along with standard errors and p-values. This 
can take a lot of space in the log view but is the only way to see these estimates if the 
"Subject field" option is chosen in the regression model dialog. 

Review settings 
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The review settings panel allows you to see all the setting used and may alert you to a 
parameter that has not been filled in correctly.  If everything is correct, click the Run button 
to run the method.  

  

  

Mixed model output 

We illustrate using a logistic model of mathematical achievement (above or below a 
threshold) as a function of gender, socio-economic status and ethnicity. The output consists 
of 

(1) Gross model features (-2log-likelihood, Akaike (AIC) and Schwartz (BIC) criteria). A 
likelihood ratio test is also carried out (with the model likelihood compared to the same 
model with all terms fixed). 

 

(2) Variances (and co-variances if required) for the regression coefficients (the random 
coefficients) that are assumed to vary across boundaries. Standard errors and p-values are 
also presented allowing the user to judge whether the selected regression coefficients vary 
significantly across boundaries. If the variation across boundaries is not significant then the 
user should re-run the regression making such coefficients fixed. 

 

In the illustrated example the variable "ses" should be set as fixed. 
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(3) Fixed regression coefficients that are the mean of the regression across all boundaries 
along with their standard errors and significance (as p-values). These are the counterparts of 
the a-spatial regression coefficients. Type III tests are also presented. 

 

(4) Estimates for the random coefficients in each of the upper level units along with 
standard errors and p-values. 

 

(5) For each lower level observation SpaceStat outputs the predicted values of the 
dependent variable, the residuals, and the standard error of the predicted value. Two 
sets of these are created in the data view. One set of predictions uses only the fixed 
regression coefficients (the marginal means, residuals and standard errors) while the other set 
(the conditional means, residuals and standard errors) uses also the estimated random 
coefficient within that particular upper level unit. 

Where to find the output 

Items (1-3) appear in tabular form in the Log view for each time interval whereas the 
residuals and predicted data in item (5) appear as datasets in the data view. The random 
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coefficient estimates (item (4)) appear as datasets in the data view under the upper level 
geography that has been chosen to group the lower level data. If there is no upper level 
geography in the project but user has used a "subject field" for the upper level units then the 
random coefficient estimates can be printed out in the log view as in the above example. 

Other computational details 

Probabilities (p-values) for the fixed terms and Type III estimates are currently displayed 
assuming a normal distribution. This aspect is currently being worked on and more options 
may be added soon once the issue of how best to calculate fixed degrees of freedom (for use 
with a t-distribution) has been settled. 

For variance components with random terms that are categorical, these terms are assumed to 
have the same variance for each of the elements of the categorical term. 

  

Geostatistics 

Variograms 

  

About Variograms 

Geostatistics provides a set of statistical tools for the analysis of data distributed in space and 
time. It describes spatial patterns in data, incorporates multiple sources of information in the 
mapping of attributes, and models the spatial uncertainty and its propagation through 
decision-making (Goovaerts, 1997). The cornerstone of any geostatistical study is the 
description and the modeling of the spatial structure of the data which is quantified using the 
variogram. 

Concept of variogram 

The variogram is a measure of the average dissimilarity between data as a function of their 
separation in geographical space. The experimental variogram can be interpreted as a discrete 
version of the variogram cloud: the values in the variogram cloud (i.e. half squared 
differences between observations) are averaged within classes of distance (called lags) and 
direction. Different types of averaging (i.e. variogram estimators) are available in SpaceStat. 
For example, the figure below shows the variogram cloud for log Toluene values computed 
up to a separation distance of 750,000 meters. These squared differences are assigned to 30 
classes of distance (width=25,000 m) to create an omnidirectional variogram. 
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Following Tobler’s first law of geography (1970), ”everything is related to everything else, 
but near things are more related than distant things’’. Thus, in the presence of spatial 
autocorrelation, one should expect the variogram values to increase as the separation distance 
|h| increases. In most situations, the variogram will stop increasing at a given distance, called 
the range, which can be interpreted as the distance of dependence or the zone of influence of 
the attribute. The discontinuity at the origin of the variogram (i.e., at very small separation 
distances) is called the nugget effect and arises from measurement errors or sources of spatial 
variation at distances smaller than the shortest sampling interval or both. 

 

  

  

Variogram Model Dialog 

The variogram model dialog allows the user to create a variogram model for a dataset.   

Click on the locations of the dialog to learn more about each section. 
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Dataset: Specify the dataset on which to perform kriging.  The user will not be able to create 
a variogram model if the values are all the same, or the associated locations all coincide. 

Variogram model name: Specify the name of the variogram model. 

Point dataset for custom-weighted centroids:  When kriging with polygons, the center-of-
mass centroids are used when calculating distances between the polygons.  This parameter 
allows the user to use centroids based on weighted locations such as population centers.  For 
example, if the source geography is U.S. states, you might create population-weighted 
centroids for the states by specifying a U.S. county geography and a population dataset for 
the counties.  SpaceStat would calculate the population-weighted average of the county 
locations in each state.  Note that the purpose of this parameter is not simply to specify an 
alternative centroid geography.  If the user wants to examine the weighted centroid that is 
created, clicking the Export-centroids button will add the weighted centroid geography to 
your project. 

Estimator:  The variogram estimator determines how the data pairs are used to create the 
variogram plot.  The traditional estimator uses the square of the difference between the data 
pair values.  The standardized estimator is the same but normalizes by the variance of the 
data.  The residuals, weighted and Poisson estimators all use a secondary dataset to modify 
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the value associated with each data pair:  the residuals estimator first subtracts from each 
value of the data pair the corresponding mean dataset value before subtracting the values and 
squaring.  The weighted estimator multiples the squared differences by the associated weight 
in the specified weight dataset, and the Poisson estimator multiplies by a weight calculated 
from the specified population dataset and subtracts from the squared difference a population-
weighted mean.  A more complete description is here. 

Variogram model parameters 

Here you can specify the settings for the variogram model and override settings for the model 
that's automatically created when the dialog is opened.  The nugget effect and the number of 
basic variogram models which comprise the full model are specified at the top.  For each 
basic model a type can be specified (spherical, exponential, Gaussian, cubic and power) and 
the basic model's sill.  You can also set the minimum and maximum range for the model and 
the orientation of the model if the ranges are different.  Note that if you choose to use a 
power model in your variogram you won't be able to conduct simple kriging which disallows 
this model type.  An XML description of the model can be exported by clicking on the 
Export Model button, and if you want to have SpaceStat auto-fit a model to your date click 
on the Auto-fit button.  This will bring up a dialog letting you specify the types of models 
SpaceStat uses when auto-fitting.  At the bottom is an indication of the mean sum-of-squares 
error between the experimental variogram and the current variogram model. 

Plot tab 

 

The variogram plot displays the experimental variogram based on the dataset's values and 
associated locations, and the current variogram model defined by the model settings.  The 
lag, lag count and tolerance fields define how the data pairs are binned by distance to create 
the experimental variogram's points.  By default (and when the Reset Lags button is clicked) 
the data pairs are grouped into 10 distance bins (the lag count).  The default distance lag is 
the geography's maximum radius (the half-diagonal of the bounding rectangle) divided by 10 
and the tolerance is half the lag distance. If the tolerance is greater than the lag data pairs will 
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be included in multiple distance bins.  Similarly, the data pairs can be segregated based on 
their directional relationships.  If the angle count is 2 then by default the data pairs are 
grouped into those falling within a 90-degree arc oriented to the right (the x-axis is 0 degrees) 
and those in a 90-degree arc oriented straight up.  The angle tolerance is half the angle lag by 
default.  Choosing more than one angle allows the variogram model to describe anisotropic 
trends in the data.  Finally, the skip factor allows for sub-sampling the data in cases where 
there are so many data pairs that model fitting is unacceptably slow. 

Map tab 

 

The variogram map is a useful tool for detecting anisotropic trends in your data.  Each block 
in the map represents data pairs whose relative directional relationship matches the direction 
between the block and the center of the map.  The color of the block indicates the similarity 
in data values between the data pairs in the block (purple and blue indicate similarity; red 
indicates disimilarity).  If there is meaningful anisotropy the map will show linear striping 
along some direction.  Moving your cursor in the map you can align the orientation line 
along the direction of least color change to determine the major axis of anisotropy, and use 
this angle as one of the start angles in the variogram plot.  The number of horizontal and 
vertical bins and bin size can also be specified.  This is analagous to the lag count and lag 
size in the plot tab. 

Cloud tab 
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The variogram cloud is a tool for viewing the data pairs making up the experimental 
variogram model.  The default, frequency-raster mode bins the pairs into blocks whose pixel 
dimensions can be changed at the bottom right.  Alternatively you can have each data pair 
drawn on the map.  This mode is slower, but allows you to select outlier data pairs 
individually so you can exclude them in the calculation of the variogram model.  After 
selecting outliers right-click to bring up a context menu with appropriate options. 

For an example of an analysis using the variogram model dialog, try the Variography tutorial. 

  

  

  

Variogram Estimators 

The following variogram estimators are available in SpaceStat: 

1. Traditional estimator (Journel and Huibregts, 1978) 

  

where z(uα) is the attribute value at the location uα and N(h) is the number of data pairs 
within that class of distance and direction. 

2. Standardized estimator (Pannatier, 1996) 
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where σ2(h) is the variance of the 2N(h) data used for estimation at lag h. This 
standardization accounts for changes in variance from one lag to the next and is used to 
correct for the preferential sampling of high values; see example for groundwater arsenic 
concentrations in Goovaerts et al (2005). 

3. Residuals estimator 

  

where the residual r(uα) is defined as the difference between the observation z(uα) and a 
mean dataset m(uα). This estimator is used to model the variability of attribute values after 
subtraction of a spatial trend; for example the residual variability of groundwater arsenic 
concentration that is not explained by geology (Goovaerts et al, 2005) 

4. Weighted estimator (Rivoirard et al., 2000) 

  

where w(uα) is the weight assigned to the attribute value at uα. Weighted estimators can be 
used to take an irregular sampling density into account (weight = surface of the polygon of 
influence of the observation). Another application is accounting for the varying level of 
reliability of the data; for example to assign less weight to unreliable mortality rates 
estimated from sparsely populated areas (weight = population size). 

5. Poisson estimator (Monestiez et al., 2006) 
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where n(uα) is the denominator (e.g. population size, observation time) of the rate datum 
z(uα), and m* is the denominator-weighted mean of all the rates. This estimator is used to 
model the spatial variability of rate data, such as cancer mortality rates or number of events 
per unit of time. The corresponding model is used in Poisson kriging. 

  

  

  

About Univariate Kriging 

Kriging was developed by the mathematician George Matheron based on the Master’s thesis 
of D. G. Krige of South Africa. The use of kriging started in the 1960’s and was first used in 
the mining industry but has become a valuable tool more generally in the the world of 
geostatistics. Kriging is used to interpolate or predict the value at point locations based on the 
values of neighboring locations. For polygon geographies SpaceStat uses the centroids of the 
polygons to make the estimations. One dataset serves as the source dataset, although 
secondary datasets can also be incorporated into the analysis. 
  

SpaceStat implements several types of kriging. When no secondary information is used 
simple kriging, ordinary kriging and kriging with a trend are the options. Population 
information can also be used in these cases to adjust for uncertainty related to small 
population size. When secondary information is available simple kriging can use a local-
means dataset (instead of a single global mean), and instead of trend terms drift datasets can 
be specified for kriging with external drift. 

  

  

Types of Kriging 

The second panel of the kriging method is where users choose the type of kriging to perform. 
 The options available change depending on whether or not there is secondary information 
available.   

The panel also holds options for estimating spatial components (also known as factorial 
kriging) and employing a population adjustment method (Poisson kriging).  If you choose to 
use the Poisson population adjustment method, you will have select the population dataset 
and the population denominator.   

The input required from the user varies with each type: 

426 



SpaceStat 4.0 Documentation 

Kriging Type User Input 

Simple kriging global mean 

Ordinary kriging -- 

Kriging with a trend trend components (X, Y, X2, Y2, 
XY) 

Factorial kriging -- 

Simple kriging with local 
means (kriging of 
residuals) 

local mean dataset, residuals 
variogram model 

Kriging with external 
drifts 

up to three drift dataset 

Poisson kriging population dataset and population 
denominator, poisson variogram 
model 

  

Implementation details for kriging 

Let u0 be the prediction unit: point or polygon centroid. 

1. Simple Kriging 

The following kriging system is used: 

  

C1n is the ”data-to-data” covariance between locations u1 and un. It is computed as: 
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where C(0) is the sill of the semivariogram model, and γ(u1 - un) is the value taken by the 
variogram model for the vector joining u1 and un.  A similar expression is used for the ”data-
to-unknown” covariance term C10. 

The vector of solutions (i.e. kriging weights) will be used to compute the kriging estimate 
and kriging variance datasets, computed as: 

  

where n is the number of observations found in the search window, and m is the ”global 
mean” parameter.  

  

2.  Ordinary Kriging 

The following kriging system is used: 

  

where µ is the Lagrange parameter, and C1n is the covariance between locations u1 and un. It 
is computed as: 

  

where C(0) is the sill of the semivariogram model, and γ(u1 - un)  is the value taken by the 
variogram model for the vector joining u1 and un. If the semivariogram has no sill (i.e. power 
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model), the sill C(0) is replaced by a  pseudo-sill A which is a large positive value such as A 
> γ(h) for all h (PG book, page 135). 

The vector of solutions (i.e. kriging weights) will be used to compute the kriging estimate 
and kriging variance datasets: 

 

If the "Output trend coefficients" option is selected, a third output dataset (trend component) 
will be computed as: 

  

where the kriging weights are computed as: 

  

3.  Kriging with a Trend 

This type of kriging allows the user to select the number K of trend components, or trend 
functions fk. For example, if the boxes X and Y are checked, the trend model is: 

429 



Statistical Methods 

  

where x and y are the x-coordinate and y-coordinate of location u = (x,y). The function f0() is 
1 by default, and other trend functions fk() k = 1,...,K are selected by the user. If the user 
checks all the boxes, the following quadratic model is selected: 

 

For example, if K=2, then the following kriging system is used: 

 

There are as many Lagrange parameters µ as constraints in the system of equations. Note that 
the ordinary kriging system is just the particular case K=0. 

The vector of solutions (i.e. kriging weights) will be used to compute the kriging estimate 
and kriging variance datasets:   

 

430 



SpaceStat 4.0 Documentation 

If the "Output trend coefficients" option is selected, (K+1) output datasets (trend component 
+ K trend coefficients) will be created. First the trend component will be computed as: 

 

where the kriging weights are computed as: 

 

Second, each of the trend coefficients ak for k>0 will be estimated as: 

 

The kriging weights are computed as: 

 

where if k’ = k and 0 otherwise. 
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4.  Factorial kriging 

In factorial kriging, spatial components corresponding to the different basic semivariogram 
models are interpolated. For example, if the semivariogram model consists of L basic models 
(i.e. L=2 for one nugget effect and one spherical model), the ordinary kriging estimate can be 
decomposed as: 

 

The kriging estimate, kriging variance and the trend component m*(u0) will be computed 
according to the equations described for ordinary kriging). In addition, each of the L spatial 
components   is estimated as: 

 

The kriging weights are computed as: 

 

is the covariance between locations u1 and u0 for the lth basic model. The following relation 
is satisfied: 

 

5.  Simple Kriging with Local Means 

The following simple kriging system is used: 
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The vector of solutions (i.e. kriging weights) will be used to compute the kriging estimate 
and kriging variance dataset: 

  

where n is the number of observations found in the search window, and m(u0) is the "local 
mean" dataset. 

6.  Kriging with External Drifts 

The user may selects K "drift" datasets: yk(u), k=1, ... ,K. These datasets are used to model 
the trend of the variable z to be interpolated. For example, if two drift datasets are selected, 
the trend model is: 

 

This formulation is similar to the trend model used for kriging with a trend, where f0()=1 by 
default, and the other trend functions fk()=yk().  The same equations can be used to compute: 

• the kriging estimate and kriging variance. 
• (K+1) output datasets (trend component + K trend coefficients) if the "Output trend 

coefficients" option is selected. 

7.  Poisson Kriging 

The following kriging system is used: 
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The only difference between this system and the ordinary kriging system is the diagonal of 
the matrix where an error variance term, m*/n(ui), is added to each of the covariance term 
Cii. m* is the population-weighted mean of the rate dataset, and n(ui) is the population at that 
location. 

The vector of solutions (i.e. kriging weights) will be used to compute the kriging estimate 
and kriging variance datasets.   

 

If the "Output trend coefficients" option is selected, a third output dataset (trend component) 
is computed as: 

 

where the kriging weights are computed as: 
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Implementation of the Back-Transform in Kriging 

In presence of strongly positively skewed datasets, it is common to conduct kriging on the 
logtransformed values (lognormal kriging) or normal score transformed values 
(multiGaussian kriging). These transforms need to be done outside the kriging method since 
variograms are computed on the transformed values. Yet, the back-transform should be 
performed within the kriging method. 

The back-transform equation is similar for both types of kriging. The kriging estimate and 
kriging variance of the original variable Z are estimated using the following empirical 
expressions: 

 

where yp(u) are p-quantiles of the standard normal distribution (mean=kriging estimate, 
variance=simple kriging variance). The function φ is: exp(.) for the natural lognormal 
transform, 10^ for log10 transforms,  and normal score back-transform for multiGaussian 
kriging. 

There are instances where the back-transform does not make any sense, for example for 
Poisson kriging. 

NORMAL SCORE BACK TRANSFORM 
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You will need to input the reference dataset whose distribution (i.e. histogram) needs to be 
reproduced. This would generally be the same dataset (and an optional weight set) entered 
for the input geography, but you have the flexibility to specify another dataset if you want. 
The distribution of the dataset is the necessary parameter, and so any geography could be 
specified here. 

You will also need to provide the minimum and maximum values (zmin and zmax) for the 
back-transformed normal scores. By default, this would be the minimum and maximum of 
the dataset specified at the previous step. 

If the maximum probability computed for the reference dataset is larger than the maximum 
value supplied, the default behavior for SpaceStat is to give that probability the maximum 
value specified.  Alternatively, you may employ the use of an upper tail extrapolation model. 
Two models are allowed: power model (with ω parameter ≤ 1) and hyperbolic model (with ω 
parameter ≥ 1). The default selection is a linear model (e.g. power model with ω = 1) 

Similarly, if the minimum probability computed is smaller than the minimum observation 
supplied, a lower tail extrapolation model may be specified. Only the power model (with ω 
parameter ≥ 1) is allowed.  The default selection is a linear model (e.g. power model with ω 
= 1).  These models are explained in great detail on pages 280-281 of Pierre Gooaverts' book. 

  

  

Perform Univariate Kriging 

SpaceStat provides many ways to customize the kriging procedure to various types of data. 
 The Task Manager separates the method into related panels that we describe below.   
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Source and Destination Geographies 

The first panel contains the source geography and dataset that you want to interpolate to the 
destination geography.  If the source and destination geographies are the same, cross-
validation is conducted and prediction statistics (e.g. mean prediction error) are reported in 
the Log view window.  The exception to this is if population adjustment (Poisson Kriging) or 
the factorial kriging option is selected. 

Kriging Type 

The second panel in the kriging method defines the kriging type.  The options available 
change depending on whether or not secondary information is available.   

If the estimation is to be Continuous attributes without secondary information, the kriging 
options available are simple kriging, ordinary kriging, and kriging with a trend.   

In addition, these three methods can also incorporate an estimation of spatial components 
(factorial kriging).  If the estimation is ordinary kriging, a Poisson population adjustment 
method can be incorporated as well.   

 

If there is secondary information available, the user may employ simple kriging with a local 
means dataset or kriging with external drifts.  Instead of specifying a single global mean, the 
local means dataset defines a mean value that varies across the landscape.  An optional 
variance dataset defines the variance on the local means.  Similarly, the drift datasets define 
spatial trends across the landscape.   
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Variogram model 

This panel allows the user to choose an existing variogram model or to create a new one. 
 Valid variogram models will appear as options in the drop down menu.  Note that certain 
kriging options will require specific parameters in the variogram model.  Simple kriging, for 
example, may not use a power model in the corresponding variogram. The user can view 
these models by opening them in the Variogram Model Dialog via the Variogram Models 
view.   

 

Search Strategy 

This panel allows the user to specify the window in which the observations are taken.   
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There are three types of search strategies provided by the Univariate kriging method: non-
stratified, quadrant, and octant.  For the non-stratified option SpaceStat will attempt to locate 
the nearest n points in any direction around the target point where n is the maximum count 
specified.  If the number of neighbors found is less than the minimum count specified, or n 
points can't be found the target point will be skipped and the value will be set to missing. 
 Note that neighboring points which hold missing values will be skipped. In the case where 
there are distance ties for the last (n-th) point all the neighboring points at the n-th distance 
will be included.   

When using a stratified search SpaceStat tries to choose neighboring points more equitably 
distributed around the target.  In this case the minimum-observations parameter is the total 
number of neighbors desired and the maximum-observations parameter indicates the 
maximum number of points to fall in each quadrant or octant.  This means that neighbors 
found in a sector that is already full will be skipped and the search will continue outward 
from the target point.  If the minimum total number of neighbors can't be found the location 
will be set to missing. 

The search ellipse parameters allows the user to define the maximum distance to look for 
neighbors and also to accommodate an anisotropic distribution of data.  The minimum and 
maximum radius specify the shape and size of the search ellipse, and the angle specifies the 
orientation.  If the two radii are equal a circular search is performed.  The search ellipse is 
overlaid on the source geography to facilitate the selection. 

Back Transform 

This panel allows a user to specify a back transform to transformed data.  If a user chooses to 
apply a back transform, they may choose between e^x and 10^x or the normal score back 
transform.   
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If the user chooses e^x or 10^x, there are no further requirements for the back transform. 
 The normal score back transform has a few more parameters associated with it. 

Other Settings 

 

Select the start and end time for the interpolation (useful when several time periods with 
different semivariogram models are available). 

Trend coefficient datasets can be created and a text file with the kriging matrix and kriging 
weights for each destination geography object can be exported for further analysis. 

You may also change the name of the output folder.   

For an example of a kriging analysis, try the New England kriging tutorial. 

  

440 



Spatial Weights 

  

About Spatial Weights 
To examine spatial association in your data, you first need to define how SpaceStat should 
define spatial relationships among objects in your geography. Exactly what is next to what? 
SpaceStat calculates spatial weights from the spatial relationships in the files you import. 
These are termed, alternatively, contiguity relationships, neighbor relationships, spatial 
weights, or adjacency sets. 

SpaceStat can calculate several different spatial weight sets, from point and polygon data for 
use in spatial statistics. Once you have created spatial weights sets, SpaceStat can use them in 
statistics or to display neighbor relationships in the map. SpaceStat holds all of the spatial 
weights sets in your project in the Spatial Weights View. 

  

  

Spatial Weights View 
The spatial weights sets and cluster sets in your project are held in a special window, which 
they share the Variogram model view.  Its default location is docked below the data view on 
the left edge of the application window.   

If the view has been hidden, you can show it by going to the "Window" menu, and checking 
the entry for "Spatial weights and variogram model view".  Another option is to use the 
Ctrl+3 shortcut. 

  

Moving and Hiding the Window 

You can undock the Spatial weights and variogram model view by clicking on the  symbol 
in the upper right corner.  To hide it, click the   button.  Undocking allows the window to 
float, so it can be moved as needed. 
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Right-Click Actions 

• Define a new point or polygon spatial weights set by right clicking a geography. 

• Import a weights set as a GAL or GWT file by right clicking on a geography. 

• Show a weights set in a map by right clicking the set and select "Show in map". This 
creates a new map and turns on the view object neighbors for that weights set. 

• Edit an existing point or polygon weights set by double clicking its name, or by 
choosing "Edit" from the right-click menu. 

• Duplicate (copy) a spatial weight set. 

• Export a weights set as a GAL or GWT file. 

• Rename or Remove a weights set. 

  

  

Spatial Weights Details 
A traditional way to represent neighbor relationships is as a spatial weights matrix. It is an n 
x n matrix, with n being the number of objects or locations in the geography. There is a row 
and column for each geographic object (for example, state or county). The value in each cell 
represents whether the location in the column header is a neighbor of the row location, 
termed "ego". Cells with nonzero weights are considered the neighbors of that ego. 

Weights can be binary (1 or 0, neighbor or not), or have continuous values, such as an 
inverse distance between points or the length of a shared border between polygons. Weights 
sets can include ego, may or may not be symmetric, and can be standardized.   

In SpaceStat, spatial weights sets are created by first defining what a neighbor is and then 
assigning weight values to neighbors. A single geography could have several different 
weights sets. Methods differ for points and polygons. 

As an example, consider a simple geography with 3 locations (IDs: 1, 2, & 3). The spatial 
weight matrix is shown in the table below where each of the non-header cells (gray) holds a 
value of the weight for the column object to the row object. 

ID 1 2 3 

1       
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2       

3       

Include Ego as Neighbor? 

Usually, the diagonal of the matrix is zeroes, as there is no weight for location 1 on location 
1. For the Gi* statistic, however, the weight set should include ego in the neighbor set, as 
shown in the version on the right. 

Ego not included 

ID 1 2 3 

1 0 0.5 0.5 

2 0.5 0 0.5 

3 0.5 0.5 0 
 

Ego is included 

ID 1 2 3 

1 0.33 0.33 0.33 

2 0.33 0.33 0.33 

3 0.33 0.33 0.33 
 

Symmetry in Weights 

Some weights sets are symmetric.  For instance, if two locations neighbor each other, they 
have the same weights in each row. Non-symmetric weights occur, however, when using a 
standardized weight set for locations that have different numbers of neighbors or when using 
a set number of neighbors for a point geography. A symmetric matrix can be efficiently 
represented as the lower half of the matrix. 

Symmetric 

ID 1 2 3 

1 0 0.5 0.5 

2 0.5 0 0.5 

3 0.5 0.5 0 

  Symmetric, short 

ID 1 2 

Asymmetric 

ID 1 2 3 

1 0 1 0 

2 0.5 0 0.5 

3 0 1 0 
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2 0.5   

3 0.5 0.5 
 

Standardized Weights 

If you standardize by neighbor count or shared border length, SpaceStat will normalize the 
weights for each location (each "ego") by its neighbor count. The sum of the weights for each 
location (each "ego") is 1. Because many spatial statistics sum up the weight multiplied by a 
value (such as a z-score), those locations with a higher weight sum have a larger influence on 
the statistic. Standardizing the weights gives each location the same vote.   

Standardized 

ID 1 2 3 

1 0 0.5 0.5 

2 0.5 0 0.5 

3 0.5 0.5 0 
 

Not Standardized 

ID 1 2 3 

1 0 1 0 

2 1 0 1 

3 0 1 0 
 

  

  

View Spatial Weights 
You can view spatial weights in the map and log by selecting an individual object (or set of 
objects) and directing SpaceStat to show you the neighbors.  For example, the polygons with 
blue borders in the image to the right are the first-order rook neighbors of the orange-
bordered polygon.  Using the "Show object neighbors" function will also add the neighbor 
IDs and their weights to the log.  The numbers shown before the weights values will be from 
the ID dataset, which is also visible in the table, or by querying the object in the map.  Note 
that if you need a reminder of the name of the ID dataset in your project, this information is 
displayed at top of the Log view. 
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Steps 

1. Right click on a map and choose "Show object neighbors". If there are multiple layers 
in the map and multiple weights sets, you will need to choose a weights set for each 
layer you want to see. The weight selection step enables the "Show neighbors" 
functionality. 

 

2. Each object you click with the selection pointer  will be highlighted in the selection 
color (orange is the default).  Its neighbors will be highlighted in blue, with the 
weights reported in the log. If ego is included in your weight calculation, then the 
selected area will also be highlighted in blue, and it will be listed as a neighbor and 
have a weight in the log. It is possible to select multiple objects to view several sets of 
neighbors at once using the Shift key. 

3. You have the option to zoom, pan, and query as usual, but the selection pointer  will 
select objects and show their neighbors in blue until you turn off the functionality. 
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4. To stop showing neighbors, right click on the map, select "Show object neighbors" 
and then uncheck the chosen weights set(s). When all sets have been cleared, the 
selection pointer returns to its normal state. 

  

Create or Edit Weights 
  

Define Point Weights 

You set spatial weights for a point geography by choosing how to define a neighbor and by 
defining weight values for these neighbors.  To create a new weight set, open the spatial 
weights and cluster sets view by selecting it under the "Window" menu.  Next, right click on 
the geography for which you would like to create a new weight set and select "Define new 
spatial weight set" option, which will open the dialog box shown below. 

To create new spatial weights, choose among these options. To edit an existing weights set, 
you can change the options using this same dialog and then save your changes by clicking 
"OK". 

 

Point 
adjacency 

You can specify whether 
neighbor relationships are 
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methods defined by a set number of 
nearest neighbors or the number 
of points within a specified 
distance range. The units for the 
range are the units of the 
geographic coordinates.  Click 
here to see details on how 
nearest neighbor ties are handled 
in SpaceStat. 

Include 
ego? 

Generally, spatial weights sets 
do not have a weight between 
ego and itself. Some statistical 
methods, such as the local G* 
do. Leave this blank unless you 
intend to calculate one of these 
methods. 

Neighbor 
weight 
method 

Constant This is the 
simplest 
method. The 
more 
neighbors a 
point has, 
the more 
influence 
they have. 

Standardized 
by neighbor 
count 

If you 
standardize 
by neighbor 
count, 
SpaceStat 
will 
normalize 
the weights 
for each 
location 
(each "ego") 
by its 
neighbor 
count. The 
sum of the 
weights for 
each location 
(each "ego") 
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is 1. 

Inverse 
distance 
rank 

This option 
assigns 
weights to 
nearest 
neighbors 
equal to the 
inverse of 
their rank. 
So the 
nearest 
neighbor's 
weight is 1, 
the second 
nearest 
neighbor's 
weight is 
1/2, the third 
nearest 
neighbor's 
weight is 
1/3, etc. 

For a 
specified 
nearest 
neighbor 
count, this 
weight value 
is essentially 
standardized 
because all 
objects in 
the dataset 
have the 
same 
neighbor 
count. For 
range-based 
neighbor 
criterion, 
this weight 
value is not 
standardized, 
as points 
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will have 
different 
numbers of 
neighbors. 

Inverse 
distance 

The farther a 
point is from 
its neighbor, 
the less 
influence it 
has. You can 
specify how 
quickly the 
weight 
declines 
with 
distance 
using the 
equation: 
a/(1+dpower). 
In the 
dialog, you 
can set the 
power 
(exponent) 
to which 
SpaceStat 
will raise the 
distance and 
a constant 
scaling 
factor, a. 
This scaling 
factor is 
useful when 
you have a 
small 
distance unit 
(such as 
meters) and 
long 
distances 
between 
points; a 
scaling 
factor keeps 
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the weights 
from going 
to near zero 
almost 
immediately. 

Note: You 
can enter 
powers of 
ten into the 
dialog by 
typing "e" to 
mean "to the 
power of". 

A Note on Missing Values in Analyses that use Adjacency Information 

Note that spatial weight sets are created by adjacency evaluations that are independent of any 
values of datasets associated with the geography, including missing values.  Therefore, if you 
have a dataset with missing values, any analyses that incorporate the weight set may actually 
use a smaller number of neighbors than was specified, due to the presence of missing values. 
 Some analytical tools in SpaceStat use the distribution of observed statistics to create a 
distribution and evaluate rarity, so removing one or more locations from a geography (thus 
creating missing values) can change results for all locations in clustering methods (not just 
those adjacent to the missing value).  The Local Moran, which uses nearest neighbor point 
adjacencies, is one example of an analysis that is sensitive to missing values.    

  

  

Ties in Nearest Neighbor Distances 

When identifying a set of nearest neighbors in a point dataset, it is possible that the kth 
neighboring point and one or more additional points will be equidistant from the focal point 
(ego).  SpaceStat handles these ties by assigning fractional weights to the set of points (S) 
which are equidistant from ego.   

Specifically, if we want the k nearest neighbors around ego, in the case of tied distances we 
first identify a+d points, where d is the size of the set of S, the group of points that are 
equidistant from ego that contains the kth nearest neighbor, and a is the number of points 
before the first member of S.  So the group of weights that would be included in calculations 
for ego is w0, w1, ..., wa, wa+1, ..., wk, ..., wa+d, where wi = 1 for i values from 0 to a, and wi 
= (k-a)/d for values of w from a+1 to a+d.  Note that a can equal 0. 
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Define Polygon Weights 

You set spatial weights for a polygon geography by choosing how to define a neighbor and 
by defining weight values for these neighbors.  To create a new spatial weights, open the 
spatial weights and cluster sets view  by selecting this view under the "Window" menu. 
 Then, right click on the geography for which you would like to create a new weight set and 
select "Define new spatial weight set" to invoke the dialog below. 

To create new spatial weights, choose among these options. To edit an existing weights set, 
you can change the options using this same dialog and then save your changes by clicking 
"OK". 

 

Neighbor 
criterion 

Choose Rook or Queen. 

Neighbor 
rings 

Specify the number of neighbor 
rings you want to include in the 
calculation. Specifying one ring 
means including those polygons 
that share a common border, 
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also known as "first order 
neighbors". Two rings means to 
include those that contact the 
first ring ("second order 
neighbors"), and so on. Please 
note that the more rings you 
include in your analysis, the 
longer it will take SpaceStat to 
calculate them. 

Include 
ego? 

Generally, spatial weights sets 
do not have a weight between 
ego and itself. Some statistical 
methods, for example the local 
G* do. Leave this blank unless 
you intend to calculate the local 
G*. 

Neighbor 
weight 
method 

Constant This is the 
simplest 
method. 
The more 
neighbors a 
polygon 
has, the 
more it is 
influenced 
by them. 

Standardized 
by neighbor 
count 

If you 
standardize 
by neighbor 
count, 
SpaceStat 
will 
normalize 
by the 
number of 
neighbors. 
It will not 
allow some 
polygons to 
have a 
higher total 
weight than 
others.  This 
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is also 
called "row 
standardized 
weights." 

Length of 
shared 
border 

This weight 
is based on 
how much 
border 
exists 
between 
polygons. 
Since 
Queen 
borders are 
points, and 
would have 
zero weight, 
this weight 
only makes 
sense with 
Rook 
adjacencies. 

Standardized 
length of 
shared 
border 

Similar to 
standardized 
by neighbor 
count. 

Once you've chosen your settings, press "OK." SpaceStat will save your definition and when 
you invoke a statistic that requires neighbor adjacencies, your newly defined spatial weights 
set will appear in the list. 

Note: Islands have no adjacent polygons. 

  

  

Polygon Adjacencies: Rook vs. Queen 

SpaceStat can derive neighbor relationships from a file of polygons. SpaceStat determines 
whether the polygons share a border with each other or overlap. If either of these conditions 
exist, they are considered neighbors. In order to derive neighbor relationships from polygons 
in shapefile or gdb format, you must specify how SpaceStat should evaluate these 
relationships. While it may seem like a trivial concept, the specification of neighbor 
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relationships can influence the outcome of statistical analyses. Unfortunately, errors in the 
polygon geometry can interfere with extracting polygon contiguity from data files. 

Rook vs. queen 

Two options are available: Rook and Queen.  Their names are derived from the movements 
of chess pieces. The rook can move only to polygons that share a border of some length with 
its current polygon. In the image on the left, the rook, illustrated as the central polygon 
outlined in orange, can move only to the five polygons outlined in blue that share borders of 
some length with it. The queen, in the image on the right, can move to any polygon that 
shares even a point-length border. Thus the queen can move to the rook's polygons and to 
any polygon that shares a corner (one vertex) with her current polygon. This gives the queen 
a total of seven adjacent polygon neighbors. 

As a result, rook is a more stringent definition of polygon contiguity than queen. For rook, 
the shared border must be of some length, whereas for queen the shared border can be as 
small as one point. 

 
 

  

Export Weights 
  

Export Weights File 

You can export a spatial weights set as a binary contiguity file (*.gal) or generalized weights 
format (*.gwt) file. Both of these files can be read with a text editor or imported into a 
spreadsheet. The main difference between these two formats is that binary contiguity files 

454 



SpaceStat 4.0 Documentation 

contain information on neighbor relationships only, while generalized weights files hold 
information on neighbors and weight values. 

Choose to export a GAL or a GWT file by right-clicking on a weights set in the weights set 
view (marked "weights view" in the middle left of this screen shot) and choosing "Export" 
from the pop-up menu. You will then need to choose whether to export a GAL or GWT file, 
a date and/or time (a field will appear for entering the time if that is appropriate for your 
weight file) and an ID dataset to use, if you choose to use one. The IDs are used to identify 
locations in the exported file. Only unique variables without any missing values at the time 
specified will show up in the "ID dataset" drop-down. If you choose a time outside the range 
of your data, no ID datasets will be available.  If you choose not to assign an ID dataset, the 
objects will be identified by the order in which they were imported or created, as they are 
originally displayed in the Table View.   

 

  

  

Spatial Weights Files 

You can export or import spatial weights from SpaceStat as a contiguity file (*.gal or *.gwt). 
These files can be read in a text editor or imported into other spatial analysis software 
products that use these formats. 

Contiguity files in the *.gal format contain binary contiguities, such as Y or N (is it a 
neighbor or not). Files in the *.gwt format contain information on which locations are the 
neighbors and their weight values. 

Binary contiguity relationships (*.gal) 

These files indicate whether a region or location has any neighbors, identifying them if so.     

The *.gal file has the following structure when it exports from SpaceStat.  Files imported into 
SpaceStat need not have the geography name entry. 

455 



Spatial Weights 

0 total region count geography name 

egolabel neighbor count 

  

  

neighbor label neighbor label......   

egolabel 1 

  

  

neighbor label     

egolabel 0 

  

  

egolabel neighbor count   

etc.     

The first row specifies the total region count and the geography name. 

The second row specifies a target region, called an "ego," by its label and a count of its 
neighbors. An ego without neighbors will be listed as having a neighbor count of zero. 

The third row lists the identities of those neighbors if the count is non-zero, with the row 
continuing until all neighbors have been listed.   

Generalized weights format file (*.gwt) 

These files identify the neighbors of each region or location in turn and specify a weight for 
each pairing. Unlike GAL files, neighbor weight values are included. 

The *.gwt file has the following structure 

0 total region count geography name 

egolabel neighbor label neighbor weight 

egolabel neighbor label neighbor weight 

egolabel neighbor label neighbor weight 
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etc.     

The first row specifies the total region count and the geography name. 

All subsequent rows specify a target region, called an "ego," by its label, the label of its 
neighbor, and the weight of that relationship. An ego without neighbors will be omitted from 
the list. 
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Tutorials 
SpaceStat offers several tutorials to help new users acquaint themselves with the software.    

• Importing data into SpaceStat 

• Interactive data exploration and animation using colon cancer mortality data for the 
southeastern United States. 

• The small numbers problem. SpaceStat provides two possible approaches to dealing 
with small denominators in rate calculations (rate instability): masking sparse data 
and smoothing. 

• Two tutorials (Variography and New England Kriging) have been adapted from 
Pierre Goovaert's short course to help new users navigate the variogram model dialog 
and the kriging method 

The following tutorials all use housing and socioeconomic data for south east Michigan. 

• Geary's C Tutorial 

• Principal Component Analysis 

• Spatial Regression 

By default, the tutorials are installed in a folder in the same location as the SpaceStat 
program - look for them under Program Files\Biomedware\SpaceStat\Tutorials. 

  

Importing 
  

Importing Tutorials 

Because SpaceStat recognizes the time dimension in your data, data import for SpaceStat 
requires time stamping your data. The time stamp can be specified on import for time-slice 
data, or read from the file for time-series data.  The Illinois tutorial will incorporate both 
types of data. 
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If you have used SpaceStat 1.8 or earlier, you may also be familiar with problem files.  Our 
new space-time platform requires some changes in how a user would import a problem file. 
The Problem File Import tutorial will describe an example of this. 

In this set of tutorials, we will explore several ways to bring data into SpaceStat. Sample files 
are provided for use in the examples. You may wish to use these sample file as models for 
preparing your own data for import into SpaceStat. 

Tutorial Geography data Associated data 

Illinois population 
projections 

time-slice shapefile time-series DBF 

Columbus problem file shapefile .DAT & .DHT file 

  

Problem File Import 

  

 Import Problem File Tutorial Overview 

If you have used SpaceStat 1.8 or earlier, you may have recorded analyses in a problem file. 
 Some of these analyses will transfer to SpaceStat 2.0 and beyond, as long as you have the 
corresponding files that go along with the problem file.  Analyses such as spatial lag 
regression, spatial error regression, and ordinary least squares regression will transfer once 
the problem file imports.  Other analyses, such as spatial ANOVA, spatial regime models, 
trend surface models, and spatial expansion require some further manipulation once the 
problem file has been imported.  Each of these reconstructions are described in the section 
Reconstructing Problem File Analyses.   

This tutorial will provide a step-by-step guide to importing problem files and how to 
reconstruct a spatial ANOVA analyses.  The data that will be using is crime data from 49 
neighborhoods in Columbus, Ohio, from 1980.  This data was used in tutorials for previous 
versions of SpaceStat.    

  

  

Importing the problem file 

The first step is to ensure that all associated files that go along with your problem file are 
gathered in the same location.  For this tutorial, all the necessary files can be found under 
C:\Program Files\Biomedware\SpaceStat\Tutorials\Problem file import.   
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To import a problem file, go to File -> Import > SpaceStat 1.x file.  You may also select the 
  icon on the toolbar and choose SpaceStat 1.x.  Click the Browse button and navigate to 
the Problem file import folder described above.  The folder includes many different files 
needed to reconstruct the analysis.  The problem file itself is Two problems.txt.  Select the 
problem file and click Open.   

 

The next step is to import the shapefile which corresponds to the data and spatial weight set 
defined in the problem file.  The shapefile and it's associated files (which include, at a 
minimum, the accompanying  .dbf file and the .shx file) do not have to be in the same 
location as the problem file.  However, in our case, the shapefile can be found in the same 
location.   

Click the Browse button and import Columbus.shp.   

Since SpaceStat 2.0 and beyond is built upon our space-time platform, the temporal 
component must be defined for all data.  If time is not a dimension of your data, leave the 
default settings and click OK.  Your data will import and will exist for the year 2001.   

If you intend to introduce the temporal component with other data, choose the appropriate 
time representation (dates, times, dates and times, or unitless) and set the time stamp.  Click 
OK and your problem file will import. 

  

  

Log Information 

Once the problem file imports, information pertaining to the analyses in your file will appear 
in the Log View.  If the log is not visible, go to the Windows menu and select Log View.   
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The log will report the name of the shapefile, as well as the Gauss file which was associated 
with the problem file.  The data contianed in the .dbf which is associated with the shapefile 
will not import, in favor of the Gauss file data linked to the problem file.  If you would like to 
import the .dbf data associated with the shapefile, go to File -> Import data, or select the   
icon on the top tool bar.   

After listing the imported files, the log will also report a list of the datasets along with their 
time stamp.   

Then the log will list each problem contained in the problem file and how to reconstruct that 
analysis.   

 

In this example, the first problem, an ANOVA, will need some further assistance.  The 
necessary information, such as spatial weight set, and the variables used in the analyses, are 
listed below the problem. 

The second problem, a general regression, is already loaded in the Task Manager.  All the 
information need to reconstruct the analysis is given in the log.  The only input needed from 
the user is what type of regression to run (Spatial Error, Spatial Lag, or Ordinary Least 
Squares).  This is found on the Regression settings tab of the Spatial Regression Task 
Manager.  Then click Run.    

  

  

Convert dataset from decimal to string 

The steps needed to reconstruct problem file analyses are recorded in the section 
Reconstructing Problem File Analyses.  This tutorial will guide you through reconstructing 
one type of these analyses, the ANOVA model described in the first problem.   

We note that the log lists CRIME (residential burglaries and vehicle theft per 1000) as the 
dependent variable and NSA (a dummy variable defining whether the neighborhood is in 
north or south columbus) as the independent variable.  NSA is intended to be a categorical 
dataset in which the levels are defined as 1 for North and 0 for South.  SpaceStat assumes 
that NSA is a continuous dataset, as shown by its icon in the Data View. 
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To convert NSA into a categorical dataset, right-click on it in the Data view and choose 
Convert data type from the drop-down menu.  Change the name of the NSA or leave the 
default name NSA_2.  In this example, we changed the name to Cat_NSA to signify that it is 
a categorical dataset.  Select the new dataset type to be String.  Choose 0 for the number of 
decimal places.  Click OK. 

 

A new dataset, Cat_NSA will appear in the Data view.  The icon next to it shows it is a 
categorical dataset.    

 

We can use this dataset to reconstruct the ANOVA from the problem file. 

  

  

Reconstruct ANOVA 
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Now that our categorical dataset is ready, we will reconstruct the ANOVA presented in the 
problem file.  Go to the Method menu and select Regression -> Spatial Regression.  Another 
tab will appear in the Task Manager.  Since our second problem was a general regression, a 
model named Problem 2 will already be list in the Task Manager.   

Select Create to invoke the Define regression model dialog.  You may rename your model or 
leave the default name.  In the screen cap below, the model has been named ANOVA.  Recall 
that the dependent variable is CRIME and the independent variable is Cat_NSA, which is 
added as a linear term.   

Select Cat_NSA in the linear term box.  The Reference value field will become active and 
will allow you to select which level to be the reference.  Let's use the 0 level (South 
neighborhoods) as our reference category.  Once the model has been defined, click OK.   

 

The next tab is Regression settings.  Choose which type of regression model you would like 
to run and make sure the correct spatial weight set is loaded.  Problem 1 used the COLFULL 
weight set.  You may also name your Output folder in this tab.   

Go to the Run method tab and inspect the input parameters.  If everything is correct, click the 
Run button.   
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Results 

Once the method runs, results will appear in the Log View.  The first table present properties 
of the model as a whole.  The second table will display the results of the ANOVA analysis, 
with significance for each level of the categorical variable.   

 

In this example, there is no significant relationship between the north/south dataset and the 
crim rate. 

For a more traditional ANOVA table, you can run the same model in an Aspatial Regression 
form, by going to the Method menu and choosing Regression -> Aspatial Regression.  This 
ANOVA table will display degrees of freedom, as well as the Type III sum of squares and 
the mean  square.   

 

You have completed this tutorial! 
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Illinois 

  

Illinois Population Projections Tutorial 

In this exercise, we will import two files: a shapefile of Illinois counties and a DBF of 
population estimates for each county from 1990 to 2020. We will then interpolate and 
animate the data within SpaceStat to watch how the population of each county changes over 
time. The image below should show an animated map (Help: I don't see this image animate). 

 

About the data 

When this tutorial was first created, the population projection data were available from the 
Illinois State University's Census and Data Users Service, a program that unfortunately is no 
longer funded by the state of Illinois.  The former home of this program was accessible 
through the LILT website at Illinois State, and you may be able to get more information 
about these data through contacts from that site. 

To prepare this tutorial, we took the original set of projections and turned them into a DBF 
for merging these datasets with the county geography within SpaceStat.  Feel free to open the 
DBF in Excel and save it as an Excel file (.xls) if you would prefer to work in that format -- 
all instructions here will work with either file format. 
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Import Illinois Counties 

Start SpaceStat. If you are already running SpaceStat, choose to start a new project (File > 
New).  Then, click the Import button  on the Projects toolbar and select "Polygon or point 
file."  You may also go to File -> Import -> Polygon or point file.   

1. Browse to Illinois.shp, in the IL folder, in the Program 
Files/Biomedware/SpaceStat/Tutorials folder. 

2. First you need to select the import type, but this is easy because you have just opened 
a new project, so your only option under "Import method" will be to create a new 
geography.  The default name SpaceStat gives to the geography will match the 
shapefile, but you can change the name in the box marked "Geography name". 

3. The time stamp we will apply to the county geography will be a time slice with a start 
and end values that matches the years of the population data.  So, choose "time slice", 
and then choose "dates" as the time format.   Next, click on the "Set" button, and 
change the start from the default (1-1-2001) to 1-1-1990.  Leave the "inclusive" box 
checked.  Then fill in 1-1-2021 for the end date, and leave the "inclusive" button 
unchecked.  SpaceStat will interpret this as meaning that the time slice ends at the 
very end of the year 2020.  Click OK to close the time stamp dialog, and then check 
that the dates that appear after "Geography time stamp" match those shown below.   

4. Click OK. Then SpaceStat will import the Illinois geography.  
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Map the Counties 

To verify that the data imported correctly, we will map the counties data. 

Click on the map icon in the visualization toolbar and choose to map the Illinois geography 
(it should be your only choice). SpaceStat will map the geography, as shown below.   
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You can change the look of the map in the map properties dialog (Click on the book icon, 
or choose "Properties" from the Map menu).  When you open this dialog, you will see that on 
the left side, SpaceStat lists the datasets available in the Illinois shapefile.  These all represent 
sources of information SpaceStat can use to color and format the geography in the map.  At 
this point, the only options are to modify the representation of counties based on three 
datasets -- COUNTY, which lists the FIPS ID code of each county, NAME, which lists the 
county name, and STATE, which lists a state code for Illinois (so all polygons would have 
the same value).  Even though it's not very meaningful, we will color our map based on the 
county name, so select the NAME dataset by clicking on it.  Because this dataset is 
alphanumeric, your only option for coloring the map will be a qualitative method -- by 
default, SpaceStat will group the names in alphabetical order.    You can combine or split the 
default groups using the "group" and "split" buttons below the listing of colors and names. 
 More options for modifying how maps look are described here. 
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The image below shows a map of the county names dataset, based on the default set of 
groups of alphabetically-ordered counties. Note that we clicked on the "+" next to "Illinois" 
in the legend to show the details regarding how the polygons have been colored.  You could 
click on the "+" signs next to Border width and Border color/style to see details about how 
those were set as well. 
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Join the Population Data 

Now we will   import the population projection data, and link them to the county 
geography.  Choose the import icon  from the project toolbar, or "Import data" from the 
File pulldown menu. 

1. Browse to the population projection file (Illinois pop projections.dbf). 

2. The population projections file does not contain any location data -- just population 
values broken down by age group and five year time interval.  So to use it in 
SpaceStat, it needs to be linked to an existing geography through a common ID 
column.  So we will choose the "Merge as data" import method, and identify the 
Illinois geography as the spatial support for the data.  Next we need to identify the 
name of the data column that is common to both files (although the heading is 
different).  As shown below, match the ID field "County" in the Illinois geography to 
"FIPS" in the DBF. 

3. You'll have to specify the dataset time stamps.  Note that this information is not in the 
file.   Instead, this file consists of columns of data for all counties, broken down by 
age group and "date only" time slices.   Note that in the image below, the dataset time 
stamp entire geography shows up in the dialog, before you specify the dataset time 
stamps.  Sometimes when you import data, you will want to match all datasets to that 
timestamp by hitting the "set" button.  However, that won't work in this case because 
our data includes multiple time segments for each age groups, and we would like to 
merge all of the different years into the same dataset for each age group.  This 
approach requires more importing steps.   

Click on the "Specify dataset timestamp" button to bring up the dialog for time stamping 
datasets 

4. (After you finish time stamping, you will be returned to this dialog -- then hit ok)        
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Group Datasets 

Before we can finish importing the data, we'll have to group the datasets and then set their 
time stamps. 

You will see that there are groups of similarly named datasets in the file, as shown below. All 
of the highlighted datasets (beginning with "0-4_") belong together. They're a group of 
estimates for the same age class, 0-4 years of age. The date of the estimate is in the suffix of 
the dataset name (values from 1990 to 2020 in 5 year intervals).  So, to create a single space-
time dataset from the pieces, highlight a set with the same prefix and click on the group 
button. 
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You'll be asked to choose a new name for the group. SpaceStat will suggest the common 
characters at the beginning of the name, in this case "0-4_", as shown below.  Choose a name 
and click OK. Go through the file and group all datasets by their age classes. 

 

The results will look like this: 

 

  

  

Set Time Stamp for Grouped Datasets 

Now, we'll set the time stamps for the group. You'll have to double-click each dataset in the 
group and set its time stamp individually. 
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Double-click a dataset with your mouse cursor. 

 

A new dialog will appear and let you choose the time stamp. For each dataset in a single 
group (say ages 0-4), set the time stamp for that data to the entire year. For 1990, the start 
date will be Jan 1 1990-inclusive, and the end date will be Jan 1 1991-not inclusive (so up 
through the last moment of 1990 but not including any of 1991). 

 

 Repeat this pattern for the rest of the grouped set. At the end your group should look like the 
example below. 

 

You don't have to repeat that process for every dataset. You can right click on the group 
name (here, "0-4"), which will give you a menu that includes the three options shown below, 
including copy group time stamps. 

 

You can copy the group stamps from this set, and then paste them onto another group. Repeat 
this process for all groups. Then, set the time stamp for the last two datasets (FIPS and 
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NAME) for the entire time period (1990 through 2020, so type in 2021-not inclusive as the 
end date). 

Now, click OK on the "Specify datasets time stamp" dialog, then click OK on the Import 
DBF dialog, and the data should import and appear in the Data View. 

  

  

Map the Projections 

Now, we can change our map from the colorful but not very informative one we had made 
based on the county names, to one that will show an animation of the changes in population 
(for an age group) in each county over time. 

Click on the properties button in the open map. 

Pick one of the age-group datasets (here we chose the age group from 30 to 34) and map it 
using a classified color mode, and the quantiles classification method. If you choose equal 
intervals or if you choose a continuous color scheme, the high population value for Cook 
County really dominates the gradient and the rest of Illinois is hard to distinguish. 

 

Click "OK" to close the dialog. 

Animate the data using the play button on the map. You'll notice that there are gaps in the 
data where there are missing values, as shown below (Help: I don't see this image animate). 
Why is this? Remember how we did the time stamps.... 
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Interpolate the Population Estimates 

Our data represent one year within five year intervals.  To "smooth" your animation, you can 
have SpaceStat project data between the 5-year estimates. 

Do this by returning to the properties dialog and checking "interpolate values" at the 
bottom left corner of the dialog. 

 

Now, click OK to save the changes and then rerun your animation. You will now see 
estimates in between the data we imported, like the map shown below. (Help: I don't see the 
image animate.) 

You've completed this tutorial! 

 

  

Geostatistics 

Variography Tutorial 
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Variography Tutorial 

This tutorial will guide you through some ways to explore your data by creating variogram 
models.  To start, you will need to load the Variography.spt project from the Tutorial files.   

Open SpaceStat and choose File -> Open project 

Navigate to the location of the Tutorials files.  The default location for these files is: 
C:\Program Files\Biomedware\SpaceStat\Tutorials 

If you installed your copy of SpaceStat in a different location, the Tutorial folder will be 
wherever SpaceStat is installed.   

Go to the Kriging folder and select the Variography.spt project.  You will see a point 
geography named NE_sample and many datasets such as MERCURY, TOLUENE, and 
LOG_LEAD.   

 

Launch the variogram model dialog 

The variogram model view by default appears at the bottom of the Data view panel.  If the 
variogram model view is not visible, you can show it via the 'Window' menu, by choosing 
'Spatial weights and variogram model view'. 

Left click the 'variogram models' Tab to view the list of variogram models available for each 
geography. The list is empty at the beginning. 

Right click a geography (i.e. NE_sample), and select the option 'Define new variogram 
model'.  The variogram model dialog appears.   
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You can also access this dialog by going to the Tools menu and selecting 'Create variogram 
model'.  A submenu will hold any valid geographies from which you may choose a dataset to 
for your variogram model. 

 

 

  

  

Create variogram model 

Select the 'LOG_TOLUENE' dataset. 

An omnidirectional variogram computed using default parameters is displayed. Five 
estimators are available. 

Specify the number and width of classes of distance (lags) used for the analysis. In this 
example, we use 45 classes of 10,000 m width. The lag tolerance is by default set to half the 
lag separation. Note that when increasing the number of lags, the lag width decreases 
automatically to preserve the range of distances (i.e. 450,000 m) considered. 

Specify the angle count  (=1 for omnidirectional variogram). 
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The skip factor is used to speed up the computation for very large datasets. 

  

  

Fit isotropic model 

Left click the 'Auto-fit model' option. A window opens with settings for the automatic fitting 
of a model, including: 

1. 1. Number and type of basic models to be considered 
2. 2. Magnitude of the nugget effect (Typically used to force the model to pass through 

zero) 
3. 3. Weight to assign to lags in the weighted regression procedure. 

Select a 'lag weight' and click OK. 
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The plot of the experimental and model variogram appears, with the value of the fitted 
parameters displayed in the right panel. Undock the plot window by a left click on 'Plot' Tab; 
windows can be expanded for a more detailed view. 

 

  

  

Compute variogram map 

Left click the 'Map' Tab to view the panel for the variogram map. 
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Select the number and width of cells to compute the variogram map (e.g. 25 cells of 40 km). 
The rotating vector allows the user to identify the direction of maximum continuity (i.e. 
smaller variability). The corresponding angle is displayed at the bottom right. 

The option 'smooth map' filters some of the noise in the variogram map and can facilitate the 
identification of the anisotropy. 

 

Undock the Map window by dragging out the 'Map' Tab. Close the window to dock it back. 

  

  

Fit anisotropic model 

Left click the 'Plot' Tab to view the panel for computing variogram. 

Specify the number and width of classes of distance (lags) used for the analysis. In this 
example, we use 20 classes of 25,000 m width. 

Select 4 angles and use the direction of maximum continuity identified on the map (i.e. 54°) 
as the 'start angle'. The 'angle lag' and 'tolerance' parameters change accordingly so that the 
full 180° window is encompassed. 
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Type 'enter' to update the plot with 4 directional semivariograms. Click display (bottom 
right) to view the legend of the graph. 

Undock the Plot window for better viewing. 

You've completed this tutorial! 

  

New England Kriging Tutorial 

  

New England Kriging Tutorial 

This tutorial will guide you through an example analysis using the kriging method.  To start, 
you will need to load the NE_kriging.spt project from the Tutorial files.   

Open SpaceStat and choose File -> Open project 

Navigate to the location of the Tutorials files.  The default location for these files is: 
C:\Program Files\Biomedware\SpaceStat\Tutorials 

If you installed your copy of SpaceStat in a different location, the Tutorial folder will be 
wherever SpaceStat is installed.   

Go to the Kriging folder and select the NE_kriging.spt project.  There will be two point 
geographies: NE_sample, and Kriging grid. 

Call the kriging method 
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Under the 'Methods' option choose 'Kriging', then 'Univariate kriging'. A 'task manager 
window' opens. 

 

Undock the Task manager window and expand it. 

  

  

Geographies and Kriging type 

Specify the names of the source geography and dataset, which contains the data used for 
kriging. In this example, the source geography is 'NE_sample' and the dataset is 
'LOG_TOLUENE'. 

Specify the name of the destination geography, which contains the coordinates of the 
locations to be estimated (i.e. 'Kriging grid' in this example). 

 

If the source or destination geographies consists of polygons, the geographical centroids will 
be used. 
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If the source and destination geographies are the same, cross-validation is conducted and 
prediction statistics (e.g. mean prediction error) are reported in the Log view window.  An 
exception to this is when the kriging method uses the Poisson population adjustment.   

Kriging Type 

Specify the type of kriging algorithm. Two categories of algorithms are available: 

1. Methods that account only for one dataset (simple kriging, ordinary kriging and kriging 
with a trend). 

2. Methods that incorporate secondary information (simple kriging with local means, kriging 
with external drifts). 

We use ordinary kriging in this exercise. 

 

An option is available to conduct factorial kriging & estimate spatial components 
corresponding to semivariogram basic models. For rate data, the option 'Poisson kriging' will 
make the appropriate population-based adjustments. 

  

  

Variogram model and Search strategy 

Variogram model panel 
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Specify the variogram model. Any previously created variogram models that are valid for 
your current settings will be appear in the drop down menu on this panel.  You may select 
from your previously created model or you may define a new model by clicking on the 
"Create new" button. Clicking this button opens the 'Variogram Model' window described in 
the Variography tutorial. 

 

The parameters of the selected model are listed in the Task manager window. 

Search strategy panel 

Select the minimum and maximum number of observations to be used for each estimation. 
These numbers can apply to the entire search window (non-stratified search) or to each 
quadrant/ octant of that window. Using a stratified search ensures that neighbors come from 
all the directions. 
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Specify the type and size of search window. If the Max. and Min radius are the same, the 
search window is a circle. If the two radii are different, the window is elliptical with its main 
axis oriented along the azimuth angle. The window is overlaid over the source geography to 
facilitate the selection. 

  

  

Back transform and Other settings 

Back Transform Panel 

Kriging estimates and variances can be automatically back-transformed into the original 
measurement space if the interpolation is conducted on transformed observations. 

 

Three types of back-transform are available, depending on the type of data transform: normal 
score transform, and two types of log transform. 

Select 10x since log10 transformed toluene data are used here. 

Other settings panel 

This panel allows you to select the start and end time for the kriging (useful when several 
time periods with different variogram models are available). 
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Trend coefficient datasets can be created and will appear in the Data view when the method 
has finished running.  You can also create a text file with the kriging matrix and kriging 
weights for each of the destination geography's objects. 

Review settings panel 

As always, the Review settings panel presents a summary of the previous panels so that you 
can review the choices you have selected.  If everything looks correct, select the "Run" 
button at the bottom of the Task manager. 

The method is executed and four new datasets (Kriging estimate and kriging variance, before 
and after the back transform) are added below the 'Kriging grid' geography in the Data view. 

  

  

Visualize the kriged map 

Right click on the 'Kriging estimate, back-transformed' dataset, and select 'Create map'.   

 

A window with the kriging grid appears in the Visualization panel.  This map may look very 
dark because of the number of points and the border outline properties that have been set as 
default.  You can change the map properties to create a more informative map. 

Change the map properties 

Left click on the open book icon on the toolbar, or right click on the map and choose 
'Properties'. 

Under the Point color tab, select the Color Mode 'Classified' and the Classification Method 
'Quantiles'. 
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Select the number of color classes (i.e. 10) and a color palette (e.g. blue to red). 

 

Under the Point size tab, decrease the size to '1' to reduce overlap between pixels. 

Under the Point symbols tab, select the 'Filled square (borderless)' option.  Click OK. 

 

Overlay the dataset 

Right click on the 'Log_Toulene' dataset, then move the cursor to 'Add to map', then 'Map: 
Kriging estimate, back-transformed' (the default name of the map including the kriging 
results). 
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Go back to the map properties.  Make sure to select the layer 'NE_sample'. 

Under 'Point color', make sure a Dataset is selected (i.e. Log_Toulene). Then select the Color 
Mode 'Classified' and the Classification Method 'Quantiles'. 

Select the number of color classes (i.e. 10) and a color palette (e.g. Blue-yellow-red). Click 
OK. 

 

  

  

Perform a cross-validation 

Go back to the task manager, and specify as destination geography the name of the source 
geography (i.e. 'NE_sample' in this example). 
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Let the other parameters stay the same and click run.   

The method is executed and 6 new datasets (i.e. Kriging estimate, kriging variance - before 
and after transformation, kriging residuals and kriging SSR) appear below the 'NE_sample' 
geography in the dataview panel. 

Prediction statistics (Mean error, Mean absolute error, Mean SSR) are reported in the Log 
view window. 

 

You've completed this tutorial! 

  

Geary's C Tutorial 
  

Geary's C Tutorial 

Geary’s C is useful for discovering spatial autocorrelation.  Spatial autocorrelation means 
that adjacent observations of the same phenomenon are correlated in space.  Spatial 
autocorrelation statistics analyze the degree of dependency among observations in a 
geographic space and depend on a spatial weight set.  These spatial weights reflect the type 
of geographic relationship between polygons or points in a neighborhood.  Spatial 
heterogeneity describes the level of variance in the autocorrelation across geographic space. 

The value of Geary’s C is between 0 and 2.   

Value of Geary's Meaning 

490 



SpaceStat 4.0 Documentation 

C 

C > 1 Negative spatial 
autocorrelation 

C = 1 No spatial 
autocorrelation 

C < 1 Positive spatial 
autocorrelation 

  

If spatial autocorrelation is positive, the value of the variable is similar to the value in nearby 
locations. 

Conversely, negative spatial autocorrelation indicates dissimilar variate values in nearby 
locations. 

  

  

Geary's C Tutorial: Running the Method 

We will be looking Census Tracts throughout Michigan to examine spatial autocorrelation in 
homeownership rates. 

Go to File -> Open and browse to the location of the Geary's C Tutorial project found under 
ProgramFiles\Biomedwaare\SpaceStat\Tutorials\ 

Next go to Methods -> Clustering -> Geary’s C.  Choose PCT_Own from the second drop-
down menu as your Input dataset.  Leave all other settings the same.  Go to the Run method 
tab at the bottom of the dialog box.  Click Run.   

The log view shows us the Geary’s C value for the PCT_Own variable.  The Geary’s C value 
is 0.46, indicating a generally positive spatial autocorrelation for homeownership in the state 
of Michigan. 
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Geary's C Tutorial: Positive Spatial Autocorrelation 

We can also examine the Geary’s C values on our map. 

 

  

The map shows positive autocorrelation in turquoise.  This means that home ownership rates 
in these census tracts are similar to those in neighboring census tracts.   

At this zoom it is difficult to discern whether any negative autocorrelation is present.  We can 
zoom in further, around the Detroit area, to find out.  Select the   icon at the top of the 
screen. Then select the area where you want to zoom in. 

  

  

Geary's C Tutorial: Negative Spatial Autocorrelation 
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We turned on a white border around the census tracts to make the significant areas stand out. 
 We can see a few purple census tracts, indicating a negative autocorrelation.  The purple 
tracts on the left side of the map are in Ann Arbor, Michigan, home to the University of 
Michigan.  These indicate that home ownership in these tracts is low, while home ownership 
in neighboring tracts is high.  This may be because a number of students live in Ann Arbor, 
so there is a large rental market close to the university.  Ann Arbor is also an attractive place 
to live with high housing values, so surrounding tracts may have high ownership percentages. 

You have completed this tutorial! 

Source for general Geary’s C info: 

http://www.hbp.usm.my/thesis/HeritageGIS/master/thesis/3-Spatial%20autocorrelation.htm 

  

Principal Component Analysis Tutorial 
  

Principal Component Analysis Tutorial 

Principal component analysis is a mathematical procedure that transforms a number of 
possibly correlated variables into a group of uncorrelated variables called principal 
components.  The first principal component accounts for as much of the variability in the 
data as possible, and each succeeding component accounts for as much remaining variability 
as possible.  Simply put, PCA reveals the internal structure of the data to best explain the 
variance in the data. 

You can use PCA at the beginning of an analysis to focus your regression parameters by 
revealing and reducing  colinearity in the data. 
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First, you need to find the tutorial files that were included when you installed SpaceStat so 
that you can import the PCA_Tutorial project.  To open this project, go to File -> Open, and 
then browse to C:/Program Files/Biomedware/SpaceStat/Tutorials/.  This is the default 
location for the tutorial files.  If you installed your version of SpaceStat elsewhere, the 
tutorial files will be where you installed SpaceStat   

Once the project has been opened, go to Methods -> Principal Components.  We will be 
using homeownership and socioeconomic data for the state of Michigan at the Census Tract 
level.  Select ”CT2000wFIPS” as your geography.  Then select "Create."  Variables for PCA 
need to be similar items that are the same size.  In this case, select PCT_Asn, PCT_Black, 
PCT_Hisp, PCT_Wht and use the arrow to put each variable into the ’PCA variables’ box. 

Select OK to finalize your model.  On the next tab, PCA settings, you can name the output 
folder where the Principal Components will appear.   

Then select Run from the Run method tab. 

  

  

PCA Tutorial: Correlation Coefficients 

The principal components will appear under the folder name specified in the Data View.  A 
scatterplot of the first two components will also appear, as well as various tables in the Log. 
 The first table displays the correlation coefficients. 

 

We can use this table to interpret correlations between the variables.  There is a strong 
negative correlation between %White and %Black, meaning as the white population 
increases, the black population decreases.  There’s a weak positive correlation between 
%White and %Asian, and no correlation between %White and %Hispanic.  There is a weak 
negative correlation between %Asian and %Black, and no correlation between %Asian and 
%Hispanic.  Finally, there is a weak negative correlation between %Black and %Hispanic. 
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PCA Tutorial:  Components, Eigenvalues, and Eigenvectors 

 

Next, we interpret the breakdown of principal components.  The first component accounts for 
about half of all the variance in the data.  Components 2 and 3 account for almost the same 
amount of variance (about a quarter each), and Component 4 accounts for very little of the 
variance in the data. 

Examining the Eigenvectors of the Pearson correlation matrix reveals the proportion of each 
variable that each Principal Component accounts for.  Prin Comp 1 accounts for 70% of 
%White and 70% of %Black. Prin Comp 2 accounts for 86% of %Hispanic.  Prin Comp 3 
accounts for 88% of %Asian. 

  

  

PCA Tutorial: Scatterplot of Components 

The Principal Component method automatically creates a scatterplot of the first two 
components.  This graphic often displays groupings within the data.   
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A good way to tease out various structues within the data is to color the observations based 
on the values of one of the variables. 

  

  

Principal Component Analysis Tutorial 

Go to "Graph" at the top of the scatterplot, and select "Properties".  Go to the Point fill 
properties tab and select "PCT_Blk".  Choose Classified as your Color mode, Quantiles as 
the Classification Method, and 10 for Number of Classes.  Then select a Color Palette that 
will clearly distinguish the different values.  "Spectrum" is a good choice because the colors 
are very saturated.  Click OK. 
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The bands of color reveal the internal structure of the data.  The blue dots are the tracts with 
highest percentage of black population and red dots are the tracts with the lowest percent of 
black population.  There seems to be a negative correlation between Prin comp 1 and 
princomp2 , until a threshold on the x axis is met, at which point the correlation becomes 
positive. 

You can use PCA to examine a number of different variables.  Just remember that the 
variables need to be similar in what they are measuring.  In our example, we used different 
races.  Similar options might be educational attainment groups, age groups, or income 
groups. 

You have completed this tutorial! 

PCA Visualizations and Sources: 

http://ordination.okstate.edu/PCA.htm 

http://www.uiweb.uidaho.edu/ag/statprog/sas/workshops/multivariate/princomp.pdf 

  

Spatial Regression 
  

Spatial Regression Tutorial: Introduction to Spatial Analysis 
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This tutorial will use spatial regression to explore home ownership and housing values in 
southeast Michigan.  We will be looking at a slice of Census Tracts from Ann Arbor to 
Detroit, Michigan to see how different variables interact with home ownership rates across 
the geography. 

 

About the data 

Detroit is known internationally for its declining population and increasing vacancy. 
 Conversely, Ann Arbor, home to the University of Michigan, displays steady housing 
demand and an increasing population.  These two very different markets should provide an 
excellent geographic context for testing our spatial regression methods. 

*All data was taken from STI:PopStats projections for 2006.  STI:PopStats uses a 
combination of Census data, Zip + 4 data, and field testing, and is widely esteemed as one of 
the most reliable sources for population data. 
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Spatial Regression Tutorial: Method Description 

The methods we will employ include Standard Linear Regression with Ordinary Least 
Squares (OLS), Spatial Error regression, and Spatial Lag regression.  OLS is used to find 
linear dependence between variables.  The assumptions of this method are: errors are 
random, constant, uncorrelated, and normally distributed. 

Spatial error autocorrelation arises if the error terms are correlated, such that  the error of one 
observation affects the error of its neighbors.  If spatial autocorrelation is present, spatial 
error regression can improve upon the OLS coefficients as indicators for the model.  Spatial 
autocorrelation may also indicate that certain spatially correlated covariates are missing from 
the equation.  For more information on spatial autocorrelation, see Geary’s C or Moran’s I. 

Spatial lag assumes that the error terms are correlated, and that events in one place may 
diffuse to neighboring places.  For example, if a town’s groundwater was polluted by arsenic, 
neighboring towns may have an increased likelihood of also being polluted.   

  

  

Spatial Regression Tutorial: Getting Started 
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We can explore relationships in our variables using histograms, maps, scatterplots, box plots, 
and time plots.   

To get started, we will first need to open the Spatial regression tutorial project.  Go to the File 
menu and choose Open.  Browse to the location of the tutorials, which install along with 
SpaceStat in C:\Program Files\Biomedware\SpaceStat\Tutorials.  Find Spatial regression 
tutorial.sps.  The project will load. 

The geography included in this project is the corridor from Ann Arbor, Michigan, to Detroit, 
Michigan.  PCT_Own (percentage of housing units owned) will be our key dependent 
variable for this tutorial.  Go to PCT_OWN under the AnnArbor_Detroit_Corridor 
geography in the Data View and right-click on the variable.  Select the Add to Map option 
and choose to create a New map. 

 

The darkest red represents the highest ownership percentage while the lightest yellow is the 
lowest ownership percentage.  In the heart of Ann Arbor, rental rates are very high because 
many students live there.  The ownership rates increase moving out from that center. 
 Similarly, the heart of Detroit (to the right of the map) has a low ownership percentage, 
which increases moving out from that center.   

  

  

Spatial Regression Tutorial: Data Exploration 

To explore initial correlations in the data, go to the Graphics menu on toolar and choose 
Scatter Plot.  AnnArbor_Detroit_Corridor should be selected as your Geography.  Choose 
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PCT_Own as the Y dataset  and PCT_Vac (percentage of housing units which are vacant) as 
the X datasets.  Click OK. 

The scatter plot will appear.  Go to the Graph menu at the top of the scatter plot and select 
Graph Statistics from the drop down menu. A line of best fit will appear on the graph and 
basic statistics will appear on the pane to the right. 

 

You can analyze the strength of the correlation by using the Correlation Coefficient (r) and 
the table below 

Value of r Strength of 
Relationship 

(-)1.0 to 0.8 Strong 

(-)0.8 to 0.5 Moderately Strong 

(-)0.5 to 0.3 Moderate 

(-)0.3 to 0.1 Weak 

(-)0.1 to 0.0 None or very weak 

We can see that our correlation coefficient of -.55 suggest a moderately strong, negative 
correlation between percentage of homes owned and percentage of homes which are vacant. 
 This means that as vacany increases, home ownership decreases.  We can continue to 
analyze pairs of variables using the scatter plot method. 
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Spatial Regression Tutorial: Ordinary Least Squares Linear Regression 

We will now analyze potential linear dependence between multiple variables with the 
Ordinary Least Squares Regression method (OLS).  Click on the Methods menu in the top 
tool bar and select Regression -> Spatial Regression from the drop-down menu.   

The AnnArbor_Detroit_Corridor geography should be loaded.  Click the Create button to 
create a regression model.  Name your regression model "OLS regression" and choose 
PCT_Own as your dependent variable.  For independent variables, we will use percentage of 
people with bachelor degrees or higher (PCT_BachUp), percentage of black individuals 
(PCT_Blk), percentage of vacancies (PCT_Vac), and percentage in the workforce that are 
unemployed (PCT_WF_UnE).  After selecting each variable, click Add linear term.  The 
variable will appear in the Linear terms box below.  You will not be working with Squared 
terms or Interaction terms at this point.  Click OK.   

 

Next click the Regression Settings tab.  Choose Ordinary least squares from the regression 
type drop-down menu.  Use the default 1st order queen neighbors as the spatial weight set. 
 Specify the output folder name as "OLS regression".  Now select the Run method tab.  Click 
Run.   
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Spatial Regression Tutorial: Interpret the Results of OLS 

The results of the analysis will appear in the Log View.  If the Log View is not present, go to 
the Window menu on the top tool bar and select "Log View". 

The log will show various tests of significance for the data.  The Model Properties shows a 
number of indicators of the model's strength.  Notice that the R-squared value is 0.43, 
indicating a linear correlation of moderate strength between the variables.  The Model 
Parameters table shows the coefficients, standard error, Z value, and the p-value for each of 
the variables.  If the p-value is significant ( p < .05) it will be highlighted in red.  In our 
example, it seems that all of our variables are significant. 

 

The Test of Normaility of Errors gives us more insight into the data.  The Jarque-Bera Test 
examines the normality of the distribution of the errors.  Remember that OLS assumes that 
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the errors are normally distributed.  The low probability of the Jarque-Bera Test indicates a 
non-normal distribution of the errors.   

 

The Random Coefficients tests also point to different levels of variance in the datasets.  The 
low probabilities indicate the presence of heteroskedasticity or non-constant variance.  This 
is consistent with the Jarque-Berra Test and means we may see better results if we use Spatial 
Error regression, and/or Spatial Lag regression. 

The Regression Diagnostics for Spatial Dependence assess whether there may be any spatial 
dependence in the model.  Moran’s I score of 0.241 is highly significant, indicating strong 
spatial autocorrelation of the residuals.  The other five tests indicate whether tests of error or 
lag are significant.  In the instances below, the Robust LM (lag) is border line non-significant 
at p=0.05, while the Robust LM (error) is significant at with a p-value of .023.  This suggests 
that Spatial Error regression might be a better model for our data than Spatial Lag regression. 

 

Another way to evaluate the estimating ability of your model is to look at the correlation 
between the Estimated Mean and the dependent variable.  Go to the PCT_Own dataset in the 
Data View.  Right-click on the dataset and choose Rename from the drop-down menu. 
  Change the name to OLS-Estimated Mean and repeat this process for the residuals and 
standard error of the mean.   

Next go to the Graphics menu and select the Scatterplot.  Choose OLS-Estimated Mean as 
the y dataset and PCT_Own as the x dataset.  The r=0.659 indicates a moderately strong 
correlation. 
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Spatial Regression Tutorial: Spatial lag model 

Since our data has violated some of the assumptions for OLS regression and we have 
evidence of spatial autocorrelation, we will see if taking the spatial component into account 
improves the precision of our model.  We will start with a spatial lag model.  Go to the 
Methods menu and select Regression -> Spatial Regression.  The OLS model from before 
will still be present.  Change the name to Spatial Lag model or create a new model with the 
same datasets.  On the Regression settings tab, choose Spatial lag from the Regression type 
menu.  Change the name of the Output folder to Lag Regression.  Under the Run method tab 
click the Run button.   
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The R-squared value under Model Properties indicates an improvement from our previous 
model, with R-squared = .48 compared to .44 in the OLS model.  The model parameters 
show significance in all of the datasets except for percent of workforce that is unemployed. 
 The Rho reflects the spatial dependence inherent in our sample data, measuring the average 
influence on observations by their neighboring observations.   

The Random Coefficients still show a high probability, and therefore relevant coefficients 
may be absent from the model.  Or we may need to add squared terms to our model and test 
them against the residuals.   

The likelihood Ratio test is a good indicator that spatial lag dependence is present in the data. 
The Lagrange Multiplier Test indicates that Spatial Error Dependence is not significant (p= 
0.44) according to this model, but because of our OLS results, we should still expore the 
Spatial Error model. 

 

Make a scatterplot of the Estimated Mean from the Lag regression against the PCT_Own 
variable, placing the estimated mean on the y axis and PCT_Own on the x axis.  r=0.664, 
indicating a slightly stronger correlation than the OLS model at r=0.659. 
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Spatial Regression Tutorial: Spatial Error Regression 

Now let’s run Spatial Error regression to compare the results with Spatial Lag and OLS.   

Go to the Methods Menu and select Regression -> Spatial Regression.  Click Modify on the 
model and change the name to Err regression or create another model with identical 
parameters but with a different name.  Under the Regression Settings tab, change Regression 
type to Spatial error.  Also change the name of the output folder to Error Regression.  Select 
the Run method tab and click Run.   

The R-squared has dropped to 0.369 when compared to 0.48 from the Spatial Lag model, and 
.44 from the OLS model.  However, in this model all of our variables are significant, 
including the percentage unemployed.  Heteroskedasticity in the errors also remains 
significant.  Interestingly, this model shows that Spatial Error Dependence is significant and 
Spatial Lag Dependence is not.   

Make a scatterplot of the Estimated Mean from the Error regression against the PCT_Own 
variable, placing the Estimated Mean on the y axis and Pct_Own on the x axis.  In this model 
r=0.651, indicating a slightly weaker correlation than the Spatial Lag model at r=0.66, and 
the OLS model at r=0.659. 
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Spatial Regression Tutorial: Drawing Conclusions 

In comparing the OLS, spatial lag, and spatial error models, we can conclude that the spatial 
lag model is most efficient because it has the highest R-squared coefficient and strongest 
correlation between estimated mean and PCT_Own. Because our heteroskedasticity remained 
high in all models, we must conclude that other factors are influencing spatial dependence. 

To improve the model and account for the heteroskedasticity, you can add new variables or 
include squared terms.  Go to the Methods menu and select Regression -> Spatial 
Regression.  Click Modify on the model and change the name to something appropriate (i.e 
Spatial Lag Squared model).  Add new variables to the current linear terms (such as 
percentage of homes which are rented "PCT_Rent" or median housing unit value 
"MedHUVal").  You can also add the variables as squared or interaction terms.   

Continue to explore the possibilities. 

You have completed this tutorial! 

Sources: 

http://www.iq.harvard.edu/blog/sss/archives/2005/11/spatial_error_1.shtml 

http://www.experiment-resources.com/statistical-correlation.html 

  

Interactive Exploration 
  

Interactive Exploration Tutorial 

This tutorial is designed to show new users how to explore space-time data interactively in 
SpaceStat. We use data from the US National Atlas of Cancer Mortality, available from the 
NCI website. 

In this tutorial, however, you will not need to download or otherwise prepare the data 
yourself. The tutorial includes a pre-made project file for exploration. So, although SpaceStat 
projects normally start with importing data, this tutorial begins with that step completed.    

Steps 

1. Interactive exploration: Compare mapped and graphed data by brushing linked 
windows. 
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2. Seamless animations: Animate several windows in concert. 

3. Integrate with other software: Export a customized animated map for use in a 
presentation. 

These tasks are a subset of what is possible with the SpaceStat software, but enough to give 
you a sense of SpaceStat's user interface and the innovative ways in which this tool can help 
you explore your data. 

  

  

Data Description 

The data in this tutorial comes from the National Cancer Institute. The datasets included in 
the project are for colon cancer deaths in 5 year time intervals from 1970-1994. Among 
cancers, the highest mortality for men is from lung, prostate, and colon cancers respectively, 
for women it is breast, lung, and colon cancers, all of which demonstrate spatial pattern 
(Devesa et al. 1999). Thus, colon cancer mortality is an important subject for study, 
especially with tools that allow you to evaluate patterns in both space and time. 

The data in this tutorial are associated with state economic areas (SEAs) which are groups of 
counties with similar socioeconomic characteristics. These data are grouped by race and 
gender for African-American and white populations. 

Variable Definition 

R Mortality rate per 100,000 person-years, age-adjusted to the 1970 U.S. 
population. 

C Number of deaths 

P Population that we back-calculate 

LBR Lower bound of the 95% confidence interval on the mortality rate 

UBR Upper bound of the 95% confidence interval on the mortality rate 

This tutorial focuses in on the southeastern part of the continental US, in part because data 
for African-Americans is sparse in rural areas in other parts of the country. One problem with 
exploring patterns for multiple ethnic groups is that there may be large differences in 
population sizes across groups in some parts of your focal goegraphy - for example there are 
low populations of African-Americans in rural areas of the midwestern and western United 
States. Because of low population numbers, the counts used to create the mortality rates are 
based on small samples and the rates are thereby unstable—subject to fluctuations that may 
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be due to chance. The NCI print and online atlas masks data based on few counts (< 6 deaths 
in the 5 year time period). We focus on the southeastern United States and Gulf Coast, 
including part of eastern Texas, Mississippi, Louisiana, Alabama, Georgia, Florida, South 
Carolina, and North Carolina. This region has high enough populations of African-
Americans to avoid the rural areas becoming masked out, as masked data is unsuitable for 
spatial analysis. The southeastern US has been identified as a region of persistently high 
mortality (Cossman et al. 2003), though it is not the highest mortality region for colon cancer 
in the U.S. For colon cancer mortality rates, the southeast is exceeded by the northeastern 
states (Devesa et al. 1999). 

The National Atlas has compiled metadata for part of this dataset. View their metadata at the 
National Atlas website. 

  

Explore 

  

Explore 

SpaceStat offers several ways for you to explore spatial and temporal data. 

1. Start SpaceStat (Start menu > Programs > Biomedware > SpaceStat). If you're 
running the evaluation version, you will have to choose to "evaluate this software" 
and hit "Continue" before it will run. 

2. Choose to open an existing project. Click on the open folder in the visualization 
toolbar or in the File menu. 

3. The project that you will be working with was copied to Program 
files/Biomedware/SpaceStat/Tutorials when you installed SpaceStat, and the name of 
the project is SEandGulf.sps. You may need to maximize the application or tile the 
windows (Window > Tile) to see all of the views of the data on your monitor. 

When the project loads, you will see a map and several graphs of the same dataset, the colon 
cancer mortality rate for black males. You will see a map, a scatterplot, a histogram, a time 
plot, and a box plot of the RBM dataset. All of the views of the data will be at the beginning 
of the project, 1/1/1970, except the time plot, which shows the entire temporal range. 

  

  

First Glance 

At first glance, this combined view of the data is revealing. 
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Starting from the upper left, the workspace shows the time plot, map, (lower row) the 
histogram, scatter plot, and boxplot.  Your views may appear in a different relative location, 
but you can drag them around to match the arrangement shown here if you wish. 

From the time plot, you see that the data is organized in 5-year time increments from 1970-
1994. It resembles an ascending staircase, indicating that the death rates for black males from 
colon cancer have increased across the entire region during the study period. Perhaps they're 
levelling off by the end.  Note that for the maps and all other plots, the range shown is for the 
entire time period.  So, for example, colors on the map, and points on the scatter plot appear 
clustered in the low ranges for this time period relative to the color ramp or maximum value 
on the axis. 

In the map, you get a sense of the spatial pattern of colon cancer deaths in 1970, with an 
area in SE Georgia popping out visually from its surroundings. 

In the scatter plot, you get a sense of the relationship between the count of cancer deaths 
(CBM) and the colon cancer rate (RBM). Because they are population standardized, the 
highest counts are not necessarily associated with the highest rates. 

In the histogram, you can see the distribution of the data for this early time period.  Note 
that, as mentioned above, the bounds of the histogram set by the range of data for the entire 
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study period, so this graph from 1970 appears clustered in the lower values of the range, but 
we know from the time plot that rates will increase. 

In the box plot, you can identify extreme values (rates higher than the horizontal 
"whiskers"). 

  

  

Brushing 

In SpaceStat, you can get beyond passive views of the data by interacting with the maps and 
graphs. 

Use your cursor to draw a selection rectangle on the box plot that includes the two points 
above the whiskers in the box plot, as shown below (lower right). 

 

The selected points turn orange. You'll notice there is now orange highlighting in all of the 
other views of the data. All of the views of the SE and Gulf Coast geography are linked 
together automatically, and when you select in one, the selection is shown in all linked views. 
Thus, you can see where those extreme rates occur on the map, as the relevant polygons are 
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outlined in orange. The box plot confirms our earlier recognition that the southeastern SEA 
in Georgia had a high rate. But, another high rate is in a smaller SEA in North Carolina. This 
one is harder to pick out visually because of its size, but the box plot helps to identify it as 
extreme. 

You can see that these SEAs with extreme cancer rates do not also have the highest cancer 
mortality counts (at least in 1970) by checking out the two highlighted points in the scatter 
plot.  In the time plot, you can see the trajectory of these areas over time, again shown in 
orange. Interestingly, although mortality rates in these two areas are quite high relative to 
other SEAs in 1970, they do not stay elevated relative to the rest of the study area; in later 
times their rates are either average or even low. 

Explore the dataset by selecting points or bars or regions in any of the views of the data.  You 
can also examine statistical characteristics of the data by going to the "Graph" menu and 
clicking on the "Graph Statistics" option to bring up the Graph Statistics windows for the 
histogram, scatter plot, or box plot. 

  

Animate 

  

Animate 

As you can see in the time plot, this dataset includes information about several time periods, 
and we see only 1970 in the initial map. 

• To see change in the map over time, hit the play button on the animation toolbar. It 
will play through the time range and stop at the end. 

• To see a continuous loop, hit the loop button and then hit play again. 

• To slow the animation, change the step size (Animation > Set step size). The original 
step size is 5 years, to linger in a time period, choose a step size of 1 year. Then, it 
will stay in each 5 year interval for 5 beats, rather than 1. 

• You can see a sample animation below, this one has a step size of 5 years. (Help: I 
don't see the image animate.) 
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But, as you can see on your screen, only the map is animated. The other views are static. You 
can hit play on each of the views except the time plot, but wouldn't it be nice if they all were 
synchronized? 

  

  

Synchronize 

Wouldn't it be nice if the maps and graphs were synchronized? 

You can synchronize all of the open views of the data so that they animate together. 

• Choose "Synchronize Views" from the Windows menu. 

• We will make the map window, which appears at the top of the list, the lead window. 
Check the boxes next to the other views in the project by clicking on the view name 
(histogram, scatterplot, box plot). Note: clicking on the check box, rather than the 
view name, will not check the box.  Also, the time plot is not available in teh 
"Synchronized view" list because it does not animate. When you're finished, the 
dialog should look like the one shown below. 
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• Click OK. 

• Now, when you hit play in the map, all views will animate in sync. 

• You can also move the time slider to change the time shown in all views. This 
provides a more interactive way to explore the data than simply watching it play. 

  

Customize and Integrate 

  

Customize 

Now, you can optimize your map and export it for use in a slide presentation or in a website. 

• First, stop the animation. 

• Then, change how the map is displayed by selecting the properties button in the 
map toolbar. 

We're going to change just the polygon fill attributes, though you can modify several things 
about how the map is displayed (more information about customizing maps). 

• Change the color mode to "Classified" 

• Choose 5 classes and "Quantiles" and change the color palette. 

• When you're done the dialog should look like this (though you may have chosen a 
different color palette). 
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• Choose "OK" to close the dialog. 

  

  

Integrate 

Now you've got a customized map, which looks quite different from the original. 
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Now, let's export the animated map to an AVI file so that you can share it with people who 
do not have the SpaceStat software. 

• Choose "Export animation" from the Map menu. 

• Choose a start and end time for the animation and a step size. The defaults are the 
range of the dataset and the step size in the animation control. 

• Choose a name and a location to save the file. 

• Now you can play it in another product. Exit SpaceStat and double click the AVI file 
to open it. 

You've completed this tutorial! 

  

Small Numbers 
  

Small Numbers Problem 

The interpretation of public health data is affected by the problem of interpreting small 
numbers. 

Statisticians and researchers have greater confidence in counts and rates for more common 
diseases and for larger subpopulations. Epidemiologists tend to have less confidence in rates 
(count/population) calculated from small populations-at-risk. These rates tend to be unstable, 
because small changes in the count or in the population lead to wide variance in the rate. 

In this tutorial, we will apply two methods to assess and perhaps reduce the influence of 
small numbers and unstable rates on an analysis. We will: 

• mask sparse data by eliminating small-population areas and 
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• smooth the data to reduce the estimates for small-population areas. 

  

  

Pancreatic Cancer Rates and Counts 

For this tutorial, we will use data on pancreatic cancer mortality rates and counts for US 
counties. 

This data is from the National Cancer Institute's Cancer Mortality Maps and Graphs website. 
We will also use population-at-risk back-calculated from the counts and rate data. This 
population at risk data is estimated from the rate and count data, and for locations with a 
count of zero deaths, we cannot estimate the population, so those areas will have missing 
values for their population-at-risk. 

Run SpaceStat and open the Pancreatic_Counties.sps file (it will be in Project 
files/Biomedware/SpaceStat/Tutorials). 

 

  

When you open the project, you will see one geography, the US counties, and several 
datasets. The names of the datasets can appear somewhat cryptic. In the "pancounty" folder, 
there is a rate dataset (begins with "R"), a count dataset (begins with "C"), and an estimated 
population dataset (begins with P) for pancreatic cancer mortality for black females (BF). 
The numbers in parentheses in the dataset name indicate the duration of the information. The 
data cover 1970-1994 for blacks. The LBR and UBR datasets are the lower and upper bound 
for the rate, respectively. 

  

  

Are Small Numbers a Problem? 
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To see if small numbers influence the interpretation of maps of pancreatic cancer (i.e., are 
associated with rate instability), map the RBF dataset.  (Note there is only one set of values 
for this dataset, and it applies to the time range 1970-1994). 

Right-click on the dataset in the data view and choose "Add to map > New map". The new 
map will appear. 

 

Next, show the box plot by clicking on the box plot icon in the visualization toolbar and 
choose "RBF...". 

 

Now, select the highest rate from the box plot using your mouse cursor. 

 

Next, query the selected location in the map (you may need to zoom in). 

What is the count for black female deaths in 1970-1994 ("CBF...")? The rate is quite high 
(377.42 deaths/100,000 person years). Yet the count is small: 1 death between 1970-1995. 
The rate is high because the population is low....So yes, it seems like small numbers do 
influence our interpretation of the pancreatic cancer mortality maps. 
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Masking 

  

Mask Sparse Data 

The website and printed atlas (Devesa et al. 1999) available from the National Cancer 
Institute (NCI) address the small numbers problem by hiding data based on very small 
counts. When the data are mapped, rates based on small counts are hidden and recoded as 
"sparse data", essentially these data are too uncertain to be emphasized in the map. 

The NCI's criteria 

The NCI masked data when the count was less than 6, when the count was less than 12 and 
the rate was similar to the national average rate, or when the expected count was less than 6 
and the rate was similar to the national average rate. 

Choosing our own criterion 

We can use the scatterplot to assess the spread in the rates based on the counts. 

Display the scatter plot of black female mortality rate (RBF) as a function of the case count 
(CBF)...(select scatter plot from the visualization toolbar). 
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What is the shape of this scatterplot?   

 

What does the wide spread of rate values at low counts tell you about the stability of the 
rates? How large should the count be to yield a stable rate?  You can use the scatterplot 
properties (under the Graph pulldown menu, then select   Properties, and look for the 
"Bounds" box in the lower left section of the General page) to limit the bounds of the x-axis 
of the plot on low counts, as shown below.   By focusing in, you can get a good idea of at 
what count value rates begin to stabilize. 

 

Choose a count cutoff to stabilize the rates, and remember it to use later.  Recall that the rate 
(RBF) represents the count over the total population of black females per county, so you 
could create a similar plot of counts on the y-axis and population size (if available; this 
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tutorial includes population sizes back-calculated from the count and rate data) on the x-axis. 
 These are just two of many examples of how you might identify criteria used for masking. 

  

  

Remove Data 

You can remove rates that are based on counts below your confidence threshold by selecting 
areas below that threshold, inverting the selection, and then creating a new geography. These 
actions create a new geography that consists of all locations above your threshold. 

• Open a table and then move its time slider to 1970. 

• Sort the "CBF..." column by right-clicking on the header, and choosing "Sort", and 
"Ascending".  Select those locations with counts less your threshold (you can use 
shift-select, and click on the first and last row you want to include, or else drag your 
cursor to select multiple rows). 

 

• Examine the map to see the distribution of counties with low counts (outlined in 
orange).  Then, right click on the map and pick "invert selection" to select counties 
with counts at or above your threshold.  (Note that you can also "invert selection" 
from the right click menu for tables, see image above).   
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• Then right click on the map again and choose "New geography from selected"; name 
it "Counties with counts > (add your threshold)" and click on "Include parent 

geography’s data sets". Then click "OK". 

 

  

  

Compare Masked and Raw Data 

A new geography named ”r;Counties with counts > threshold” should have been added to the 
data view as a result of your previous exercise, and if you click on the "+" next to the 
geography name, you can reveal all of the datasets. Create a map for "RBF..." from this new 
geography by right clicking on the dataset name, and selecting "Add to map" and then "New 
map".   

Now create a box plots for RBF for the new geography (masked data) and compare it to the 
one you already created for the county geography (raw data).  How do the box plots differ? 
How do the maps differ? 
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You could use other criteria or datasets, such as the count and population datasets mentioned 
previously, to mask rates, or you could choose to select all but the outliers outside the 
whiskers in the box plot....feel free to experiment to see whether you prefer one criterion to 
another. 

What do you think of masking data this way? Given that many spatial statistics are based on 
contiguity relationships (e.g., counts of polygons that share borders), how would you expect 
masking to affect statistical inference? 

  

Smoothing 

  

Smoothing Pancreatic Cancer Rates 

Instead of hiding data, you can smooth the unreliable rates based on small populations. In 
SpaceStat, you can smooth using the Empirical Bayesian smoother. This smoother shrinks 
rates based on small populations towards the global or the local mean. Smoothing produces 
three new datasets, two smoothed rates and one set of local means. 
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To smooth the rates, choose "Smoothing > Empirical Bayesian smoother" from the 
"Methods" menu. You will then see this dialog. Choose "RBF..." as the disease rate dataset 
and "PBF..." as the population at risk dataset. You will need to specify the range of the local 
mean for the local mean smoothing, which is determined by your choice of spatial weights 
set. You can use the prepared weights set (1st and 2nd order neighbors, with ego) or your 
own. If you choose a custom one, make sure it includes ego. 

The input page of the Task Manager for Empirical Bayesian smoothing should look like the 
one shown below (your weights set may differ).  The bottom of the page asks for the units 
multiplier for the count dataset, which is 100,000 for all NCI data.  We will keep the output 
page at the default value, but you can click on this section to see the name stem assigned to 
the output files.  Click on the run method page, which will summarize all of the options 
chosen on the preceding three pages, and then select "Run". 

 

  

  

Smoothing Results 

Create four maps, one of the raw RBF data, one of the RBF data smoothed to the global 
mean, one of the RBF data smoothed to the local mean, and the last of the local means 
themselves. (To do this, you can right-click the datasets in the Data View and then choose to 
"Add to map > New map".) 
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To facilitate comparisons, apply the same classified color scheme with "custom" breaks to all 
four maps, shown below. Click on   Properties, and you will see options for changing the 
polygon fill.  The screenshot below uses a five-class scheme with color break values of 0, 5, 
15, 45, 90, and 380. You have to apply these break values manually to each map by typing 
them into the "Min" and "Max" boxes that you will see once you have chosen a classified 
"custom" scheme with 5 classes.   

 

You can see that there are a few differences in the maps. 

Both smoothed datasets are much smoother than the raw data. The darkest greens and the 
white are missing from the smoothed datasets -- even though these colors show up as classes 
in the legend, they have no representative polygons on the map. 

The smoothed datasets differ. The local means smoothed dataset is less smooth than the 
global mean smoothed dataset. You can tell that the local means smoothed map closely 
resembles the population-weighted local means map. 

Another difference is that the local mean smoothed map has missing values, while the global 
mean smoothed map does not. The missing values in the local means come from missing 
values in the population estimates. As the local mean is population-weighted, it cannot be 
calculated where population estimates are missing. The global mean is not sensitive to local 
variations in population or rates.   
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With a true (rather than estimated) population dataset, the local mean smoothed dataset 
would not have missing values. In this case, it is as if we masked out locations with counts of 
zero and then smoothed the rest. 

  

  

Methods Compared 

You can see that masking and smoothing are two alternative ways to accomplish the same 
goal. They both stabilize rate datasets. But, masking throws away locations, while smoothing 
reduces the variance in the data by shrinking lower population areas towards the dataset 
mean. Both reduce the information in the raw dataset, but they can give you data you may 
trust more than the unstable raw rates. 

You've completed this tutorial! 
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SpaceStat Resources 
This section of the help files provides a number of tools to help you learn more about 
working with SpaceStat.  These include: 

• A glossary of terms and acronymns. 

• A troubleshooting guide for importing and exporting files. 

• A list of references cited in the method descriptions. 

Finally, this section has information on registering SpaceStat, and information on the people 
behind the software. 

Note that if you would like to send us a suggestion for additional resources, to report a bug, 
or to tell us what you would like to see in the next version of SpaceStat, please contact us via 
support@biomedware.com or through the "Contact us" section of the BioMedware website.   

  

  

Troubleshooting 

Problems importing problem files 

I have a problem file from an analysis in a previous version of SpaceStat, but I don't have 
the shapefile that goes with it.   

Older versions of SpaceStat used spatial weight sets to define neighbor relationships between 
objects, but did not have the visualization capabilities to map these objects.  The space-time 
platform on which SpaceStat 2.0 and beyond was built requires that all imported data have a 
spatial and temporal component.  This allows SpaceStat to create sophisticated maps that can 
be animated through time.   

If you do not have a shapefile or some other geographic file there still is a way in which you 
can import this data into the new SpaceStat.  You will be able to conduct analyses which use 
the information found in the spatial weight set, but you will not be able to map this data.   
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To import a problem file, go to File -> Import > SpaceStat 1.x file.  You may also select the 
  icon on the toolbar and choose SpaceStat 1.x.  When you click on SpaceStat 1.x file, hold 
down the SHIFT key.  The following dialog will appear. 

 

This is similar to the usual import problem file dialog except there is an option to create a 
provisional geography.  This type of geography is created from randomly generated points 
and serves only to host the datasets and spatial weight sets that are associated with the 
problem file.  You will be able to run any analysis that uses spatial weight sets but will not be 
able to map the objects (since the geographical location of the objects have no relationship to 
the data or spatial weight sets).  Also, you will not be able to create new spatial weight sets or 
create variogram clouds for the same reason.  Any methods which reference the geographic 
locations of the objects, such as Turnbull's or Besag & Newell, can not be performed with 
provisional geographies. 

In the Data View, provisional geographies will use the old SpaceStat icon instead of the icon 
for polygon   or point  geographies.   

 

Problems importing shapefiles 

Click here to see information on export-related problems 

I imported a shapefile, but I get an error message when I try to merge a newly imported 
shapefile or DBF to it. 
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This happens when the parent or original geography does not have any datasets which can 
serve as an ID field (the ID field is used to join the datasets and must be integer or string, 
each value unique). You may need to convert the type of a dataset to make it fit the 
requirements. 

This can also happen if you have multiple objects in your shapefile with the same ID. This 
can occur if a complex set of polygons is represented as separate rows in a DBF associated 
with a shapefile (so separate objects in the shapefile). To avoid this, you can merge polygons 
by ID when you import the shapefile. 

I tried to import a large shapefile, and the import process seems to have stalled while 
SpaceStat calculates spatial weights. 

If you have a very large geography, the import process may appear to hang up as SpaceStat 
calculate spatial weights.  You can either be patient and wait for the calculations to be 
completed, or choose to skip the calculation of weights, and then calculate them later as 
needed for the use of particular statistical methods.   

After I imported a shapefile, I see an error message about self-intersecting polygons 

In some polygon geographies, polygons that share one ID have boundaries that self-intersect, 
which will trigger an error message from SpaceStat that will appear in the log view.  For 
example, the message shown below comes up when you import the National Cancer 
Institute's State Economic Area geography (available from the NCI website).  One of the 
polygons that self intersects is in Texas (see orange SEA on map).  Information on how to 
identify this and other problematic polygons is given in the error message (bottom-left of 
image), which allows you to find them in the table and highlight them on the map.   
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As you can see, SpaceStat maps these polygons and includes them in the tabular data. 
 However, self intersecting polygons are excluded from Scale Conversion/Interpolation 
methods, so we note their presence as part of the import process.  Often, you can make small 
edits in the shapefile (in a GIS software program) to correct this problem, and then re-import 
the file into SpaceStat (you can't edit polygon boundaries within SpaceStat).   

Problems exporting shapefiles and datasets 

I exported a shapefile from SpaceStat, but the datasets in the file can't be read by ESRI GIS 
software.   

In some cases, when you try to use a shapefile exported from SpaceStat in ESRI's most 
recent ArcGIS products, you will get an error message that says "A column was specified 
that does not exist."  When this error occurs, you will be able to view a map of the shapefile 
in ArcMap, but won't be able to open the associated table (dbf file).  This error does not 
occur if you try to bring the exported shapefile into older ESRI products (i.e., ArcView 3.2), 
or into free GIS programs (i.e., DIVA).  The problem appears to be related to the ArcGIS 
products not being able to handle spaces in the names (headers) of datasets.  So, you can 
either remove these spaces in your dataset names before trying to export the shapefile, or can 
edit the dbf component of the shapefile (in Microsoft Excel or some other program) after you 
export it from SpaceStat, but before you try to import it.   Note, dataset names are also 
truncated when you export them from SpaceStat, so if you do your name editing prior to 
export, you may wish to shorten one with similar suffixes so that you can tell them apart after 
you export. 

I exported datasets (or a shapefile) from SpaceStat, and in the output dbf, some datasets 
now have the same name.   

When SpaceStat exports datasets (tabular data), the column headers are truncated at 10 
characters.  If you are exporting datasets that represent output from various statistical 
procedures (which sometimes have long "output" names), you may find that when the names 
are truncated, you can no longer tell the datasets apart because the first 10 characters in their 
names are the same (i.e., you are exporting data from several runs of the same statistical 
method, perhaps with different parameter values).  The solution is to right click on the 
dataset names prior to exporting them, and use the "rename dataset" option to shorten the 
name to 10 characters or less.   
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ColorBrewer www.colorbrewer.org 

  

  

Licensing and Updating SpaceStat 
You can download a trial version of SpaceStat from the BioMedware website. 

When you reach the end of your evaluation period or your license expires, you will see the 
following window.  To continue to use the software, please visit our website to explore 
various purchase options, or contact us at sales@biomedware.com.   

 

Licensing Process 

When you decide to purchase the software, choose the "License now" button.  When you do, 
you will see a window like the one below with a user code, and a string of zeroes and dashes 
where you will later enter a license code.  The user code you see, and the license code you 
will receive from us will be specific to your computer (do not use the codes shown below!). 
 Email the user code to sales@biomedware.com and the sales department will email you the 
registration code. Once you have the code, start SpaceStat, and again select the "Purchase 
now" option. Then, type or copy the license code that you received into the license code box 
and choose "OK". The codes will unlock SpaceStat on your computer and you will not see 
these windows again until your license expires. 
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If your license is valid, you can check to see how much time is left until it expires by going 
to the Help menu and selecting Licensing.  The dialog will report the duration of your license 
and how much longer until it expires. 

 

Contact sales@biomedware.com for information regarding the installation of SpaceStat on 
additional computers. 

Updating 

For information on future updates for SpaceStat, please contact BioMedware at 
sales@biomedware.com or visit www.biomedware.com. 

For support, contact support@biomedware.com. 
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About BioMedware's SpaceStat 
Principal Investigators: Pierre Goovaerts and Geoffrey Jacquez 

SpaceStat Team:  Eve Do, Sue Hinton, Justin Holman, Geoff Jacquez, Andy Kaufmann, 
Sharon Matthews, Susan Maxwell, Yanna Pallicaris, Jawaid Rasul, and Bob Rommel 

Contact Information: 

BioMedware 
121 W. Washington, 4th Floor - TBC 
Ann Arbor, MI 
48104 

We can be reached via info@biomedware.com or through the "Contact us" section of the 
BioMedware website.   

This product includes color specifications and designs developed by Cynthia Brewer 
(http://colorbrewer.org/). 

This project was supported by grant CA92669 from the National Cancer Institute (NCI) and 
grant ES10220 from the National Institute for Environmental Health Sciences (NIEHS) to 
BioMedware, Inc. The software and help contents are solely the responsibility of the authors 
and do not necessarily represent the official views of the NCI or NIEHS. 

This version of SpaceStat is dedicated to the loving memory of Jawaid Rasul.   

© 2014 BioMedware. All rights reserved. 

BioMedware's SpaceStat is protected by U.S. patents 6,360,184, 6,460,011, 6,704,686, 
6,738,729, and 6,985,829, with other patents pending. 
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